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Warning: MATHSOFT IS WILLING TO LICENSE THE ENCLOSED SOFTWARE TO YOU ONLY UPON 
THE CONDITION THAT YOU ACCEPT ALL OF THE TERMS CONTAINED IN THIS LICENSE 
AGREEMENT. PLEASE READ THE TERMS CAREFULLY BEFORE OPENING THE PACKAGE WITH 
THE CD-ROM OR OTHER MEDIA, AS OPENING THE PACKAGE WILL INDICATE YOUR ASSENT 
TO THEM. IF YOU DO NOT AGREE TO THESE TERMS, THEN MATHSOFT IS UNWILLING TO 
LICENSE THE SOFTWARE TO YOU, IN WHICH EVENT YOU SHOULD RETURN THIS COMPLETE 
PACKAGE WITH ALL ORIGINAL MATERIALS AND THE UNOPENED PACKAGE WITH THE CD-
ROM OR OTHER MEDIA AND YOUR MONEY WILL BE REFUNDED.

MATHSOFT, INC. LICENSE AGREEMENT

Both the Software and the documentation are protected under applicable copyright laws, international treaty
provisions, and trade secret statutes of the various states. This Agreement grants you a personal, limited, n
exclusive, non-transferable license to use the Software and the documentation. This is not an agreement for
of the Software or the documentation or any copies or part thereof. Your right to use the Software and the 
documentation is limited to the terms and conditions described therein.

You may use the Software and the documentation solely for your own personal or internal purposes, for no
remunerated demonstrations (but not for delivery or sale) in connection with your personal or internal purpo

(a) if you have a single license, on only one computer at a time and by only one user at a time, the user of the c
on which the software is installed may make a copy for his or her exclusive use on a portable computer so l
the Software is not used on both computers at the same time;

(b) if you have acquired multiple licenses, the Software may be used on either stand alone computers, or on c
networks, by a number of simultaneous users equal to or less than the number of licenses that you have acqu

(c) if you maintain the confidentiality of the Software and documentation at all times.

Persons for whom license fees have not been paid may not access or use the Software, or any part thereof
“programmatic access” or otherwise. Anyone wishing programmatic access will need to be established as use
the terms of this Agreement.

You may make copies of the Software solely for archival purposes, provided you reproduce and include the co
notice on any backup copy.

You must have a reasonable mechanism or process which ensures that the number of users at any one time
exceed the number of licenses you have paid for and prevents access to the Software to any person not au
under the above license to use the Software. Any copy which you make of the Software, in whole or in part,
property of MathSoft. You agree to reproduce and include MathSoft’s copyright, trademark and other propri
rights notices on any copy you make of the Software.

You may receive the Software in more than one medium. Regardless of the type or size of media you recei
may use only one medium that is appropriate for your single computer. You may not use or install other med
another computer. You may not loan, rent, lease, or otherwise transfer the other medium to another user.

You may not reverse engineer, decompile, or disassemble the Software, except and only to the extent that suc
is expressly permitted by applicable law notwithstanding this limitation.

If the Software is labeled as an upgrade, you must be properly licensed to use a product identified by MathS
being eligible for the upgrade in order to use the Software. Software labeled as an upgrade replaces and/or sup
the product that formed the basis of your eligibility for the upgrade. You may use the resulting upgraded pro
only in accordance with the terms of this license, which superseded all prior agreements.

MathSoft reserves all rights not expressly granted to you by this License Agreement. The license granted h
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limited solely to the uses specified above and, without limiting the generality of the foregoing, you are NOT lic
to use or to copy all or any part of the Software or the documentation in connection with the sale, resale, lice
other for-profit personal or commercial reproduction or commercial distribution or computer programs or oth
materials without the prior written consent of MathSoft. You will not export or re-export the Software without
appropriate United States and/or foreign government licenses.

LIMITED WARRANTY

MathSoft warrants that the media on which the Software is recorded will be free from defects in materials a
workmanship under normal use for a period of ninety (90) days from the date of purchase as evidenced by a
your receipt. The liability of MathSoft pursuant to this limited warranty shall be limited to the replacement of
defective media. If failure of the media has resulted from accident, abuse, or misapplication of the product, 
MathSoft shall have no responsibility to replace the media under this limited warranty.

THIS LIMITED WARRANTY AND RIGHT OF REPLACEMENT IS IN LIEU OF, AND YOU HEREBY 
WAIVE, ANY AND ALL OTHER WARRANTIES BOTH EXPRESS AND IMPLIED, RELATING TO THE 
SOFTWARE, DOCUMENTATION, MEDIA OR THIS LICENSE, INCLUDING BUT NOT LIMITED TO 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE AND 
NONINFRINGEMENT. IN NO EVENT SHALL MATHSOFT BE LIABLE FOR INCIDENTAL OR CON-
SEQUENTIAL DAMAGES, INCLUDING BUT NOT LIMITED TO LOSS OF USE, LOSS OF REVENUES 
OR PROFIT, LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED 
BY THIRD PARTIES EVEN IF MATHSOFT HAS BEEN ADVISED OF THE POSSIBILITIES OF SUCH 
DAMAGES. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY MATHSOFT, ITS 
EMPLOYEES, DISTRIBUTORS, DEALERS, OR AGENTS SHALL INCREASE THE SCOPE OF THE 
ABOVE WARRANTIES OR CREATE ANY NEW WARRANTIES; WE DISCLAIM AND EXCLUDE ALL 
OTHER IMPLIED OR EXPRESS WARRANTIES.  This warranty gives you specific legal rights which may 
vary from state to state. Some states do not allow the limitation or exclusion of liability for consequential 
damages, so the above limitation may not apply to you.

MathSoft hereby warns you that due to the complexity of the Software it is possible that use of the Software
lead unintentionally to the loss or corruption of data. You assume all risk for such data loss or corruption; th
warranties provided hereunder do not cover any damage or losses resulting therefrom.

MathSoft’s licensors do not warrant the Software, do not assume any liability regarding the Software and do
undertake to furnish any support or information regarding the Software.

IN NO CASE WILL MATHSOFT’S LIABILITY EXCEED THE AMOUNT OF THE LICENSE FEE ACTUALLY 
PAID BY YOU TO MATHSOFT.

The Software and documentation are provided with restricted rights. Use, duplication, or disclosure by the G
ment is subject to restriction as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Com
Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Sof
Restricted Rights at 48 CCFR 52.227-19, as applicable. Manufacturer is MathSoft, Inc., 101 Main Street, Cam
MA 02142.

Without prejudice to any other rights, MathSoft may terminate this license if you fail to comply with the terms
conditions of this Agreement. If this license is terminated, you agree to destroy all copies of the Software an
documentation in your possession.

This License agreement shall be governed by the laws of the Commonwealth of Massachusetts and shall in
the benefit of MathSoft, its successors, representatives, and assigns. The license granted hereunder may n
assigned, sublicensed, or otherwise transferred by you without the prior written consent of MathSoft. If any pro
of this Agreement shall be held to be invalid, illegal or unenforceable, the validity, legality, and enforceability 
remaining provisions shall in no way be affected or impaired thereby. 
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How  to Use This User ’s Guide  

This User’s Guide is organized into the following parts:

τ The Basics

This section contains a quick introduction to Mathcad’s features and worksp
including resources available in the product and on the Internet for getting m
out of Mathcad. Be sure to read this section first if you are a new Mathcad u

τ Creat ing Mathcad Worksheet s

This section describes in more detail how to create and edit Mathcad worksh
It leads you through editing and formatting equations, text, and graphics, as 
as opening, editing, saving, and printing Mathcad worksheets and templates

τ Com putat ional Features

This section describes how Mathcad interprets equations and explains Mathc
computational features: units of measurement, complex numbers, matrices, 
in functions, solving equations, programming, and so on. This section also 
describes how to do symbolic calculations and how to use Mathcad’s two- a
three-dimensional plotting features.

The User’s Guide ends with reference appendices and a comprehensive index.

As far as possible, the topics in this guide are described independently of each o
This means that once you are familiar with the basic workings of Mathcad, you can
select a topic of interest and read about it.

The on-line Mathcad Resource Center (choose Resource Center from the Help menu) 
provides step by step tutorials, examples, and application files that you can use di
in your own Mathcad worksheets. Mathcad QuickSheets are templates available 
Resource Center that provide live examples that you can manipulate.

Notat ions and Convent ions
This User’s Guide uses the following notations and conventions:

Italics represent scalar variable names, function names, and error messages.

Bold Courier  represents keys you should type.

Bold represents a menu command. It is also used to denote vector and matrix va
variables.

An arrow such as that in “Graph⇒X-Y Plot” indicates a pull-right menu command.

Function keys and other special keys are enclosed in brackets. For example, [↑], [↓], 
[←], and [→] are the arrow keys on the keyboard. [F1], [F2], etc., are function keys; 
[BkSp] is the Backspace key for backspacing over characters; [Del ] is the Delete key 
for deleting characters to the right; [Ins ] is the Insert key for inserting characters to
the left of the insertion point; [Tab ] is the Tab key; and [Space ] is the space bar.

[Ctrl ], [Shift ], and [Alt ] are the Control, Shift, and Alt keys. When two keys ar
shown together, for example, [Ctrl ]V, press and hold down the first key, and then
press the second key.
1
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The symbol [↵] and [Enter ] refer to the same key.

When this User’s Guide shows spaces in an equation, you need not type the spac
Mathcad automatically spaces the equation correctly.

Pro This User’s Guide applies to Mathcad 2000 Professional and Mathcad 2000 Stand
If you’re not using Mathcad 2000 Professional, certain features described in the User’s 
Guide will not be available to you. The word Pro appears:

• In the page margin, as it does above, whenever a section in a chapter descri
feature or a function that is unique to Mathcad 2000 Professional.

• In the page footer, whenever all features described in that chapter are unique
Mathcad 2000 Professional.

This User’s Guide also describes a few product features that are available only in 
on packages for Mathcad. For example, some numerical solving features and func
are provided only in the Solving and Optimization Extension Pack (Expert Solver).
2    How to Use This User’s Guide
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Chapter  1
W elcom e to Mathcad

τ What  I s Mathcad?

τ Mathcad Edit ions

τ New in Mathcad 2000

τ System  Requirem ents 

τ I nstallat ion

τ Contact ing MathSoft

W hat  I s Mathcad?

Mathcad is the industry standard calculation software for technical professionals
educators, and college students. Mathcad is as versatile and powerful as program
languages, yet it’s as easy to learn as a spreadsheet. Plus, it is fully wired to tak
advantage of the Internet and other applications you use every day.

Mathcad lets you type equations as you’re used to seeing them, expanded fully on
screen. In a programming language, equations look something like this:

x=(-B+SQRT(B**2-4*A*C))/(2*A)

In a spreadsheet, equations go into cells looking something like this:

+(B1+SQRT(B1*B1-4*A1*C1))/(2*A1)

And that’s assuming you can see them. Usually all you see is a number.

In Mathcad, the same equation looks the way you might see 
it on a blackboard or in a reference book. And there is no 
difficult syntax to learn; you simply point and click and your 
equations appear.

But Mathcad equations do much more than look good. You can use them to solv
about any math problem you can think of, symbolically or numerically. You can pl
text anywhere around them to document your work. You can show how they look 
Mathcad’s two- and three-dimensional plots. You can even illustrate your work w
graphics taken from another Windows application. Plus, Mathcad takes full advan
of Microsoft’s OLE 2 object linking and embedding standard to work with other 
applications, supporting drag and drop and in-place activation as both client and s

Mathcad comes with its own on-line reference system called the Resource Cent
gives you access to tutorials as well as many useful formulas, data values, and refe
material at the click of a button. 
What Is Mathcad? 3
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Mathcad simplifies and streamlines documentation, critical to communicating an
meeting business and quality assurance standards. By combining equations, tex
graphics in a single worksheet, Mathcad makes it easy to keep track of the most co
calculations. By printing the worksheet exactly as it appears on the screen, Math
lets you make a permanent and accurate record of your work. 

Mathcad Edit ions

Mathcad 2000 is available in two versions:

• Mathcad Professional is the industry standard for applied math in technical field
delivering complete calculation and reporting functionality for professional resu
With the most complete set of features available, the Professional edition del
an integrated environment for performing, sharing, and communicating techn
work. 

• Mathcad Standard is the ideal application for everyday technical calculations
well suited for quick and easy use when pencil and paper, calculators, and sp
sheets aren’t up to the job.

New  in Mathcad 2 0 0 0

I m p roved Com p utat iona l Fea tures
• New boolean operators for AND, OR, NOT, and XOR logical statements

• Improvements to the root function

• New special-purpose fitting functions for statistical analysis of exponential, lo
rithmic, power, sinusoidal, and logistic data

Pro • New differential equation solve block and Odesolve function for solving a differ-
ential equation more easily using real math notation

• 19 new functions for financial calculations

Math  D is p la y  
• Better display of characters and operators in equations

• Choice of appearance of certain operators for presentations

Visua liza t ion  and Gra p h in g
• New 3D QuickPlots for quickly graphing a function of two variables

Pro • Axum LE extends the 2D plotting capabilities of Mathcad via the Axum compon

• SmartSketch LE for Mathcad allows you to insert technical drawings that are
computationally linked to your Mathcad equations

Docum ent  Pre p ara t ion,  Presentat ion , and Publishin g  Fea tures
• Control for layering regions on top of one another

• New ruler for aligning regions and setting tabs and indents in text

Pro • Ability to create an Electronic Book with a table of contents and index
4  Chapter 1  Welcome to Mathcad
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Usabil it y  Enhancem ents
• New error tracing tool for finding errors in a worksheet

• Improved support for sharing Mathcad worksheets over a network

• Improved Collaboratory for communicating with Mathcad users around the w

Sy stem  Re q uirem ents

In order to install and run Mathcad Professional or Standard, the following are 
recommended or required:

• Pentium 90-based IBM or compatible computer

• CD-ROM drive

• Windows 95 or higher or Windows NT 4.0 or higher

• At least 16 megabytes of memory. 32 is recommended.

• For improved appearance and full functionality of on-line Help, installation of 
Internet Explorer 4.0 or higher is recommended. IE does not need to be your de
browser.

I nsta llat ion

You should first read and accept the license agreement found in the beginning o
Mathcad User’s Guide. Then install Mathcad:

1. Insert the CD into your CD-ROM drive. The first time you do this, the CD will
automatically start the installation program. If the installation program does n
start automatically, you can start it by choosing Run from the Start menu and ty
D:\SETUP (where “D:” is your CD-ROM drive). Click “OK.”

2. Click the Mathcad icon on main installation page. 

3. When prompted, enter your product serial number, which is located on the ba
the CD envelope.

4. Follow the remaining on-screen instructions.

To install other items such as Axum LE, SmartSketch LE, or on-line documentat
follow step 1 above. Then click the icon for the item you want to install.
System Requirements 5
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Contact in g  MathSoft

Genera l

W eb Site : h t tp:/ / w w w .m athsoft .com

Techn ica l Su pp ort
MathSoft provides free technical support for individual users of Mathcad. In the Un
States and Canada, contact MathSoft Technical Support:

• Email: support@mathsoft.com 

• Fax: 617-577-8829 

• Automated support and fax-back system: 617-577-1778

• Web: http://www.mathsoft.com/support/support.htm

• Phone: 617-577-1778 

If you reside outside the U.S. and Canada, please refer to the technical support c
your Mathcad package to find details for your local support center. You may also
contact: 

• Automated solution center and fax-back system: +44 1276 475350

• Fax: +44 1276 451224 (Attn: Tech Support)

• Email: help@mathsoft.co.uk 

Contact MathSoft or your local distributor for information about technical support pl
for site licenses.

US and Canada

MathSoft, Inc.
101 Main Street
Cambridge, MA 02142

Phone: 617-577-1017
Fax: 617-577-8829

All other count r ies

MathSoft International
Knightway House
Park Street
Bagshot, Surrey
GUI19 5AQ
United Kingdom

Phone: +44 1276 452299
Fax: +44 1276 451224
6  Chapter 1  Welcome to Mathcad
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Chapter  2
Get t in g  Star ted w ith  Mathcad

τ The Mathcad Workspace

τ Regions

τ A Sim ple Calculat ion

τ Definit ions and Var iables

τ Entering Text

τ I t erat ive Calculat ions

τ Graphs

τ Saving, Print ing, and Exit ing

The Mathcad W orks p ace

For information on system requirements and how to install Mathcad on your comp
refer to Chapter 1, “Welcome to Mathcad.”

When you start Mathcad, you’ll see a window like that shown in Figure 2-1. By def
the worksheet area is white. To select a different color, choose Color⇒Background 
from the Format menu.

Figure 2-1: Mathcad Professional with various toolbars displayed.
The Mathcad Workspace 7
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Each button in the Math toolbar , shown in Figure 2-1, opens another toolbar of 
operators or symbols. You can insert many operators, Greek letters, and plots by
clicking the buttons found on these toolbars:   

The Standard toolbar is the strip of buttons shown just below the main menus in
Figure 2-1: 

Many menu commands can be accessed more quickly by clicking a button on th
Standard toolbar. 

The Formatting toolbar  is shown immediately below the Standard toolbar in Figu
2-1. This contains scrolling lists and buttons used to specify font characteristics 
equations and text.

Tip To learn what a button on any toolbar does, let the mouse pointer rest on the button momen
You’ll see a tooltip beside the pointer giving a brief description.

To conserve screen space, you can show or hide each toolbar individually by cho
the appropriate command from the View menu. You can also detach and drag a toolb
around your window. To do so, place the mouse pointer anywhere other than on a b
or a text box. Then press and hold down the mouse button and drag. You’ll find 
the toolbars rearrange themselves appropriately depending on where you drag t
And Mathcad remembers where you left your toolbars the next time you open th
application.

But ton Opens m ath  toolbar .. .

Calculator—Common arithmetic operators.

Graph—Various two- and three-dimensional plot types and graph too

Matrix —Matrix and vector operators.

Evaluation—Equal signs for evaluation and definition.

Calculus—Derivatives, integrals, limits, and iterated sums and produ

Boolean—Comparative and logical operators for Boolean expression

Programming—Programming constructs (Mathcad Professional only).

Greek—Greek letters.

Symbolic—Symbolic keywords.
8  Chapter 2  Getting Started with Mathcad
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Tip The Standard, Formatting, and Math toolbars are customizable. To add and remove button
one of these toolbars, click with the right mouse button on the toolbar and choose Customize 
from the pop-up menu to bring up the Customize Toolbar dialog box. 

The worksheet ruler is shown towards the top of the screen in Figure 2-1. To hide
show the ruler, choose Ruler from the View menu. To change the measurement syste
used in the ruler, click on the ruler with the right mouse button, and choose Inches, 
Centimeters, Points, or Picas from the pop-up menu. For more information on using th
ruler to format your worksheet, refer to “Using the worksheet ruler” on page 79.

W ork in g  w ith  W indow s 
When you start Mathcad, you open up a window on a Mathcad worksheet. You can 
have as many worksheets open as your available system resources allow. This a
you to work on several worksheets at once by simply clicking the mouse in which
document window you want to work in. 

There are times when a Mathcad worksheet cannot be displayed in its entirety be
the window is too small. To bring unseen portions of a worksheet into view, you 

• Make the window larger as you do in other Windows applications.

• Choose Zoom from the View menu or click  on the Standard toolbar  nd 
choose a number smaller than 100%.

You can also use the scroll bars, mouse, and keystrokes to move around the Ma
window, as you can in your other Windows applications. When you move the mo
pointer and click the mouse button, for example, the cursor jumps from wherever it
to wherever you clicked. 

Tip Mathcad supports the Microsoft IntelliMouse and compatible pointing devices. Turning th
wheel scrolls the window one line vertically for each click of the wheel. When you press 
[Shift ] and turn the wheel, the window scrolls horizontally.

See “Arrow and Movement Keys” on page 314 in the Appendices for keystrokes

move the cursor in the worksheet. If you are working with a longer worksheet, ch
Go to Page from the Edit  menu and enter the page number you want to go to in th
dialog box. When you click “OK,” Mathcad places the top of the page you specif
the top of the window.

Tip Mathcad supports standard Windows keystrokes for operations such as file opening, [Ctrl ]O], 
saving, [Ctrl ]S], printing, [Ctrl ]P, copying, [Ctrl ]C], and pasting, [Ctrl ]V]. Choose 
Preferences from the View menu and check “Standard Windows shortcut keys” in the Keyboa
Options section of the General tab to enable all Windows shortcuts. Remove the check to
shortcut keys supported in earlier versions of Mathcad.
The Mathcad Workspace 9
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Reg ions 

Mathcad lets you enter equations and text anywhere in the worksheet. Each equ
piece of text, or other element is a region. Mathcad creates an invisible rectangle to 
hold each region. A Mathcad worksheet is a collection of such regions. To start a
region in Mathcad: 

1. Click anywhere in a blank area of the worksheet. You see a small crosshair. 

Anything you type appears at the crosshair.

2. If the region you want to create is a math region, just start typing anywhere 
you put the crosshair. By default Mathcad understands what you type as 
mathematics. See “A Simple Calculation” on page 12 for an example.

3. To create a text region, first choose Text Region from the Insert menu and then 
start typing. See “Entering Text” on page 14 for an example.

In addition to equations and text, Mathcad supports a variety of plot regions. See
“Graphs” on page 17 for an example of inserting a two-dimensional plot. 

Tip Mathcad displays a box around any region you are currently working in. When you click ou
the region, the surrounding box disappears. To put a permanent box around a region, clic
with the right mouse button and choose Properties from the pop-up menu. Click on the Display
tab and click the box next to “Show Border.”

Se lect in g  Reg ions
To select a single region, simply click it. Mathcad shows a rectangle around the re

To select multiple regions:

1. Press and hold down the left mouse button to anchor one corner of the selec
rectangle.

2. Without letting go of the mouse button, move the mouse to enclose everything
want to select inside the selection rectangle.

3. Release the mouse button. Mathcad shows dashed rectangles around region
have selected.

Tip You can also select multiple regions anywhere in the worksheet by holding down the [Ctrl ] 
key while clicking. If you click one region and [Shift ]-click another, you select both regions
and all regions in between.

Movin g  and Co py in g  Reg ions   
Once the regions are selected, you can move or copy them.

Moving regions   

You can move regions by dragging with the mouse or by using Cut and Paste.

To drag regions with the mouse: 

1. Select the regions as described in the previous section.

2. Place the pointer on the border of any selected region. The pointer turns into a
hand.
10  Chapter 2  Getting Started with Mathcad
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3. Press and hold down the mouse button.

4. Without letting go of the button, move the mouse. The rectangular outlines o
selected regions follow the mouse pointer.

At this point, you can either drag the selected regions to another spot in the works
or you can drag them to another worksheet. To move the selected regions into an
worksheet, press and hold down the mouse button, drag the rectangular outlines
the destination worksheet, and release the mouse button.

To move the selected regions by using Cut and Paste:

1. Select the regions as described in the previous section.

2. Choose Cut from the Edit  menu (keystroke: [Ctrl ] X), or click  on the 
Standard toolbar. This deletes the selected regions and puts them on the Clip

3. Click the mouse wherever you want the regions moved to. Make sure you’ve cli
in an empty space. You can click either someplace else in your worksheet or
different worksheet altogether. You should see the crosshair.

4. Choose Paste from the Edit  menu (keystroke: [Ctrl ] V), or click  on the 
Standard toolbar. 

Not e You can move one region on top of another. If you do, you can move a particular region t
top or bottom by clicking on it with the right mouse button and choosing Bring to Front  or Send 
to Back from the pop-up menu.

Copying Regions

You copy regions by using the Copy and Paste commands:

1. Select the regions as described in “Selecting Regions” on page 10.

2. Choose Copy from the Edit  menu (keystroke: [Ctrl ] C), or click  on the 
Standard toolbar. This copies the selected regions to the Clipboard.

3. Click the mouse wherever you want to place a copy of the regions. You can 
either someplace else in your worksheet or in a different worksheet altogether. M
sure you’ve clicked in an empty space. You should see the crosshair.

4. Choose Paste from the Edit  menu (keystroke: [Ctrl ] V), or click  on the 
Standard toolbar. 

Tip If the regions you want to copy are coming from a locked area (see “Safeguarding an Area 
Worksheet” on page 85) or an Electronic Book, you can copy them simply by dragging th
with the mouse into your worksheet.

Dele t in g  Reg ions   
To delete one or more regions:

1. Select the regions as described in “Selecting Regions” on page 10.
Regions 11
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2. Choose Cut from the Edit  menu (keystroke: [Ctrl ] X), or click  on the 
Standard toolbar.

Choosing Cut removes the selected regions from your worksheet and puts them o
Clipboard. If you don’t want to disturb the contents of your Clipboard, or if you do
want to save the selected regions, choose Delete from the Edit  menu (Keystroke: 
[Ctrl ] D) instead.

A Sim p le Calcu lat ion 

Although Mathcad can perform sophisticated mathematics, you can just as easil
it as a simple calculator. To try your first calculation, follow these steps:

1. Click anywhere in the worksheet. You see a small 
crosshair. Anything you type appears at the crosshair.

2. Type 15-8/104.5=  . When you type the equal sign 

or click  on the Evaluation toolbar, Mathcad 
computes and shows the result.

This calculation demonstrates the way Mathcad works:

• Mathcad shows equations as you might see them in a book or on a blackboa
expanded fully in two dimensions. Mathcad sizes fraction bars, brackets, and o
symbols to display equations the same way you would write them on paper.

• Mathcad understands which operation to perform first. In this example, Math
knew to perform the division before the subtraction and displayed the equatio
accordingly.

• As soon as you type the equal sign or click  on the Evaluation toolbar, Math
returns the result. Unless you specify otherwise, Mathcad processes each eq
as you enter it. See the section “Controlling Calculation” in Chapter 8 to learn h
to change this.

• As you type each operator (in this case, − and /  ), Mathcad shows a small rectangle
called a placeholder. Placeholders hold spaces open for numbers or expressions
yet typed. As soon as you type a number, it replaces the placeholder in the 
expression. The placeholder that appears at the end of the expression is use
unit conversions. Its use is discussed in “Displaying Units of Results” on page

Once an equation is on the screen, you can edit it by clicking in the appropriate 
and typing new letters, digits, or operators. You can type many operators and G
letters by clicking in the Math toolbars introduced in “The Mathcad Workspace” o
page 7. Chapter 4, “Working with Math,” explains in detail how to edit Mathcad 
equations.
12  Chapter 2  Getting Started with Mathcad
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Def init ions and Var iables 

Mathcad’s power and versatility quickly become apparent once you begin using 
variables and functions. By defining variables and functions, you can link equation
together and use intermediate results in further calculations.

The following examples show how to define and use several variables.

Def inin g  Var iables 
To define a variable t, follow these steps:

1. Type t  followed by a colon:  or click  on the 
Calculator toolbar. Mathcad shows the colon as the 
definition symbol := . 

2. Type 10  in the empty placeholder to complete the 
definition for t.

If you make a mistake, click on the equation and press 
[Space ] until the entire expression is between the two editing lines, just as you d
earlier. Then delete it by choosing Cut from the Edit  menu (keystroke: [Ctrl ] X). See 
Chapter 4, “Working with Math,” for other ways to correct or edit an expression.

These steps show the form for typing any definition: 

1. Type the variable name to be defined.

2. Type the colon key :  or click  on the Calculator toolbar to insert the definitio
symbol. The examples that follow encourage you to use the colon key, since
is usually faster.

3. Type the value to be assigned to the variable. The value can be a single numb
in the example shown here, or a more complicated combination of numbers a
previously defined variables.

Mathcad worksheets read from top to bottom and left to right. Once you have def
a variable like t, you can compute with it anywhere below and to the right of the equation 
that defines it. 

Now enter another definition.

1. Press [↵]. This moves the crosshair below the first 
equation.

2. To define acc as –9.8, type: acc:–9.8 . Then press 
[↵] again. Mathcad shows the crosshair cursor 
below the last equation you entered.
Definitions and Variables 13
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Calcu la t in g  Resu lt s    
Now that the variables acc and t are defined, you can use them in other expression

1. Click the mouse a few lines below the two 
definitions. 

2. Type acc/2 [Space ]*t^2 . The caret symbol (^ ) 
represents raising to a power, the asterisk (* ) is 
multiplication, and the slash (/ ) represents division.

3. Press the equal sign (=).

This equation calculates the distance traveled by a falling body in time t with 
acceleration acc. When you enter the equation and press the equal sign (=), or cli

 on the Evaluation toolbar, Mathcad returns the result.

Mathcad updates results as soon as you make changes. For example, if you click
10 on your screen and change it to some other number, Mathcad changes the re
soon as you press [↵] or click outside of the equation.

Enter in g  Tex t  

Mathcad handles text as easily as it does equations, so you can make notes abo
calculations you are doing. 

Here’s how to enter some text:

1. Click in the blank space to the right of the 
equations you entered. You’ll see a small 
crosshair.

2. Choose Text Region from the Insert menu, or 
press "  (the double-quote key), to tell Mathcad 
that you’re about to enter some text. Mathcad changes the crosshair into a ve
line called the insertion point. Characters you type appear behind this line. A
surrounds the insertion point, indicating you are now in a text region. This bo
called a text box. It grows as you enter text.

3. Type Equations of motion . Mathcad 
shows the text in the worksheet, next to the 
equations.

Not e If Ruler under the View menu is checked when the cursor is inside a text region, the ruler res
to indicate the size of your text region. For more information on using the ruler to set tab s
and indents in a text region, see “Changing Paragraph Properties” on page 59.

Tip If you click in blank space in the worksheet and start typing, which creates a math region,
Mathcad automatically converts the math region to a text region when you press [Space ].

To enter a second line of text, just press [↵] and continue typing:

1. Press [↵].
14  Chapter 2  Getting Started with Mathcad
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2. Then type for falling body under gravity.

3. Click in a different spot in the worksheet or press 
[Ctrl ][Shift ][↵] to move out of the text 
region. The text box disappears and the cursor 
appears as a small crosshair.

Not e Use [Ctrl ][Shift ][↵] to move out of the text region to a blank space in your worksheet.
you press [↵], Mathcad inserts a line break in the current text region instead.

You can set the width of a text region and change the font, size, and style of the t
it. For more information on how to do these things, see Chapter 5, “Working with Te

I t erat ive Calculat ions 

Mathcad can do repeated or iterative calculations as easily as individual calculat
Mathcad uses a special variable called a range variable to perform iteration.

Range variables take on a range of values, such as all the integers from 0 to 10.
Whenever a range variable appears in a Mathcad equation, Mathcad calculates 
equation not just once, but once for each value of the range variable. 

This section describes how to use range variables to do iterative calculations.

Crea t in g  a  Ran g e Var iable
To compute equations for a range of values, first create a range variable. In the pro
shown in “Calculating Results” on page 14, for example, you can compute result
a range of values of t from 10 to 20 in steps of 1. To do so, follow these steps:

1. First, change t into a range variable by editing its 
definition. Click on the 10  in the equation t:=10 . The 
insertion point should be next to the 10 as shown on the 
right.

2. Type ,  11 . This tells Mathcad that the next number in 
the range will be 11.

3. Type ;  for the range variable operator, or click  on 
the Calculator toolbar, and then type the last number, 20 . 
This tells Mathcad that the last number in the range will be 20. Mathcad show
range variable operator as a pair of dots.
Iterative Calculations 15



 

4. Now click outside the equation for t. Mathcad begins to compute 
with t defined as a range variable. Since t now takes on eleven 
different values, there must also be eleven different answers. 
These are displayed in an output table as shown at right. You 
may have to resize your window or scroll down to see the whole 
table.

Def inin g  a  Funct ion
You can gain additional flexibility by defining functions. Here’s 
how to add a function definition to your worksheet:

1. First delete the table. To do so, drag-select the entire region until 
you’ve enclosed everything between the two editing lines. Then 

choose Cut from the Edit  menu (keystroke: [Ctrl ] X) or click  on the Standard 
toolbar. 

2. Now define the function d(t) by typing d(t):

3. Complete the definition by typing this expression: 
1600+acc/2 [Space ]*t^2 [↵]

The definition you just typed defines a function. The func-
tion name is d, and the argument of the function is t. You can use this function to evaluate
the above expression for different values of t. To do so, simply replace t with an 
appropriate number. For example:

1. To evaluate the function at a particular value, such as 3.5, 
type d(3.5)= . Mathcad returns the correct value as 
shown at right.

2. To evaluate the function once for each value of the range variable 
t you defined earlier, click below the other equations and type 
d(t)= . As before, Mathcad shows a table of values, as shown at 
right.

Form at t in g  a  Resu lt  
You can set the display format for any number Mathcad calculates and 
displays. This means changing the number of decimal places shown, 
changing exponential notation to ordinary decimal notation, and so on.
16  Chapter 2  Getting Started with Mathcad
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For example, in the example above, the first two values,  and 
are in exponential (powers of 10) notation. Here’s how to change the table produ
above so that none of the numbers in it are displayed in exponential notation:

1. Click anywhere on the table with 
the mouse. 

2. Choose Result from the Format 
menu. You see the Result Format 
dialog box. This box contains 
settings that affect how results are 
displayed, including the number of 
decimal places, the use of 
exponential notation, the radix, 
and so on.

3. The default format scheme is General which has Exponential 
Threshold set to 3. This means that only numbers greater than or 

equal to  are displayed in exponential notation. Click the 
arrows to the right of the 3 to increase the Exponential Threshold 
to 6.

4. Click “OK.” The table changes to reflect the new result format.

For more information on formatting results, refer to “Formatting 
Results” on page 110.

Not e When you format a result, only the display of the result is affected. Mathcad maintains ful
precision internally (up to 15 digits).

Gra phs 

Mathcad can show both two-dimensional Cartesian and polar graphs, contour pl
surface plots, and a variety of other three-dimensional graphs. These are all exa
of graph regions.

This section describes how to create a simple two-dimensional graph showing the p
calculated in the previous section.

Crea t in g  a  Gra p h 
To create an X-Y plot in Mathcad, click in blank space where you want the graph

appear and choose Graph⇒X-Y Plot  from the Insert menu or click  on the Graph
toolbar. An empty graph appears with placeholders on the x-axis and y-axis for the 
expressions to be graphed. X-Y and polar plots are ordinarily driven by range varia
you define: Mathcad graphs one point for each value of the range variable used 

1.11 103⋅ 1.007 103⋅

103
Graphs 17
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graph. In most cases you enter the range variable, or an expression depending 
range variable, on the x-axis of the plot. For example, here’s how to create a plot of t
function d(t) defined in the previous section:

1. Position the crosshair in a blank spot and type 
d(t) . Make sure the editing lines remain 
displayed on the expression.

2. Now choose Graph⇒X-Y Plot  from the 

Insert menu, or click  on the Graph 
toolbar. Mathcad displays the frame of the 
graph.

3. Type t  in the bottom middle placeholder on 
the graph.

4. Click anywhere outside the graph. Mathcad 
calculates and graphs the points. A sample 
line appears under the “d(t).” This helps you 
identify the different curves when you plot 
more than one function. Unless you specify 
otherwise, Mathcad draws straight lines 
between the points and fills in the axis limits.

For detailed information on creating and 
formatting graphs, see Chapter 12, “2D Plots.” In particular, refer to Chapter 12 
information about  the QuickPlot feature in Mathcad which lets you plot expression
even when you don’t specify the range variable directly in the plot.

Resizin g  a  g ra p h

To resize a plot, click in the plot to select it. Then move the cursor to a handle al
the edge of the plot until the cursor changes to a double-headed arrow. Hold the m
button down and drag the mouse in the direction that you want the plot’s dimensio
change. 

Form at t in g  a  Gra p h 
When you first create a graph it has default characteristics: numbered linear axes, n
grid lines, and points connected with solid lines. You can change these character
by formatting the graph.
18  Chapter 2  Getting Started with Mathcad
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To format the graph created previously, follow these steps:

1. Click on the the graph and choose 
Graph⇒X-Y Plot from the Format 
menu, or double-click the graph to 
bring up the formatting dialog box. 
This box contains settings for all 
available plot format options. To learn 
more about these settings, see Chapter 
12, “2D Plots.”

2. Click the Traces tab. 

3. Click “trace 1” in the scrolling list 
under “Legend Label.” Mathcad 
places the current settings for trace 1 in 
the boxes under the corresponding 
columns of the scrolling list.

4. Click the arrow under the “Type” column to see a drop-down list of trace type
Select “bar” from this drop-down list.

5. Click “OK” to show the result of 
changing the setting. Mathcad shows 
the graph as a bar chart instead of 
connecting the points with lines. Note 
that the sample line under the d(t) now 
has a bar on top of it.

6. Click outside the graph to deselect it.

Savin g , Pr in t in g , and Exit in g  

Once you’ve created a worksheet, you will probably want to save or print it.

Savin g  a  W orksheet  
To save a worksheet:

1. Choose Save from the File menu (keystroke: [Ctrl ] S) or click  on the 
Standard toolbar. If the file has never been saved before, the Save As dialog box 
appears. Otherwise, Mathcad saves the file with no further prompting. 

2. Type the name of the file in the text box provided. To save to another folder, lo
the folder using the Save As dialog box.

By default Mathcad saves the file in Mathcad (MCD) format, but you have the option
of saving in other formats, such as RTF and HTML, as a template for future Mathcad 
worksheets, or in a format compatible with earlier Mathcad versions. For more 
information, see Chapter 7, “Worksheet Management.”
Saving, Printing, and Exiting 19



 

s in 
 want 

bers 
Pr in t in g

To print, choose Print from the File menu or click  on the Standard toolbar. To

preview the printed page, choose Print Preview from the File menu or click    on 
the Standard toolbar.

For more information on printing, see Chapter 7, “Worksheet Management.”

Ex it in g  Mathcad 
When you’re done using Mathcad, choose Exit  from the File menu. Mathcad closes 
down all its windows and returns you to the Desktop. If you’ve made any change
your worksheets since the last time you saved, a dialog box appears asking if you
to discard or save your changes. If you have moved any toolbars, Mathcad remem
their locations for the next time you open the application.

Not e To close a particular worksheet while keeping Mathcad open, choose Close from the 
File menu.
20  Chapter 2  Getting Started with Mathcad
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On- Line Resources

τ Resource Center  and Elect ronic Books 

τ Help

τ I nternet  Access in Mathcad

τ The Collaboratory

τ Other Resources

Resource Center  and Electronic Books

If you learn best from examples, want information you can put to work immediatel
your Mathcad worksheets, or wish to access any page on the World Wide Web f

within Mathcad, choose Resource Center from the Help menu or click  on the 
Standard toolbar. The Resource Center is a Mathcad Electronic Book that appears in a 
custom window with its own menus and toolbar, as shown in Figure 3-1. 

Figure 3-1: Resource Center for Mathcad Professional. Topics available in 
Mathcad Standard differ somewhat.
Resource Center and Electronic Books 21
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Not e A number of Electronic Books are available on the MathSoft Web Library which you can ac
through the Resource Center. In addition, a variety of Mathcad Electronic Books are avai
from MathSoft or your local distributor or software reseller. To open an Electronic Book yo
have installed, choose Open Book from the Help menu and browse to find the location of the
appropriate Electronic Book (HBK) file. 

The Resource Center offers:

• A comprehensive Mathcad Electronic Book containing a collection of tutorials
QuickSheet templates, examples, reference tables, and samples of Mathcad a
products. Simply drag and drop information from the Resource Center into yo
own Mathcad worksheets.

• Immediate access to Mathcad worksheets and Electronic Books on MathSoft
World Wide Web site and other Internet sites.

• Access to the full Web-browsing functionality of Microsoft Internet Explorer fro
within the Mathcad environment.

• Access to the Collaboratory where you can exchange messages with other Ma
users

Tip The Resource Center may open automatically every time you start Mathcad. To prevent it
opening automatically, choose Preferences from the View menu, click the General tab, and 
check “Open Resource Center at startup.”

Not e You can make your own Mathcad Electronic Book. See “Creating an Electronic Book” on p
89 for more information.

Content  in  the  Resource Cente r
Here are brief descriptions of the topics available in the Resource Center. Exact t
vary in Mathcad Professional and Mathcad Standard.

• Overview and Tutorials. A description of Mathcad’s features, tutorials for gettin
started with Mathcad, and tutorials for getting more out of Mathcad’s solving, d
analysis, programming, graphing, and worksheet creation features.

• QuickSheets and Reference Tables. Over 300 QuickSheets – “recipes” take yo
through a wide variety of common mathematical tasks that you can modify for y
own use. Tables for looking up physical constants, chemical and physical data
mathematical formulas you can use in your Mathcad worksheets.

• Extending Mathcad. Dozens of discipline- and industry-specific examples, tak
from Mathcad Electronic Books and Extension Packs, show how you can app
Mathcad to your work.

• Collaboratory . A connection to MathSoft’s free Internet forum lets you consu
with the world-wide community of Mathcad users.

• Web Library . A built-in connection to regularly updated technical content and
resources for Mathcad users.

• MathSoft.com. MathSoft’s Web page with access to Mathcad and mathemati
resources and the latest information from MathSoft.
22  Chapter 3  On-Line Resources
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• Training/Support . Information on Mathcad training and support available from
MathSoft.

• Web Store. MathSoft’s Web store where you can get information on and purch
Mathcad add-on products and the latest educational and technical profession
software products from MathSoft and other choice vendors.

Findin g  I nform at ion  in  an  Elect ron ic Book
The Resource Center is a Mathcad Electronic Book—a hyperlinked collection of 
Mathcad worksheets. As in other hypertext systems, you move around a Mathca
Electronic Book simply by clicking on icons or underlined text. The mouse pointe
automatically changes into the shape of a hand when it hovers over a hypertext 
and a message in the status bar tells you what will happen when you click the lin
Depending on how the book is organized, the activated link automatically opens
appropriate section or displays information in a pop-up window.

You can also use the buttons on the toolbar at the top of the Electronic Book win
to navigate and use content within the Electronic Book:

   

Mathcad keeps a record of where you’ve been in the Electronic Book. When you 

, Mathcad goes back to the last page you were on when you left it. Backtrac
is especially useful when you have clicked to look at a cross- reference and then
to return to the section you just came from.

 But ton Funct ion

Links to the Table of Contents, the page that appears when you first o
the Electronic Book.

Opens a toolbar for entering a World Wide Web address.

Backtracks to whatever document was last viewed.

Reverses the last backtrack.

Goes backward one section in the Electronic Book.

Goes forward one section in the Electronic Book.

Displays a list of documents most recently viewed.

Searches the Electronic Book for a particular term.

Copies selected regions to the Clipboard.

Saves current section of the Electronic Book.

Prints current section of the Electronic Book.
Resource Center and Electronic Books 23
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If you don’t want to go back one section at a time, click . This opens a Histor
window from which you can jump to any section you viewed since you first open
the Electronic Book. 

Full- tex t  search

In addition to using hypertext links to find topics in the Electronic Book, you can sea
for topics or phrases. To do so:

1. Click  to open the Search dialog 
box.

2. Type a word or phrase in the “Search 
for” text box. Select a word or phrase 
and click “Search” to see a list of 
topics containing that entry and the 
number of times it occurs in each 
topic. 

3. Choose a topic and click “Go To.” 
Mathcad opens the Electronic Book 
section containing the entry you want 
to search for. Click “Next” or 
“Previous” to bring the next or previous occurrence of the entry into the windo

Annota t in g  an  Elect ron ic Book
A Mathcad Electronic Book is made up of fully interactive Mathcad worksheets. Y
can freely edit any math region in an Electronic Book to see the effects of chang
parameter or modifying an equation. You can also enter text, math, or graphics a
annotations in any section of your Electronic Book, using the menu commands on
Electronic Book window and the Mathcad toolbars. 

Ti p By default any changes or annotations you make to the Electronic Book are displayed in 
annotation highlight color. To change this color, choose Color⇒Annotation from the Format 
menu. To suppress the highlighting of Electronic Book annotations, remove the check fro
Highlight Changes on the Electronic Book’s Book menu.

Sav in g  annota t ions

Changes you make to an Electronic Book are temporary by default: your edits disa
when you close the Electronic Book, and the Electronic Book is restored to its orig
appearance the next time you open it. You can choose to save annotations in an
Electronic Book by checking Annotate Book on the Book menu or on the pop-up menu
that appears when you click with the right mouse button. Once you do so, you hav
following annotation options:

• Choose Save Section from the Book menu to save annotations you made in the
current section of the Electronic Book, or choose Save All Changes to save all 
changes made since you last opened the Electronic Book. 
24  Chapter 3  On-Line Resources
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• Choose View Original Section to see the Electronic Book section in its original
form. Choose View Edited Section to see your annotations again.

• Choose Restore Section to revert to the original section, or choose Restore All to 
delete all annotations and edits you have made to the Electronic Book.

Co py in g  I nform at ion  from  an Elect ron ic Book
There are two ways to copy information from an Electronic Book into your Mathc
worksheet:

• You can use the Clipboard. Select text or equations in the Electronic Book us

one of the methods described in “Selecting Regions” on page 10, click  on
Electronic Book toolbar or choose Copy from the Edit  menu, click on the 
appropriate spot in your worksheet, and choose Paste from the Edit menu.

• You can drag regions from the Book window and drop them into your worksh
Select the regions as above, then click and hold down the mouse button ove
of the regions while you drag the selected regions into your worksheet. The reg
are copied into the worksheet when you release the mouse button.

W eb Brow sin g  
If you have Internet access, the Web Library button in the Resource Center conn
you to a collection of Mathcad worksheets and Electronic Books on the World W
Web. You can also use the Resource Center window to browse to any location o
World Wide Web and open standard Hypertext Mark-up Language (HTML ) and other 
Web pages, in addition to Mathcad worksheets. You have the convenience of acce
all of the Internet’s rich information resources right in the Mathcad environment.

Not e When the Resource Center window is in Web-browsing mode, Mathcad is using a Web-
browsing OLE control provided by Microsoft Internet Explorer. Web browsing in Mathcad
requires Microsoft Internet Explorer version 4.0 or later to be installed on your system, bu
does not need to be your default browser. Although Microsoft Internet Explorer is availabl
installation when you install Mathcad, refer to Microsoft Corporation’s Web site at http://
www.microsoft.com/  for licensing and support information about Microsoft Internet 
Explorer and to download the latest version.

To browse to any World Wide Web page from within the Resource Center windo

1. Click  on the Resource Center toolbar. As shown below, an additional too
with an “Address” box appears below the Resource Center toolbar to indicate
you are now in a Web-browsing mode:

2. In the “Address” box type a Uniform Resource Locator (URL) for a document on 
the World Wide Web. To visit the MathSoft home page, for example, type
http://www.mathsoft.com/  and press [Enter ]. If you have Internet 
Resource Center and Electronic Books 25
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access and the server is available, you load the requested page in your Reso
Center window. Under Windows NT 3.51 or if you do not have a supported ver
of Microsoft Internet Explorer installed, you launch your default Web browser
instead.

The remaining buttons on the Web Toolbar have the following functions:

Not e When you are in Web-browsing mode and click with the right mouse button on the Resou
Center window, Mathcad displays a pop-up menu with commands appropriate for viewing 
pages. Many of the buttons on the Resource Center toolbar remain active when you are in
browsing mode, so that you can copy, save, or print material you locate on the Web, or bac

to pages you previously viewed. When you click , you return to the Table of Contents
the Resource Center and disconnect from the Web.

Tip You can use the Resource Center in Web-browsing mode to open Mathcad worksheets any
on the World Wide Web. Simply type the URL of a Mathcad worksheet in the “Address” bo
the Web toolbar.

Help

Mathcad provides several ways to get help on product features through an exten
on-line Help system. To see Mathcad’s on-line Help at any time, choose Mathcad Help 

from the Help menu, click  on the Standard toolbar, or press [F1]. Mathcad’s Help 
system is delivered in Microsoft’s HTML Help environment, as shown in Figure 3-2
You can browse the Explorer view in the Contents tab, look up terms or phrases o
Index tab, or search the entire Help system for a keyword or phrase on the Sear

Not e To run the Help, you must have Internet Explorer 3.02 or higher installed, but not necessar
as your default browser.

You can get context-sensitive help while using Mathcad. For Mathcad menu com
mands, click on the command and read the status bar at the bottom of your wind
For toolbar buttons, hold the pointer over the button momentarily to see a tool tip

Not e The status bar in Mathcad is displayed by default. You can hide the status bar by removin
check from Status Bar on the View menu.

But ton Funct ion

Bookmarks current page for a later visit.

Reloads the current page.

Interrupts the current file transfer.
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You can also get more detailed help on menu commands or on many operators 
error messages. To do so:

1. Click an error message, a built-in function or variable, or an operator.

2. Press [F1] to bring up the relevant Help screen.

To get help on menu commands or on any of the toolbar buttons:

1. Press [Shift ][F1]. Mathcad changes the pointer into a question mark.

2. Choose a command from the menu. Mathcad shows the relevant Help scree

3. Click any toolbar button. Mathcad displays the operator’s name and a keyboa
shortcut in the status bar.

To resume editing, press [Esc ]. The pointer turns back into an arrow.

Tip Choose Tip of the Day from the Help menu for a series of helpful hints on using Mathcad. 
Mathcad automatically displays one of these tips whenever you start it if “Show Tips at Sta
is checked.

I n te rnet  Access in  Mathcad

Many of the on-line Mathcad resources described in this chapter are located not on
own computer or on a local network but on the Internet. 

To access these resources on the Internet you need:

• Networking software to support a 32-bit Internet (TCP/IP) application. Such 
software is usually part of the networking services of your operating system; 
your operating system documentation for details. 

Figure 3-2: Mathcad on-line Help is delivered in HTML Help.
Internet Access in Mathcad 27
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• A direct or dial-up connection to the Internet, with appropriate hardware and 
communications software. Consult your system administrator or Internet acce
provider for more information about your Internet connection. 

Before accessing the Internet through Mathcad, you also need to know whether 
use a proxy server to access the Internet. If you use a proxy, ask your system 
administrator for the proxy machine’s name or Internet Protocol (IP) address, as well 
as the port number (socket) you use to connect to it. You may specify separate p
servers for each of the three Internet protocols understood by Mathcad: HTTP, for the 
World Wide Web; FTP, a file transfer protocol; and GOPHER, an older protocol for access
to information archives. 

Once you have this information, 
choose Preferences from the View 
menu, and click the Internet tab. 
Then enter the information in the 
dialog box.

The remaining information in the In-
ternet tab of the Preferences dialog 
was entered at the time you installed 
Mathcad: 

• Your name

• Your Internet electronic mail 
address

• The URL for the Collaboratory server you contact when you click the Collaborat
button on the Resource Center home page

The Collaborator y

If you have a dial-up or direct Internet connection, you can access the MathSoft 
Collaboratory server from the Resource Center home page. The Collaboratory is
interactive World Wide Web service that puts you in contact with a community o
Mathcad users. The Collaboratory consists of a group of forums that allow you to
contribute Mathcad or other files, post messages, and download files and read me
contributed by other Mathcad users. You can also search the Collaboratory for mes
containing a key word or phrase, be notified of new messages in forums that inte
you, and view only the messages you haven’t read yet. You’ll find that the Collabora
combines some of the best features of a computer bulletin board or an on-line n
group with the convenience of sharing worksheets and other files created using 
Mathcad. 

Lo gg in g  in
To open the Collaboratory, choose Resource Center from the Help menu and click on 
the Collaboratory icon. Alternatively, you can open an Internet browser and go to
Collaboratory home page:

http://collab.mathsoft.com / ~mathcad2000/
28  Chapter 3  On-Line Resources
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You’ll see the Collaboratory login screen in a browser window:

The first time you come to the login screen of the Collaboratory, click “New User
This brings you to a form that you should fill out with your name and other requir
and optional information about yourself. 

Not e MathSoft does not use this information for any purposes other than for your participation i
Collaboratory and to notify you of important information concerning Mathcad.

Click “Create” when you are finished filling out the form. In a short while, check yo
email box for an email message with your login name and password. Go back to
Collaboratory, enter your login name and password given in the email message 
click “Log In.” You see the main page of the Collaboratory:

A list of forums and messages appears on the left side of the screen. The menu
the top of the window gives you access to features such as searches and on-line

Figure 3-3: Opening the Collaboratory from the Resource Center. Available 
forums change over time.
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Tip After you log in, you may want to change your password to one you’ll remember. To do so,  
More Options on the menubar at the top of the window, click Edit User Profile and enter a n
password in the password fields. Then click “Save.”

Not e MathSoft maintains the Collaboratory server as a free service, open to all in the Mathcad
community. Be sure to read the Agreement posted in the top level of the Collaboratory fo
important information and disclaimers.

Readin g  M essa g es 
When you enter the Collaboratory, you see text telling you how many messages
new and how many are addressed to your attention. Click the links on the text to
these messages or examine the list of messages in the right part of the screen. T
any message in any forum of the Collaboratory:

1. Click on the  next to the forum name or click on the forum name.

2. Click on a message to read it. Click the  to the left of a message to see rep
underneath it. 

3. The message shows in the right side of the window.

Messages that you have not yet read are shown in italics. You may also see a “n
icon next to the messages.

Post in g  Messa g es
After you enter the Collaboratory, you can go to any forum and post a message 
reply to a message. To post a new message or a reply to an existing one:

1. Decide which forum you want to post a message in. Click on the forum name
show the messages under it. If you want to reply to a message, click on the me

2. Choose Post from the menubar at the top of the Collaboratory window to post 
new message. Or, to reply to a message, click Reply at the top of the message in 
the right side of the window. You’ll see the post/reply page in the right side of
window. For example, if you post a new topic message in the Biology forum, 
see:

3. Enter the title of your message in the Topic field.

4. Click on any of the boxes below the title to specify whether you want to, for 
example, preview a message, spell check a message, or attach a file.
30  Chapter 3  On-Line Resources
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5. Type your text in the message field.

Tip You can include hyperlinks in your message by entering an entire URL such as http://
www.myserver.com/main.html.

6. Click “Post” after you finish typing. Depending on the options you selected, th
Collaboratory either posts your message immediately or allows you to preview
It might also display possible misspellings in red with links to suggested spellin

7. If you preview the message and the text looks correct, click “Post.” 

8. If you are attaching a file, a new page appears. Specify the file type and file o
next page and click “Upload Now.”

Not e For more information on reading, posting messages, and other features of the Collaborat
click Help on the Collaboratory menubar.

To delete a message that you posted, click on it to open it and click Delete in the 
menubar just above the message on the right side of the window.

Search in g
To search the Collaboratory, click Search on the Collaboratory menubar. You can 
search for messages containing specific words or phrases, messages within a c
date range, or messages posted by specific Collaboratory users.

You can also search the Collaboratory user database for users who are in a part
country or have a particular email address, etc. To do so, click Search Users at t
of the Search page.

Chan g in g  Your  User  I n form at ion
When you first logged into the Collaboratory, you filled out a New User Informati
form with your name, address, etc. This information is stored as your user profile
change any of this information or to make changes to the Collaboratory defaults,
need to edit your profile. To do so:

1. Click More Options on the menubar at the top of the window.

2. Click Edit Your Profile.

3. Make changes to the information in the form and click “Save.”

You can change information such as your login name and password. You can also
your email address.

Not e For privacy when posting messages, you can hide your email address or change your login
by editing your profile. Be aware, however, that if you hide your email address, other 
Collaboratory participants cannot send you email messages.

Other  Fea tures
The Collaboratory has other features which make it easy to find and provide inform
to the Mathcad community. To perform activities such as creating an address bo
marking messages as read, viewing certain messages, and requesting automatic
The Collaboratory 31
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announcements when specific forums have new messages, choose More Options from 
the Collaboratory menubar. 

The Collaboratory also supports participation via email or a news group. For mor
information on these and other features available in the Collaboratory, click Help on 
the Collaboratory menubar.

Other  Resources

On- line  Docum enta t ion
The following pieces of Mathcad documentation are available in PDF form on th
Mathcad CD in the DOC folder:

• Mathcad User’s Guide. This User’s Guide with the latest information, including
updates since the printed edition was created.

• Mathcad Reference Manual. An in-depth guide to Mathcad’s built-in functions,
operators, and symbolic keywords.

Pro • MathConnex User’s Guide. A guide to using MathConnex, an environment for
visually integrating and linking applications and data sources.

Pro • Creating a User DLL . A file with instructions for using C or C++ to create your 
own function in the form of a DLL.

You can read these PDF files by installing Adobe Acrobat Reader which is also availab
on the Mathcad CD in the DOC folder. See the readme file in the DOC folder for more 
information about the on-line documentation.

Sam p les Folde r
The SAMPLES folder, located in your Mathcad folder, contains sample Mathcad a
MathConnex files which demonstrate components such as the Axum, Excel, and
SmartSketch components. There are also sample Visual Basic applications desig
work with Mathcad files. Refer to Chapter 16, “Advanced Computational Feature
for more information on components and other features demonstrated in the sam

Release  N otes
The release notes are located in the DOC folder located in your Mathcad folder. It 
contains the latest information on Mathcad, updates to the documentation, troub
shooting instructions, and more.
32  Chapter 3  On-Line Resources



d 

ing 

 

 and 
 

 enter 

9 as 
Chapter  4
W ork in g  w ith Math

τ I nser t ing Math

τ Building Expressions

τ Edit ing Expressions

τ Math Sty les

I nser t in g  Math

You can place math equations and expressions anywhere you want in a Mathca
worksheet. All you have to do is click in the worksheet and start typing.

1. Click anywhere in the worksheet. You see a small 
crosshair. Anything you type appears at the crosshair.

2. Type numbers, letters, and math operators, or insert them 
by clicking buttons on Mathcad’s math toolbars, to create 
a math region.

You’ll notice that unlike a word processor, Mathcad by default understands anyth
you type at the crosshair cursor as math. If you want to create a text region instead, 
follow the procedures described in Chapter 5, “Working with Text.”

You can also type math expressions in any math placeholder, which appears when you
insert certain operators. See Chapter 9, “Operators,” for more on Mathcad’s 
mathematical operators and the placeholders that appear when you insert them.

The rest of this chapter introduces the elements of math expressions in Mathcad
describes the techniques you use to build and edit them. See the chapters in the
Computational Features section of this User’s Guide for details on numerical and 
symbolic calculation in Mathcad.

Num bers and Com p lex  Num bers
This section describes the various types of numbers that Mathcad uses and how to
them into math expressions. A single number in Mathcad is called a scalar. For 
information on entering groups of numbers in arrays, see “Vectors and Matrices” on 
page 35.

Types of  num bers

In math regions, Mathcad interprets anything beginning with one of the digits 0–
a number. A digit can be followed by:

• other digits

• a decimal point

• digits after the decimal point
Inserting Math 33
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• one of the letters b, h, or o, for binary, hexadecimal, and octal numbers, or i  or j  
for imaginary numbers. These are discussed in more detail below. See “Suffi
for Numbers” on page 312 in the Appendices for additional suffixes.

Not e Mathcad uses the period (. ) to signify the decimal point. The comma (, ) is used to separate 
values in a range variable definition, as described in “Range Variables” on page 101. So 
you enter numbers greater than 999, do not use either a comma or a period to separate dig
groups of three. Simply type the digits one after another. For example, to enter ten thousan
“10000 ”. 

I m aginary  and com plex  num bers

To enter an imaginary number, follow it with i or j, as in 1i  or 2.5j . 

Not e You cannot use i or j alone to represent the imaginary unit. You must always type 1i  or 1j . If 
you don’t, Mathcad thinks you are referring to a variable named either i or j. When the cursor is 
outside an equation that contains 1i or 1j, however, Mathcad hides the (superfluous) 1.   

Although you can enter imaginary numbers followed by either i or j, Mathcad normally 
displays them followed by i. To have Mathcad display imaginary numbers with j, 
choose Result from the Format menu, click on the Display Options tab, and set 
“Imaginary value” to “ j(J).” See “Formatting Results” on page 110 for a full descriptio
of the result formatting options.

Mathcad accepts complex numbers of the form  (or ), where a and b are 
ordinary numbers.

Binary  num bers

To enter a number in binary, follow it with the lowercase letter b. For example, 

11110000b  represents 240 in decimal. Binary numbers must be less than . 

Octa l num bers

To enter a number in octal, follow it with the lowercase letter o. For example, 25636o  

represents 11166 in decimal. Octal numbers must be less than . 

Hexadecim al num bers

To enter a number in hexadecimal, follow it with the lowercase letter h. For example, 
2b9eh  represents 11166 in decimal. To represent digits above 9, use the upper
lowercase letters A through F. To enter a hexadecimal number that begins with a lett
you must begin it with a leading zero. If you don’t, Mathcad will think it’s a variab
name. For example, use 0a3h  (delete the implied multiplication symbol between 0 
and a) rather than a3h  to represent the decimal number 163 in hexadecimal. 

Hexadecimal numbers must be less than .

Exponent ia l nota t ion  

To enter very large or very small numbers in exponential notation, just multiply a

number by a power of 10. For example, to represent the number , type 3*10^8 .

a bi+ a bj+

231

231

231

3 108⋅
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Vectors and Mat r ices    
A column of numbers is a vector, and a rectangular array of numbers is called a matrix. 
The general term for a vector or matrix is an array. 

There are a number of ways to create an array in Mathcad. One of the simplest 
filling in an array of empty placeholders as discussed in this section. This techniq
useful for arrays that are not too large. See Chapter 11, “Vectors, Matrices, and 
Arrays,” for additional techniques for creating arrays of arbitrary size.

Tip You may wish to distinguish between the names of matrices, vectors, and scalars by font
example, in many math and engineering books, names of vectors are set in bold while th
scalars are set in italic. See “Math Styles” on page 51 for a description of how to do this.

Creat ing a  vector or  m at r ix

To create a vector or matrix in Mathcad, follow these steps:

1. Choose Matrix  from the Insert menu or click  
on the Matrix toolbar. The dialog box shown on the 
right appears.

2. Enter a number of rows and a number of columns in 
the appropriate boxes. In this example, there are two 
rows and three columns. Then click “OK.” Mathcad 
inserts a matrix of placeholders. 

3. Fill in the placeholders to complete the matrix. Press 
[Tab ] to move from placeholder to placeholder. 

You can use this matrix in equations, just as you would 
a number.

Tip The Insert Matrix  dialog box also allows you to insert or delete a specified number of rows
columns from an array you have already created. See“Changing the size of a vector or m
on page 192.

Not e Throughout this User’s Guide, the term “vector” refers to a column vector. A column vector is 
simply a matrix with one column. You can also create a row vector by creating a matrix with one 
row and many columns. 

St r in g s
Although in most cases the math expressions or variables you work with in Math
are numbers or arrays, you can also work with strings (also called string literals or 
string variables). Strings can include any character you can type at the keyboard,
including letters, numbers, punctuation, and spacing, as well as a variety of spec
symbols as listed in “ASCII codes” on page 316 in the Appendices. Strings differ f
variable names or numbers because Mathcad always displays them between do
Inserting Math 35
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quotes. You can assign a string to a variable name, use a string as an element of a
or matrix, or use a string as the argument to a function.

To create a string:

1. Click on an empty math placeholder in a math 
expression, usually on the right-hand side of a 
variable definition.

2. Type the double-quote (" ) key. Mathcad displays a 
pair of quotes and an insertion line between them.

3. Type any combination of letters, numbers, 
punctuation, or spaces. Click outside the expression 
or press the right arrow key (→) twice when you are 
finished.

To enter a special character corresponding to one of the ASCII codes, do the following:

1. Click to position the insertion point in the string.

2. Hold down the [Alt ] key, and type the number “0” followed immediately by th
number of the ASCII code using the numeric keypad at the right of the keyboard in 
number-entry mode. 

3. Release the [Alt ] key to see the symbol in the string. 

For example, to enter the degree symbol (° ) in a string, press [Alt ] and type “0176” 
using the numeric keypad.

Not e The double-quote key (" ) has a variety of meanings in Mathcad, depending on the exact loca
of the cursor in your worksheet. When you want to enter a string, you must always have a blank 
placeholder selected.

Valid strings include expressions such as “The Rain in Spain Falls Mainly on the Pl
“Invalid input: try a number less than -5,” and “Meets stress requirements.” A strin
Mathcad, while not limited in size, always appears as a single line of text in your
worksheet. Note that a string such as “123,” created in the way described above
understood by Mathcad to be a string of characters rather than the number 123.

Tip Strings are especially useful for generating custom error messages in programs, as descr
Chapter 15, “Programming.” Other string handling functions are listed in “String Functions
page 187. Use strings also to specify system paths for arguments to some Mathcad built-
functions; see “File Access Functions” on page 188. 

Nam es     
A name in Mathcad is simply a sequence of characters you type or insert in a ma
region. A name usually refers to a variable or function that you use in your 
computations. Mathcad distinguishes between two kinds of names:

• Built-in names, which are the names of variables and functions that are alwa
available in Mathcad, and which you can use freely in building up math express

• User-defined names, which are the names of variables and functions you cre
your Mathcad worksheets.
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Built - in  nam es

Because Mathcad is an environment for numerical and symbolic computation, a 
number of names are built into the product for use in math expressions. These bu
names include built-in variables and built-in functions. 

• Mathcad includes several variables that, unlike ordinary variables, are alread
defined when you start Mathcad. These predefined or built-in variables either have 
a conventional value, like π (3.14159...) or e (2.71828...), or are used as system 
variables to control how Mathcad calculates. See “Built-in Variables” on page
for more information.

• In addition to these predefined variables, Mathcad treats the names of all bui
units as predefined variables. For example, Mathcad recognizes the name “A
the ampere, “m” as the meter, “s” as the second, and so on. Choose Unit  from the 

Insert menu or click  on the Standard toolbar to insert one of Mathcad’s 
predefined units. See “Units and Dimensions” on page 106 for more on built-
units in Mathcad. 

• Mathcad includes a large number of built-in functions that handle a range of 
computational chores ranging from basic calculation to sophisticated curve fitt
matrix manipulation, and statistics. To access one of these built-in functions,
can simply type its name in a math region. For example, Mathcad recognizes
name “mean” as the name of the built-in mean function, which calculates the 
arithmetic mean of the elements of an array, and the name “eigenvals” as the 
of the built-in eigenvals function, which returns a vector of eigenvalues for a matr

You can also choose Function from the Insert menu or click  on the Standard
toolbar to insert one of Mathcad’s built-in functions. See Chapter 10, “Built-in
Functions,” for a broad overview of Mathcad’s built-in functions.

User - de f ined var iable  and funct ion  nam es

Mathcad lets you use a wide variety of expressions as variable or function name

Names in Mathcad can contain any of the following characters:

• Uppercase and lowercase letters.

• The digits 0 through 9. 

• The underscore (_ ). 

• The prime symbol (' ). Note that this is not the same as an apostrophe. You’ll fi
the prime symbol on the same key as the tilde (~) or press [Ctrl ][F7] to insert it.

• The percent symbol (%).

• Greek letters. To insert a Greek letter, click a button on the Greek toolbar or 
the equivalent roman letter and press [Ctrl ]G. The section “Greek letters” on page
38 gives more details.

• The infinity symbol ∞, which you insert by clicking  on the Calculus toolba
or by typing [Ctrl ][Shift ]Z.
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The following are examples of valid names:

alpha b

xyz700 A1_B2_C3_D4%%%

F1' a%%

The following restrictions apply to variable names:

• A name cannot start with one of the digits 0 through 9. Mathcad interprets anyt
beginning with a digit as either an imaginary number (  or ), a binary, oct

or hexadecimal number (e.g., 5o, 7h), or as a number times a variable ( ).

• The infinity symbol, ∞, can only appear as the first character in a name.

• Any characters you type after a period (.) appear as a subscript. This is discusse
in “Literal subscripts” on page 39.

• All characters in a name must be in the same font, have the same point size, a
in the same style (italic, bold, etc.). Greek letters can, however, appear in an
variable name. See “Math Styles” on page 51.

• Mathcad does not distinguish between variable names and function names. T
if you define f(x), and later on you define the variable f, you will find that you cannot 
use f(x) anywhere below the definition for f.

• Although you can redefine Mathcad’s names for built-in functions, constants, 
units, keep in mind that their built-in meanings will no longer exist after the 
definition. For example, if you define a variable mean, Mathcad’s built-in function 
mean(v) can no longer be used.

Not e Mathcad distinguishes between uppercase and lowercase letters. For example, diam is a different 
variable from DIAM. Mathcad also distinguishes between names in different fonts, as discu
in “Math Styles” on page 51. Thus, Diam is also a different variable from Diam. 

Tip To type symbols such as $ in a name, press [Ctrl ][Shift ]K, type the symbol(s), and type  
[Ctrl ][Shift ]K again.

Greek  le t te rs

There are two ways to enter a Greek variable name in Mathcad:

• Click on the appropriate letter on the Greek toolbar. To see this toolbar, click 
on the Math toolbar, or choose Toolbars⇒Greek from the View menu.

• Type the Roman equivalent of the Greek symbol and then press [Ctrl ]G. For 
example, to enter φ, press f[Ctrl]G . See “Greek Letters” on page 313 in the 
Appendices for a table of Greek letters and their Roman equivalents.

Not e Although many of the uppercase Greek letters look like ordinary capital letters, they are not the 
same. Mathcad distinguishes between Greek and Roman letters, even if they appear visu
equivalent.

2i 3j

3 x⋅
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Tip Because it is used so frequently, the Greek letter π can also be typed by pressing 
[Ctrl ][Shift ]P.

Lit era l subscr ipt s 

If you include a period in a variable name, Mathcad displays whatever follows th
period as a subscript. You can use these literal subscripts to create variables with names
like  and .

To create a literal subscript, follow these steps:

1. Type the portion of the name that appears before the subscript.

2. Type a period (. ), followed by the portion of the name that is to 
become the subscript.

Not e Do not confuse literal subscripts with array subscripts, which are generated with the left brack

key ([ ) or by clicking  on the Calculator toolbar. Although they appear similar—a liter
subscript appears below the line, like an array subscript, but with a slight space before th
subscript—they behave quite differently in computations. A literal subscript is simply a 
cosmetic part of a variable name. An array subscript represents a reference to an array el
See Chapter 11, “Vectors, Matrices, and Data Arrays,” for a description of how to use subs
with arrays.

Op erators
As described in the previous section, certain characters, like letters and digits, ma
parts of names and numbers. Other characters, like *  and +, represent “operators.” 

Operators are symbols like “+” and “−” that link variables and numbers together to 
form expressions. The variables and numbers linked together by operators are ca
operands. For example, in an expression like:

the operands for the “+” are x and y. The operands for the exponent operator are a and 

the expression . 

You type the common arithmetic operators using the standard keystrokes, like *  and 
+, used in your spreadsheet and other applications. But all of Mathcad’s operator
be entered with keystrokes or by clicking buttons in the Math toolbars. For exam

you insert Mathcad’s derivative operator by typing ? or by clicking  on the Calculus 
toolbar. See “Operators” on page 298 in the Appendices for a complete list of opera
Mathcad’s operators are also discussed in detail in Chapter 9, “Operators.” 

Buildin g  Ex p ressions 

You can create many mathematical expressions by simply typing in a stream of 
characters, or by inserting appropriate operators from the Math toolbars. 

velinit uair

ax y+

x y+
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For example, if you type the characters

3/4+5^2=

you get the result shown at the right.

On the surface, Mathcad’s equation editor seems very much like a 
simple text editor, but there’s more to it than this. Mathematical expressions hav
well-defined structure and Mathcad’s equation editor is designed specifically to w
within that structure. In Mathcad, mathematical expressions are not so much typ
as they are built.

Mathcad automatically assembles the various parts that make up an expression
the rules of precedence and some additional rules that simplify entering denomin

exponents, and expressions in radicals. For example, when you type /  or click  on 
the Calculator toolbar to create a fraction, Mathcad stays in the denominator until
press [Space ] to select the entire expression. 

Typ in g  in  Nam es and N um bers
When you type in names or numbers, Mathcad behaves very much like a standard
processor. As you type, you see the characters you type appear behind a vertical editing 
line. The left and right arrow keys move this vertical editing line to the left or to th
right a character at a time, just as they would in a word processor. There are, how
two important differences:

• As it moves to the right, the vertical editing line leaves behind 
a trail. This trail is a “horizontal editing line.” Its importance 
becomes apparent when you begin working with operators.

• Unless the equation you’ve clicked in already has an operator in it, pressing 
[Space ] turns the math region into a text region. It is not possible to turn a te
region back into a math region.

Typ in g  in  O p erators
The key to working with operators is learning to specify what variable or expressio
to become an operand. There are two ways to do this: 

• You can type the operator first and fill in the placeholders with operands, or 

• You can use the editing lines to specify what variable or expression you want
turn into an operand.

The first method feels more like you’re building a skeleton and filling in the detail
later. This method may be easier to use when you’re building very complicated 
expressions, or when you’re working with operators like summation that require m
operands but don’t have a natural typing order.

The second method feels more like straight typing and can be much faster when
expressions are simple. In practice, you may find yourself switching back and fort
the need arises.
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Here’s how to create the expression  using the first method:

1. Press ̂ to create the exponent operator, or click  on the 
Calculator toolbar. You see two placeholders. The editing lines 
“hold” the exponent placeholder.

2. Click in the lower placeholder and type a.

3. Click in the upper placeholder.

4. Type +.

5. Click in the remaining placeholders and type x  and y .

To use the editing lines to create the expression , proceed as 
follows:

1. Type a. The editing lines hold the a indicating that a becomes the 
first operand of whatever operator you type next.

2. Press ̂ to create the exponent operator. As promised, a becomes the 
first operand of the exponent. The editing lines now hold another 
placeholder. 

3. Type x+y  in this placeholder to complete the expression.

Note that in this example, you could type the expression the same way you’d say 
loud. However, even this simple example already contains an ambiguity. When y

say “a to the x plus y” there’s no way to tell if you mean  or . For more 
complicated expressions, the number of ambiguities increases dramatically. 

Although you can always resolve ambiguities by using parentheses, doing so ca
quickly become cumbersome. A better way is to use the editing lines to specify t
operands of whatever operator you type. The following example illustrates this b

describing how to create the expression  instead of .

1. Enter a^x  as you did in the previous example. Note how the editing 
lines hold the x between them. If you were to type + at this point, 
the x would become the first operand of the plus.

2. Press [Space ]. The editing lines now hold the entire expression . 

3. Now type +. Whatever was held between the editing lines now 
becomes the first operand of the plus.

ax y+

ax y+

ax y+ ax y+

ax y+ ax y+

ax
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4. In the remaining placeholder, type y .

Mult i p l ica t ion
A common way to show multiplication between two variables on a piece of paper 

place them next to each other. For example, expressions like ax or  are easily 
understood to mean “a times x” and “a times the quantity x plus y,” respectively. 

This cannot be done with Mathcad variables for the simple reason that when you
ax , Mathcad has no way of knowing whether you mean “a times x” or “the variable 
named ax.” Similarly, when you type a(x+y) , Mathcad cannot tell if you mean “a 
times the quantity x plus y” or whether you mean “the function a applied to the argument 

.” 

To avoid ambiguity in your everyday work, we recommend that you always pres*  
explicitly to indicate multiplication, as shown in the following example:

1. Type a followed by * . Mathcad inserts a small dot after the “a” to 
indicate multiplication.

2. In the placeholder, type the second factor, x .

Not e In the special case when you type a numerical constant followed immediately by a variab
name, such as 4x , Mathcad interprets the expression to mean the constant multiplied by th

variable: . Mathcad displays a space between the constant and the variable to indica
the multiplication is implied. In this way, you can produce math notation that closely 
approximates the notation you see in textbooks and reference books. However, Mathcad
reserves certain letters, such as “i” for the imaginary unit and “o” for octal, as suffixes for 
numbers, and in these cases does not attempt to multiply the number by a variable name
rather treats the expression as a single number with a suffix.

Tip You can change the display of the multiplication operator to an X, a thin space, or a large
To do so, click on the multiplication operator with the right mouse button and choose View 
Multiplication As...  Or to change all the multiplication operators in a worksheet, choose 
Options from the Math  menu, click on the Display tab, and choose from the selections nex
“Multiplication.” See “Changing the Display of an Operator” on page 124 for additional 
information.

An Annota ted Exam p le 
When it comes to editing equations, knowing how to use the editing lines assum
importance similar to knowing where to put the flashing vertical bar (insertion po
you see in most word processors. A word processor can use a simple vertical bar b
text is inherently one-dimensional, like a line. New letters go either to the left or to
right of old ones. An equation, on the other hand, is really two-dimensional, with a 
structure more like a tree with branches than like a line of text. As a result, Math
has to use a two-dimensional version of that same vertical bar. That’s why there are
two editing lines: a vertical line and a horizontal line.

a x y+( )

x y+

4 x⋅
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Suppose, for example, that you want to type the slightly more complicated expre

Watch what happens to the editing lines in the following steps:

1. Type x-3*a^2 . Since the editing lines contain just the “2,” 
only the “2” becomes the numerator when you press the / . 

Since we want the whole expression, , to be the 
numerator, we must make the editing lines hold that entire expression.

2. To do so, press [Space ]. Each time you press [Space ], the 
editing lines hold more of the expression. You need to press 
[Space ] three times to enclose the entire expression.

3. Now press /  to create a division bar. Note that the numerator 
is whatever was enclosed between the editing lines when you 
pressed / .

4. Now type -4+  and click  on the Calculator toolbar. Then 
type y+1  under the radical to complete the denominator. 

5. To add something outside the radical sign, press [Space ] 
twice to make the editing lines hold the radical. For example, 
to add the number π to the denominator, press [Space ] twice.

6. Press +. Since the editing lines are holding the entire radical, 
it is the entire radical that becomes the first operand when you 
press +.

7. Click  on the Calculator toolbar or press 
[Ctrl ][Shift ]P. This is one of Mathcad’s built-in variables.

Edit in g  Ex p ressions

This section describes how to make changes to an existing expression.

Chan g in g  a  N am e or  Num ber      
To edit a name or number:

1. Click on it with the mouse. This places the vertical editing line where you click
the mouse. 

2. Move the vertical editing line if necessary by pressing the [→] and [←] keys.

3. If you type a character, it appears just to the left of the vertical editing line. Pres
[Bksp ] removes the character to the left of the vertical editing line. Pressing 
[Delete ] removes the character to the right of the vertical editing line.

x 3 a2⋅–

4– y 1+ π+ +
---------------------------------------

x 3 a2⋅–
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If you need to change several occurrences of the same name or number, you ma
it useful to choose Replace from the Edit  menu. To search for a sequence of characte
choose Find from the Edit  menu. These commands are discussed further in “Text
Tools” on page 64.

I nser t in g  an  O p era tor
The easiest place to insert an operator is between two characters in a name or t
numbers in a constant. For example, here’s how to insert a plus sign between tw
characters:

1. Place the editing lines where you want the plus sign to be.

2. Press the + key, or click  on the Calculator toolbar.

Not e You never need to insert a space when typing an equation. Mathcad inserts spaces autom
around operators wherever doing so is appropriate. If you do try to insert a space, Mathca
assumes you meant to type text rather than math and converts your math region into a text
accordingly.

Operators such as division and exponentiation result in more dramatic formatting
changes. For example, when you insert a divide sign, Mathcad moves everything
comes after the divide sign into the denominator. Here’s how you insert a divide 

1. Place the editing lines where you want the divide sign to be. 

2. Press the /  key or click  on the Calculator toolbar. Mathcad 
reformats the expression to accommodate the division.

Some operators require only one operand. Examples are the square root, absolute
and complex conjugate operators. To insert one of these, place the editing lines on
side of the operand and press the appropriate keystroke. Many of these operato

available on the Calculator toolbar as well. For example, to turn x into  do the 
following:

1. Place the editing lines around the “x,” either preceding or following 
the character.

2. Press \  to insert the square root operator, or click  on the 
Calculator toolbar.

App l y in g  an Op era tor  to an  Ex p ression
The methods described in the previous section work most predictably when you 
to apply an operator to a variable or a number. If, however, you want to apply an ope
to an entire expression, there are two ways to proceed:

• Surround that expression in parentheses and proceed as described in the pr
section, or

x
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• Use the editing lines to specify the expression to which you want to apply the
operator.

Although the first method may be more intuitive, it is slower since you need to typ
pair of parentheses. The more efficient, second method is the subject of this sec
The sections “Inserting Parentheses” on page 48 and “Deleting Parentheses” on
49 describe ways to work with parentheses more efficiently. 

The editing lines consist of a horizontal line and a vertical line that moves left to r
along the horizontal line. To make an operator apply to an expression, select the
expression by placing it between the two editing lines. The following examples s
how typing *c  results in completely different expressions depending on what was
selected.

• Here, the two editing lines hold only the numerator. This means 
any operator you type will apply only to the numerator.

• Typing *c  results in this expression. Note how the expression 
held between the editing lines became the first operand of the 
multiplication.

• Here, the editing lines hold the entire fraction. This means any 
operator you type will apply to the entire fraction.

• Typing *c  results in this expression. Note how everything 
between the editing lines became the first operand of the 
multiplication. 

• Here, the editing lines hold the entire fraction as they did in the 
previous example. However, this time the vertical editing line 
is on the left side instead of on the right side. 

• Typing *c  results in this expression. Note how the expression 
enclosed by the editing lines became the second rather than the 
first operand of the multiplication. This happened because the 
vertical editing line was on the left side rather than the right side. 

Cont rollin g  the edit in g  lines

You use the following techniques to control what’s between the editing lines:

• Click on an operator. Depending on where on the operator you click, you’ll fin
the vertical editing line either on the left or on the right of the operator, with th
horizontal line selecting an operand of the operator. If you want to move the ver
editing line from one side to the other of the currently selected expression, pr
[Insert ].

• Use the left and right arrow keys to move the vertical editing line one characte
a time. The horizontal editing line selects an operand of the nearest operator. If
expression contains built-up fractions, you can also use the up and down arrow
to move the editing lines.

• Press [Space ] to select progressively larger parts of the expression with the edit
lines. Each time you press [Space ], the editing lines enclose more and more of th
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expression, until eventually they enclose the entire expression. Pressing [Space ] 
one more time brings the editing lines back to where they were when you sta

Tip You can also drag-select parts of an expression to hold it between the editing lines. When y
do this, the selected expression is highlighted in reverse video. Note that whatever you typ
overwrites the highlighted expression.

The following example walks you through a short cycle of using [Space ]:

1. This is the starting position. The two editing lines hold just the 
single variable “d.”

2. Pressing [Space ] makes the editing lines grow so that they now 
hold the entire denominator.

3. Pressing [Space ] once makes the editing lines grow again so that 
they now hold the entire expression. 

4. At this point, the editing lines can’t become any longer. Pressing 
[Space ] brings the editing lines back to the starting point of the 
cycle.

You’ll notice that in stepping through the previous cycle there was never an 
intermediate step in which the editing lines held just the numerator. Nor was there
a step in which the editing lines held just the a or just the b in the numerator. That’s 
because the sequence of steps the editing lines go through as you press [Space ] 
depends on the starting point of the cycle.

To set the starting point of the cycle, either click on the appropriate part of the expre
as described earlier, or use the arrow keys to move around the expression. The 
keys walk the editing lines through the expression in the indicated direction. Kee
mind, however, that the idea of “up” and “down” or “left” and “right” may not alway
be obvious, particularly when the expression becomes very complicated or if it invo
summations, integrals, and other advanced operators.

Not e Editing of strings differs from editing of other math expressions because you must use the 
keys or click outside the string to move out of a string. Pressing [Space ], which can be used 
in other expressions to change the position of the editing lines, is interpreted as just anoth
character in a string.

Dele t in g  an  Op erator
To delete an operator connecting two variable names or constants:

1. Place the vertical editing line after the operator.

2. Press [BkSp].

Now you can easily insert a new operator to replace the one you deleted 
just by typing it in.

Tip You can also delete an operator by placing the editing lines before it and pressing [Delete ]. 
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In the above examples, it is easy to see what “before” and “after” mean because
expressions involved naturally flow from left to right, the same way we read. Fract
behave the same way. Since we naturally say “a over b,” putting the editing lines “after” 
the division bar means putting them just before the b. Similarly, putting the editing lines 
“before” the division bar means putting them immediately after the a. The following 
example illustrates this:

1. Place the vertical editing lines after the division bar. 

2. Press [BkSp].

To delete an operator having only one operand (for example, ,  or ):

1. Position the editing lines just after the operator. 

2. Press [BkSp].

For certain operators, it may not be clear where to put the editing lines. 
For example, it is not clear when looking at  or  what “before” and “after” me
When this happens, Mathcad resolves the ambiguity by referring to the spoken f

of the expression. For example, since you read  as “x conjugate,” the bar is treated as
being after the x.

Rep lacin g  an Op era tor
To replace an operator after deleting it between two variables or constants or on a 
variable, as shown in the steps above, simply type the new operator after pressi
[BkSp].

To replace an operator between two expressions:

1. Position the editing lines just after the operator.

2. Press [BkSp]. An operator placeholder appears.

3. Type the new operator.

I nser t in g  a  M inus Si g n  
The minus sign that means “negation” uses the same keystroke as the 
one that means “subtract.” To determine which one to insert, Mathcad looks at w
the vertical editing line is. If it’s on the left, Mathcad inserts the “negation” minus si
If it’s on the right, Mathcad inserts the “subtract” minus sign. To move the vertica
editing line from one side to the other, use [Insert ].

The following example shows how to insert a minus sign in front of “sin(a).”

1. Click on the sin(a). If necessary, press [Space ] to select the entire 
expression.

x x x!

x x

x
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2. If necessary, press [Insert ] to move the vertical editing line all 
the way to the left.

3. Type - , or click  on the Calculator toolbar, to insert a minus 
sign.

If what you really want to do is turn  into , insert another operato
(say, “+”) as described in the section “Inserting an Operator” on page 44. Then rep
the operator with a minus sign as described in the section “Deleting an Operator

page 46. Notice that in Mathcad the unary negation symbol in the expression 

appears smaller than the minus sign in expressions such as .

Not e When you are replacing an operator and the operator placeholder is showing, select an 
expression, rather than a single variable, to the right of the operator placeholder and type-  in 
order to put a subtraction minus sign in the placeholder. Otherwise Mathcad inserts a neg
sign.

I nser t in g  Paren theses    
Mathcad places parentheses automatically as needed to maintain the precedenc
operations. There may be instances, however, when you want to place parenthe
clarify an expression or to change the overall structure of the expression. You can 
insert a matched pair of parentheses all at once or insert the parentheses one at
We recommend you insert a matched pair since this avoids the possibility of unma
parentheses.

To enclose an expression with a matched pair of parentheses:

1. Select the expression by placing it between the editing lines. Do 
this by clicking on the expression and pressing [Space ] one or 
more times.

2. Type the single-quote key (‘ ), or click  on the Calculator 
toolbar. The selected expression is now enclosed by 
parentheses. 

It is sometimes necessary to insert parentheses one at a time using the (  and )  keys. 
For example, to change  to  do the following:

1. Move the editing lines just to the left of the b. Make sure the 
vertical editing line is on the left as shown. Press [Insert ] if 
necessary to move it over.

2. Type (  and click to the right of the c. Make sure the vertical 
editing line is to the right as shown. Press [Insert ] if 
necessary to move it over.

3. Type ) .

a( )sin 1 a( )sin–

a( )sin–

1 a( )sin–

a b– c+ a b c+( )–
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Dele t in g  Parentheses
You cannot delete one parenthesis at a time. Whenever you delete one parenthe
Mathcad deletes the matched parenthesis as well. This prevents you from inadver
creating an expression having unmatched parentheses.

To delete a matched pair of parentheses:

1. Move the editing lines to the right of the “(”.

2. Press [BkSp]. Note that you could also begin with the editing 
lines to the left of the “)”and press [Delete ] instead.

App l y in g  a  Funct ion to an  Ex p ression  
To turn an expression into the argument of a function, follow these steps:

1. Click in the expression and press [Space ] until the entire 
expression, , is held between the editing lines. 

2. Type the single-quote key (‘ ), or click  on the Calculator 
toolbar. The selected expression is enclosed by parentheses.

3. Press [Space ]. The editing lines now hold the parentheses 
as well.

4. If necessary, press the [Insert ] key so that the vertical 
editing line switches to the left side. If the vertical editing line 
is already on the left side, skip this step.

5. Now type the name of the function. If the function you wish 
to use is a built-in function, you can also choose Function 

from the Insert  menu or click  on the Standard toolbar 
and double-click the name of the function.

Movin g  Part s of an  Ex p ression     
The menu commands Cut, Copy, and Paste from the Edit menu are useful for editing 
complicated expressions. They function as follows:

• Cut  (  on the Standard toolbar or [Ctrl ]X on the keyboard) deletes whateve
is between the editing lines and copies it to the Clipboard.

• Copy (  on the Standard toolbar or [Ctrl ]C on the keyboard) takes whateve
is between the editing lines and copies it to the Clipboard.

• Paste (  on the Standard toolbar or [Ctrl ]V on the keyboard) takes whateve
is on the Clipboard and places it into your worksheet, either into a placeholde
into the blank space between other regions.

w t⋅ k z⋅–
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The Copy and Paste commands use the Clipboard to move expressions from one p
to another. You can, however, bypass the Clipboard by using Mathcad’s equation drag 
and drop feature.

Suppose you want to build the expression

1. Drag-select the argument to the cosine 
function so that it is highlighted in reverse 
video.

2. Press and hold down [Ctrl ] and the mouse 
button. The pointer changes to indicate that it 
carries the selected expression with it. It 
continues to carry the selected expression until you release the mouse butto

3. With the mouse button still held down, drag 
the pointer over the placeholder.

4. Release the mouse button. The pointer drops 
the expression into the placeholder. It then 
recovers its original form.

Tip You can drag and drop expressions, or even entire math regions, into placeholders in oth
expressions or into any blank space in your worksheet. Just be sure you don’t let go of the 
button before you’ve dragged the expression to wherever you want to drop it. If you’re tryin
drop the expression into a placeholder, be sure to position the pointer carefully over the 
placeholder.

Dele t in g  Par t s of an  Ex p ression  
You can delete part of an expression by using either the [Delete ] key or the [BkSp] 
key. If you use this method, whatever you delete is not placed on the Clipboard. This 
is useful when you intend to replace whatever you delete with whatever is current
the Clipboard. 

To delete part of an expression without placing it on the Clipboard:

1. Drag-select the part of the expression (in this case, the 
numerator) so that it is highlighted in reverse video.

2. Press [Delete ] or [BkSp]. This removes the numerator and 
leaves behind a placeholder.

Not e If you select an expression with the editing lines instead of drag-selecting as shown above
must press [Bksp ] or [Delete ] twice to remove it. In this case, [Bksp ] removes the expression
to the left of the editing lines, and [Delete ] removes to the right.

wt x+( )cos wt x+( )sin+
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Math St y les   

You may already have encountered styles in your other applications to determine the
appearance of text or other elements. By making changes to text styles rather th
individual text elements in a word processing document, you can make sweeping
strikingly uniform changes in the way that documents looks. (See Chapter 5, “Wor
with Text,” for an explaination of Mathcad’s text styles) You can get this same kind
leverage by using math styles to assign particular fonts, font sizes, font styles and 
effects, and colors to the elements of your math expressions. 

Mathcad has predefined math styles that govern the default appearance of all the
in your worksheet, but you can define and apply additional styles to enhance the
appearance of your equations.

Mathcad’s predefined math styles are:

• Variables, which governs the default appearance of all variables.

• Constants, which governs the default appearance of all numbers you type in m
regions as well as all numbers that appear in results.

Whenever you type a variable name, Mathcad: 

• Assigns to it a math style named “Variables.”

• Displays the variable name using the characteristics associated with the style n
“Variables.”

Similarly, when you type a number or when a result is calculated, Mathcad:

• Assigns to it a math style named “Constants.”

• Displays the number using the characteristics associated with the style name
“Constants.”

Edit in g  Math  St y les
To change Mathcad’s default style for all variables and plots:

1. Click on a variable name in your worksheet.

2. Choose Equation from the Format menu. 
The style name “Variables” is selected.

3. Click “Modify” to change the font associated 
with the “Variables” style. You’ll see a dialog 
box for changing fonts.

4. Make any changes using the dialog box and 
click “OK.” Mathcad changes the font of all 
variables in the worksheet.

If you change the Variables style, you may also 
want to change the style used for numbers so that the two look good together. To 

1. Click on a number. 

2. Choose Equation from the Format menu to see the Equation Format dialog bo
The style name “Constants” is now selected.
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3. Follow the procedure given above for modifying the Variables style. 

You can also use the Formatting toolbar to change the font, font size, or font sty
associated with a math style. For example, to use the Formatting toolbar to modify 
of the settings for the Variables math style, click on a variable, then click on the 
appropriate Formatting toolbar button to make variables bold, italic, or underline
to specify the font or point size in the drop-down lists.

Not e Mathcad’s line-and-character grid does not respond automatically to changes in the font s
used in text and math. Changing font characteristics, particularly font sizes, may cause re
to overlap. You can separate these regions by choosing Separate Regions from the Format 
menu.

You may wish to have your equations display in a different color than your default
regions to avoid confusing the two. To change the default color of all equations in 
worksheet,

1. Choose Equation from the Format menu. 

2. Select a color in the “Default Equation Color” drop-down list.

3. Click “OK.”

App l y in g  Math  St y les
The “Variables” and “Constants” styles govern the default appearance of all mat
your worksheet. These two style names cannot be changed. You may, however, 
and apply additional math styles, named as you choose, in your worksheets and
templates.

To see what math style is currently assigned to a name or number, simply click i
name or number, and look at the style window on the Formatting toolbar.

Alternatively, click the name or number and 
choose Equation from the Format menu. The 
math style associated with whatever you clicked 
on appears in the drop-down list in the Equation 
Format dialog box. 

If you click on the button to the right of 
“Variables” in either the Formatting toolbar or the 
Equation Format dialog box, you’ll see a drop-
down list of available math styles. If you now 
choose “User 1” and click “OK,” a new math style is applied to the selected elem
and its appearance changes accordingly. 

In this way you can apply any of a variety of math styles to:

• individual variable names in an expression, or

• individual numbers in a math expression (but not in computed results, which alw
display in the “Constants” style).
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For example, many math books show vectors in a bold, underlined font. If you wa
use this convention, do the following:

1. Choose Equation from the Format menu.

2. Click the down arrow beside the name of the current math styles to see a drop-
list of available math styles.

3. Click on an unused math style name like “User 1” to select it. The name “Use
should now appear in the “New Style Name” text box. Click in this text box an
change the name to something like “Vectors.”

4. Click “Modify” to change this style to a bold, underlined font.

This creates a math style called “Vectors” with the desired appearance. When yo
done defining the style, click “OK.”

Now rather than individually changing the font, font size, and font style for name
vectors, you can simply change their math styles. 

Not e All names, whether function names or variable names, are font sensitive. This means thatx and 
x refer to different variables, and f(x) and f(x) refer to different functions. In deciding whether 
two variable names are the same, Mathcad actually checks math styles rather than fonts. To 
avoid having distinct variables that look identical, don’t create a math style with exactly th
same font, size, and other characteristics as another math style.

Savin g  M ath St y les
Once you’ve completed a set of math styles that you like, you need not repeat the p
for other worksheets. You can save math style information by saving a workshee
template. Choose Save As from the File menu and select Mathcad Template (*.mct
as the file type in the Save As dialog box.

To apply math style information to another worksheet, open your template from 
File menu and copy the contents of the worksheet to the template. For more inform
about worksheet templates, see Chapter 7, “Worksheet Management.”
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Chapter  5
W ork in g  w ith Text

τ I nser t ing Text

τ Text  and Paragraph Propert ies

τ Text  St y les

τ Equat ions in Text

τ Text  Tools

I nser t in g  Text  

This section describes how to create text regions in Mathcad. Text regions are u
for inserting any kind of text into your worksheets and templates: comments arou
the equations and plots in your worksheet, blocks of explanatory text, backgroun
information, instructions for the use of the worksheet, and so on. Mathcad ignores
when it performs calculations, but you can insert working math equations into te
regions as described in “Equations in Text” on page 63. 

Crea t in g  a  Tex t  Re g ion 
To create a text region, follow these steps. First, click in a blank space in your work
to position the crosshair where you want the text region to begin. Then:

1. Choose Text Region from the Insert menu, or press the 
double-quote (" ) key. Mathcad begins a text region. The 
crosshair changes into an insertion point and a text box 
appears.

2. Now begin typing some text. Mathcad displays the text and 
surrounds it with a text box. As you type, the insertion point 
moves and the text box grows.

3. When you finish typing the text, click outside the text region. 
The text box disappears.

Not e You cannot leave a text region simply by pressing [↵]. You must leave the text region by 
clicking outside the region, by pressing [Ctrl ][Shift ][↵], or by repeatedly pressing one of 
the arrow keys until the cursor leaves the region.

To insert text into an existing text region:

• Click anywhere in a text region. A text box now surrounds your text. Anything y
type gets inserted at the insertion point. 

To delete text from an existing text region, click in the text region and:

1. Press [BkSp] to delete the character to the left of the insertion point, or
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2. Press [Delete ] to delete the character to the right of the insertion point.

To overtype text:

1. Place the insertion point to the left of the first character you want to overtype

2. Press [Insert ] to begin typing in overtype mode. To return to the default insert 
mode, press [Insert ] again. 

You can also overtype text by first selecting it (see “Selecting Text” on page 56).
Whatever you type next replaces your selection.

Tip To break a line or start a new line in a text region, press [↵]. Mathcad inserts a hard return and
moves the insertion point down to the next line. Press [Shift ][↵] to start a new line in the same
paragraph. When you rewrap the text by changing the width of the text region, Mathcad 
maintains line breaks at these spot in the text.  

Movin g  the I nser t ion  Poin t
In general, you move the insertion point within text regions by clicking with the mo
wherever you want to put the insertion point. However, you can also use the arrow
to move the insertion point. 

The arrow keys move the insertion point character by character or line by line wi
text. Pressing [Ctrl ] and an arrow key moves the insertion point word by word or li
by line. These and other ways of moving the insertion point are summarized belo

Se lect in g  Tex t  
One way to select text within a text region is:

1. Click in the text region so that the text box appears.

2. Drag across the text holding the mouse button down.

Key Act ion

[→] Move right one character.

[←] Move left one character.

[↑] Move up to the previous line.

[↓] Move down to the next line.

[Ctrl ][→] Move to the end of the current word. If the insertion point is alread
there, move to the end of the next word.

[Ctrl ][←] Move to the beginning of the current word. If the insertion point is
already there, move to the beginning of the previous word.

[Ctrl ][↑] Move to the beginning of the current line. If the insertion point is 
already there, move to the beginning of the previous line.

[Ctrl ][↓] Move to the end of the current line. If the insertion point is already
there, move to the end of the next line.

[Home] Move to the beginning of the current line.

[End] Move to the end of the current line.
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Mathcad highlights the selected text, including any full lines 
between the first and last characters you selected.

On- line Help You can also select text using arrow keys and multiple clicks of the mouse button, just as
can in most word processing applications. For more information, refer to the topic “Select
text” in the on-line Help.

Once text is selected, you can delete it, copy it, cut it, check the spelling, or chan
font, size, style, or color. 

Tip Once you’ve cut or copied text to the Clipboard, you can paste it back into any text region o
an empty space to create a new text region.

To select and move an entire text region or group of regions, follow the same step
you would use with math regions, described on “Moving and Copying Regions” o
page 10. To perform other editing actions, select the regions, and then choose Cut, 
Delete, Paste, or Copy from the Edit  menu, or click the corresponding buttons on th
Standard toolbar.

Greek Le t te rs in  Tex t
To type a Greek letter in a text region, use one of these two methods:

• Click on the appropriate letter on the Greek toolbar. To see this toolbar, click 
on the Math toolbar, or choose Toolbars⇒Greek from the View menu, or

• Type the Roman equivalent of the Greek symbol and then press [Ctrl ]G. For 
example, to enter φ, press f [Ctrl ]G. See “Greek Letters” on page 313 in the 
Appendices for a table of Greek letters and their Roman equivalents.

Tip As discussed in the section “Inserting Math” in Chapter 4, typing [Ctrl ]G after a letter in a math 
region also converts it to its Greek equivalent. In addition, [Ctrl ]G converts a nonalphabetic 
character to its Greek symbol equivalent. For example, typing [Shift ]2[Ctrl ]G in a text 
region produces the “≅” character.

To change a text selection into its Greek equivalent, select the text and then:

1. Choose Text from the Format menu.

2. From the Font list select the Symbol font.

You can also change the font of a text selection by using the Formatting toolbar.

Chan g in g  the  W idth  of a Tex t  Re g ion
When you start typing in a text region, the region grows as you type, wrapping o
when you reach the right margin or page boundary. (The location of the right ma
is determined by the settings in the Page Setup dialog box, which you can modif
choosing Page Setup from the File menu.) Press [↵] whenever you want to start a new
line. To set a width for your whole text region and have lines wrap to stay within 
width as you type. To do this:

1. Type normally until the first line reaches the width you want.

2. Type a space and press [Ctrl ][↵]. 
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All other lines break to stay within this width. When you add to or edit the text, Math
rewraps the text according to the width set by the line at the end of which you pre
[Ctrl ][ ↵]. 

To change the width of an existing text region, do the following:

1. Click anywhere in the text region. A selection box encloses the text region.

2. Move the pointer to the middle of the right edge of the text region until it hove
over the “handle” on the selection rectangle. The pointer changes to a double
headed arrow. You can now change the size of the text region the same way
change the size of any window—by dragging the mouse.

Tip You can specify that a text region occupies the full page width by clicking on the region a
choosing Properties from the Format menu. Click the Text tab and check “Occupy Page 
Width.” As you enter more lines of text into a full-width text region, any regions that are be
are automatically pushed down in the worksheet.

Text  and Para gra p h Pro p er t ies 

This section describes changing various font properties and changing the alignm
and indenting of paragraphs within a text region.

Chan g in g  Tex t  Pro p er t ies 
To change the font, size, style, 
position, or color of a portion of 
the text within a text region, first 
select the text. (See “Selecting 
Text” on page 56.) Then choose 
Text from the Format menu to 
access the Text Format dialog box. 
The Text Format dialog box also 
appears when you click with the 
right mouse button on selected 
text and choose Font from the 
pop-up menu.

Many of the options of the Text 
Format dialog box are also available via the buttons and drop-down lists on the 
Formatting toolbar:

When you first insert text, its properties are determined by the worksheet or tem
defaults for the style called “Normal.” See “Text Styles” on page 61 to find out ab
applying and modifying existing text styles and creating new ones for governing 
default appearance of entire text paragraphs or regions. Any properties that you c
for selected text as described here override the properties associated with the style fo
that text region.
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Tip If you simply place the insertion point in text and then change the text properties through 
Text Format dialog box or the Formatting toolbar, any text you now type at that insertion p
will have the new properties you selected.

You can change the following properties of selected text:

• Font

• Font style

• Font size

• Effects such as subscripts and superscripts

• Color 

Font sizes are in points. Note that some fonts are available in many sizes and ot
aren’t. Remember that if you choose a bigger font, the text region you’re in may g
and overlap nearby regions. Choose Separate Regions from the Format menu if 
necessary.

Tip You can specify that a text region automatically pushes following regions down as it grow
clicking on the region and choosing Properties from the Format menu. Click the “Text” tab and 
select “Push Regions Down As You Type.” 

Tip As a shortcut for creating subscripts and superscripts in text, use the Subscript and Superscript 
commands on the pop-up menu that appears when you click with the right mouse button 
selected text.

Chan g in g  Para g ra p h Pro p er t ies
A paragraph in a text region is any stream of characters followed by a hard return, w
is created when you type [ ↵] . You can assign distinct properties to each paragraph
a text region, including alignment, indenting for either the first or all lines in the 
paragraph, tab stops, and bullets or sequential numbering to begin the paragraph.

When you first create a text region, its paragraph properties are determined by th
worksheet or template defaults for the style called “Normal.” See “Text Styles” on p
61 to find out about text styles for governing the default appearance of entire text re
or paragraphs. Any paragraph properties that you change as described here override 
the paragraph properties associated with the style for that text region.

Not e When you type [Shift ][↵] Mathcad inserts a new line within the current paragraph; it does 
create a new paragraph.
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You can change the properties for a paragraph within a text region by doing the 
following: 

1. Select the paragraph by clicking in it 
to place the insertion point, by drag-
selecting it, or by triple-clicking it.

2. Choose Paragraph from the Format 
menu, or click with the right mouse 
button and choose Paragraph from 
the pop-up menu. Mathcad displays 
the Paragraph Format dialog box.

3. Change the appropriate properties in 
the dialog box and click “OK.” 

You can change the following paragraph properties:

I ndent

To indent every line in the paragraph the same amount, enter numbers in the “Left
“Right” text boxes. To indent the first line of the paragraph a different amount than th
rest of the lines, as for a conventional or hanging indent, select “First Line” or 
“Hanging” from the “Special” drop-down list and enter a value below.

You can also set indents using the text ruler. Click in a paragraph and choose Ruler 
from the View menu. Move the top or bottom arrow in the ruler to set a different ind
for the first line, or move both arrows to indent all the lines in the paragraph.

Bullet s and num bered list s

To begin the paragraph with a bullet, select “Bullets” from the “Bullets” drop-dow
list. Select “Numbers” from the drop-down list to have Mathcad number success

paragraphs in the region automatically. Alternatively, click  or  on the 
Formatting toolbar.

Ali g nm ent

To align the paragraph at either the left or right edge of the text region, or to cente
text within the text region, use the three alignment buttons in the dialog box. Alte

tively, click one of the three alignment buttons on the Formatting toolbar: , , 

or . 

Tab sto p s

To specify tabs, click the “Tabs” button in the Paragraph Format dialog box to op
the Tabs dialog box. Enter numbers into the “Tab stop position” text box. Click “S
for each tab stop then click “OK.”

Altenatively, you can set tab stops using the text ruler. Click in a paragraph and ch
Ruler from the View menu. Click in the ruler where you want a tab stop to be. A t
stop symbol appears. To remove a tab stop, click on the tab stop symbol, hold the m
button down, and drag the cursor away from the ruler.
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Tip To change the measurement system used in the Paragraph Format dialog box or in the tex
choose Ruler from the View menu to show the text ruler if it is not already showing, click on
the ruler with the right mouse button, and choose Inches, Centimeters, Points, or Picas from 
the pop-up menu.

Text  St y les

Mathcad uses text styles to assign default text and paragraph properties to text regio
Text styles give you an easy way to create a consistent appearance in your works
Rather than choosing particular text and paragraph properties for each individua
region, you can apply an available text style, setting a range of text and paragra
properties at once.

Every worksheet has a default “normal” text style with a particular choice of text 
paragraph properties. Depending on your worksheet and the template from whic
worksheet is derived, you may have other predefined text styles to which you can a
to existing or new text regions. You can also modify existing text styles, create n
ones of your own, and delete ones you no longer need. 

This section describes the procedures for applying, modifying, creating, and dele
text styles. See the previous section, “Text and Paragraph Properties,” for detail
the available text and paragraph properties. 

App l y in g  a  Tex t  St y le  to a  Para g ra p h in a  Text  Re g ion
When you create a text region in your worksheet, the region is tagged by default
the “Normal” style. You can, however, apply a different style to each paragraph—e
stream of characters followed by a hard return—within the text region:

1. Click in the text region on the paragraph where 
you want to change the style.

2. Choose Style from the Format menu, or click 
with the right mouse button and choose Style 
from the pop-up menu, to see a list of the avail-
able text styles. Available text styles depend on 
the worksheet template used.

3. Select one of the available text styles and click 
“Apply.” The default text in your paragraph ac-
quires the text and paragraph properties associ-
ated with that style.

Tip As an alternative to choosing Style from the Format menu, you can apply a text style to a tex
paragraph simply by clicking in the paragraph and choosing a style from the left-most dro
down list in the Formatting toolbar. To apply a text style to an entire text region, first selec
the text in the region. For information on selecting text, refer to “Selecting Text” on page 5

Modif y in g  an  Ex ist in g  Tex t  St y le
You can change the definition of a text style—its text and paragraph properties—a
time.
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To modify a text style:

1. Choose Style from the Format menu. Mathcad brings up the Text Styles dialog
box showing the currently available text styles.

2. Select the name of the text style you want to modify and click “Modify.”

3. The Define Style dialog 
box displays the defini-
tions of that text style.

4. Click “Font” to modify 
text formats such as the 
font, font size, font styl-
ing, special effects, and 
color. Click “Paragraph” 
to modify the indenting 
and alignment and other properties for paragraphs. See “Text and Paragraph
Properties” on page 58 for details about the available text and paragraph forma
options. 

5. Click “OK” to save your changes. 

Any new text regions to which you apply the modified text style will reflect the ne
definition for that text style. In addition, any text regions previously created with t
text style will be modified accordingly.

Crea t in g  and Delet in g  Text  St y les
You can modify the list of available text styles in your worksheet by creating new o
and deleting ones you no longer use; any text style changes are saved with your
worksheet. You can base a new text style on an existing text style, such that it inh
text or paragraph properties, or you can create an entirely new style. For example
may want to base a new “Subheading” style on an existing “Heading” style, but ch
a smaller font size, keeping other text and paragraph properties the same. 

Creat ing a  tex t  style

To create a new text style:

1. Choose Style from the Format menu. Mathcad brings up the Text Styles dialog
box showing the currently available text styles.

2. Click “New” to bring up the Define Style dialog box.

3. Enter a name for the new style in the “Name” text box. If you want to base the 
style on one of the existing styles in the current worksheet or template, select a
from the “Based on” drop-down list.

4. Click the “Font” button to make your choices for text formats for the new style
Click the “Paragraph” button to choose paragraph formats for the new style.

5. Click “OK” when you have finished defining the new style.

Your new style now appears in the Text Styles dialog box and can be applied to
text region as described in “Applying a Text Style to a Paragraph in a Text Region
page 61. When you save the worksheet, the new text style is saved with it. If you 
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to use the new text style in your future worksheets, save your worksheet as a tem
as described in Chapter 7, “Worksheet Management.” You may also copy the text
into another worksheet simply by copying and pasting a styled region into the ne
worksheet.

Not e If you base a new text style on an existing text style, any changes you later make to the or
text style will be reflected in the new text style as well.

Delet ing a  tex t  style

You may delete a text style at any time. To do so:

1. Choose Style from the Format menu. Mathcad brings up the Text Styles dialog
box showing the currently available text styles.

2. Select one of the available text styles from the list.

3. Click “Delete.”

The text style is removed from the list of available text styles. However, any text reg
in your worksheet whose text and paragraph properties were defined in terms of
text style will continue to display the properties of that style.

Eq uat ions in  Tex t

This section describes how to insert equations into your text regions. Equations ins
into text have the same properties as those in the rest of your worksheet. You ca
them using the methods described in Chapter 4, “Working with Math.” 

I nser t in g  an  Eq ua t ion  in to Tex t  
Place an equation into text either by creating a new equation inside a text region 
pasting an existing equation into a text region.

To add a new equation into a text region or a paragraph, follow these steps:

1. Click in the text region or paragraph 
to place the insertion point where you 
want the equation to start.

2. Choose Math Region from the
Insert menu. A placeholder appears. 

3. Type in the equation just as you 
would in a math region.

4. When you’ve finished typing in the 
equation, click on any text to return 
to the text region. Mathcad adjusts 
the line spacing in the text region to 
accommodate the embedded math region.
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To paste an existing equation into a text region, follow these steps:

1. Select the equation you want to paste into the text.

2. Choose Copy from the Edit  menu, or click  on the Standard toolbar.

3. Click in the text region to place the insertion point where you want the equatio
start.

4. Choose Paste from the Edit  menu, or click  on the Standard toolbar.

Disablin g  Em bedded E q ua t ions
When you first insert an equation into text, it behaves just like an equation in a m
region; it affects calculations throughout the worksheet. If you want the equation t
purely cosmetic, you can disable it so that it no longer calculates. To do so:

1. Click on the equation you want to disable.

2. Choose Properties from the Format menu. Click on the Calculation tab.

3. Click the “Disable Evaluation” check box.

4. Click “OK.”

Once you have done so, the equation can neither affect nor be affected by other
equations in the worksheet. To turn it back on, remove the check next to “Disabl
Evaluation” in the Properties dialog box.

For a more general discussion of disabling and locking equations, see “Disabling
Equations” on page 118.

Text  Tools 

Mathcad has tools for finding and replacing text as well as checking the spelling of

Find and Re p lace
Mathcad’s Find and Replace commands on the Edit  menu are capable of working in
both text and math regions. By default, however, Mathcad finds and replaces tex
text regions only.

Search ing for tex t

To find a sequence of characters:

1. Choose Find from the Edit  menu. 
Mathcad brings up the Find dialog 
box.

2. Enter the sequence of characters you 
want to find. 

3. Click “Find Next” to find the occur-
rence of the character sequence im-
mediately after the current insertion point location. Use the available options in
dialog box to search upward or downward in the worksheet, to match whole w
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only, to match the case exactly of the characters you entered, and to specify wh
Mathcad should search in text or math regions or both.

On- line Help The Help topic “Characters You Can Find and Replace” details the characters you can fin
math and text regions, including Greek symbols. Many special characters, including punctu
and spaces, can be located only in text or math strings.

Replacing  characters

To search and replace text:

1. Choose Replace from the Edit  menu 
to bring up the Replace dialog box.

2. Enter the string you want to find (the 
target string) in the “Find what” box. 

3. Enter the string you want to replace it 
with in the “Replace with” box. Check 
the appropriate boxes to match whole 
words only, to match the case exactly 
of the characters you entered, and to 
specify whether Mathcad should search in text or math regions or both.

You now have the following options:

• Click “Find Next” to find and select the next instance of your target string.

• Click “Replace” to replace the currently selected instance of the string.

• Click “Replace All” to replace all instances of the string.

Sp e ll- Checkin g  
After creating text, you can have Mathcad search the text for misspelled words a
suggest replacements. You can also add words that you commonly use to your pe
dictionary. 

Not e Mathcad spell-checks text regions only, not math or graphics regions.

To begin spell-checking, specify the portion of the worksheet to spell-check. There
two ways to do this:

• Click at the beginning of wherever you want to spell-check. Mathcad spell-che
starting from this point and continues to the end of the worksheet. You can th
either continue the spell-check from the beginning of the worksheet or quit sp
checking.

• Alternatively, select the text you want to spell-check.
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Once you’ve defined a range over which to check spelling:

1. Choose Check Spelling from the Edit  

menu, or click  on the Standard 
toolbar. 

2. When Mathcad finds a misspelled 
word, it opens the Check Spelling di-
alog box. The misspelled word is 
shown along with a suggested replace-
ment or a list of possible replace-
ments. If Mathcad has no immediate 
suggestions, it shows only the misspelled word. 

Tip To determine whether a word is misspelled, Mathcad compares it with the words in two 
dictionaries: a general dictionary of common English words supplemented by mathematic
terms and a personal dictionary. If there are certain correctly spelled words throughout yo
worksheet which Mathcad nevertheless shows as being misspelled, you may want to add
to your personal dictionary. 

After the Check Spelling dialog box appears, you have several options:

• To change the word to the suggested replacement, or to another word you se
from the list of possible replacements, click “Change.”

• Click “Suggest” to see additional but less likely replacements. If Mathcad can o
no additional suggestions, “Suggest” is grayed.

• To change the word to one not listed, type the replacement into the “Change
box and click “Change.”

• To leave the word as is, click “Ignore” or “Add.” If you click “Ignore,” Mathcad
leaves the word alone, continues spell-checking, and ignores all future occurre
of the word. If you click “Add,” the word is added to your personal dictionary. 

Not e To choose a dialect associated with the English dictionary, choose Preferences from the View 
menu, click on the General tab, and choose an option below “Spell Check Dialect.” 
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Chapter  6
W ork in g  w ith Graphics 
and Other  Ob j ects

τ Overview

τ I nser t ing Pictures

τ I nser t ing Obj ect s

τ I nser t ing Graphics Com putat ionally Linked to Your Worksheet

Overview

To visually explain your Mathcad calculations, it is often useful to add graphs, pictu
or other objects. You can include the following in your Mathcad worksheet:

• 2D graphs, including X-Y and polar plots. 

• 3D graphs, including surface plots, contour plots, three-dimensional scatter p
and others.

• Pictures based on values in a matrix, copied and pasted from another applica
or based on a bitmap file

• Objects created by another application (.AVI  files, .DOC files, .MDI  files, etc.)

• Graphics computationally linked to your calculations

For information on creating two-dimensional graphs, see Chapter 12, “2D Plots.” R
to Chapter 13, “3D Plots,” for information on creating three-dimensional graphs.

The remaining sections in this chapter describe how to insert pictures and object
a Mathcad worksheet and format them. The last section of this chapter introduce
process of inserting a graphic that is computationally linked to your calculations.
a more detailed discussion of computationally linked applications, see Chapter 1
“Advanced Computational Features.”

I nser t in g  Pictures

This section describes techniques for creating and formatting pictures—static graphic 
images—in your Mathcad worksheet.

Crea t in g  a  Picture
You can create a picture in a Mathcad worksheet in the following ways:

• By using the picture operator and supplying either the name of a Mathcad matr
or the name of an external bitmap file, or 

• By importing an image from another application via the Clipboard. 
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Creat in g  a  p icture  from  a  m at r ix

You can view any matrix in Mathcad as a picture by using the picture operator:

1. Click in a blank space in your Mathcad worksheet.

2. Choose Picture from the Insert menu or click  on the Matrix toolbar.

3. Type the name of a matrix in the placeholder at the bottom of the operator.

Mathcad creates a 256-shade grayscale representation of the data in the matrix,
each matrix element corresponding to a pixel in the picture. 

Not e Mathcad’s picture operator assumes a 256-color model with the value 0 represented as bla
255 as white. Numbers outside the range 0–255 are reduced modulo 256, and any nonin
value is treated as if its decimal part has been removed.

Since the matrices used in picture rendering are usually quite large, this techniqu
creating a picture is most useful when you import graphics files into Mathcad as 
matrices as described in “File Access Functions” on page 188. For example, you
use the READBMP function to read an external graphics file into a matrix, and then u
the picture operator to see the picture in Mathcad. 

Ti p To display an image in color, you must provide the picture operator with the names of thr
matrices of the same size containing the red, green, and blue color values of the image. Ty
three names, separated by commas, in the placeholder of the picture operator. Otherwise
image appears in grayscale.

Creat in g  a  p icture  b y  re fe rence  to a  bitm a p  f ile

Mathcad can create a picture directly from an external file in Windows bitmap (BMP) 
format. To do so, click in a blank space in your worksheet and then:

1. Choose Picture from the Insert menu, 

or click  on the Matrix toolbar, to 
insert the picture operator. 

2. In the placeholder, type a string 
containing the name of a bitmap file in 
the current directory, or type a full path 
to a bitmap file. You create a string in 
the placeholder by first typing the 
double-quote (" ) key.

3. Click outside the picture operator. The 
bitmap appears in your worksheet.

Each time you open the worksheet or 
calculate the worksheet, the bitmap file is 
read into the picture operator. 
68  Chapter 6  Working with Graphics and Other Objects



ified 

to 
tion 
 

le or 
 
 only 

d 

le-
o edit 

ng:

 via a 
e.

 on 

 from 

 you 
 that 

more 
that 

e 
 

colors 
Not e If you modify the source bitmap file, you must recalculate your worksheet to see the mod
image. If you move the source bitmap file, Mathcad can no longer display the picture.

Creat ing a  picture  by im por t ing from  the  Clipboard

You can copy an image from another application to the Clipboard and paste it in
Mathcad in one of the formats put on the Clipboard at the time of copying. This sec
describes using the Paste Special command on the Edit  menu to paste a graphic image
into a Mathcad worksheet from the Clipboard in a noneditable format: as a metafi
bitmap. A metafile, which is strictly a Windows graphic format, can be resized in
Mathcad without undue loss of resolution, whereas a bitmap is usually viewed best
at its original size. A device-independent bitmap, or DIB, is stored in a bitmap format 
that is portable to other operating systems.

Not e If you use the Paste command on Mathcad’s Edit  menu to paste in an image from the Clipboar
(or use drag-and-drop from another application), you typically paste a linked OLE object into 
your Mathcad worksheet, as discussed in “Inserting Objects” on page 71. When you doub
click a linked OLE object, you activate the application that created the object and are able t
the object in your Mathcad worksheet.

To paste a graphics image from another application into Mathcad, do the followi

1. Open the application and place the graphics image on the Clipboard, usually
Copy command on the Edit  menu. Many Windows applications have this featur

2. Click the mouse wherever you want the image in your Mathcad worksheet.

3. Choose Paste Special from the Edit  menu, and choose “Picture (metafile)” or 
“Device Independent Bitmap.” 

4. Click “OK.” Mathcad creates a picture region and puts into it the image stored
the clipboard.

Not e The format choices in the Paste Special dialog box will vary, depending on the application
which you originally copied a picture. 

Mathcad stores the color depth—the number of colors in the image—at the time
paste it into a worksheet. This means that you can safely resave any worksheets
contain color images on systems that have different color displays, either fewer or 
colors. The images continue to display at the proper color depth on the systems 
created the worksheets.

Not e When you import directly from the Clipboard, the picture information is stored as part of th
Mathcad worksheet. This makes the file size larger. It also means that when you copy the
worksheet, the picture information travels along with it. 

Not e To avoid making your Mathcad file too large, paste bitmaps that have been saved in as few 
as possible such as 16 or 256 colors.
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Form at t in g  a  Picture
This section describes your options for formatting a picture once you’ve created 

Resizing a  picture

To resize a picture region, do the following:

1. Click the mouse inside the picture region to select it.

2. Move the mouse pointer to one of the handles along the edge of region. The p
changes to a double-headed arrow.

3. Press and hold down the left mouse button. With the button still held, drag the m
in the direction you want the picture region to be stretched.

Tip When you change the size of the picture region, the picture inside may be distorted. If you 
the picture by dragging diagonally on the handle in the lower right corner, you preserve th
aspect ratio—the ratio of height to width—of the original picture. To restore a picture to its
original size, click on the picture and choose Properties from the Format menu. On the display 
tab of the Properties dialog box, check “Display at Original Size.”

Fram ing a  picture

Mathcad allows you to place a border all the way around a picture region. To do

1. Double-click the picture itself, or choose Properties from the Format menu. This 
brings up the Properties dialog box.

2. Click “Show Border.”

3. Click “OK.” Mathcad draws a border around the picture region.

Cont rolling color  pa le t tes

If you are using a 256-color display and have color bitmaps in your Mathcad 
worksheets, Mathcad by default uses a single 256-color palette to display all the bit
in your worksheets. This is the same default color palette Mathcad uses for displa
the rest of the Mathcad screen, and is suitable for most pictures. 

This default color palette, however, may not be the exact one that any color bitma
a worksheet were designed to use. To improve the appearance of bitmaps in yo
worksheet, you can tell Mathcad to optimize its default color palette so that it cho
the best possible 256 colors to display bitmaps in the worksheet. To do so:

1. Choose Color⇒Optimize Palette from the Format menu. Mathcad surveys the 
pictures in the worksheet and generates an optimal 256-color palette to use f
of them. 

2. Make sure that Color⇒Use Default Palette in the Format menu is checked. Then
Mathcad uses the new default palette it generates. 

Not e If your display driver supports more than 256 colors, the palette-setting options on the Format 
menu are grayed.
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I nser t in g  Ob j ects

This section describes techniques for inserting and editing objects created by other 
applications in your Mathcad worksheets. OLE (Object Linking and Embedding) 
technology in Microsoft Windows makes it possible not only to insert static pictur
of such objects into your applications (or of Mathcad objects into other applicatio
but to insert the objects in such a way that they can be fully edited in their origina
applications. 

An object can be either embedded in or linked to a Mathcad worksheet. An object tha
is linked must exist in an external saved file. An object that you embed may be cre
at the time of insertion. When you edit a linked object, any changes you make to
object also update the original file containing the object. When you edit an embe
object, any changes you make to the object affect it only in the context of the Mat
worksheet. The original object in the source application, if there is one, is unchan

Tip For information about using specialized objects called components to import and export data, as
well as establish dynamic connections between Mathcad and other applications, see Chap
“Vectors, Matrices, and Data Arrays,” and Chapter 16, “Advanced Computational Feature

I nser t in g  an  Ob j ect  in to a W orksheet
You insert an object into Mathcad, which is an OLE 2–compatible application, by using
the Object command from the Insert menu, by copying and pasting, or by dragging
and dropping. The method you choose depends on whether you want to create the
on the fly, whether the object has already been created, or whether you want the o
to be an entire file. You can edit objects in a Mathcad worksheet simply by doub
clicking them, causing in-place activation of the originating application in most cases

Tip In general, you use the same methods to insert a Mathcad object into another application and edit
it inside that application as you do to insert objects into a Mathcad worksheet. However, t
details depend on the extent to which the application receiving a Mathcad object supports
2. Once you’ve inserted a Mathcad object into a compatible application, you can edit it by
double-clicking it. If the application supports in-place activation, as current releases of 
Microsoft Office applications do, the menus and toolbars will change to Mathcad’s.

I nser t  Obj ect  com m and

When you use the Object command from the Insert menu, you can insert an object 
that you create at the time you are inserting it, or you can insert an entire file you
already created.

To insert an object or a saved file:

1. First click in your worksheet where you want to insert the object. Make sure y
see the crosshair.
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2. Choose Object from the 
Insert menu to bring up 
the Insert Object dialog 
box. By default “Create 
New” is selected:

3. Check “Display As Icon” 
if you want an icon, rather 
than the actual object, to 
appear in your worksheet. 
The icon is typically the 
icon of the application that 
created the object.

To create a new object:

1. Select an application from the “Object Type” list. The available object types dep
on the applications you have installed on your system.

2. Click “OK.” 

The source application opens so that you can create the object. When you are fin
working to create the object, exit the source application. The object you created is
embedded in your Mathcad worksheet.

If you want to insert a 
previously created file:

1. Click “Create from File” 
in the Insert Object dialog 
box. The dialog box then 
changes appearance.

2. Type the path to the 
object file or click 
“Browse” to locate it.

3. Check “Link” to insert a 
linked object. Otherwise, 
the object is embedded.

4. Click “OK.”

Past in g  an  ob j ect  in to a  w orksheet

You can copy an object from a source application to the Clipboard and paste it dir
into Mathcad. This method is particularly useful when you’ve already created the ob
in another application and you don’t want to insert an entire file. 

To insert an embedded or linked object into a worksheet via the Clipboard:

1. Open the source application containing the object.

2. Copy the object from the source application to the Clipboard. You typically do 
by choosing Copy from the Edit  menu or by pressing [Ctrl ]C.

3. Click in the Mathcad worksheet where you’d like to place the object. 
72  Chapter 6  Working with Graphics and Other Objects
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4. Choose Paste or Paste Special from Mathcad’s Edit  menu. 

If you choose Paste, the object is pasted in your Mathcad worksheet in a format th
depends on what the source application has placed on the Clipboard. The behav
differs depending on whether you have selected a math placeholder or are pastin
a blank space in the worksheet. Mathcad creates one of the following:

• A matrix, if you are pasting numeric data from the clipboard into an empty ma
placeholder. 

• A text region, if you are pasting text that does not contain numeric data exclusiv

• A bitmap or picture (metafile), if the originating application generates graphics.

• An embedded object, if the originating application supports OLE. 

If you choose Paste Special, you have the option of pasting the object in one of the
available formats placed on the Clipboard. Typically you can choose to paste the o
as an embedded or linked OLE object (if the object was stored in a saved file in an OLE-
compatible source application), a picture (metafile), or a bitmap. See “Creating a pi
by importing from the Clipboard” on page 69 for more information on pasting metaf
and bitmaps. 

Dra gg in g  and dro pp in g  an  ob j ect  in to a  w ork sheet

A third way to insert an OLE object into a Mathcad worksheet is to drag it from the
source application and drop it into the worksheet. This is very similar to copying 
pasting, but does not allow you to create a link to an object. To do so, open both Ma
and the source application and arrange the two windows side by side on the scr
Then select the object in the source application and drag it with the mouse into y
Mathcad worksheet. The object appears when you release the mouse button.

Edit in g  an Ob j ect
To edit an embedded object in a Mathcad worksheet, double-click the object. Math
menus and toolbars change to those of the source application, and a hatched bo
surrounds the object so that you can edit it. This OLE editing mechanism is called in-
place activation. For example, you can use in-place activation to edit objects crea
by Microsoft Office applications such as Excel and Word inside Mathcad.

If the source application does not support in-place activation inside Mathcad or t
object is linked, the behavior is different. In the case of an embedded object, a co
the object is placed into a window from the other application. If the object is linke
the source application opens the file containing the object. 

Edit in g  a  Link
If you’ve inserted a linked object into a Mathcad worksheet, you can update the 
eliminate it, or change the source file to which the object is linked. To do so, cho
Links  from the Edit  menu.
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Choose the link you 
want to edit from the list 
of links. Then make 
changes using the 
available options.

On- line Help See the on-line Help topic 
“Links dialog box” for 
information on each option 
in the dialog box.

I nser t in g  Gra p hics Com p utat ionall y  Linked to Your  W orksheet

If you want to insert a drawing or other kind of graphic that is computationally link
to your Mathcad worksheet, you can insert a component. A component is a specialized
OLE object. Unlike other kinds of OLE objects you can insert into a worksheet, a
described in “Inserting Objects” on page 71, a component can receive data from
Mathcad, return data to Mathcad, or both, linking the object dynamically to your 
Mathcad computations.

The SmartSketch component, for example, allows you to insert SmartSketch draw
whose dimensions are computationally linked to your Mathcad calculations. 

An example using the SmartSketch component is shown in Figure 6-1. In additio
the SmartSketch component, Mathcad includes several components for exchang
data with applications such as Excel, Axum, and MATLAB. For more information
these and other components, refer to Chapter 16, “Advanced Computational Feat

Figure 6-1: The SmartSketch component inserted into a Mathcad worksheet.
74  Chapter 6  Working with Graphics and Other Objects
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Chapter  7
W orksheet  Mana g em ent

τ Worksheets and Tem plates

τ Rearranging Your Worksheet

τ Layout

τ Safeguarding an Area of the Worksheet

τ Hyper links

τ Creat ing an Elect ronic Book

τ Print ing and Mailing

W orksheets and Tem p lates 

As you use Mathcad and save your work for later use, you typically create a worksheet 
that contains unique text, math, and graphic regions. Mathcad uses .MCD as the default 
file extension for worksheets.

When you create a new worksheet in Mathcad, you can start with Mathcad’s def
choices for formats and layout, or you can use a template that contains customized 
information for laying out and formatting the worksheet. When you create a works
based on a template, all of the formatting information and any text, math, and gra
regions from the template are copied to the new worksheet. The new worksheet
therefore inherits the appearance and formatting instructions of the template, allo
you to maintain consistency in the appearance of multiple worksheets.

Mathcad comes with a variety of predefined templates for you to use as you create
Mathcad worksheets. You extend the collection of templates by saving any of yo
Mathcad worksheets as a template. Mathcad uses .MCT as the default file extension for
templates.

Other saving options are available in Mathcad. You can save a worksheet in rich
format (RTF), so that it can be opened by most word processors, or in Hypertext M
up Language (HTML), so that the file can be viewed through a Web browser. You c
also save a worksheet in a format that can be read by earlier versions of Mathca

Crea t in g  a  N ew  W orksheet  

When you first open Mathcad or click  on the Standard toolbar, you see an em
worksheet based on the blank worksheet template (normal.mct). You can enter and 
format equations, graphs, text, and graphics in this space, as well as modifying 
worksheet attributes such as the page margins, numerical format, headers and fo
and text and math styles. The blank worksheet is only one of the templates Math
provides. Other built-in templates are specific to types of worksheets you might b
Worksheets and Templates 75
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creating. For example, there is a template for Electronic Books, one for engineer
reports, and one for specification sheets. 

To create a new worksheet based on a template:

1. Choose New from the File menu. Mathcad 
displays a list of available worksheet 
templates. The exact templates available 
differ depending on the templates you have 
developed.

2. Choose a template other than “Blank 
Worksheet.” By default Mathcad displays 
worksheet templates saved in the 
TEMPLATE folder of the directory you used 
to install Mathcad. Click “Browse” to find a 
template in another directory or on another drive.

3. Click “OK.”

Savin g  Your  W orksheet
When you want to save the worksheet, choose either Save or Save As from the File 
menu and enter a file name with the extension .MCD. After the first time you save the 

worksheet, simply choose Save from the File menu or click  on the Standard toolba
to update the saved copy of the worksheet.

Tip To work on a worksheet you saved before, choose Open from the File menu or click  on 
the Standard toolbar. Mathcad prompts you for a name by displaying the Open dialog box
can locate and open a Mathcad worksheet from other directories or drives just as you wo
any other Windows application. At the bottom of the File menu, Mathcad maintains a list of the
most recently used worksheets, which you can choose directly, if you wish.

Sav ing your  w orksheet  in RTF form at     

To save a worksheet so you can open it in a word processor capable of reading aRTF 
file with embedded graphics:

1. Scroll to the bottom of your worksheet to update all calculated results.

2. Choose Save As from the File menu.

3. In the Save As dialog box, choose “Rich Text Format File” from the “Save as ty
drop-down list. 

4. Enter a file name and then click “Save.”

When you open an RTF file with a word processor such as Microsoft Word, you’ll fin
all the Mathcad regions lined up one above the other at the left edge of the 
document.You may have to move regions in the word processors to make them 
like your original Mathcad worksheet. Once the Mathcad regions have been loade
a word processor, you will be able to edit the text. However, you’ll no longer be a
to edit math regions and graphs, which have become embedded graphics. To em
Mathcad worksheets or regions in a word processing document in a form that al
76  Chapter 7  Worksheet Management
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you to continue to edit the original Mathcad worksheets, see “Inserting Objects” 
page 71.

Tip Mathcad’s text supports Microsoft’s “Rich Text Format” (RTF) specification. This means y
can easily export text from Mathcad text regions to most word processing programs via th
Clipboard. Simply select text in a Mathcad text regions, copy the text to the Clipboard by 

choosing Copy from the Edit  menu or clicking  on the Standard toolbar, and choose Paste 
from the Edit  menu in your word processing application. 

Sav ing your  w orksheet  in H TM L form at     

To save a worksheet so that a Web browser can open it:

1. Scroll to the bottom of your worksheet to update all calculated results.

2. Choose Save As from the File menu.

3. In the Save As dialog box, choose “HTML File” from the “Save as type” drop-down
list. 

4. Enter a file name and then click “Save.”

Not e When you save a worksheet as HTML, regions other than text regions are saved as indiv
JPEG files. If your worksheet contains many regions other than text, save the worksheet in
folder so that all the files will be accessed in a single location.

Sav ing your  w orksheet  in an  ear lie r  form at

In general, worksheets created in an earlier version of Mathcad open in the curre
version, but files created in the current version of Mathcad do not open in earlier 
versions. Mathcad 2000, however, allows you to save a worksheet as a Mathcad
or 6 worksheet.

Not e Features in your worksheet available only in Mathcad 2000 will not be recognized in earli
versions of Mathcad. Regions or features that won’t work in an earlier version are rendere
bitmaps.

To save a worksheet in a form that can be read by an earlier version of Mathcad

1. Choose Save or Save As from the File menu.

2. In the “Save as type” drop-down list, select “Mathcad 8 Worksheet,” “Mathca
Worksheet,” or “Mathcad 6 Worksheet” and provide a file name.

3. Click “Save.” A message appears warning you that certain features available
in Mathcad 2000 will not work in earlier versions. 

Crea t in g  a  N ew  Tem p la te
You can extend the collection of templates by creating your own. A template you cr
can have equations, text, and graphics in places you determine, as well as custo
information in the headers and footers (see “Layout” on page 83). The template 
specifies:

• Definitions of all math styles (Chapter 4).

• Definitions of all text styles (Chapter 5).
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• Margins for printing (see “Layout” on page 83).

• Numerical result formats and values for Mathcad’s built-in variables (Chapter

• Names of Mathcad’s basic units and the default unit system (Chapter 8).

• The default calculation mode (Chapter 8).

• Ruler visibility and measurement system (see “Aligning Regions” on page 79

To create a new template, first create a new worksheet having the options listed a
set the way you want. The worksheet can also contain any equations, text, and gra
that you want in the template. The next step is to save this worksheet as a templa
do so:

1. Choose Save As from the File menu.

2. Double-click the TEMPLATE folder in the Save As dialog.

3. In the “Save as type” drop-down list, select “Mathcad Templates (*.mct).”

4. Type a name for the template in the “File name” box.

5. Click “Save.” 

Your template is now added to the list of templates available in the dialog box th
appears when you choose New from the File menu. To make a new worksheet base
on a template you’ve created, simply choose New from the File menu and select your 
template from the list. If you did not save your template to the TEMPLATE folder, you 
need to browse to find the template. 

Modif y in g  a  Tem p late
To modify an existing worksheet template:

1. Choose Open from the File menu or click  on the Standard toolbar.

2. In the “Files of type” drop-down list, select “All Files.”

3. Type the name of the template in the “File name” box, or browse to locate it in
dialog box. Worksheet templates are saved by default in the TEMPLATE folder.

4. Click “Open.” The template opens in the Mathcad window.

You may now edit the template as you would modify any Mathcad worksheet. To 
your changes under the current template name, choose Save from the File menu or click 

 on the Standard toolbar. If you want to give a new name to the modified temp
choose Save As from the File menu and enter a new name for the template.

Tip To modify the default template for a blank worksheet, modify the template file NORMAL.MC

Not e When you modify a template, your changes affect only new files created from the modifie
template. The changes do not affect any worksheets created with the template before the
template was modified.
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Rearran g in g  Your  W orksheet  

This section describes how to rearrange math, graphics, and text in your worksh
See the section “Regions” on page 10 for the basics on selecting, copying, moving
deleting regions.

Not e You can get an overall view of how your worksheet looks by choosing Zoom from the View 

menu or clicking  on the Standard toolbar and choosing a magnification. Choose a 
magnification less than 100% to zoom out of the worksheet, or use a magnification greate
100% to zoom in. Alternatively, use the Print Preview command as described under “Print 
Preview” on page 94.

Ali g nin g  Reg ions
Once you’ve inserted regions into your worksheet, you can align them vertically 
horizontally using menu commands or you can align them using the worksheet r

Using com m ands

To align regions horizontally or vertically using commands:

1. Select regions as described on page 10.

2. Choose Align Regions⇒Across (to align horizontally) or Align Regions⇒Down 
(to align vertically) from the Format menu. Or choose these commands by clic

 and  on the Standard toolbar.

When you choose Align Regions⇒Down from the pull-right menu or click  on 
the Standard toolbar, Mathcad does the following:

• Mathcad draws an invisible vertical line halfway between the right edge of the r
most selected region and the left edge of the left-most selected region.

• All selected regions to the right of this line are moved left until their left edges 
aligned with this line.

• All selected regions to the left of this line are moved right until their left edges 
aligned with this line.

Choosing Align Regions⇒Across or clicking  on the Standard toolbar works in
much the same way. Mathcad draws an invisible horizontal line halfway between
top edge of the uppermost region and the bottom edge of the lowest region. Sele
regions below and above this line are moved up and down respectively until the 
midpoints of their left edges are on this line.

Not e Aligning regions may inadvertently cause regions to overlap. Mathcad warns you when this
occur, but you can separate overlapping regions as described in “Separating Regions” be

Using the w orksheet  ru le r

When you choose Ruler from the View menu while the cursor is in a blank spot or in
a math region, you see the worksheet ruler at the top of the window. You can us
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alignment guidelines on the ruler to align regions at particular measurements alon
worksheet.

To set an alignment guideline on the ruler:

1. Click on the ruler wherever you want the alignment guideline to appear. A tab 
symbol appears on the ruler.

2. Click on the tab stop symbol with the right mouse button and choose Show 
Guideline from the pop-up menu. A check appears next to the command.

The alignment guideline appears as a green vertical line. Select and move regio
the guideline. Figure 7-1 shows how you can use an alignment guideline to align 
regions.

Not e The tab stops you insert on the ruler specify where the cursor should move when you pre
[TAB] key. To remove a tab stop, click on its symbol, hold the mouse button down, and dra
cursor away from the ruler.

To remove an alignment guideline, click on the ruler with the right mouse button wh
the guideline is located and choose Show Guideline from the menu to uncheck it.

Tip You can change the measurement system used in the ruler by clicking on the ruler with the
mouse button, and choosing Inches, Centimeters, Points, or Picas from the pop-up menu. To 
change the ruler measurement for all documents, make this change to normal.mct.

I nser t in g  or  Dele t in g  Blank  Lines 
You can easily insert one or more blank lines into your worksheet: 

1. Click on the blank line below which you want to insert one or more blank line
Make sure the cursor looks like a crosshair.

2. Press [Enter ] to insert a blank line and move the cursor to the left margin. Do t
as many times as you want to insert lines.

Figure 7-1: Using an alignment guideline to align regions vertically.
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To delete one or more blank lines from your worksheet:

1. Click above the blank lines you want to delete. Make sure the cursor looks lik
crosshair and that there are no regions to the right or left of the cursor.

2. Press [Delete ] as many times as there are lines you want to delete. Mathcad
deletes blank lines below your cursor. Alternatively, press [BkSp] as many times 
as there are lines you want to delete. Mathcad deletes blank lines above your cursor.

If you press either [Delete ] or [BkSp] and nothing seems to be happening, check 
make sure that the cursor is on a line all by itself. If any region in your worksheet ext
into the line you are trying to delete, Mathcad won’t be able to delete that line.

Tip To quickly insert or delete a specific number of lines from your worksheet, click in a blank par
of the worksheet with the right mouse button, choose Insert Lines or Delete Lines from the pop-
up menu, and enter the number of lines in the dialog box.

Sep arat in g  Reg ions 
As you move and edit the regions in a Mathcad worksheet, they may end up overla
one another. Overlapping regions don’t interfere with each other’s calculations, b
they may make your worksheet hard to read.

A good way to determine whether regions 
overlap is to choose Regions from the View 
menu. As shown at right, Mathcad displays 
blank space in gray and leaves the regions 
in your default background color. To turn 
the blank space back into the default 
background color, choose Regions from 
the View menu again.

To separate all overlapping regions, choose 
Separate Regions from the Format menu. 
Wherever regions overlap, this command 
moves the regions in such a way as to avoid 
overlaps while preserving the order of the 
calculations, as shown at right.

Not e Be careful with the Separate Regions menu command since not only can it have far-reachin
effects, it also cannot be undone. Regions are moved around and the order of calculation
change. As an alternative, you can drag regions individually, add lines by pressing [Enter ], or 
cut and paste the regions so they don’t overlap.

Hig h li g h t in g  Reg ions
Mathcad allows you to highlight regions so that they stand out from the rest of th
equations and text in your worksheet:
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To apply a background highlight color to a region:

1. Click in the region you want to highlight.

2. Choose Properties from the Format menu.

3. Click the Display tab.

4. Check “Highlight Region.” Click “Choose Color” to choose a highlight color oth
than the default choice.

5. Click “OK.”

Mathcad fills a box around the equation with either the default background highli
color or the color you chose. This is a purely cosmetic change with no effect on 
equation other than making it more conspicuous.

Not e The appearance of a highlighted region on printing depends very much on the capabilitie
your printer and the choice of highlight color. Some black and white printers render a colo
black, obscuring the equation in the process. Others render just the right gray to highlight
equation without obscuring it.

To change the default background color of highlighted regions, do the following:

1. Choose Color from the Format menu.

2. Pull right and choose Highlight to bring up a dialog box containing a palette of 
colors. Click the appropriate color.

3. Click “OK.”

Chan g in g  the  w orkshee t  back g round color
Mathcad allows you to change the color of the background of your worksheet. To d

1. Choose Color from the Format menu.

2. Pull right and choose Background to bring up a dialog box containing a palette o
colors. Click the appropriate color. 

3. Click “OK.”
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La y out

Before printing a worksheet, you may need to adjust the margins, paper options,
breaks, and headers and footers so that pages of the worksheet are printed approp

Set t in g  M ar g ins, Pa p er  Size , Source , and Or ienta t ion  
Mathcad worksheets have user-
specifiable margins at the left, right, top, 
and bottom of the worksheet. To set 
these margins, choose Page Setup from 
the File menu.

Use the four text boxes in the lower right 
of the Page Setup to specify the distances 
from the margin to the corresponding 
edge of the actual sheet of paper on 
which you are printing. 

You can also use settings in the Page 
Setup dialog box to change the size, 
source, or orientation of the paper on 
which you print your worksheet. See 
“Printing and Mailing” on page 93 for 
more about printing your Mathcad 
worksheets.

Tip If you want the margin and other page setup settings in the current worksheet to be used in
worksheets, save the worksheet as a template as described in “Creating a New Template
page 77.

Pag e Breaks
Mathcad provides two kinds of page breaks:

• Soft page breaks: Mathcad uses your default printer settings and your top and
bottom margins to insert these page breaks automatically. These show up as d
horizontal lines, and you see them as you scroll down in your worksheet. You ca
add or remove soft page breaks.

• Hard page breaks: You can insert a hard page break by placing the cursor at 
appropriate place in your worksheet and choosing Page Break from the Insert  
menu. Hard pagebreaks display as solid horizontal lines in your worksheets.

When Mathcad prints your worksheet, it begins printing on a new page wheneve
encounters either a soft or a hard page break. 

To delete a hard page break:

1. Drag-select the hard page break as you would select any other region in you
Mathcad worksheet. A dashed selection box appears around the page break

2. Choose Delete from the Edit  menu. 
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Tip Because Mathcad is a WYSIWYG environment, any region that overlaps a soft or hard pa
break prints by default in pieces on successive pages. To separate a region from a hard p
break, choose Separate Regions from the Format menu. However, this command does not 
separate regions from any overlapping soft page breaks. Choose Repaginate Now from the 
Format menu to force Mathcad to insert a soft page break above any region that otherwis
would print in pieces on successive pages.

Headers and Footers
To add a header or a footer to every printed page, to create a different header or 
for the first page of a worksheet, or to modify an existing header or footer, choos
Headers/Footers from the Format menu. The Header/Footer dialog box appears:

To add or edit a header or footer:

1. Click the Header or Footer tab to modify the header or footer for the workshee
create a different header or footer for the first page of your worksheet, check
“Different header and footer on first page” option and click the Header–Page 
Footer–Page 1 tab.

2. Type the header or footer information into one or more of the text boxes. What
you type into the Left, Center, and Right text boxes will appear in these posit
on the page. Click “Format” in the Tools group to change the header or footer f
font style, size, or alignment. Click “Use full width for each section” if you wan
text in any of the boxes to extend beyond the width of the text box.

3. Click one or more of the buttons in the Tools group to insert items such as the
name, page number, current date, or time automatically wherever the insertion
is. To insert an image, click “Image” in the Tools group and browse to locate 
bitmap (.BMP format) file.

Tip Mathcad by default begins numbering at page 1. You can set a different starting page num
the Options group in the Header/Footer dialog box.
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Safe g uardin g  an Area of the  W orksheet

The ease with which you can alter a Mathcad worksheet can present a problem. I
too easy to alter a worksheet and to change things which are not meant to be cha
For example, if you’ve developed and thoroughly tested a set of equations, you 
want to prevent readers of your worksheet from tampering with them. To avoid 
unintended edits to your worksheet, you can safeguard an area of your workshe
locking it such that you can still edit it even though nobody else can. 

Pro You can use Mathcad Professional to lock an area of your worksheet. To do so:

1. You create an area in your worksheet to contain the regions to be protected.

2. You place the regions that you want to safeguard into that area.

3. You lock the area. Optionally you can password protect and collapse the are

Once a region is safely inside a locked area, nobody can edit it. Any math regions i
a locked area continue, however, to affect other equations in the document. For 
example, if you define a function inside a locked area, you can still use that func
anywhere below and to the right of its definition. You cannot, however, change t
function’s definition itself unless you unlock the area first.

I nser t in g  an  Area
To insert a lockable area into your worksheet:

1. Choose Area from the Insert menu. 
Mathcad inserts a pair of lines into the 
worksheet. These mark the boundaries of 
the lockable area.

2. Select either of these boundary lines just as you’d select any region: by drag
the mouse across the line or by clicking the line itself.

3. Once you’ve selected the boundary line, drag it just as you’d drag any other re
to move it. 

You should position the boundaries so that there’s enough space between them
whatever regions you want to lock. You can have any number of lockable areas in
worksheet. The only restriction is that you cannot have one lockable area inside an

Tip To name an area in your worksheet, click on an area boundary, choose Properties from the 
Format menu, and enter a name on the Area tab. The Area tab also lets you modify other d
attributes of an area, such as whether a border or icon appears.

Lock in g  and Colla p sin g  an  Area     
Once you’ve placed whatever regions you want inside an area, you can lock the
You can choose to lock an area with a password to prevent unauthorized editing 
regions in it. You can also collapse the area, either with or without locking it, so t
the regions are hidden from view. 
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To lock an area:

1. Click in the area.

2. Choose Area⇒Lock from the Format 
menu.

3. In the Lock Area dialog box, enter a 
password if you want to lock the area with 
a password. Type any combination of 
letters, numbers, and other characters. 
You must re-enter the password to 
confirm it.

4. Check “Collapse when locked” to hide the locked regions from view. Check “Sh
lock timestamp” to display the date and time the area was last locked above 
below the boundary lines.

5. Click “OK.”

The area is now locked and by default shows padlocks 
on the boundaries and a timestamp.

Not e If you choose to password protect an area, make sure you remember your password. If you
it, you will find yourself permanently locked out of that area. Keep in mind also that the 
password is case sensitive.

To collapse an area without locking it first:

1. Click in the area.

2. Choose Area⇒Collapse from the Format menu.

A collapsed area appears by default as a single line in your worksheet.

Unlock in g  and Ex p and in g  an Area     
If you want to make changes to a region inside a locked area, you have to unlock
the area is collapsed, you must also expand it.

To unlock a locked area:

1. Click in the area you want to unlock. 

2. Choose Area⇒Unlock from the Format menu.

3. If a password is required, you are prompted for the password. 

To expand a collapsed area:

1. Click on the boundary line.

2. Choose Area⇒Expand from the Format menu.

Once an area is unlocked and expanded, you can make whatever changes you w
just as freely as you would elsewhere in your worksheet.

Tip When you lock an area without a password, anyone can unlock it by simply choosing 
Area⇒Unlock from the Format menu. 
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Dele t in g  an  Area
You can delete a lockable area just as you would any other region. To do so: 

1. Make sure the area is unlocked. You cannot delete a locked area.

2. Select either of the two lines indicating the extent of the locked area by dragg
the mouse across it.

3. Choose Cut from the Edit  menu or click  on the Standard toolbar.

Hyp er links

Mathcad allows you to create hyperlinks —that is, to create “hotspots” in your Mathcad
worksheets that, when double-clicked, open Mathcad worksheets or other files. 

Crea t in g  Hyp er links Betw een W orkshee ts
You can create a hyperlink from any Mathcad region, such as a text region or a gr
element, to any Mathcad worksheet. When you double-click the hyperlink, Mathc
opens the Mathcad worksheet designated by the hyperlink. In this way you can co
groups of related worksheets in a form similar to Mathcad’s Electronic Books, or sim
cross-reference a related Mathcad worksheet from within the current worksheet.

You have two options for the appearance of the linked worksheet when you dou
click the hyperlink:

• The hyperlinked worksheet can open in a full-sized Mathcad worksheet wind
that overlays the current worksheet window and allows you to edit its content

• The hyperlinked worksheet can open in a small pop-up window that displays the 
contents of the worksheet, but does not allow you to edit its contents. This typ
hyperlink is called a Popup.

Mathcad can follow a hyperlink to any worksheet, whether it is stored on a local d
a network file system, or the World Wide Web. 

To create a hyperlink, first specify the hyperlink by:

1. Selecting a piece of text, or 

2. Clicking anywhere in an equation or graphics region, or

3. Placing the insertion point anywhere within an entire text region.

Tip In general, either selected text or an embedded graphic works best as a hyperlink to anot
worksheet.
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The next step is to specify the target. To do so:

1. Choose Hyperlink  
from the Insert menu. 
Mathcad opens the 
Insert Hyperlink 
dialog box.

2. Click “Browse” to 
locate and select the 
target worksheet. 
Alternatively, enter 
the complete path to a 
worksheet in the empty text box at the top of the dialog box, or enter an Inter
address (URL) to create a hyperlink to a file on the World Wide Web. 

3. Click “Use relative path for hyperlink” to store the location of the target worksh
relative to the Mathcad worksheet containing the hyperlink. This allows the 
hyperlink to be valid even if you move the target file and the worksheet contain
the hyperlink, but keep the relative directory structure between the two the sa

Not e In order for “Use relative path for hyperlink” to be available, you must first save the worksh
in which you are inserting the hyperlink. 

4. Check “Display as pop-up document” if you want the target worksheet to ope
a small pop-up window.

5. If you want a message to appear on the status line at the bottom of the window
the mouse hovers over the hyperlink, type the message in the text box at the b
of the dialog box.

6. Click “OK.” 

When you double-click a hyperlink, Mathcad opens the target worksheet in the kin
window (either pop-up or full) you specified. Close a pop-up window by clicking o
the close box in the upper right corner. 

To change any aspects of a hyperlink—for example, if you move the target works
and still want the hyperlink to work—click the hyperlink and choose Hyperlink  from 
the Insert menu. Make any changes you wish in the Edit Hyperlink dialog box.

To remove a hyperlink, click the hyperlink and choose Hyperlink  from the Insert 
menu. Click “Remove Link” in the dialog box. Mathcad removes all traces of the l

Not e If you launch a hyperlink from selected text, Mathcad underlines the text and makes it bo
indicate the existence of a hyperlink. Mathcad changes the mouse pointer to a “hand” cur
when you hover over any hyperlink, and any message you specified appears on the status
the bottom of the window when the cursor is over the hyperlink.

Crea t in g  Hyp er links to Other  Fi les
The methods described in the previous section can create a hyperlink not only from
Mathcad worksheet to another, but also from a Mathcad worksheet to any other 
type, either on a local or network file system or on the World Wide Web. Use this
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feature to create Electronic Books, as described in “Creating an Electronic Book
compound documents that contain not only Mathcad worksheets but word proce
files, animation files—any file type that you want. 

Not e When you double-click a hyperlink to a file other than a Mathcad worksheet, you launch e
the application that created the file or an application associated with a file of that type in t
Windows Registry. You cannot display such hyperlinked files within a pop-up window.

Creat in g  an Electronic Book

As described in Chapter 3, “On-Line Resources,” an Electronic Book is a hyperlin
collection of Mathcad worksheets. When you open an Electronic Book in Mathca
opens in its own window. The Electronic Book has a table of contents and an ind
well as other browsing features which you can access using the buttons on the to
in the window. The worksheets in an Electronic Book are live so a reader can exper
directly within the book.

If you have several Mathcad worksheets which you want to collect together and 
have Mathcad Professional, you can create your own Electronic Book. The steps
creating an Electronic Book are easy; they include:

1. Creating individual Mathcad files

2. Preparing a Table of Contents

3. Adding hyperlinks between appropriate files

4. Creating an .HBK file to specify the order of the files in the book

5. Developing an index

Each step is explained in more detail below. The process of creating a sample Elec
Book called “Explorations in Algebra” is described. After you’ve created an Electro
Book, you or others can open it in Mathcad and navigate through it using the too
buttons on the Electronic Book window. 

Step 1 : Creat ing Mat hcad f iles

Create as many Mathcad worksheets as you would like to include in your book. P
the worksheets into a special folder designated for your Electronic Book.

Tip If you want to include data from a data file in a worksheet, you should insert an input table
import the data into it. This will ensure your book is readable even if it is on a CD or on a W
site. Refer to “Importing Once from a Data File” on page 196 for information on importing d
to an input table.

For example, for the Electronic Book titled “Explorations in Algebra,” you have crea
three Mathcad worksheets called FRACTIONS.MCD, PRIMES.MCD, and 
SQUARE.MCD. Store these files in a folder called ALGEBRA.

To create a consistent look to your worksheets, you can create and use template
text styles. Refer to “Worksheets and Templates” on page 75 and “Text Styles” on 
61 for more information.
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Ste p s 2  and 3 : Pre p ar in g  a  Table of  Contents and addin g  h yp er links

Prepare a file called CONTENTS.MCD containing a list of the topics that describe the
worksheets in your Electronic Book. Then insert hyperlinks from the list of topics
the worksheets. Follow the steps on page 87 for inserting hyperlinks.

For example, the “Explorations in Algebra” book, CONTENTS.MCD could conta
the following text:

You would create hyperlinks from “Continue Fractions,” “Searching for Prime 
Numbers,” and from “Journey Around the Square” to the files FRACTIONS.MCD, 
PRIMES.MCD, and SQUARE.MCD, respectively.

The table of contents allows readers to browse to the sections as they prefer.

Ste p  4 : Creat in g  an  H BK f ile

An HBK file for a Mathcad Electronic Book serves the same function as a traditio
book binding: it specifies the order for the individual files in the book as the read
browses through it. To create an HBK file:

1. Use any text editor or word processing application.

2. Enter the following four required keywords at the beginning of the HBK file:
.version 2000
.title
SPLASH 
TOC

Note that SPLASH and TOC must be capitalized. In the second column of these lin
follow .title with the title of the book; follow SPLASH and TOC with the names of 
.MCD files. See Figure 7-2. Use tabs to separate the columns.

3. Enter a line for each file in the book with three columns. Use tabs to separate
columns. In the first column, type the logical name of the file (the filename with
the extension). In the second column, type the filename. In the third column, 
a colon (: ), a space, and the title of the file that should appear in the title bar of
book window. See Figure 7-2. 

4. Save the file as a text-only file with an HBK extension and a name that is the sam
as the name of your folder containing the Mathcad worksheets that are includ
the book. For example, if the folder called ALGEBRA contains all the worksheets 
for the Electronic Book “Explorations in Algebra,” save the HBK file as 
ALGEBRA.HBK.
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5. Look for a subfolder called HANDBOOK located under the Mathcad Professio
folder. If you do not have a subfolder called HANDBOOK, create one. 

6. Place the HBK file and the folder containing your worksheets in the HANDBOOK 
folder. For example, place ALBEGRA.HBK and the ALGEBRA folder in the 
HANDBOOK folder.

Tip You can create an HBK file using any text editor or word processing application. Just be su
save the HBK file as text-only. 

Tips for creating an HBK file:

• Limit the worksheet filenames to eight characters to avoid problems some netw
may have reading long filenames.

• If the titles of your files are very long, abbreviate the title so it is not cut off wh
it appears at the top of the window. Think of this as the running head or heade
appears at the top of book page.

• You may not include any blank lines in the HBK file.

• Files to which hyperlinks popup rather than jump and files linked to from subd
rectories do not have to be listed in the HBK file.

• Any lines beginning with a semicolon is ignored.

• If you include a space and the keyword “skip” following the name of a file in t
second column of the HBK file, a reader of the book will not be able to brows
that file. This is helpful if you want people to link to a file but not browse to it.

Step 5  ( opt iona l) : Developing a  searchable  index

You can create a searchable phrase index for your Electronic Book much as the a
of a printed book creates an index. To see an example of a searchable index, ch

Resource Center from the Help menu and click on the  button.

Figure 7-2: Sample HBK file.
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Not e To create an index, use a DOS utility called NEWDICT.EXE located in your Mathcad direct
You should only create a searchable index if you are comfortable working in DOS.

To create a searchable index:

1. Create a text file with any name you wish and the extension .TXT.

2. Type entries into the text file. For example, for the “Explorations in Algebra” bo
type entries such as those shown in Figure 7-3. Each line consists of an index 
a region number enclosed in |  | characters, and a filename.

 

To find the region number in a Mathcad file, open the file in Mathcad, click inside 
region, and press [Ctrl ] [Shift ] L. You will see a message on the status bar at t
bottom of the Mathcad window that says, for example, “Region Label is 3, Regio
Count is 2.” The region number, 2 in this example, is the Region Count number. 

Tip If you are using unusual terms for a concept, you may want to include standard terms that r
might be looking for. The more entries you add to the index, the more helpful it will be for y
users. It is also a good idea to list terms in multiple ways. For example, the topic “Prime 
Numbers” might be indexed under “numbers, prime” and “prime numbers.”

3. Before processing the index file, you need to sort it alphabetically. You can do
manually or use the sort routine from a number a variety of other applications 
as Microsoft Word.

4. Place the following files in the HANDBOOK folder:

• NEWDICT.EXE (index utility located in the main Mathcad folder)

• the TXT file

• the HBK file

5. In MSDOS or Command Prompt mode, change to the \HANDBOOK folder a
type:
 newdict index.txt book.hbk .

If there is an error in the index file, NEWDICT.EXE stops its execution and issue
line number on which the error occurs. If an error occurs, check and fix errors in
TXT or HBK file and run NEWDICT.EXE until it executes completely without issuin
an error.

Figure 7-3: Sample index file.
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Not e Errors will occur if there are any blank lines in either the index or the HBK file. Many errors a
occur because of discrepancies between filenames in the index file and the HBK file or be
filenames are missing. 

6. This process will create two files, OUT.DCT and OUT.RFS. Rename them to
correspond to the name of the HBK file and folder for your Electronic Book. F
example, if you have a folder called ALGEBRA and an HBK file called 
ALGEBRA.HBK, rename the files to ALGEBRA.DCT and ALGEBRA.RFS.

7. Place the DCT and RFS files inside your Electronic Book folder. For example,
them in the ALGEBRA folder.

Not e If you make any changes to the files in the Electronic Book that affect the position or numb
regions or if you make any changes to the HBK file, you must re-create the index.

Additional information about creating Electronic Books is available in the Resour
Center and on the MathSoft FTP site at ftp://ftp.mathsoft.com/pub/
author .

Opening your Elect ronic Book

To open your Electronic Book:

1. Start Mathcad and choose Open Book from the Help menu.

2. Browse to the location of your .HBK file and click on it. 

3. Click “Open.”

Your book opens in the Electronic Book window. Use the buttons on the toolbar a

top of the window to navigate. For example, click  to go to the Table of Conte

or click  to open the searchable index. For more information on Electronic Bo
and the navigation tools, refer to Chapter 3, “On-Line Resources.”

Pr int in g  and Mailin g  

To print a Mathcad worksheet, 
choose Print  from the File 
menu. The Print dialog box lets 
you control whether to print the 
entire worksheet, selected 
pages, or selected regions; what 
printer to print on; and the 
number of copies to print. The 
particular dialog box you see 
depends on the printer you’ve 
selected. A typical dialog box is 
shown at right.
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Pr in t in g  W ide  W orksheets
Mathcad worksheets can be wider than a sheet of paper, since you can scroll as
the right as you like in a Mathcad worksheet and place equations, text, and grap
wherever you like. As you scroll horizontally, however, you see dashed vertical l
appearing to indicate the right margins of successive “pages” corresponding to t
settings for your printer. The sections of the worksheet separated by the dashed v
lines print on separate sheets of paper, yet the page number at the bottom of the M
window does not change as you scroll to the right.

You can think of the 
worksheet as being 
divided into vertical 
strips. Mathcad 
begins printing at the 
top of each strip and 
continues until it 
reaches the last region 
in this strip. It prints 
successive strips left 
to right. Note that 
certain layouts will 
produce one or more 
blank pages. 

Tip You can control whether a wide worksheet is printed in its entirety or in a single page width
do so, choose Page Setup from the File menu to open the Page Setup dialog box. Then, to 
suppress printing of anything to the right of the right margin, check “Print single page wid

You can ask Mathcad to print a range of pages in the worksheet by using the Print d
box. The page numbers in the dialog box refer only to horizontal divisions. For exam
if your worksheet looks like that shown above, and you ask Mathcad to print pag
you will see two sheets of paper corresponding to the lower-left and lower-right 
quadrants.

Tip Mathcad allows you to change the display of some operators including the := , the bold equals, 
the derivative operator, and the multiplication operator. Before you print, you can choose 
Options from the Math  menu and click on the Display tab to change the appearance of the
operators. This can make your printout clearer to someone unfamiliar with Mathcad notat

Pr in t  Preview
To check your worksheet’s layout before printing, choose Print Preview from the File 

menu or click  on the Standard toolbar. The Mathcad window shows the curr
section of your worksheet in miniature, as it will appear when printed, with a strip
buttons across the top of the window: 
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To print your worksheet from this screen, click “Print.” Click “Close” to go back to t
main worksheet screen. The remaining buttons give you more control over the pre

Tip Although you can use the “Zoom In” and “Zoom Out” buttons to magnify the worksheet, y
can also magnify the worksheet by moving the cursor onto the previewed page so that the 
changes to a magnifying glass. Then click the mouse. Click again to magnify your worksh
even more. Once you’re at the maximum magnification, clicking on the page de-magnifie

Not e You cannot edit the current page or change its format in the Print Preview screen. To edi
page or change its format, return to the normal worksheet view by clicking “Close.” 

Mail in g
If you’re connected to a mail system that’s compatible with Microsoft’s Mail API 
(MAPI), you can use Mathcad to direct that system to send an electronic mail mes
and your current Mathcad worksheet. When you use Mathcad to send a workshe
electronic mail, the recipient receives the worksheet as a file attached to an ordin
mail message, provided that the recipient’s mail system uses the same encoding
technique as yours.

Tip The settings in your mail system determine how Mathcad worksheets are attached to or en
in the mail message. We recommend that you use an encoding method such as MIME or
UUENCODE, if available, to attach Mathcad worksheets to mail messages.

To send a Mathcad worksheet by electronic mail:

1. Open the worksheet you want to send.

2. Choose Send from the File menu.

Once you do so, your mail system launches and creates a new message with yo
worksheet as an attachment. You should then enter the text of your mail messag
address of the recipient, and any other information allowed by your mail system.
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Chapter  8
Calcula t in g  in Mathcad

τ Defining and Evaluat ing Variables

τ Defining and Evaluat ing Funct ions

τ Units and Dim ensions

τ Working with Result s

τ Cont rolling Calculat ion

τ Anim at ion

τ Error  Messages

Def inin g  and Eva lua t in g  Var iables 

When you type an expression into a worksheet, you are usually doing one of two th

• You could be typing a variable or function name and assigning some value to

• You could be typing an equation and asking Mathcad to give you the answer

We introduce these topics in this and the following section. See “Evaluating Exp
sions Numerically” on page 99 for details on numerical evaluation.

Def inin g  a  Var iable 
A variable definition defines the value of a variable everywhere below and to the r
of the definition. To define a variable, follow these three steps:

1. Type the variable name to be defined. Chapter 4, “Working with 
Math,” contains a description of valid variable names.

2. Press the colon (: ) key, or click  on the Calculator toolbar. 
The definition symbol (:=) appears with a blank placeholder to 
the right. 

3. Type an expression to complete the definition. This expression 
can include numbers and any previously defined variables and 
functions.

The left-hand side of a “:=” can contain any of the following:

• A simple variable name like x.

• A subscripted variable name like .vi
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• A matrix whose elements are either of the above. For example, . This techn

allows you to define several variables at once: each element on the right-hand
is assigned simultaneously to the corresponding element on the left-hand sid

• A function name with an argument list of simple variable names. For example
. This is described further in the next section.

• A superscripted variable name like .

Built - in  Var iables   
Mathcad includes predefined or built-in variables. Predefined variables can have a 
conventional value, like π and e, or be used as system variables to control how Mathc
works. See “Predefined Variables” on page 311 in the Appendices for a list of bu
variables in Mathcad.

Not e In addition to the built-in variables described here, Mathcad treats the names of all built-in units 
as predefined variables. See “Units and Dimensions” on page 106.

Although Mathcad’s predefined variables already have values when you start Math
you can still redefine them. For example, if you want to use a variable called e with a 
value other than the one Mathcad provides, enter a new definition, like . The 

variable e takes on the new value everywhere in the worksheet below and to the 
of the new definition. Alternatively, create a global definition for the variable as 
described in “Global Definitions” on page 100.

Not e Mathcad’s predefined variables are defined for all fonts, sizes, and styles. This means that
redefine e as described above, you can still use e, for example, as the base for natural logarithm
Note, however, that Greek letters are not included. 

You can modify many of Mathcad’s 
built-in variables without having to ex-
plicitly define them in your worksheet. 
To do so, choose Options from the 
Math  menu, and click the Built-In 
Variables tab on the Math Options dia-
log box.

To set new starting values for any of 
these variables, enter a new value in the 
appropriate text box and click “OK.” 
Then choose Calculate Worksheet 
from the Math  menu to ensure that all 
existing equations take the new values 
into account. 

The numbers in brackets to the right of the variable names represent the default v
for those variables. To restore these default values for the built-in variables listed
the dialog box, click “Restore Defaults” and then click “OK.”

x

y1

f x y z, ,( )

M
1〈 〉

e 2:=
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Eva lua t in g  Ex p ressions Num er ica ll y  
To evaluate an expression numerically, follow these steps:

1. Type an expression containing any valid combination of 
numbers, variables, and functions. Any variables or func-
tions in this expression should be defined earlier in the 
worksheet.

2. Press the “=” key, or click  on the Calculator toolbar. 
Mathcad computes the value of the expression and shows 
it after the equal sign. 

Figure 8-1 shows some results calculated from preceding variable definitions.

Tip Whenever you evaluate an expression, Mathcad shows a final placeholder at the end of t
equation. You can use this placeholder for unit conversions, as explained in “Working wit
Results” on page 110. As soon as you click outside the region, Mathcad hides the placeh

How  M athcad Scans a  W orksheet  
Mathcad scans a worksheet the same way you read it: left to right and top to bot
This means that a variable or function definition involving a “:= ” affects everything 
below and to the right of it.

To see the placement of regions more clearly in your worksheet, choose Regions from 
the View menu. Mathcad displays blank space in gray and leaves regions in you
background color. 

Figure 8-2 shows examples of how placement of equations in a worksheet affec
evaluation of results. In the first evaluation, both x and y are highlighted (Mathcad 
shows them in red on screen) to indicate that they are undefined. This is becaus
definitions for x and y lie below where they are used. Because Mathcad scans from
to bottom, when it gets to the first equation, it doesn’t know the values of x and y.

Figure 8-1: Calculations based on simple variable definitions.
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The second evaluation, on the other hand, is below the definitions of x and y. By the 
time Mathcad gets to this equation, it has already assigned values to both x and y. 

Not e You can define a variable more than once in the same worksheet. Mathcad simply uses th
definition for all expressions below the first definition and above the second. For expressi
below the second definition and above the third, Mathcad uses the second definition, and

Globa l De f init ions 
Global definitions are exactly like local definitions except that they are evaluated bef
any local definitions. If you define a variable or function with a global definition, th
variable or function is available to all local definitions in your worksheet, regardle
of whether the local definition appears above or below the global definition.

To type a global definition, follow these steps:

1. Type a variable name or function to be defined.

2. Press the tilde (~) key, or click  on the Evaluation toolbar. 
The global definition symbol appears.

3. Type an expression. The expression can involve numbers or other 
globally defined variables and functions.

You can use global definitions for functions, subscripted variables, and anything
that normally uses the definition symbol “:=”. 

This is the algorithm that Mathcad uses to evaluate all definitions, global and otherw

• First, Mathcad takes one pass through the entire worksheet from top to botto
During this first pass, Mathcad evaluates global definitions only.

• Mathcad then makes a second pass through the worksheet from top to bottom
time, Mathcad evaluates all definitions made with “:=” as well as all equations 
containing “=” and “≡”. Note that during this pass, global definitions do not use
any local definitions.

Figure 8-2: Mathcad evaluates equations from top to bottom in a worksheet. 
Undefined variables are highlighted.
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Not e A global definition of a variable can be overriden by a local definition of the same variable n
with the definition symbol “:=”.

Figure 8-3 shows the results of a global definition for the variable R which appears at 
the bottom of the figure. 

Although global definitions are evaluated before any local definitions, Mathcad e
uates global definitions the same way it evaluates local definitions: top to bottom
left to right. This means that whenever you use a variable to the right of a “≡”:

• that variable must also have been defined with a “≡,” and

• the variable must have been defined above the place where you are trying to use i

Otherwise, the variable is marked in red to indicate that it is undefined.

Tip It is good practice to allow only one definition for each global variable. Although you can d
things like define a variable with two different global definitions or with one global and one lo
definition, this may make your worksheet difficult for others to understand.

Ran g e Var iables 
Iterative processes in Mathcad worksheets depend on range variables. Except for the 
way it is defined, a range variable looks just like a conventional variable. The differe
is that a conventional variable takes on only one value. A range variable, on the 
hand, takes on a range of values separated by uniform steps. For example, you
define a range variable to go from –4 through 4 in steps of 2. If you now use this r
variable in an expression, Mathcad evaluates that expression five times, once for
value taken by the range variable.

Range variables are crucial to exploiting Mathcad’s capabilities to their fullest. T
section shows how to define and use range variables to perform iteration. For a 

Figure 8-3: Using the global definition symbol.
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description of more advanced iterative operations made possible by the program
operators in Mathcad Professional, turn to Chapter 15, “Programming.”

Defin in g  and usin g  ran g e var iab les 

To define a range variable, type the variable name followed by a colon and a ran
values. For example, here’s how to define the variable j ranging from 0 to 15 in steps
of 1:

1. Type j  and then press the colon key (: ), or click  on the 
Calculator toolbar. The empty placeholder indicates that Mathcad 
expects a definition for j. At this point, Mathcad does not know whether j is to be 
a conventional variable or a range variable. 

2. Type 0. Then press the semicolon key (; ), or click  on the 
Calculator toolbar. This tells Mathcad that you are defining a range 
variable. Mathcad displays the semicolon as two periods “..” to indicate a ran
Complete the range variable definition by typing 15  in the remaining placeholder.

This definition indicates that j now takes on the values . To define a rang
variable that changes in steps other than 1, see the section “Types of ranges” on
103. 

Once you define a range variable, it takes on its complete range of values every time 
you use it. If you use a range variable in an equation, for example, Mathcad evalu
that equation once for each value of the range variable.

You must define a range variable exactly as shown above. There must be:

• a variable name on the left,

• either a “:=” or a “≡” in the middle, and

• a valid range on the right.

Not e You cannot define a variable in terms of a range variable. For example, if after having definj 

as shown you now define , Mathcad assumes you are trying to set a scalar varia

equal to a range variable and marks the equation with an appropriate error message.

One application of range variables is to fill up the elements of a vector or matrix. 
can define vector elements by using a range variable as a subscript. For examp
define  for each value of j:

• Type x[j:j^2 [Space ]+1.

Figure 8-4 shows the vector of values computed by this equation. Since j is a range 
variable, the entire equation is evaluated once for each value of j. This defines  for 

each value of j from 0 to 15. 

0 1 2…15, ,

i j 1+:=

xj

xj
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To understand how Mathcad computes with range variables, keep in mind this fu
mental principle: 

If you use a range variable in an expression, Mathcad evaluates the expression 
for each value of the range variable.    

If you use two or more range variables in an equation, Mathcad evaluates the equ
once for each value of each range variable. 

Tip Mathcad takes longer to compute equations with ranged expressions since there may be
computations for each equation. While Mathcad is computing, the mouse pointer change
appearance. To learn how to interrupt a calculation in progress, see “Interrupting Calculat
on page 118.

Types of  ranges 

The definition of j in the previous section, ranging from 0 to 15, is an example of t
simplest type of range definition. But Mathcad permits range variables with value
ranging from any value to any other value, using any constant increment or decre

To define a range variable with a step size other than 1, type an equation of this

k:1,1.1;2

This appears in your worksheet window as:

In this range definition: 

• The variable k is the name of the range variable itself. 

• The number 1 is the first value taken by the range variable k.

Figure 8-4: Using a range variable to define the values of a vector.

k 1 1.1 2..,:=
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• The number 1.1 is the second value in the range. Note that this is not the step size. 
The step size in this example is 0.1, the difference between 1.1 and 1. If you 
the comma and the 1.1, Mathcad assumes a step size of one in whatever dir
(up or down) is appropriate.

• The number 2 is the last value in the range. In this example, the range value

constantly increasing. If instead you had defined , then k would count 

down from 10 to 1. If the third number in the range definition is not an even num
of increments from the starting value, the range will not go beyond it. For exam

if you define  then k takes values 10, 20, 30, . . ., 60.

Not e You can use arbitrary scalar expressions in range definitions. However, these values mus
always be real numbers. Also note that if you use a fractional increment for a range variable,
will not be able to use that range variable as a subscript because subscripts must be inte

Def inin g  and Eva lua t in g  Funct ions 

As described in Chapter 10, “Built-in Functions,” Mathcad has an extensive built
function set. You can augment Mathcad’s built-in function set by defining your ow
functions.

You define a function in much the same way you define a variable. The name go
the left, a definition symbol goes in the middle, and an expression goes on the ri
The main difference is that the name includes an argument list. The example below 
shows how to define a function called dist(x, y) that returns the distance between the
point (x, y) and the origin.

To type such a function definition:

1. Type the function name. 

2. Type a left parenthesis followed by one or more names separated by 
commas. Complete this argument list by typing a right parenthesis. 

Not e It makes no difference whether or not the names in the argument list have been defined o
elsewhere in the worksheet. What is important is that these arguments must be names. They 
cannot be more complicated expressions. 

• Press the colon (: ) key, or click  on the Calculator 
toolbar. You see the definition symbol (:=).

• Type an expression to define the function. In this 
example, the expression involves only the names in 
the argument list. In general though, the expression 
can contain any previously defined functions and variables as well.

Once you have defined a function, you can use it anywhere below and to the rig
the definition, just as you would use a variable.

k 10 1..:=

k 10 20 65..,:=
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When you evaluate an expression containing a function, as shown in Figure 8-5
Mathcad:

1. evaluates the arguments you place between the parentheses,

2. replaces the dummy arguments in the function definition with the actual argum
you place between the parentheses, 

3. performs whatever arithmetic is specified by the function definition,

4. returns the result as the value of the function.

Not e As shown in Figure 8-5, if you type only the name of a function without its arguments, Mathc
returns the word “function.”

The arguments of a user-defined function can represent scalars, vectors, or mat

For example, you could define the distance function as . This

an example of a function that accepts a vector as an argument and returns a scalar
See Chapter 11, “Vectors, Matrices, and Data Arrays,” for more information. 

Not e User-defined function names are font and case sensitive. The function f(x) is different from the 
function f(x) and SIN(x) is different from sin(x). Mathcad’s built-in functions, however, are 
defined for all fonts (except the Symbol font), sizes, and styles. This means that sin(x), sin(x), 
and sin (x) all refer to the same function. 

Var iables in  User - Def ined  Funct ions 
When you define a function, you don’t have to define any of the names in the argu
list since you are telling Mathcad what to do with the arguments, not what they are. 
When you define a function, Mathcad doesn’t even have to know the types of th
arguments—whether the arguments are scalars, vectors, matrices, and so on. It 
when Mathcad evaluates a function that it needs to know the argument types.

However, if in defining a function you use a variable name that is not in the argument 
list, you must define that variable name above the function definition. The value of
variable at the time you make the function definition then becomes a permanent 
of the function. This is illustrated in Figure 8-6.

Figure 8-5: A user-defined function to compute the distance to the origin.

dist v( ) v0
2 v1

2+:=
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If you want a function to depend on the value of a variable, you must include tha
variable as an argument. If not, Mathcad just uses that variable’s fixed value at the
in the worksheet where the function is defined.

Recursive Funct ion  De fin it ions
Mathcad supports recursive function definitions—you may define the value of a 
function in terms of a previous value of the function. As shown in Figure 8-7, recur
functions are useful for defining arbitrary periodic functions, as well as elegantly 
implementing numerical functions like the factorial function

Note that a recursive function definition should always have at least two parts:

• An initial condition that prevents the recursion from going forever.

• A definition of the function in terms of some previous value(s) of the function.

Not e If you do not specify an initial condition that stops the recursion, Mathcad generates a “st
overflow” error message when you try to evaluate the function.

Pro The programming operators in Mathcad Professional also support recursion. Se
section “Programs Within Programs” in Chapter 15 for examples.

Units and Dim ensions

When you first start Mathcad, a complete set of units is available for your calculati
You can treat these units just like built-in variables. To assign units to a number 
expression, just multiply it by the name of the unit. 

Mathcad recognizes most units by their common abbreviations. Lists of all of Ma
cad’s built-in units in several systems of units are in the Appendices. By default 
Mathcad uses units from the SI unit system (also known as the International System

Figure 8-6: The value of a user function depends on its arguments.
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Units) in the results of any calculations, but you may use any supported units you w
in creating your expressions. See “Displaying Units of Results” on page 113 for m
information about selecting a unit system for results.

For example, type expressions like the following:

mass:75*kg

acc:100*m/s^2

acc_g:9.8*m/s^2

F:mass*(acc + acc_g)

Figure 8-8 shows how these equations appear in a worksheet.

Figure 8-7: Mathcad allows recursive function definitions.

Figure 8-8: Equations using units.
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Tip If you define a variable which consists of a number followed immediately by a unit name, 
can omit the multiplication symbol; Mathcad inserts a very small space and treats the 
multiplication as implied. See the definition of mass at the bottom of Figure 8-8. 

You can also use the Insert Unit dialog box to insert one of Mathcad’s built-in un
into any placeholder. To use the Insert Unit dialog box:

1. Click in the empty placeholder and choose Unit  from the Insert menu, or click  
on the Standard toolbar. Mathcad opens the Insert Unit dialog box.

2. The list at the bottom shows built-in 
units, along with their Mathcad names, 
corresponding to whatever physical 
quantity is selected in the top scrolling 
list. When “Dimensionless” is selected 
at the top, a list of all available built-in 
units shows on the bottom.

3. If necessary, use the top scrolling list 
to display only those units correspond-
ing to a particular physical quantity. 
This makes it easier to find a particular 
unit or to see what choices are appro-
priate.

4. In the bottom list, double-click the unit you want to insert, or click the unit you
want and then click “Insert.” Mathcad inserts that unit into the empty placehol

Not e Mathcad performs some dimensional analysis by trying to match the dimensions of your se
result with one of the common physical quantities in the top scrolling list. If it finds a matc
you’ll see all the built-in units corresponding to the highlighted physical quantity in the bot
scrolling list. If nothing matches, Mathcad simply lists all available built-in units on the bott

Dim ensiona l Check in g
Whenever you enter an expression involving units, Mathcad checks it for dimensi
consistency. If you add or subtract values with incompatible units, or violate othe
principles of dimensional analysis, Mathcad displays an appropriate error messa

For example, suppose you had defined acc 

as  instead of  as 
shown at right. Since acc is in units of 
velocity and acc_g is in units of accelera-
tion, it is inappropriate to add them togeth-
er. When you attempt to do so, Mathcad 
displays an error message. 

Other unit errors are usually caused by one 
of the following:   

• An incorrect unit conversion.

100 m s⁄⋅ 100 m s2⁄⋅
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• A variable with the wrong units.

• Units in exponents or subscripts (for example  or ). 

• Units as arguments to inappropriate functions (for example, ).

Tip If you want to temporarily remove units from an argument, x, divide x by UnitsOf(x). For 

example, if p is defined as 2 ft then  gives an error but .

Def inin g  Your Ow n Un it s
Although Mathcad recognizes many common units, you may need to define your
unit if that unit isn’t one of Mathcad’s built-in units or if you prefer to use your ow
abbreviation instead of Mathcad’s abbreviation.

Not e Although absolute temperature units are built into Mathcad, the Fahrenheit and Celsius 
temperature units are not. See the QuickSheet “Temperature Conversions” in the on-line
Resource Center for examples of how to define these temperature scales and to convert b
them.

You define your own units in terms of existing units in exactly the same way you wo
define a variable in terms of an existing variable. Figure 8-9 shows how to define
units as well as how to redefine existing units.

Not e Since units behave just like variables, you may run into unexpected conflicts. For exampl
you define the variable m in your worksheet, you won’t be able to use the built-in unit m for 
meters anywhere below that definition. However, Mathcad automatically displays the unit m in 
any results involving meters, as described in “Displaying Units of Results” on page 113.

Figure 8-9: Defining your own units.

v3 acre⋅ 23 f t⋅

0 henry⋅( )sin

p( )sin p
UnitsOf p( )
----------------------------- 

 sin 0.573=
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W ork in g  w ith  Results 

Form at t in g  Resu lt s
The way that Mathcad displays numbers (the number of decimal places, whether 
i or j for imaginary numbers, and so on) is called the result format. You can set the 
result format for a single calculated result or for an entire worksheet.

Set t ing the form at  of a  single  resu lt

When you evaluate expressions numerically in Mathcad, results are formatted in
worksheet according to the worksheet default result format. You can modify the fo
for a single result as follows:

1. Click anywhere in the equation whose result you 
want to format. 

2. Choose Result from the Format 
menu. Alternatively, double-click 
the equation itself. The Result For-
mat dialog box appears. 

3. Change the desired settings. See be-
low to learn about the various set-
tings in the dialog box. To display a 
result with six decimal places, you 
would increase “Number of decimal 
places” from 3 to 6. 

4. Click “OK.” Mathcad redisplays 
the result using the new format.

To redisplay a result using the worksheet default result 
format settings, click on the result to enclose the result between the editing lines, d
the equal sign, and press = to replace the equal sign. The result is now restored to 
default worksheet settings.

Not e When the format of a result is changed, only the appearance of the result changes in the 
worksheet. Mathcad continues to maintain full precision internally for that result. To see a
number as it is stored internally, click on the result, press [Ctrl ][Shift ]N, and look at the 
message line at the bottom of the Mathcad window. If you copy a result, however, Mathca
copies the number only to the precision displayed.

Set t ing w orksheet  defau lt  form at  

To change the default display of numerical results in your worksheet:

1. Click in a blank part of your worksheet.

2. Choose Result from the Format menu. 

3. Change the desired settings in the Result Format dialog box.

4. Click “OK.” 

Mathcad changes the display of all results whose formats have not been explicit
specified. 
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Alternatively, you can change the worksheet default by clicking on a particular re
choosing Result from the Format menu, changing the settings in the Result Form
dialog box, and clicking “Set as Default.”

Tip Changing the worksheet default result format affects only the worksheet you are working 
when you make the change. Any other worksheets open at the time retain their own default
formats. If you want to re-use your default result formats in other Mathcad worksheets, save
worksheet as a template as described in Chapter 7, “Worksheet Management.”

The Resu lt  Form at  dia log box

The tabs in the Result Format dialog box lead to pages containing options for forma
various aspects of a result. 

The Number Format page lets you control the number of decimal places, trailing zer
and whether a result is in exponential notation. Depending on the format scheme
choose under the Format section, you see different options.

• Choosing General lets you control the number of digits to the right of the decim
point, trailing zeros, and exponential threshold. A result  is displayed in expone
notation when the exponential threshold is exceeded. You can display trailing z
to the right of the decimal until you exceed 15 digits total.

• Choosing Decimal lets you control the number of digits to the right of the decim
point and never display the results in exponential notation. You can display tra
zeros to the right of the decimal point beyond 15 digits total, but only the first
digits are accurate.

• Choosing Scientific or Engineering lets you control the number of digits to the 
right of the decimal point and always display results in exponential notation. F
Engineering, the exponents are displayed in multiples of three. You can use 
notation for the exponents by choosing “Show exponents as ± E 000.” You ca
display trailing zeros to the right of the decimal point beyond 15 digits total, b
only the first 15 digits are accurate.

Not e Settings that are grayed can only be changed for the entire worksheet, as described in “S
worksheet default format” on page 110.

The Display Options page lets you control whether arrays are displayed as tables
matrices, whether nested arrays are expanded, and whether i or j is used to indi
imaginary. You can also specify another radix such as Binary or Octal.           

The Unit Display page gives you options to format units (as fractions) or simplify t
units to derived units.

The Tolerance page allows you to specify when to hide a real or imaginary part o
result and how small a number has to be for it to display as zero.   

On- line Help For more details and examples of the options available on a particular page in the Result F
dialog box, click the Help button at the bottom of the dialog box.

Figure 8-10 shows some examples of formatting options.
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Com p lex Result s
Complex numbers can arise in results if you enter an expression that contains a co
number. Even a Mathcad expression that involves only real numbers can have a

complex value. For example, if you evaluate , Mathcad returns i. See Figure 8-11 
for examples.

Not e When complex numbers are available, many functions and operators we think of as retur
unique results become multivalued. In general, when a function or operator is multivalued
Mathcad returns the principal value: the value making the smallest positive angle relative to t

positive real axis in the complex plane. For example, when it evaluates , Mathcad

returns  despite the fact that we commonly think of the cube root of –1 as being
This is because the number  makes an angle of only 60 degrees from the positiv
axis. The number –1, on the other hand, is 180 degrees from the positive real axis. Mathc
nth root operator returns –1 in this case, however.

Figure 8-10: Several ways to format the same number.

Figure 8-11: Examples of complex results.

1–

1–( )1 3⁄

.5 .866i+
.5 .866i+
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Dis p la y in g  Units of  Result s   
Mathcad by default displays results in terms of the fundamental units of the unit sy
you’re working with. Mathcad offers the following unit system choices: SI, CGS, MKS, 
U.S. customary units, or no unit system (see below).

Tip Check “Simplify units when possible” in the Result Format dialog box (see page 110) to s
units in a result expressed in terms of derived units rather than in base units. Check “Form
units” to see units in a result displayed as a built-up fraction containing terms with positive
exponents only rather than as a product of units with positive and negative exponents.

You can have Mathcad redisplay a particular result in terms of any of Mathcad’s b
in units. To do so:

1. Click in the result. You’ll see an empty placeholder to its right. This is the units 
placeholder.

2. Click the units placeholder and choose Unit  from the Insert menu, or click  
on the Standard toolbar. Mathcad opens the Insert Unit dialog box. This is desc
in “Units and Dimensions” on page 106.

3. Double-click the unit in which you want to display the result. Mathcad inserts 
unit in the units placeholder.

Not e For some engineering units—such as hp, cal, BTU, and Hz—Mathcad adopts one common 
definition for the unit name but allows you to insert one of several alternative unit names,
corresponding to alternative definitions of that unit, in your results. In the case of horsepo
for example, Mathcad uses the U.K. definition of the unit hp but gives you several variants, such
as water horsepower, metric horsepower, boiler horsepower, and electric horsepower. 

Another way to insert a unit is to type its name directly into the units placeholder. T
method is more general since it works not only for built-in units but also for units you
defined yourself and for combinations of units.

Unit  system s 

When you start Mathcad, the SI system of units is loaded by default. This means th
when you use the equal sign to display a result having units, Mathcad automatic
displays the units in the result in terms of base or derived SI units.

You can have Mathcad display results in terms of the units of any of the other bu
unit systems in Mathcad: CGS, US customary, MKS, or no unit system at all. To do so,
choose Options from the Math menu and click the Unit System tab. 
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Select the default unit system in which 
you want to display results. The SI unit 
system, widely used by scientists and 
engineers in many countries, provides 
two additional base units over the other 
systems, one for luminosity (candela) 
and one for substance (mole), and the 
base SI electrical unit (ampere) differs 
from the base electrical unit in the oth-
er systems (coulomb).

The following table summarizes the 
base units available in Mathcad’s unit 
systems:

Unit  System Base Units

SI m, kg, s, A, K, cd, and mole

MKS m, kg, sec, coul, and K

CGS cm, gm, sec, coul, and K

U.S. ft, lb, sec, coul, and K

None Displays results in terms of fundamental dimensions of length, m
time, charge, and absolute temperature. All built-in units are disab

The standard SI unit names—such as A for ampere, L for liter, s for second, and S for 
siemens—are generally available only in the SI unit system. Many other unit names ar
available in all the available systems of units. For a listing of which units are avail
in each system, see the Appendices. Mathcad includes most units common to sci
and engineering practice. Where conventional unit prefixes such as m- for milli -, n- for 
nano-, etc. are not understood by Mathcad, you can easily define custom units su

 as described in “Defining Your Own Units” on page 109. 

Tip For examples of units with prefixes not already built into Mathcad, see the QuickSheets in
on-line Resource Center.

If you click “None” in the Unit System tab of the Math Options dialog box, Mathc
doesn’t understand any built-in units and displays answers in terms of the fundam
dimensions of length, mass, time, charge, and temperature. However, even if you are 
working in one of Mathcad’s built-in unit systems, you can always choose to see re
in your worksheet displayed in terms of fundamental dimension names rather tha
base units of the unit system. To do so:

1. Choose Options from the Math  menu. 

2. Click the Dimensions tab.

3. Check “Display dimensions.”

4. Click “OK.”

µm
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Unit  conversions

There are two ways to convert from one set of units to another:

• By using the Insert Unit dialog box, or

• By typing the new units in the units placeholder itself.

To convert units using the Insert Unit dialog box:

1. Click the unit you want to replace.

2. Choose Unit  from the Insert menu, or click  on the Standard toolbar.

3. In the scrolling list of units, double-click the unit in which you want to display t
result. 

As a quick shortcut, or if you want to display the result in terms of a unit not availa
through the Insert Unit dialog box—for example, a unit you defined yourself or a
algebraic combination of units—you can edit the units placeholder directly.

Figure 8-12 shows F displayed both in terms of fundamental SI units and in terms of 
several combinations of units.

When you enter an inappropriate unit in the units placeholder, Mathcad inserts a
combination of base units that generate the correct units for the displayed result

example, in the last equation in Figure 8-12,  is not a unit of force. Mathca

therefore inserts  to cancel the extra length dimension.

Whenever you enter units in the units placeholder, Mathcad divides the value to
displayed by whatever you enter in the units placeholder. This ensures that the com
displayed result—the number times the expression you entered for the placeholder
is a correct value for the equation.

Figure 8-12: A calculated result displayed with different units

kW s⋅

m 1–
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Not e Conversions involving an offset in addition to a multiplication, for example gauge pressur
absolute pressure, or degrees Fahrenheit to Celsius, cannot be performed directly with 
Mathcad’s unit conversion mechanism. You can, however, perform conversions of this typ
defining suitable functions. See the QuickSheet “Temperature Conversions” in the on-line
Resource Center for examples of temperature conversion functions.

You can enter any variable, constant, or expression in a units placeholder. Mathca
then redisplays the result in terms of the value contained in the units placeholder
example, you can use the units placeholder to display a result as a multiple of π or in 

engineering notation (as a multiple of , , etc.). 

Tip You can also use the units placeholder for dimensionless units like degrees and radians. M
treats the unit rad as a constant equal to 1, so if you have a number or an expression in rad
you can type deg into the units placeholder to convert the result from radians to degrees. 

Co py in g  and Past in g  Num erica l Resu lt s
You can copy a numerical result and paste it either elsewhere in your worksheet o
a new application. 

To copy a single number appearing to the right of an equal sign:

4. Click on the result to the right of the equal sign. This puts the result between
editing lines.

5. Choose Copy from the Edit  menu, or click  on the Standard toolbar to plac
the result on the Clipboard.

6. Click wherever you want to paste the result. If you’re pasting into another app
tion, choose Paste from that application’s Edit  menu. If you’re pasting into a 

Mathcad worksheet, choose Paste from Mathcad’s Edit menu or click  on the 
Standard toolbar.

When you paste a numerical result into a Mathcad worksheet, it appears as:

• A math region consisting of a number if you paste it into empty space.

• A number if you paste it into a placeholder in a math region.

• A number if you paste it directly into text or into a placeholder in text created us
the Math Region command on the Insert menu.

To copy more than one number, follow the steps for copying from an array. See
“Displaying Arrays” on page 198 for information on copying and pasting arrays.

Not e The Copy command copies the numerical result only to the precision displayed. To copy t
result in greater precision, double-click it and increase “Displayed Precision” on the Resu
Format dialog box. Copy does not copy units and dimensions from a numerical result.

103 106
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Cont rollin g  Calcula t ion 

When you start Mathcad, you are in automatic mode. This means that Mathcad update
results in the worksheet window automatically. You can tell you’re in automatic m
because the word “Auto” appears in the message line at the bottom of the windo

If you don’t want to wait for Mathcad to make computations as you edit, you can dis
automatic mode by choosing Automatic Calculation from the Math  menu. The word 
“Auto” disappears from the message line and the check beside Automatic Calculation 
disappears to indicate that automatic mode is now off. You are now in manual mode.

Tip The calculation mode—either manual or automatic—is a property saved in your Mathcad
worksheet. As described in Chapter 7, “Worksheet Management,” the calculation mode is
a property saved in Mathcad template (MCT) files. 

Ca lcu la t in g  in Autom at ic Mode
Here is how Mathcad works in automatic mode:

• As soon as you press the equal sign, Mathcad displays a result.

• As soon as you click outside of an equation having a “:=” or a “≡,” Mathcad 
performs all calculations necessary to make the assignment statement.

When you process a definition in automatic mode by clicking outside the equatio
region, this is what happens:

• Mathcad evaluates the expression on the right side of the definition and assig
to the name on the left.

• Mathcad then takes note of all other equations in the worksheet that are in any
affected by the definition you just made.

• Finally, Mathcad updates any of the affected equations that are currently visib
the worksheet window. 

Not e Although the equation you altered may affect equations throughout your worksheet, Math
performs only those calculations necessary to guarantee that whatever you can see in the w
is up-to-date. This optimization ensures you don’t have to wait for Mathcad to evaluate 
expressions that are not visible. If you print or move to the end of the worksheet, howeve
Mathcad automatically updates the whole worksheet.

Whenever Mathcad needs time to complete computations, the mouse pointer ch
its appearance and the word “WAIT” appears on the message line. This can occur wh
you enter or calculate an equation, when you scroll, during printing, or when you
enlarge a window to reveal additional equations. In all these cases, Mathcad eva
pending calculations from earlier changes.

As Mathcad evaluates an expression, it surrounds it with a green rectangle. This m
it easy to follow the progress of a calculation.

To force Mathcad to recalculate all equations throughout the worksheet, choose
Calculate Worksheet from the Math  menu.
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Calcu la t in g  in Manua l M ode
In manual mode, Mathcad does not compute equations or display results until yo
specifically request it to recalculate. This means that you don’t have to wait for Mat
to calculate as you enter equations or scroll around a worksheet.

Mathcad keeps track of pending computations while you’re in manual mode. As s
as you make a change that requires computation, the word “Calc” appears on th
message line. This is to remind you that the results you see in the window are no
to-date and that you must recalculate them before you can be sure they are upd

You can update the screen by choosing Calculate from the Math  menu or clicking  
on the Standard toolbar. Mathcad performs whatever computations are necessa
update all results visible in the worksheet window. When you move down to see m
of the worksheet, the word “Calc” reappears on the message line to indicate tha
must recalculate to see up-to-date results.

To process the whole worksheet, including those portions not visible in the works
window, choose Calculate Worksheet from the Math  menu.

Not e When you print a worksheet in manual calculation mode, the results on the printout are n
necessarily up-to-date. In this case, make sure to choose Calculate Worksheet from the Math  
menu before you print.

I n te rru p t in g  Ca lcu la t ions   
To interrupt a computation in progress:

1. Press [Esc ]. The dialog box shown at right appears.

2. Click “OK” to stop the calculations or “Cancel” to resume 
calculations.

If you click “OK,” the equation that was being processed when 
you pressed [Esc ] is marked with an error message (see “Error 
Messages” on page 121) indicating that calculation has been interrupted. To resu
interrupted calculation, first click in the equation having the error message, then ch

Calculate from the Math  menu or click  on the Standard toolbar.

Tip If you find yourself frequently interrupting calculations to avoid having to wait for Mathcad
recalculate as you edit your worksheet, you can switch to manual mode as described abo

Disablin g  Eq ua t ions 
You can disable a single equation so that it no longer calculates along with other reg
in your worksheet. Disabling an equation does not affect Mathcad’s equation edi
formatting, and display capabilities.

To disable calculation for a single equation in your worksheet, follow these steps

1. Click on the equation you want to disable.

2. Choose Properties from the Format menu, and click the Calculation tab.

3. Under “Calculation Options” check “Disable Evaluation.” 
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4. Mathcad shows a small rectangle after the equation to indi-
cate that it is disabled. An example is shown at right.

Tip An easy shortcut for disabling evaluation is to click with the right 
mouse button on an equation and select Disable Evaluation from the pop-up menu.

To re-enable calculation for a disabled equation:

1. Click on the equation to select it.

2. Choose Properties from the Format menu, and click the Calculation tab.

3. Remove the check from “Disable Evaluation.” 

Mathcad removes the small rectangle beside the equation, and calculation is re-en

Anim at ion

This section describes how to use Mathcad to create and play short animation cli
using the built-in variable FRAME. Anything that can be made to depend on this variab
can be animated. This includes not only plots but numerical results as well. You 
play back the animation clips at different speeds or save them for use by other 
applications.

Crea t in g  an  An im at ion  Cli p
Mathcad comes with a predefined constant called FRAME whose sole purpose is to 
drive animations. The steps in creating any animation are as follows:

1. Create an expression or plot, or a group of expressions, whose appearance ul
ly depends on the value of FRAME. This expression need not be a graph. It can 
anything at all. 

2. Choose Animate from the View 
menu to bring up the Animate dialog 
box.

3. Drag-select the portion of your work-
sheet you want to animate as shown 
in Figure 8-13. Draw a rectangle 
around as many regions as you want 
to appear in the animation.

4. Set the upper and lower limits for 
FRAME in the dialog box. When you 
record the animation, the FRAME variable increments by one as it proceeds from
the lower limit to the upper limit.

5. Enter the playback speed in the Frames/Sec. box. 

6. Click “Animate.” You’ll see a miniature rendition of your selection inside the dial
box. Mathcad redraws this once for each value of FRAME. This won’t necessarily 
match the playback speed since at this point you’re just creating the animation.

7. To save your animation clip as a Windows AVI  file, suitable for viewing in other 
Windows applications, click “Save As” in the dialog box. 
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Tip Since animation clips can take considerable disk space, Mathcad saves them in compres
format. Before creating the animation, you can choose what compression method to use 
whether to compress at all. To do so, click “Options” in the Animate dialog box. 

Pla y in g  an Anim at ion  Cli p
As soon as you’ve created an animation clip as described in 
the previous section, Mathcad opens a Playback window:

The first frame of the animation clip you just created is 
already in the window. To play back the animation clip, click 
the arrow at the lower left corner of the window. You can 
also play back the animation clip on a frame by frame basis, 
either forward or backward. To do so, drag the slider below 
the animated picture to the left or right.

Tip You can control the playback speed by clicking the button to the 
right of the play button, which then opens a pop-up menu. Choose Speed from the menu and 
adjust the slider control. 

Pla y in g  a  Previousl y  Saved An im at ion
If you have an existing Windows AVI  file on your disk, you can play it within Mathcad.
To do so:

1. Choose Playback from the View menu to 
bring up the Playback dialog box. The win-
dow is collapsed since no animation clip has 
been opened. 

2. Click on the button to the right of the play button and choose Open from the menu. 
Use the Open File dialog box to locate and open the AVI  file you want to play.

Once you’ve loaded a Windows AVI  file, proceed as described in the previous sectio

Figure 8-13: Selecting an area of a worksheet for animation.
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Tip To launch an animation directly from your worksheet, you can insert a hyperlink to an AVI
by choosing Hyperlink  from the Insert menu. You can also embed a shortcut to the AVI file 
your worksheet by dragging the icon for the AVI file from the Windows Explorer and dropp
it into your worksheet. Finally, you can embed or link an OLE animation object in your 
worksheet (see “Inserting Objects” on page 71).

Error  Messa g es 

If Mathcad encounters an error when evaluating an expression, it marks the expre
with an error message and highlights the offending name or operator in red.

An error message is visible only when you click on the 
associated expression, as shown to the right. 

Mathcad cannot process an expression containing an error. 
If the expression is a definition, the variable or function it 
is supposed to define remains undefined. This can cause 
any expressions that reference that variable to be unde-
fined as well.

Tip You can get on-line help about some error messages by clicking on them and pressing [F1]. 

Findin g  the Source of  an Er ror
When a Mathcad worksheet contains an expression that is dependent on one or
definitions made earlier in the worksheet, an error on that expression may origina
an earlier definition.

For example, in the figure above, the error appears on the third region, f(0). However, 
f(x) is based on the definition of g(x). When x is zero, g(x) is the first region that exhibits 
the error. 

You can try to find the source of an error yourself simply by examining your worksh
to see where the error began, or you can use Mathcad to trace the error back th
your worksheet. To find the source of an error using Mathcad:

1. Click on the region showing the error with the right mouse button and choose T
Error from the pop-up menu. The Trace Error dialog box appears:

2. Use the buttons in the dialog box to navigate among the regions associated wi
region showing the error.

For example, click Back to step back to 
the previous dependent region.
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Or click First to jump to the first region 
causing the error.

Tip If you anticipate time-consuming calculations, switch to manual mode as described in 
“Controlling Calculation” on page 117. When you are ready to recalculate, choose Calculate 

from the Math  menu or click  on the Standard toolbar turn. Alternatively, turn on automa
mode again.

Fix in g  Errors 
Once you have determined which expression caused the error, edit that express
fix the error or change the variable definitions that led to the error. When you clic
the expression and begin editing, Mathcad removes the error message. When you
outside the equation (or in manual calculation mode, when you recalculate), Mat
recomputes the expression. Once you have fixed the error, Mathcad then recom
the other expressions affected by the expression you changed.

Not e When you define a function, Mathcad does not try to evaluate it until you subsequently use
the worksheet. If there is an error, the use of the function is marked in error, even though th
problem may lie in the definition of the function itself, possibly much earlier in the workshe
122  Chapter 8  Calculating in Mathcad
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Chapter  9
Opera tors

τ Working with Operators

τ Arit hm et ic and Boolean Operators

τ Vector  and Matr ix Operators

τ Sum m at ions and Products

τ Derivat ives

τ I ntegrals

Pro τ Custom izing Operators 

W ork in g  w ith  O p era tors  

I nser t in g  an  O p era tor
You insert the common arithmetic operators into math expressions in Mathcad u
the standard keystrokes, like *  and +, that you use in spreadsheet and other applicatio
Additionally, all of Mathcad’s operators can be inserted into math expressions by
clicking buttons in the math toolbars. For example, you insert Mathcad’s derivati

operator by clicking  on the Calculus toolbar, or by typing ?. Choose Toolbars 
from the View menu to see any of the math toolbars. See “Operators” on page 29
the Appendices for a complete list of operators, their keystrokes, and description

Not e In general, you only insert operators into blank space in your worksheet or when you hav
already clicked in a math region. To use operators in text, first click in the text and choose Math 
Region from the Insert menu. This creates a math placeholder in the text into which you ca
insert operators.

Tip You can find out the keyboard shortcut for inserting an operator by hovering the mouse po
over an operator button in one of the Math toolbars and reading the tooltip that appears.

As introduced in Chapter 4, “Working with Math,” when you insert a Mathcad opera
into a blank space in your worksheet, a mathematical symbol with empty placeholders 
appears in the worksheet. The placeholders are for you to enter expressions that 
operands of the operator. The number of empty placeholders varies with the opera
some operators like the factorial operator have only a single placeholder, while o
such as the definite integral have several. You must enter a valid math expressio
each placeholder of an operator in order to calculate a result.
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Here is a very simple example involving Mathcad’s addition operator:

1. Click in a blank space in your worksheet and click  on the 
Calculator toolbar, or simply type +. The addition operator with 
two placeholders appears.

2. Enter 2 in the first placeholder.

3. Click in the second placeholder, or press [Tab ] to move the 
cursor, and enter 6.

4. Press =, or click  on the Evaluation toolbar, to see the 
numerical result.

Tip See Chapter 4, “Working with Math,” for a discussion of how to build and edit more comp
math expressions, including how to use the editing lines to specify what becomes the operand o
the next operator you insert or delete.

Addit iona l O p era tors
This chapter focuses on those Mathcad operators you can use to calculate num
answers. Additional operators in Mathcad include: 

• Symbolic operators, which can only be used to generate other math expression
exact numerical answers. As described in Chapter 14, “Symbolic Calculation
Mathcad’s symbolic processor understands virtually any Mathcad expression
expressions that include the following operators on the Calculus toolbar can only 

be evaluated symbolically: indefinite integral , two-sided limit , limit from

above , and limit from below . To evaluate an expression symbolicall

click  on the Evaluation toolbar.

Pro • Programming operators, which you use to link multiple Mathcad expressions v
conditional branching, looping constructs, local scoping of variables, and othe
attributes of traditional programming languages. These operators, available on

Mathcad Professional (click  on the Math toolbar), are introduced in Chap
15, “Programming.”

Chan g in g  the  Dis p la y  of an  O p era tor
When you insert an operator into a worksheet, it has a certain default appearanc

example, when you type a colon:  or click  on the Calculator toolbar, Mathcad 
shows the colon as the definition symbol := . This is a special symbol used by Mathca
to indicate a variable or function definition. 

There may be times when you want to control the appearance of a special symbo
as the definition symbol. For example you may want the definition symbol to look 
an ordinary equal sign, but you still want to use it to define variables and function
your worksheet. Mathcad therefore allows you to change the appearance of som
124  Chapter 9  Operators



e the 

s on 

 
y can 
operators, such as the definition symbol, so that they appear different but behav
same way.

To change the way an operator is displayed throughout a worksheet:

1. Choose Options from the Math  
menu.

2. Click the Display tab.

3. Use the drop-down options next to 
each operator to select a display 
option.

4. Click “OK.”

For information on the options avail-
able for each operator, click the Help 
button at the bottom of the Display tab 
in the Math Options dialog box.

To change the appearance of an opera-
tor in one or more individual expressions, click 
with the right mouse button and use the pop-up 
menu. For example, to change the multiplica-
tion in an expression from a dot to an X:

1. Click on the multiplication with the right 
mouse button.

2. Choose View Multiplication As…  ⇒ X 
from the pop-up menu.

Arithm et ic and Boolean O p erators

Ar ithm et ic Opera tors

You can freely combine all types of numbers with arithmetic operators you acces
the Calculator toolbar. Figure 9-1 shows examples.

Boolean Opera tors
Mathcad includes logical or Boolean operators on the Boolean toolbar. Unlike other
operators, the Boolean operators can return only a zero or a one. Despite this, the
be very useful to perform tests on your expressions.    
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The following table lists the Boolean operators available on the Boolean toolbar 
their meaning. Note that the “Equal to” operator (bold equal sign) is different from
evaluation equal sign you insert by typing =.

Not e The Boolean operators return 1 if the expression is true, 0 otherwise. The four operators 

 cannot take complex numbers because the concepts of greater than and les
lose their meaning in the complex plane.

Figure 9-1: Combining different types of numbers with arithmetic operators.

Appea rance But ton Descr ip t ion Keyst roke

Equal to; displays as bold equal
sign. 

[Ctrl ] =

Less than <

Greater than >

Less than or equal to [Ctrl ] 9

Greater than or equal to [Ctrl ] 0

Not equal to  [Ctrl ] 3

Not [Ctrl ] [Shift ] 1

And [Ctrl ] [Shift ] 7

Or [Ctrl ] [Shift ] 6

Xor (Exclusive Or) [Ctrl ] [Shift ] 5

w z=

x y<

x y>

x y≤

x y≥

w z≠

z¬

w z∧

w z∨

w z⊕

>, <, , and ≥≤
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Tip The comparative boolean operators such as < and > can also be used to compare strings. 
Mathcad compares two strings character by character by determining the ASCII codes of
characters. For example, the string “Euler” precedes the string “Mach” in ASCII order and
the expression (“Euler”<“Mach”) evaluates to 1. To determine the character ordering Math
uses in comparing strings, see “ASCII codes” on page 316 in the Appendices. 

Com p lex O p erators       

Mathcad has the following arithmetic operators for working with complex numbe

Figure 9-3 shows some examples of how to use complex numbers in Mathcad.

Vector and Mat r ix  O p erators 

Most of the operators on the Calculator toolbar also have meaning for vectors an
matrices. For example, when you use the addition operator to add two arrays of 
same size, Mathcad performs the standard element-by-element addition. Mathca
uses the conventional arithmetic operators for matrix subtraction, matrix multiplicat
integer powers, and determinants, among others.

Some of Mathcad’s operators have special meanings for vectors and matrices, and

of these are grouped on the Matrix toolbar (click  on the Math toolbar). For 
example, the multiplication symbol means multiplication when applied to two numb
but it means dot product when applied to vectors, and matrix multiplication when
applied to matrices. 

Figure 9-2: Using boolean operators.

Appea rance But ton Descr ipt ion

Complex conjugate of z. To apply the conjugate 
operator to an expression, select the expressio
then press the double-quote key (" ). The conjugate
of the complex number  is . 

The magnitude of the number z. 

z

a b i⋅+ a b i⋅–

z
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The table below describes Mathcad’s vector and matrix operations. Operators not 
in this table do not work for vectors and matrices. You can, however, use the vect

operator (click  on the Matrix toolbar) to perform any scalar operation or funct
element by element on a vector or matrix. See “Doing Calculations in Parallel” on p
201. Figure 9-4 shows some ways to use vector and matrix operators.

Figure 9-3: Complex numbers in Mathcad.

Figure 9-4: Vector and matrix operations.
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In the following table,

• A  and B represent arrays, either vector or matrix.

• u and v represent vectors.

• M  represents a square matrix.

•  and  represent the individual elements of vectors u and v.

• z represents a scalar.

• m and n represent integers.

Appea rance But t on Descrip t ion

Scalar multiplication. Multiplies each element of
A by the scalar z.

Dot product. Returns a scalar: . The 

vectors must have the same number of element

Matrix multiplication. Returns the matrix product
of A and B. The number of columns in A must 
match the number of rows in B. 

Vector/matrix multiplication. Returns the produc
of A and v. The number of columns in A must 
match the number of rows in v.

Scalar division. Divides each element of the arra
A by the scalar z.

Scalar division. Divides each element of the arra
A by the scalar z. Type [Ctrl ] /  to insert.

Vector and matrix addition. Adds corresponding
elements of A and B. The arrays A and B must 
have the same number of rows and columns.

Scalar addition. Adds z to each element of A.

Vector and matrix subtraction. Subtracts 
corresponding elements of A and B. The arrays A 
and B must have the same number of rows and 
columns.

Scalar subtraction. Subtracts z from each element 
of A.

Negative of vector or matrix. Returns an array 
whose elements are the negatives of the eleme
of A.

ui vi

A z⋅

u v⋅ Σ ui vi⋅〈 〉

A B⋅

A v⋅

A
z
----

A z÷

A B+

A z+

A B–

A z–

A–
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Tip Operators and functions that expect vectors always expect column vectors. They do not ap
row vectors. To change a row vector into a column vector, use the transpose operator by cl

 on the Matrix toolbar. 

Sum m at ions and Products 

The summation operator sums an expression over all values of an index. The ite
product operator works much the same way. It takes the product of an expression
all values of an index.

To create a summation operator in your worksheet:

1. Click in a blank space. Then click  on the Calculus toolbar. A 
summation sign with four placeholders appears.

nth power of square matrix M  (using matrix 
multiplication). n must be an integer.  
represents the inverse of M . Other negative 
powers are powers of the inverse. Returns a 
matrix.

Magnitude of vector. Returns  where  is 
the complex conjugate of v.

Determinant. M  must be a square matrix.

Transpose. Interchanges row and columns of A.

Cross product. u and v must be three-element 
vectors; result is another three-element vector.

Complex conjugate. Takes complex conjugate o
each element of A. Insert in math with the double-
quote key (" ).

Vector sum. Sum elements in v.

Vectorize. Treat all operations in A element by 
element. See “Doing Calculations in Parallel” on
page 201 for details. 

Array superscript. nth column of array A. Returns 
a vector.

Vector subscript. nth element of a vector.

Matrix subscript. m,nth element of a matrix.

M n

M 1–

v v v⋅ v

M

AT

u v×

A

Σv

A

A n〈 〉

vn

Am n,
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2. Type a variable name in the placeholder to the left of the equal sign. This 
variable is the index of summation. It is defined only within the 
summation operator and therefore has no effect on, and is not influenced 
by, variable definitions outside the summation operator.

3. Type integers, or any expressions that evaluate to integers, in the 
placeholders to the right of the equal sign and above the sigma. 

4. Type the expression you want to sum in the remaining placeholder. 
Usually, this expression involves the index of summation. If this 
expression has several terms, first type an apostrophe (' ) to create 
parentheses around the placeholder.

Iterated products are similar to summations. Just click  on the Calculus toolba
fill in the placeholders as described earlier.

Tip Use the keyboard shortcut [Ctrl ][Shift ]4 to enter the iterated sum and the shortcut 
[Ctrl ][Shift ]3 to enter the iterated product operator.

Figure 9-5 shows some examples of how to use the summation and product oper

To evaluate multiple summations, place another summation in the final placehold
the first summation. An example appears at the bottom of Figure 9-5.

When you use the summation operator shown in Figure 9-5, the summation mus
carried out over subsequent integers and in steps of one. Mathcad provides more g
versions of these operators that can use any range variable you define as an ind
summation. To use these operators:

1. Define a range variable. For example, type i:1,2;10 . 

Figure 9-5: Summations and products.
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2. Click in a blank space. Then click  on the Calculus toolbar. 
A summation sign with two placeholders appears.

3. Click on the bottom placeholder and type the name of a range 
variable.

4. Click on the placeholder to the right of the summation sign and 
type an expression involving the range variable. If this 
expression has several terms, first type an apostrophe (' ) to 
create parentheses around the placeholder.

5. Press =, or click  on the Evaluation toolbar, to get a result.

Tip To enter the expression in the example above using fewer keystrokes and mouse clicks, 
i$i^2 . 

A generalized version of the iterated product also exists. To use it, click  on 
Calculus toolbar. Then fill in the two placeholders.

Tip The operation of summing the elements of a vector is so common that Mathcad provides

special operator for it. The vector sum operator (click  on the Matrix toolbar) sums th
elements of a vector without needing a range variable.

Var iable U pp er  Lim it  of  Sum m at ion
Mathcad’s range summation operator runs through each value of the range variab
place in the bottom placeholder. It is possible, by judicious use of Boolean express

to sum only up to a particular value. In Figure 9-6, the term  returns the valu
whenever it is true and 0 whenever it is false. Although the summation operator 

sums over each value of the index of summation, those terms for which  are
multiplied by 0 and hence do not contribute to the summation.

You can also use the four-placeholder summation and product operators to com
sums and products with a variable upper limit, but note that the upper limit in the
operators must be an integer.

i x≤

i x>
132  Chapter 9  Operators



ch 
racy 
order 
Der ivat ives 

You can use Mathcad’s derivative operators to evaluate the first or higher order 
derivatives of a function at a particular point. 

As an example, here’s how to evaluate the first derivative of  with respect to x at the 

point :

1. First define the point at which you want to evaluate the 
derivative. As a shortcut, type x:2 .

2. Click below the definition of x. Then click  on the Calculus 
toolbar. A derivative operator appears with two placeholders.

3. Type x  in the bottom placeholder. You are differentiating with 
respect to this variable. In the placeholder to the right of the

 , enter x^3 . This is the expression to be differentiated.

4. Press =, or click  on the Evaluation toolbar, to get the result.

Figure 9-7 shows examples of differentiation in Mathcad.

With Mathcad’s derivative algorithm, you can expect the first deriv-
ative to be accurate within 7 or 8 significant digits, provided that the value at whi
you evaluate the derivative is not too close to a singularity of the function. The accu
of this algorithm tends to decrease by one significant digit for each increase in the 
of the derivative (see “Derivatives of Higher Order” on page 135).

Figure 9-6: A variable upper limit of summation

x3

x 2=

xd
d
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Not e Keep in mind that the result of numerical differentiation is not a function, but a single num
the computed derivative at the indicated value of the differentiation variable. In the previo

example, the derivative of  is not the expression  but  evaluated at . To 
evaluate derivatives symbolically, see Chapter 14, “Symbolic Calculation.”

Although differentiation returns just one number, you can still define one function
the derivative of another. For example:

Evaluating f(x) returns the numerically computed derivative of g(x) at x.

You can use this technique to evaluate the derivative of a function at many points
example of this is shown in Figure 9-8.

There are some important things to remember about differentiation in Mathcad:

• The expression to be differentiated can be either real or complex.

• The differentiation variable must be a single variable name. If you want to eval
the derivative at several different values stored in a vector, you must evaluate
derivative at each individual vector element (see Figure 9-8). 

Figure 9-7: Examples of Mathcad differentiation.

x3 3x2 3x2 x 2=

f x( )
xd

d g x( ):=
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Tip You can change the display of the derivative operator to partial derivative symbols. For exa

you can make  look like  . To change the display of a derivative operator to partial 

derivative symbols, click on it with the mouse button and choose View Derivative As... ⇒ 
Partial. Or to change the display of all the derivative operators in a worksheet, choose Options 
from the Math  menu, click on the Display tab, and select “Partial Derivative” next to Derivati
See “Changing the Display of an Operator” on page 124 for additional information.

Der iva t ives of  H i g her Order  
To evaluate a higher order derivative, insert the nth derivative operator using steps 
similar to those for inserting the derivative operator described above. 

As an example, here’s how to evaluate the third derivative of  with respect to x at 

the point : After defining x as 2:

1. Click below the definition of x. Then click  on the 
Calculus toolbar. A derivative operator appears with four 
placeholders.

2. Click on the bottom-most placeholder and type x .   

3. Click on the expression above and to the right of the 
previous placeholder and type 3. This must be an integer 
between 0 and 5 inclusive. Note that the placeholder in the 
numerator automatically mirrors whatever you’ve typed.

Figure 9-8: Evaluating the derivative of a function at several points

xd
d

x∂
∂

x9

x 2=
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4. Click on the placeholder to the right of the  and type 

x^9 . This is the expression to be differentiated.

5. Press =, or click  on the Evaluation toolbar, to see the 
result.

Not e For , the nth derivative operator gives the same answer as the first-derivative opera
discussed on page 133. 

I n te g ra ls 

You can use Mathcad’s integral operator to numerically evaluate the definite inte
of a function over some interval.

As an example, here’s how to evaluate the definite integral of  from 0 to 

(In Mathcad you enter  as .) Follow these steps:

1. Click in a blank space and click  on the Calculus 
toolbar. An integral symbol appears, with placeholders for 
the integrand, limits of integration, and variable of 
integration.

2. Click on the bottom placeholder and type 0. Click on the 
top placeholder and type p[Ctrl]G/4 . These are the 
upper and lower limits of integration.

3. Click on the placeholder between the integral sign and the 
“d.” Then type sin(x)^2 . This is the expression to be 
integrated. 

4. Click on the remaining placeholder and type x . This is the 

variable of integration. Then press =, or click  on the 
Evaluation toolbar, to see the result. 

Not e Some points to keep in mind when you evaluate integrals in Mathcad: 1) The limits of integr
must be real. The expression to be integrated can, however, be either real or complex. 2) E
for the integrating variable, all variables in the integrand must have been defined previous
the worksheet. 3) The integrating variable must be a single variable name. 4) If the integr
variable involves units, the upper and lower limits of integration must have the same units

I n te g rat ion  Al g or it hm s and AutoSe lect
Mathcad has a number of numerical integration methods at its disposal to calcula
numerical approximation of an integral. When you evaluate an integral, by defau
Mathcad uses an AutoSelect procedure to choose the most accurate integration meth

x
3

d

d

n 1=

sin2 x( ) π 4⁄

sin2 x( ) sin x( )2
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If you have Mathcad Professional, you can override AutoSelect and choose from am
the available integration algorithms yourself.

Here are the methods from which Mathcad chooses when you evaluate an integ
numerically:

Rom ber g

Applies a Romberg integration method that divides the interval of integration into
equally spaced subintervals.

Ada p t ive

Applies an adaptive quadrature algorithm in cases where the integrand varies co
erably in magnitude over the interval of integration.

I n f in ite  Lim it

Applies an algorithm designed for improper integral evaluation in cases where e
limit of integration is ∞ or −∞. 

Sin g u lar  End p oin t

Applies a routine that avoids use of the interval endpoints in cases where the inte
is undefined at either limit of integration.

Not e Although designed to handle a wide range of problems, Mathcad’s integration algorithms—
all numerical methods—can have difficulty with ill-behaved integrands. For example, if the
expression to be integrated has singularities or discontinuities the solution may still be 
inaccurate. 

Pro With Mathcad Professional, you can override Mathcad’s integration 
AutoSelect as follows:

1. Evaluate the value of the integral as described on page 136, 
allowing Mathcad to AutoSelect an integration algorithm.

2. Click with the right mouse button on the integral. 

3. Click one of the listed integration methods on the pop-up menu. 
Mathcad recalculates the integral using the method you selected.

Ti p In some cases, you may be able to find an exact numerical value for your integral by usin
Mathcad’s symbolic integration capability. You can also use this capability to evaluate indefinite 
integrals. See Chapter 14, “Symbolic Calculation.” 

Var iable Lim it s of  I nte g rat ion
Although the result of an integration is a single number, you can always use an int
with a range variable to obtain results for many numbers at once. You might do 
for example, when you set up a variable limit of integration. Figure 9-9 shows ho
do this. 

Keep in mind that calculations such as those shown in Figure 9-9 require repeat
evaluating an integral. This may take considerable time depending on the compl
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of the integrals, the length of the interval, and the value of the tolerance parameteTOL 
(see below).

Tole rance  for  I n te g ra ls 
Mathcad’s numerical integration algorithms make successive estimates of the val
the integral and return a value when the two most recent estimates differ by less
the value of the built-in variable TOL. 

As described in “Built-in Variables” on page 98, you can change the value of the
tolerance by including definitions for TOL directly in your worksheet. You can also 
change the tolerance by using the Built-In Variables tab when you choose Options 
from the Math  menu. To see the effect of changing the tolerance, choose Calculate 
Document from the Math  menu to recalculate all the equations in the worksheet.

If Mathcad’s approximation to an integral fails to converge to an answer, Mathca
marks the integral with an error message. Failure to converge can occur when th
function has singularities or “spikes” in the interval or when the interval is extrem
long. 

Not e When you change the tolerance, keep in mind the trade-off between accuracy and compu
time. If you decrease (tighten) the tolerance, Mathcad computes integrals more accuratel
takes longer to return a result. Conversely, if you increase (loosen) the tolerance, Mathca
computes more quickly, but the answers are less accurate.

Contour  I n te g ra ls 
You can use Mathcad to evaluate complex contour integrals. To do so, first param
the contour and then integrate over the parameter. If the parameter is something
than arc length, you must also include the derivative of the parametrization as a 
correction factor. Figure 9-10 shows an example. Note that the imaginary unit i used 
in specifying the path must be typed as 1i . 

Figure 9-9: Variable limits of integration. 
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Mult i p le in te g ra ls
You can also use Mathcad to evaluate double or multiple integrals. To set up a d

integral, for example, click  on the Calculus toolbar twice. Fill in the integrand
the limits, and the integrating variable for each integral. Figure 9-11 shows an exa

Not e Multiple integrals generally take much longer to converge to an answer than single integr
Wherever possible, use an equivalent single integral in place of a multiple integral.

Figure 9-10: A complex contour integral in Mathcad.

Figure 9-11: Double integrals.
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Custom izin g  Op era tors 

Pro This section describes how you can use Mathcad Professional to define and use
own customized operators.

You can think of operators and functions as being fundamentally very similar. A 
function takes “arguments” and returns a result. An operator, likewise, takes “opera
and returns a result. The differences are largely notational: 

• Functions usually have names you can spell, like tan or spline; operators are 
generally math symbols like “+” or “×.”

• Arguments to a function are enclosed by parentheses, they come after the func
name, and they’re separated by commas. Operands, on the other hand, can 

elsewhere. For example, you’ll often see  but you’ll rarely see . 

Similarly, you’ll often find “ ” but you rarely find “ .”

Def inin g  a  Custom  O p era tor
You define a custom operator just as if you were defining a function that happen
have an unusual looking name:

1. Type the operator name followed by a pair of parentheses. Enter the operand
at the most) between the parentheses.

2. Enter the definition symbol := . 

3. Type an expression describing what you want the operator to do with its oper
on the other side of the definition symbol. 

Tip Mathcad provides a collection of math symbols to define custom operators. To access the
symbols, open the QuickSheets from the Resource Center (choose Resource Center on the 
Help menu) and then click on “Extra Math Symbols.” You can drag any of these symbols to 
worksheet for use in creating a new operator name.

For example, suppose you want to define a new union operator using the symbol 

1. Drag the symbol into your worksheet from the “Extra Math 
Symbols” QuickSheet.

2. Type a left parenthesis followed by two names separated by a 
comma. Complete this argument list by typing a right parenthesis.

3. Press the colon (: ) key, or click  on the Calculator toolbar. 
You see the definition symbol followed by a placeholder.

4. Type the function definition in the placeholder.

At this point, you’ve defined a function which behaves in every 
way like the user-defined functions described in Chapter 8, “Calculating in Mathc
You could, if you wanted to, type “ ” in your worksheet and see the res
a vector with the elements 1 and 2, on the other side of the equal sign. 

f x y,( ) x f y

x y+ + x y,( )

 ∪ 1 2,( ) =
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Tip Once you’ve defined the new operator, click on “Personal QuickSheets” in the QuickShee
the Mathcad Resource Center. Then choose Annotate Book from the Book menu and drag or 
type the definition into the QuickSheet. Then choose Save Section from the Book menu. When 
you need to use this operator again, just open your Personal QuickSheet and drag it into 
worksheet.

Usin g  a Custom  O p era tor  
Once you’ve defined a new operator, you can use it in your calculations just as y
would use any of Mathcad’s built-in operators. The procedure for using a custom

operator depends on whether the operator has one operand (like “ ” or “5!”) or

(like “ ”).

To use an operator having two operands:

1. Define any variables you want to use as arguments.

2. Click  on the Evaluation toolbar. You’ll see three empty 
placeholders.

3. In the middle placeholder, insert the name of the operator. 
Alternatively, copy the name from the operator definition and paste it 
into the placeholder.

4. In the remaining two placeholders, enter the two operands.

5. Press =, or click  on the Evaluation toolbar, to get the 
result.

Tip An alternative way to display an operator having two operands is to click  on the Evalua
toolbar. If you follow the preceding steps using this operator, you’ll see a tree-shaped dis

To insert an operator having only one operand, decide first whether you want the

operator to appear before the operand, as in “ ,” or after the operand as in “5!.”
former is called a prefix operator; the latter is a postfix operator. The example below 
shows how to use a postfix operator. The steps for creating a prefix operator are a
identical.

1–

1 2÷

1–
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The following example shows how to define and use a new logical Not 
operator. First define an operator “ ′(x)” . To do so, follow the steps for 
defining ∪(x, y) in the previous section, substituting the symbol “ ′ ” for 
“∪” and using only one argument instead of two. 

Then, to evaluate with the new operator:

1. Click  on the Evaluation toolbar to make a postfix operator. 

Otherwise, click . In either case, you see two empty placeholders.

2. If you clicked , put the operator name in the second placeholder. 
Otherwise put it in the first placeholder. In either case, you may find 
it more convenient to copy the name from the operator definition and paste it 
the placeholder.

3. In the remaining placeholder, place the operand.

4. Press =, or click  on the Evaluation toolbar, to see the result.

Tip Just as Mathcad can display a custom operator as if it were a function, you can converse 
display a function as if it were an operator. For example, many publishers prefer to omit 
parentheses around the arguments to certain functions such as trigonometric functions, iesin x 

rather than . To create this notation, you can treat the sin function as an operator with one

operand. 
x( )sin
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Built - in Funct ions

τ I nser t ing Built - in Funct ions

τ Core Mathem at ical Funct ions

τ Discrete Transform  Funct ions

τ Vector  and Matr ix Funct ions

τ Solv ing and Opt im izat ion Funct ions

τ Stat ist ics,  Probability , and Data Analysis Funct ions

τ Finance Funct ions

Pro τ Different ial Equat ion Funct ions

τ Miscellaneous Funct ions

I nser t in g  Built - in  Funct ions

 Mathcad’s set of built-in functions can change depending on whether you’ve insta
additional Extension Packs or whether you’ve written your own built-in functions
These functions can come from the following sources:

Built - in  Mat hcad funct ions 

This is the core set of functions that come with Mathcad. These functions are introd
in this chapter. 

Pro Mathcad Ex tension  Packs

An Extension Pack consists of a collection of advanced functions geared to a part
area of application. Documentation for these functions comes with an Electronic B
accompanying the Extension Pack itself. The list of available Extension Packs curr
includes collections for signal processing, image processing, steam tables, num
analysis, and wavelets. To find out more about these and other Extension Packs, c
MathSoft or your local distributor, or visit MathSoft’s Web site at:

http://www.mathsoft.com/

or refer to Mathcad Add-on Products in the on-line Resource Center (choose Resource 
Center from the Help menu). After you purchase and install an Extension Pack, th
additional functions appear in the Insert Function dialog box.

Pro Bu ilt - I n  funct ions you w r ite  yourse lf in  C 

If you have Mathcad Professional and a supported 32-bit C/C++ compiler, you can write 
your own built-in functions. For details see the Adobe Acrobat file CREATING A USER 
DLL.PDF included on your installation CD.
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I nser t  Funct ion  Fea ture
To see a list of built-in functions available with your copy of Mathcad, arranged 
alphabetically or by category, or to insert a function together with placeholders fo
arguments, use the Insert Function dialog box:

1. Click in a blank area of your worksheet or on a placeholder. 

2. Choose Function from the 

Insert menu or click  on the 
Standard toolbar. Mathcad opens 
the Insert Function dialog box.

3. Click a Function Category or 
click “All” to see all available 
functions sorted alphabetically.

4. Double-click the name of the 
function you want to insert from the right-hand scrolling list, or click 
“Insert.” The function and placeholders for its arguments are inserted 
into the worksheet. 

5. Fill in the placeholders.

To apply a function to an expression you have already entered, place the expres
between the two editing lines and follow the steps given above. See Chapter 4, 
“Working with Math,” for information about using the editing lines. 

You can also simply type the name of a built-in function directly into a math placeho
or in a math region.

Tip Although built-in function names are not font sensitive, they are case sensitive. If you do no
the Insert Function dialog box to insert a function name, you must enter the name of a bu
function in a math region exactly as it appears in the tables throughout this chapter: uppe
lowercase, or mixed, as indicated.

Not e Throughout this chapter and in the Insert Function dialog box, brackets, [  ], around an argu
indicate that the argument is optional.

Assistance  for  Usin g  Bu ilt - in  Funct ions
Mathcad includes several sources of assistance for using built-in functions:

• The Insert Function dialog box gives you a convenient way to look up a funct
by category, to see the arguments required, and to see a brief function synop
When you click “Help” in the Insert Function dialog box, you immediately ope
the Help topic associated with the currently selected function.
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• The on-line Help system (choose Mathcad Help from the Help menu, or click  
on the Standard toolbar) provides both overview and detailed help topics on 
functions and function categories.

• The Resource Center (choose Resource Center from the Help menu, or click  
on the Standard toolbar) includes a range of Mathcad files to help you use bu
functions to solve problems including Tutorials and QuickSheet examples.

• The Mathcad Reference Manual, which provides details on the syntax, argument
algorithms, and behavior of all of Mathcad’s built-in functions, operators, and
keywords. The Reference Manual is provided as an Adobe Acrobat file on all 
Mathcad installation media. Mathcad Professional includes a printed copy.

Core Mathem at ica l Funct ions

Tr i g onom et r ic Funct ions

Mathcad’s trig functions and their inverses accept any scalar argument: real, com
or imaginary. They also return complex numbers wherever appropriate. 

Not e Trigonometric functions expect their arguments in radians. To pass an argument in degrees, us
the built-in unit deg. For example, to evaluate the sine of 45 degrees, type sin(45*deg) . 

Tip In Mathcad you enter powers of trig functions such  as . Alternatively, you c

use the prefix operator in Mathcad Professional, described on “Customizing Operators” on

140. For example, to type . Click  on the Evaluation toolbar, enter sin 2 in the 

left-hand placeholder, enter (x)  in the right-hand placeholder.

angle(x, y) Returns the angle (in radians) from the positive x-axis to point (x, y) in the 
x-y plane. The result is between 0 and 2π.

cos(z) Returns the cosine of z. In a right triangle, this is the ratio of the length o
the side adjacent to the angle over the length of the hypotenuse.

cot(z) Returns , the cotangent of z. z should not be a multiple of .

csc(z) Returns , the cosecant of z. z should not be a multiple of .

sec(z) Returns , the secant of z. z should not be an odd multiple of 

sin(z) Returns the sine of z. In a right triangle, this is the ratio of the length of th
side opposite the angle over the length of the hypotenuse.

tan(z) Returns , the tangent of z. In a right triangle, this is the ratio
of the length of the side opposite the angle over the length of the side 
adjacent to the angle. z should not be an odd multiple of .

1 z( )tan⁄ π

1 z( )sin⁄ π

1 z( )cos⁄ π 2⁄

z( )sin z( )cos⁄

π 2⁄

sin2 x( ) sin x( )2

sin2 x( )
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With the exception of atan2 and acot, the inverse trigonometric functions can take 
either a real or complex argument and return an angle in radians between 

, or the principal value in the case of a complex argument. atan2 takes only real 
arguments and returns a result between  and , acot returns an angle in radians 
between 0 and  for a real argument or the principal value in the case of a comp
argument.

To convert a result into degrees, either divide the result by the built-in unit deg or type 
deg  in the units placeholder as described in “Displaying Units of Results” on page 

Hyp erbolic Funct ions 

acos(z) Returns the angle (in radians) whose cosine is z.

acot(z) Returns the angle (in radians) whose cotangent is z.

acsc(z) Returns the angle (in radians) whose cosecant is z.

asec(z) Returns the angle (in radians) whose secant is z.

asin(z) Returns the angle (in radians) whose sine is z.

atan(z) Returns the angle (in radians) whose tangent is z.

atan2(x, y) Returns the angle (in radians) from the positive x-axis to point (x, y) in 
the x-y plane.

acosh(z) Returns the number whose hyperbolic cosine is z.

acoth(z) Returns the number whose hyperbolic cotangent is z.

acsch(z) Returns the number whose hyperbolic cosecant is z.

asech(z) Returns the number whose hyperbolic secant is z.

asinh(z) Returns the number whose hyperbolic sine is z.

atanh(z) Returns the number whose hyperbolic tangent is z.

cosh(z) Returns the hyperbolic cosine of z.

coth(z) Returns , the hyperbolic cotangent of z.

csch(z) Returns , the hyperbolic cosecant of z.

sech(z) Returns , the hyperbolic secant of z.

sinh(z) Returns the hyperbolic sine of z.

tanh(z) Returns , the hyperbolic tangent of z.

π 2⁄–
π 2⁄

π– π
π

1 z( )tanh⁄

1 z( )sinh⁄

1 z( )cosh⁄

z( )sinh z( )cosh⁄
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Lo g  and Ex p onent ia l Funct ions 

Mathcad’s exponential and logarithmic functions can accept and return complex
arguments. ln returns the principal branch of the natural log function.

Bessel Funct ions 

exp(z) Returns e raised to the power z.

ln(z) Returns the natural log of z. ( ).

log(z, b) Returns the base b logarithm of z. ( , ). If b is omitted, returns 
the base 10 logarithm.

Pro Returns the value of the Airy function of the first kind. x must be real.

Pro Returns the value of the imaginary Bessel Kelvin function of order n.

Pro Returns the value of the real Bessel Kelvin function of order n.

Pro Returns the value of the Airy function of the second kind. x must be real.

Returns the value of the zeroth order modified Bessel function of the f
kind. x must be real.

Returns the value of the first order modified Bessel function of the fi
kind. x must be real.

Returns the value of the mth order modified Bessel function of the first
kind. x must be real, m is an integer,  .

Returns the value of the zeroth order Bessel function of the first kindx 
must be real.

Returns the value of the first order Bessel function of the first kind. x 
must be real.

Returns the value of the mth order Bessel function of the first kind. x real, 
.

Pro Returns the value of the spherical Bessel function of the first kind, o
integer order n. , .

Returns the value of the zeroth order modified Bessel function of the
second kind. x real, .

Returns the value of the first order modified Bessel function of the 
second kind. x real, .

Returns the value of the mth order modified Bessel function of the 
second kind. , m is an integer, .

z 0≠

z 0≠ b 0≠

Ai x( )

bei n x,( )

ber n x,( )

Bi x( )

I0 x( )

I1 x( )

In m x,( )
0 m 100≤ ≤

J0 x( )

J1 x( )

Jn m x,( )
0 m 100≤ ≤

js n x,( )
x 0> n 200–≥

K0 x( )
x 0>

K1 x( )
x 0>

Kn m x,( )
x 0> 0 m 100≤ ≤
Core Mathematical Functions 147



sed 
 
r. See 

ind. 

d. 

 

, of 

h 
Com p lex Num bers

Piecew ise  Cont inuous Funct ions

Not e The if function is generally useful for branching in calculation: choosing one of two values ba
on a condition. Although the first argument of the if function, cond, can be any expression at all,
it is usually a Boolean expression that relates two math expressions with a Boolean operato
“Arithmetic and Boolean Operators” on page 125.   

Returns the value of the zeroth order Bessel function of the second k
x real, .

Returns the value of the first order Bessel function of the second kinx 
real, .

Returns the value of the mth order Bessel function of the second kind.
, m is an integer, .

Pro Returns the value of the spherical Bessel function of the second kind
integer order n. x must be real.  , .

arg(z) Returns the angle in complex plane from real axis to z. The result is 
between −π and π radians.

csgn(z) Returns 0 if , 1 if  or (  and ), 
−1 otherwise.

Im(z) Returns the imaginary part of a number z. 

Re(z) Returns the real part of a number z. 

signum(z) Returns 1 if ,  otherwise.

if(cond, tvl, fvl) Returns tvl if cond is nonzero (true), fvl if cond is zero (false). cond 
is usually a Boolean expression.

δ(m, n) Kronecker’s delta function. Returns 1 if , 0 otherwise. Bot
arguments must be integers.

ε(i, j, k) Completely antisymmetric tensor of rank 3. i, j, and k must be 
integers between 0 and 2 inclusive (or between ORIGIN and
ORIGIN + 2 inclusive if ORIGIN≠0). Result is 0 if any two are the 
same, 1 for even permutations,  for odd permutations.

Φ(x) Heaviside step function. Returns 1 if , 0 otherwise. x must be 
real.

sign(x) Returns 0 if , 1 if , and  otherwise. x must be real.

Y0 x( )
x 0>

Y1 x( )
x 0>

Yn m x,( )
x 0> 0 m 100≤ ≤

ys n x,( )
x 0> n 200–≥

z 0= Re z( ) 0> Re z( ) 0= Im z( ) 0>

z 0= z z⁄

m n=

1–

x 0≥

x 0= x 0> 1–
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Num ber Theor y / Com bina tor ics

Truncat ion  and Round- Off Funct ions 

Sp ecia l Funct ions

combin(n, k) Returns the number of combinations: the number of subsets of s
k that can be formed from n objects. n and k integers, .

gcd(A, B, C, ...) Returns the greatest common divisor: the largest integer that eve
divides all the elements in arrays or scalars A, B, C, ... The elements 
of A, B, C, ... must be non-negative integers.

lcm(A, B, C, ...) Returns the least common multiple: the smallest positive integer t
is a multiple of all the elements in the arrays or scalars A, B, C, ... 
The elements of A, B, C, ... must be non-negative integers.

mod(x, y) Remainder on dividing real number x by y ( ). Result has same 
sign as x.

permut(n, k) Returns the number of permutations: the number of ways of order
n distinct objects taken k at a time. n and k integers, .

ceil(x) Least integer ≥ x (x real).

floor(x) Greatest integer ≤ x (x real). 

round(x, n) Rounds real number x to n decimal places. If , x is rounded to 
the left of the decimal point. If n is omitted, returns x rounded to the 
nearest integer.

trunc(x) Returns the integer part of a real number x by removing the 
fractional part.

erf(x) Returns the value of the error function at x. x must be real.

erfc(x) Returns the value of the complementary error function at x: 
. x real.

Pro fhyper(a, b, c, x) Returns the value of the Gauss hypergeometric function at the p
x given parameters a, b, c. .

Γ(z) Returns the value of the classical Euler gamma function at z, a real 
or complex number. Undefined for 

Γ(x, y) Returns the value of the extended Euler gamma function for rea
numbers , .

Pro Her(n, x) Returns the value of the Hermite polynomial of degree n at x.

Pro ibeta(a, x, y) Returns the value of the incomplete beta function of x and y with 
parameter a. 

0 k n≤ ≤

y 0≠

0 k n≤ ≤

n 0<

1 erf x( )–

1– x 1< <

z 0 1– 2– …, , ,=

x 0> y 0≥

0 a 1≤ ≤
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Discrete Transform  Funct ions

Mathcad contains a variety of functions for performing discrete transforms. All of th
functions require vectors as arguments. 

Not e When you define a vector v for use with Fourier or wavelet transforms, Mathcad indexes the
vector beginning at 0, by default, unless you have set the value of the built-in variable OR
to a value other than 0 (see page 98). If you do not define , Mathcad automatically sets
zero. This can distort the results of the transform functions.

Four ie r Transform s on  Rea l and Com p lex  Da ta

Pro Jac(n, a, b, x) Returns the value of the Jacobi polynomial of degree n at x with 
parameters a and b.

Pro Lag(n, x) Returns the value of the Laguerre polynomial of degree n at x.

Pro Leg(n, x) Returns the value of the Legendre polynomial of degree n at x.

Pro mhyper(a, b, x) Returns the value of the confluent hypergeometric function at th
point x given parameters a and b.

Pro Tcheb(n, x) Returns the value of the Chebyshev polynomial of degree n, of the 
first kind, at x.

Pro Ucheb(n, x) Returns the value of the Chebyshev polynomial of degree n, of the 
second kind, at x.

cfft(A) Returns the fast Fourier transform of a vector or matrix of complex d
representing equally spaced measurements in the time domain. The 
returned is the same size as its argument.

icfft(A) Returns the inverse Fourier transform of a vector or matrix of data 
corresponding to cfft. Returns an array of the same size as its argume

fft(v) Returns the fast discrete Fourier transform of a  element vector of 
data representing measurements at regular intervals in the time dom

.

ifft( v) Returns the inverse Fourier transform of a vector of data correspond

to fft. Takes a vector of size , and returns a real vector of si

. .

CFFT(A) Returns a transform identical to cfft, except using a different normalizing
factor and sign convention.

ICFFT(A) Returns the inverse Fourier transform of a vector or matrix of data 
corresponding to CFFT. Returns an array of the same size as its argum

v0

2m

m 2>

1 2n 1–+

2n n 2>
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Mathcad comes with two types of Fourier transform pairs: fft / ifft (or the alternative 
FFT / IFFT) and cfft / icfft (or the alternative CFFT / ICFFT). These functions are discrete
they apply to and return vectors and matrices only. You cannot use them with ot
functions. 

Use the fft and ifft (or FFT / IFFT) functions if:

• the data values in the time domain are real, and

• the data vector has  elements.

Use the cfft and icfft (or CFFT / ICFFT) functions in all other cases.

Be sure to use these functions in pairs. For example, if you used CFFT to go from the 
time domain to the frequency domain, you must use ICFFT to transform back to the 
time domain. See Figure 10-1 for an example.

Not e Different sources use different conventions concerning the initial factor of the Fourier trans
and whether to conjugate the results of either the transform or the inverse transform. The
functions fft, ifft, cfft, and icfft use  as a normalizing factor and a positive exponent in
going from the time to the frequency domain. The functions FFT, IFFT, CFFT, and ICFFT 
use  as a normalizing factor and a negative exponent in going from the time to the 
frequency domain. 

FFT(v) Returns a transform identical to fft, except using a different normalizing
factor and sign convention.

IFFT(v) Returns the inverse Fourier transform of a vector of data correspond
to FFT. Takes a vector of size , and returns a real vector of s

.

Figure 10-1: Use of fast Fourier transforms in Mathcad. Since the random 
number generator gives different numbers every time, you may not be able to 
recreate this example exactly as you see it.

1 2n 1–+
2n

2m

1 N⁄

1 N⁄
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W avelet  Transform s 

Vector and Mat r ix  Funct ions 

Note that functions that expect vectors always expect column vectors rather than
vectors. To change a row vector into a column vector, use the transpose operator

 on the Matrix toolbar).

Size  and Sco p e  of  an  Ar ra y

Sp ecia l T yp es of  Ma t r ices

Pro wave(v) Returns the discrete wavelet transform of v, a  element vector 
containing real data, using the Daubechies four-coefficient wavelet fil
The vector returned is the same size as v.

Pro iwave(v) Returns the inverse discrete wavelet transform of v, a  element vector 
containing real data. The vector returned is the same size as v.

cols(A) Returns the number of columns in array A. If A is a scalar, returns 0.

last(v) Returns the index of the last element in vector v. 

length(v) Returns the number of elements in vector v. 

max(A, B, C, ...) Returns the largest of the strings, arrays, or scalars A, B, C, ... If any 
value is complex, returns the largest real part plus i times the largest 
imaginary part.

min(A, B, C, ...) Returns the smallest of the strings, arrays, or scalars A, B, C, ... If 
any value is complex, returns the smallest real part plus i times the 
smallest imaginary part.

rows(A) Returns the number of rows in array A. If A is a scalar, returns 0.

Pro diag(v) Returns a diagonal matrix containing on its diagonal the elemen
of v. 

Pro geninv(A) Returns the left inverse matrix L  of A, such that , where 
I  is the identity matrix having the same number of columns as A. 
Matrix A is an  real-valued matrix, where .

identity(n) Returns an  matrix of 0’s with 1’s on the diagonal.

rref(A) Returns the reduced-row echelon form of A. 

2m

2m

L A⋅ I=

m n× m n≥

n n×
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Sp ecia l Character ist ics of  a  M at r ix

Form in g  N ew  M at r ices

Figure 10-2: Functions for transforming arrays.

Pro cond1(M ) Returns the condition number of the matrix M  based on the  norm.

Pro cond2(M ) Returns the condition number of the matrix M based on the  norm.

Pro conde(M ) Returns the condition number of the matrix M  based on the Euclidean 
norm.

Pro condi(M ) Returns the condition number of the matrix M  based on the infinity 
norm.

Pro norm1(M ) Returns the  norm of the matrix M .

Pro norm2(M ) Returns the  norm of the matrix M .

Pro norme(M ) Returns the Euclidean norm of the matrix M .

Pro normi(M ) Returns the infinity norm of the matrix M .

rank(A) Returns the rank of the real-valued matrix A.

tr(M ) Returns the sum of the diagonal elements, known as the trace, of M . 

augment(A, B, C, ...)   Returns an array formed by placing A, B, C, ... left 
to right. A, B, C, ... are arrays having the same 
number of rows or they are scalars and single-row 
arrays.

L1

L2

L1

L2
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Not e For the functions CreateMesh and CreateSpace, instead of using a vector-valued function, F, 
you can use three functions, f1, f2, and f3, representing the x-, y-, and z-coordinates of the 
parametric surface or space curve. Your call to one of these functions might look somethin

this: .

Alternatively, for CreateMesh, you can use a single function of two variables such as 

.

Figure 10-3 shows examples of using stack and augment.

CreateMesh(F, [[s0], 
[s1], [t0], [t1], [sgrid], 
[tgrid], [fmap]])

Returns a nested array of three matrices 
representing the x-, y-, and z-coordinates of a 
parametric surface defined by the function, F. F is 
a three-element vector-valued function of two 
variables. s0, s1, t0, and t1 are the variable limits, 
and sgrid and tgrid are the number of gridpoints. 
All must be real scalars. fmap is a three-element 
vector-valued mapping function. All arguments 
but the function argument are optional.

CreateSpace(F,[[ t0], [t1], 
[tgrid], [fmap]])

Returns a nested array of three vectors 
representing the x-, y-, and z-coordinates of a space 
curve defined by the function, F. F is a three-
element vector-valued function of one variable. t0 
and t1 are the variable limits, and tgrid is the 
number of gridpoints. All must be real scalars. 
fmap is a three-element vector-valued mapping 
function. All arguments but the function argument 
are optional.

matrix(m, n, f) Creates a matrix in which the i,j th element 
contains  where  and 

. Function f must have been 
defined previously in the worksheet.

stack(A, B, C, ...) Returns an array formed by placing A, B, C, ... top 
to bottom. A, B, C, ... are arrays having the same 
number of columns or they are scalars and vectors.

submatrix(A, ir , jr , ic, jc) Returns a submatrix of A  consisting of all 
elements contained in rows ir  through jr  and 
columns ic through jc. Make sure  and 

 or the order of rows or columns will be 
reversed.

f i j,( ) i 0 1 … m 1–, , ,=

j 0 1 … n 1–, , ,=

ir jr≤
ic jc≤

CreateMesh f1 f2 f3, ,( )

F x y,( ) x( )sin y( )cos+
2

--------------------------------------=
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Eig enva lues and Ei g envectors

 Figure 10-4 shows how some of these functions are used.

Figure 10-3: Joining matrices with the augment and stack functions.

eigenvals(M ) Returns a vector containing the eigenvalues of the square matrixM .

eigenvec(M , z) Returns a vector containing the normalized eigenvector 
corresponding to the eigenvalue z of the square matrix M .

Pro eigenvecs(M ) Returns a matrix containing normalized eigenvectors correspond
to the eigenvalues of the square matrix M . The nth column of the 
matrix returned is an eigenvector corresponding to the nth 
eigenvalue returned by eigenvals.

Pro genvals(M , N) Returns a vector v of computed eigenvalues each of which satisfie
the generalized eigenvalue problem . Vector x is 
the corresponding eigenvector. M  and N are real square matrices 
having the same number of columns. 

Pro genvecs(M , N) Returns a matrix containing the normalized eigenvectors 
corresponding to the eigenvalues in v, the vector returned by 
genvals. The nth column of this matrix is the eigenvector x 
satisfying the generalized eigenvalue problem 

Matrices M  and N are real-valued square matrices having the sam
number of columns. 

M x⋅ vi N x⋅ ⋅=

M x⋅ vn N x⋅ ⋅=
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Solv in g  a  Linear  S y stem  of  E q ua t ions

With Mathcad Professional, you can use the lsolve function to solve a linear system of
equations whose coefficients are arranged in a matrix M . 

Not e The argument M  for lsolve must be a matrix that is neither singular nor nearly singular. An 
alternative to lsolve is to solve a linear system by using matrix inversion. See “Solving and 
Optimization Functions” on page 157 for additional solving functions.

Decom p osit ion

Figure 10-4: Eigenvalues and eigenvectors in Mathcad.

Pro lsolve(M , v) Returns a solution vector x such that . v is a vector having the 
same number of rows as the matrix M .

Pro cholesky(M ) Returns a lower triangular matrix L  such that . This 
uses only the upper triangular part of M . The upper triangular of M , 
when reflected about the diagonal, must form a positive definite
matrix.

Pro lu(M ) Returns a single matrix containing the three square matrices P, L , 
and U, all having the same size as M  and joined together side by 
side, in that order. These three matrices satisfy the equation 

, where L and U are lower and upper triangular 
respectively.

Pro qr(A) Returns a matrix whose first n columns contain the square, 
orthonormal matrix Q, and whose remaining columns contain the
upper triangular matrix, R. Matrices Q and R satisfy the equation 

, where A is a real-valued array.

M x⋅ v=

L L T⋅ M=

P M⋅ L U⋅=

A Q R⋅=
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Sor t in g  Funct ions      

Tip Unless you change the value of ORIGIN, matrices are numbered by default starting with 
zero and column zero. To sort on the first column of a matrix, for example, use csort(A, 0). 

Solvin g  and O p t im izat ion Funct ions

This section describes how to solve equations ranging from a single equation in 
unknown to large systems with multiple unknowns. The techniques described he
generate numeric solutions. Chapter 14, “Symbolic Calculation,” describes a var
of techniques for solving equations symbolically.

Findin g  Roots 

Pro svd(A) Returns a single matrix containing two stacked matrices U and V, 
where U is the upper  submatrix and V is the lower  
submatrix. Matrices U and V satisfy the equation 

, where s is a vector returned by svds(A). 

A is an  array of real values, where .

Pro svds(A) Returns a vector containing the singular values of the  rea

valued array A, where .

csort(A, n) Returns an array formed by rearranging rows of the matrix A such 
that the elements in column n are in ascending order. The result ha
the same size as A.

reverse(A) Returns an array in which the elements of a vector, or the rows o
matrix, are in reverse order.

rsort(A, n) Returns an array formed by rearranging the columns of the matriA 
such that the elements in row n are in ascending order. The result ha
the same size as A.

sort(v) Returns the elements of the vector v sorted in ascending order.

polyroots(v) Returns the roots of an nth degree polynomial whose coefficients 
are in v, a vector of length . Returns a vector of length n.

root(f(z), z) Returns the value of z which the expression f(z) is equal to 0. The 
arguments are a real- or complex-valued expression f(z) and a real 
or complex scalar, z. Must be preceded in the worksheet by a 
guess value for z. Returns a scalar.

root(f(z), z, a, b) Returns the value of z lying between a and b at which the 
expression f(z) is equal to 0. The arguments to this function are a
real-valued expression f(z), a real scalar, z, and real endpoints 
a<b. No guess value for z is required. Returns a scalar.

m n× n n×

A U diag s( ) VT⋅ ⋅=

m n× m n≥

m n×
m n≥

n 1+
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Not e When you specify the arguments a and b for the root function, Mathcad will only find a root for
the function f if f(a) is positive and f(b) is negative or vice versa.

The root function solves a single equation in a single unknown. This function take
arbitrary expression or function and one of the variables from the expression. root can 
also take a range in which the solution lies. It then varies that variable until the 
expression is equal to zero and lies in the specified range. Once this is done, the fu
returns the value that makes the expression equal zero and lies in the specified 

Tip root makes successive estimates of the value of the root and returns a value when the tw
recent estimates differ by less than the value of the tolerance parameter, TOL. As describ
“Built-in Variables” on page 98, you can change the value of the tolerance, and hence the
accuracy of the solution, by including definitions for TOL directly in your worksheet. You c
also change the tolerance by using the Built-In Variables tab when you choose Options from the 
Math  menu. 

To find the roots of a polynomial or an expression having the form:

you can use polyroots rather than root. polyroots does not require a guess value, and
polyroots returns all roots at once, whether real or complex. Figure 10-5 shows 
examples.

By default, polyroots uses a LaGuerre method of finding roots. If you want to use 
companion matrix method instead, click on the polyroots function with the right mouse 
button and choose Companion Matrix  from the pop-up menu.

Not e root and polyroots can solve only one equation in one unknown, and they always return 
numerical answers. To solve several equations simultaneously, use the techniques descr
the next section, “Linear/Nonlinear System Solving and Optimization.” To solve an equati
symbolically, or to find an exact numerical answer in terms of elementary functions, choo

Figure 10-5: Finding roots with root and polyroots.

vnxn … v2x2 v1x v0+ + + +
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Solve for Variable from the Symbolic menu or use the solve keyword. See Chapter 14, 
“Symbolic Calculation.”

Linear/ Non linear  S y stem  Solv in g  and O p t im iza t ion    
Mathcad includes powerful numerical solving functions that readily solve problem
the following types:

• Linear systems of equations with constraints (equalities or inequalities).

• Nonlinear systems of equations with constraints.

• Optimization (maximization or minimization) of an objective function.

• Optimization (maximization or minimization) of an objective function with
constraints.

• Linear programming, in which all constraints are either equalities or inequalit
that compare linear functions to constants and the objective function is of the fo

Pro • Quadratic programming, in which all constraints are linear but the objective 
function contains not only linear terms but also quadratic terms. Quadratic prog
ming features are available in the Solving and Optimization Extension Pack (Expert 
Solver) for Mathcad Professional, available for separate sale from MathSoft or y
local distributor or reseller.

Not e The size of the problem you can solve depends on your version of Mathcad. Mathcad Sta
solves systems of up to 50 variables, while Mathcad Professional solves nonlinear system
to 200 variables and linear systems of up to 500 variables. The Solving and Optimization 
Extension Pack (Expert Solver) for Mathcad Professional solves nonlinear systems of up to 2
variables, linear systems of up to 1000 variables, and quadratic systems of up to 1000 va

Solve  Blocks

The general form for using system solving functions in Mathcad is within the bod
a solve block. There are four general steps to creating a solve block. These are:

1. Provide an initial guess (definition) for each of the unknowns you intend to so
for. Mathcad solves equations by making iterative calculations that ultimately
converge on a valid solution. The initial guesses you provide give Mathcad a p
to start searching for solutions. Guess values are usually required for all syst

2. Type the word Given in a separate math region below the guess definitions. Th
tells Mathcad that what follows is a system of constraint equations. Be sure y
don’t type “Given” in a text region. 

3. Now enter the constraints (equalities and inequalities) in any order below the 

Given. Make sure you use the bold equal symbol (click  on the Boolean toolbar 
or press [Ctrl ]=) for any equality. You can separate the left and right sides of
inequality with any of the symbols <, >, ≤, and ≥.  

4. Enter any equation that involves one of the functions Find, Maximize, Minimize, or 
Minerr below the constraints.

c0x0 c1x1 … cnxn+ + +
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Not e Solve blocks cannot be nested inside each other—each solve block can have only one Given and 
one Find (or Maximize, Minimize, or Minerr). You can, however, define a function like 

 at the end of one solve block and refer to this function in another solve blo

Solve  Blocks

Tip Unlike most Mathcad functions, the solving functions Find, Maximize, Minerr, and Minimize 
can be entered in math regions with either an initial lowercase or an initial capital letter.

Figure 10-6 shows a solve block with several kinds of constraints and ending wit
call to the Find function. There are two unknowns. As a result, the Find function here 
takes two arguments, x and y, and returns a vector with two elements. 

Find(z0, z1, . . .) Returns values of z0, z1, . . . that satisfy the constraints in a 
solve block. z0, z1, . . . are real or complex scalars, vectors, 
arrays, or individual elements of vectors equal in number to 
number of unknowns in the system. Returns a scalar for a 
single unknown; otherwise returns a vector of solutions.   

Maximize(f, z0, z1, . . .) Returns values of z0, z1, . . . that make the function f take on 
its largest value. z0, z1, . . . are real or complex scalars, vectors
arrays, or individual elements of vectors equal in number to 
number of unknowns in the system. Returns a scalar for a 
single unknown; otherwise returns a vector of solutions. So
block constraints are optional.

Minerr(z0, z1, . . .) Returns values of z0, z1, . . . that come closest to satisfying th
constraints in a solve block. z0, z1, . . . are real or complex 
scalars, vectors, arrays, or individual elements of vectors eq
in number to the number of unknowns in the system. Return
scalar for a single unknown; otherwise returns a vector of 
solutions.

Minimize(f, z0, z1, .. .) Returns values of z0, z1, . . . that make the function f take on 
its smallest value. z0, z1, . . . are real or complex scalars, 
vectors, arrays, or individual elements of vectors equal in 
number to the number of unknowns in the system. Returns
scalar for a single unknown; otherwise returns a vector of 
solutions. Solve block constraints are optional.

f x( ) Find x( ):=
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Const ra in ts

The table below lists the kinds of constraints that can appear in a solve block bet
the keyword Given and one of the functions Find, Maximize, Minerr, and Minimize. In 
the table, x and y represent real-valued expressions, and z and w represent arbitrary 
expressions. The Boolean constraints are inserted using buttons on the Boolean to
While constraints are often scalar expressions, they may also be vector or array
expressions.     

Condit ion But ton De scri p t ion

Mathcad does not allow the following inside a solve block:

• Constraints with “≠.” 
• Assignment statements (statements like x:=1 ).

Figure 10-6: A solve block with both equalities and inequalities.

Constrained to be equal.

Greater than. 

Less than.

Greater than or equal to. 

Less than or equal to. 

And

Or

Xor (Exclusive Or)

Not

w z=

x y>

x y<

x y≥

x y≤

x y∧

x y∨

x y⊗

x¬
Solving and Optimization Functions 161



tions 
tional 

g 

ues 
 less 

be 
 such 

 

or for 

wns 

ing 
lock. 

lvers.
You can, however, include compound statements such as .

Not e Mathcad returns only one solution for a solve block. There may, however, be multiple solu
to a set of equations. To find a different solution, try different guess values or enter an addi
inequality constraint that the current solution does not satisfy.   

Tolerances for  solving

Mathcad’s numerical solvers make use of two tolerance parameters in calculatin
solutions in solve blocks:

• Convergence tolerance. The solvers calculate successive estimates of the val
of the solutions and return values when the two most recent estimates differ by
than the value of the built-in variable TOL. A smaller value of TOL often results in 
a more accurate solution, but the solution may take longer to calculate.

• Constraint tolerance. This parameter, determined by the value of the built-in 
variable CTOL, controls how closely a constraint must be met for a solution to 
acceptable. For example, if the constraint tolerance were 0.0001, a constraint
as  would be considered satisfied if, in fact, the value of x satisfied .

Procedures for modifying the values of these tolerances are described in “Built-in
Variables” on page 98.

Tip If you use Minerr in a solve block, you should always include additional checks on the 
reasonableness of the results. The built-in variable ERR returns the size of the error vect
the approximate solution returned by Minerr. There is no built-in variable for determining the 
size of the error for individual solutions to the unknowns. 

Solving a lgor ithm s and AutoSe lect

When you solve an equation, by default Mathcad uses an AutoSelect procedure to 
choose an appropriate solving algorithm. You can override Mathcad’s choice of 
algorithm and select another available algorithm yourself.

Here are the available solving methods:

Linear

Applies a linear programming algorithm to the problem. Guess values for the unkno
are not required.

Nonlinear

Applies either a conjugate gradient, Levenberg-Marquardt, or quasi-Newton solv
routine to the problem. Guess values for all unknowns must precede the solve b
If you use Mathcad Professional, choose Nonlinear⇒Advanced Options from the 
pop-up menu to control settings for the conjugate gradient and quasi-Newton so

Not e The Levenberg-Marquardt method is not available for the Maximize and Minimize functions.

1 x 3≤ ≤

x 2< x 2.0001<
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Pro Quadra t ic

Applies a quadratic programming algorithm to the problem. The option is availab
only if the Solving and Optimization Extension Pack (Expert Solver) for Mathcad 
Professional is installed. Guess values for the unknowns are not required.

You can override Mathcad’s default choice of solving algorithm as follows:

5. Create and evaluate a solve block, allowing 
Mathcad to AutoSelect an algorithm.

6. Click with the right mouse button on the 
name of the function that terminates the 
solve block, and remove the check from 
AutoSelect on the pop-up menu. 

7. Check one of the available solving methods 
on the pop-up menu. Mathcad recalculates 
the solution using the method you selected.

Pro Rep ort s

If you have the Solving and Optimization Extension Pack (Expert Solver) for Mathcad 
Professional installed, you can generate reports for a linear optimization problem
generate a report, click on a solving function with the right mouse button and cho
Report from the pop-up menu. For more information on reports, refer to the on-li
Help.

Pro Mixed int e g er  p ro g ram m in g  

If you have Solving and Optimization Extension Pack (Expert Solver) for Mathcad 
Professional installed, you can perform mixed integer programming. Using mixe
integer programming you can force the solution for an unknown variable to be a bi
number (1 or 0) or an integer. For more information mixed integer programming, r
to the on-line Help.

Stat ist ics, Probabilit y , and Data  Ana l y sis Funct ions

Sta t ist ics 

corr(A, B) Returns the Pearson’s r correlation coefficient for the  
arrays A and B.

cvar(A, B) Returns the covariance of the elements in  arrays A and B.

gmean(A, B, C, ...) Returns the geometric mean of the elements of the arrays or 
scalars A, B, C, ... All elements must be real and greater than 0

m n×

m n×
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Probabilit y  Dist r ibu t ions
Mathcad includes functions for working with several common probability densitie
These functions fall into four classes:

• Probability densities. These functions, beginning with the letter “d,” give the 
likelihood that a random variable will take on a particular value. 

• Cumulative probability distributions.  These functions, beginning with the lette
“p,” give the probability that a random variable will take on a value less than or 
equal to a specified value. These are obtained by simply integrating (or summ
when appropriate) the corresponding probability density from  to a specifi
value. 

• Inverse cumulative probability distributions. These functions, beginning with 
the letter “q,” take a probability p between 0 and 1 as an argument and return a

hist(int , A) Returns a vector representing the frequencies with which valu
in A  fall in the intervals represented by int . When int  is a vector 
of intervals in ascending order, the ith element of the returned 
vector is the number of points in data falling between the ith and 
(i+1)th element of int . When int  is a an integer, it is the number
of subintervals of equal length. Both int  and A must be real. 

hmean(A, B, C, ...) Returns the harmonic mean of the elements of the arrays or 
scalars A, B, C, ... All elements must be nonzero.

kurt(A, B, C, ...) Returns the kurtosis of the elements of the arrays or scalars A, B, 
C, ...

mean(A, B, C, ...) Returns the arithmetic mean of the elements of the arrays or 
scalars A, B, C, ...

median(A, B, C, ...) Returns the median of the elements of the arrays or scalars A, B, 
C, ... the value above and below which there are an equal num
of values. If there are an even number of elements, this is the
arithmetic mean of the two central values.

mode(A, B, C, ...) Returns the element from the arrays or scalars A, B, C, ... that 
occurs most often.

skew(A, B, C, ...) Returns the skewness of the elements of the arrays or scalarA, 
B, C, ...

stdev(A, B, C, ...) Returns the population standard deviation (square root of the
variance) of the elements of the arrays or scalars A, B, C, ... 

Stdev(A, B, C, ...) Returns the sample standard deviation (square root of the sam
variance) of the elements of the arrays or scalars A, B, C, ... 

var(A, B, C, ...) Returns the population variance of the elements of the arrays
scalars A, B, C, ... 

Var(A, B, C, ...) Returns the sample variance of the elements of the arrays or
scalars A, B, C, ...

∞–
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value such that the probability that a random variable will be less than or equal to 
that value is p.

• Random number generators. These functions, beginning with the letter “r,” return
a vector of m elements drawn from the corresponding probability distribution. Ea
time you recalculate an equation containing one of these functions, Mathcad 
generates new random numbers. 

Tip Mathcad’s random number generators have a “seed value” associated with them. A given
value always generates the same sequence of random numbers, and choosing Calculate from the 
Math  menu advances Mathcad along this random number sequence. Changing the seed
however, advances Mathcad along a different random number sequence. To change the 
value, choose Options from the Math  menu and enter a value on the Built-In Variables tab. 

Not e See comments above about the nomenclature, arguments, and returned values for the pro
distribution functions in the following table.

Probabilit y  Dist r ibu t ions

 

qbeta(p, )

Probability distribution functions for the beta distribution i
which  are the shape parameters. . 

.

dbinom(k, n, p)
pbinom(k, n, p)
qbinom(p, n, r)
rbinom(m, n, p)

Probability distribution functions for the binomial 
distribution in which n and k are integers satisfying 

. . r is the probability of success on a 
single trial.

dcauchy(x, l, s)
pcauchy(x, l, s)
qcauchy(p, l, s)
rcauchy(m, l, s)

Probability distribution functions for the Cauchy 
distribution in which l is a location parameter and  is 

scale parameter. .

dchisq(x, d)
pchisq(x, d)
qchisq(p, d)
rchisq(m, d)

Probability distribution functions for the chi-squared 
distribution in which  are the degrees of freedom an

. .

dexp(x, r)
pexp(x, r)
qexp(p, r)
rexp(m, r)

Probability distribution functions for the exponential 
distribution in which  is the rate and .

dF( )
pF( )
qF( )
rF( )

Probability distribution functions for the F distribution in 
which  are the degrees of freedom and 

. .

dgamma(x, s)
pgamma(x, s)
qgamma(p, s)
rgamma(m, s)

Probability distribution functions for the gamma 
distribution in which  is the shape parameter and 

. .

dbeta x s1 s2, ,( )
pbeta x s1 s2, ,( )

s1 s2,
rbeta m s1 s2, ,( )

s1 s2, 0>( ) 0 x 1< <

0 p 1≤ ≤

0 k n≤ ≤ 0 p 1≤ ≤

s 0>
0 p 1< <

d 0>
x 0≥ 0 p≤ 1<

r 0> x 0≥ 0 p≤ 1<

x d1 d2, ,
x d1 d2, ,
p d1 d2, ,
m d1 d2, ,

d1 d2, 0>( )

x 0≥ 0 p≤ 1<

s 0>
x 0≥ 0 p≤ 1<
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Tip Two additional functions that are useful for common probability calculations are rnd(x), which 
is equivalent to runif(1, 0, x), and cnorm(x), which is equivalent to pnorm(x, 0, 1).

dgeom(k, p)
pgeom(k, p)
qgeom(p, r)
rgeom(m, p)

Probability distribution functions for the geometric 
distribution in which  is the probability of succes
and k is a nonnegative integer. r is the probability of success
on a single trial.

dhypergeom(M, a, b, n)
phypergeom(M, a, b, n)
qhypergeom(p, a, b, n)
rhypergeom(M, a, b, n)

Probability distribution functions for the hypergeometric 
distribution in which M, a, b, and n are integers with 

, , and . . 

dlnorm( )
plnorm( )
qlnorm( )
rlnorm(m, µ, σ)

Probability distribution functions for the lognormal 
distribution in which µ is the logmean and  is the 

logdeviation. . .

dlogis(x, l, s)
plogis(x, l, s)
qlogis(p, l, s)
rlogis(m, l, s)

Probability distribution functions for the logistic 
distribution in which l is the location parameter and  i

the scale parameter. .

dnbinom(k, n, p)
pnbinom(k, n, p)
qnbinom(p, n, r)
rnbinom(m, n, p)

Probability distribution functions for the negative binomia
distribution in which  and n and k are integers, 

 and .

dnorm( )
pnorm( )
qnorm( )
rnorm(m, µ, σ)

Probability distribution functions for the normal 
distribution in which µ and σ are the mean and standard 
deviation. .

dpois(k, λ)
ppois(k, λ)
qpois(p, λ)
rpois(m, λ)

Probability distribution functions for the Poisson 
distribution in which  and k is a nonnegative integer.

.

dt(x, d)
pt(x, d)
qt(p, d)
rt(m, d)

Probability distribution functions for Student’s t 
distribution in which  are the degrees of 

freedom. .

dunif(x, a, b)
punif(x, a, b)
qunif(p, a, b)
runif(m, a, b)

Probability distribution functions for the uniform 
distribution in which b and a are the endpoints of the 
interval with . .

dweibull(x, s)
pweibull(x, s)
qweibull(p, s)
rweibull(m, s)

Probability distribution functions for the Weibull 
distribution in which  is the shape parameter and 

. .

0 p 1≤<

0 M a≤ ≤ 0 n M– b≤ ≤ 0 n a b+≤ ≤ 0 p≤ 1<

x µ σ, ,
x µ σ, ,
p µ σ, ,

σ 0>
x 0≥ 0 p≤ 1<

s 0>
0 p 1< <

0 p< 1≤
n 0> k 0≥

x µ σ, ,
x µ σ, ,
p µ σ, , σ 0>

λ 0>
0 p 1≤ ≤

d 0>
0 p 1< <

a x b≤ ≤ 0 p 1≤ ≤

s 0>
x 0≥ 0 p 1< <
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I n te r p ola t ion  and Predict ion  Funct ions          

Not e Whenever you use arrays in any of the functions described in this section, be sure that ev
element in the array contains a data value. Mathcad assigns 0 to any elements you have
explicitly assigned.

Interpolation involves using existing data points to predict values between these 
points. Mathcad allows you to connect the data points either with straight lines (li
interpolation) or with sections of a cubic polynomial (cubic spline interpolation). 
Unlike the regression functions discussed in the next section, these interpolation
functions return a curve which must pass through the points you specify. If your 
is noisy, you should consider using regression functions instead (see page 169).

Cubic spline interpolation passes a curve through a set of points in such a way that
first and second derivatives of the curve are continuous across each point. This 
is assembled by taking three adjacent points and constructing a cubic polynomia

Pro bspline(vx, vy, u, n) Returns a vector of coefficients of a B-spline of degree n, which 
is used in the interp function. The knot locations of the spline ar
specified in vector u. vx and vy must be real vectors of the sam
length. The values in vx must be in ascending order. 

cspline(vx, vy) Returns a vector of coefficients of a cubic spline with cubic 
endpoints, which is used in the interp function. vx and vy must be 
real vectors of the same length. The values in vx must be in 
ascending order.

interp(vs, vx, vy, x) Returns the interpolated y value corresponding to the argument x. 
The vector vs is a vector of intermediate results obtained by 
evaluating bspline, cspline, lspline, or pspline or the regression 
routine regress or loess using the data vectors vx and vy. vx and 
vy must be real vectors of the same length. The vector vx must be 
in ascending order.

linterp(vx, vy, x) Uses the data vectors vx and vy to return a linearly interpolated y 
value corresponding to the argument x. vx and vy must be real 
vectors of the same length. The vector vx must be in ascending 
order. 

lspline(vx, vy) Returns a vector of coefficients of a cubic spline with linear 
endpoints, which is used in the interp function. vx and vy must be 
real vectors of the same length. The values in vx must be in 
ascending order.

predict(v, m, n) Returns n predicted values based on m consecutive values from 
the data vector v. Elements in v should represent samples taken a
equal intervals. m and n are integers

pspline(vx, vy) Returns a vector of coefficients of a cubic spline with parabol
endpoints, which is used in the interp function. vx and vy must be 
real vectors of the same length. The values in vx must be in 
ascending order.
Statistics, Probability, and Data Analysis Functions 167
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passing through those points. These cubic polynomials are then strung together to
the completed curve. In the case of “traditional” cubic splines, the data points to 
interpolated define the “knots” where the polynomials are joined, but B-splines 
(implemented in the function bspline) allow you to join the polynomials at arbitrary 
points. 

Linear prediction involves using existing data values to predict values beyond the
existing ones. 

The coefficients returned by the spline interpolation functions bspline, cspline, lspline, 
and pspline and the regression functions regress and loess described in the next section
are designed to be passed to Mathcad’s interp function. interp returns a single 
interpolated y value for a given x value, but as a practical matter you’ll probably be 
evaluating interp for many different points, as shown in Figure 10-7. It usually mak
sense to store the coefficients returned by the spline or regression functions in a v
(such as vs in Figure 10-7) that can be passed to interp for evaluation, plotting, or further 
calculation.

Tip For best results with spline interpolation, do not use the interp function on values of x far from 
the fitted points. Splines are intended for interpolation, not extrapolation.

Not e Mathcad handles two-dimensional cubic spline interpolation in much the same way as the on
dimensional case illustrated: in this case the spline function takes two matrix arguments, Mxy  
and Mz. The first is an  matrix specifying the points along the diagonal of a rectangu
grid, and the second is an  matrix of z-values representing the surface to be interpolate
Mathcad passes a surface through the grid of points. This surface corresponds to a cubic 
polynomial in x and y in which the first and second partial derivatives are continuous in the

Figure 10-7: Spline curve for the points stored in vx and vy. Since the random 
number generator gives different numbers every time, you may not be able to 
recreate this example exactly as you see it.

n 2×
n n×
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corresponding direction across each grid point. For an example see the “Data Analysis” 
QuickSheets and in the Resource Center (choose Resource Center from the Help menu).

Reg ression and Sm ooth in g  Funct ions 
Mathcad includes a number of functions for performing regression. Typically, these 
functions generate a curve or surface of a specified type in some sense minimize
error between itself and the data you supply. The functions differ primarily in the t
of curve or surface they use to fit the data. Unlike interpolation functions, these 
functions do not require that the fitted curve or surface pass through points you su
and they are therefore less sensitive to spurious data.

Smoothing involves taking a set of y (and possibly x) values and returning a new set o
y values that is smoother than the original set. Unlike the regression and interpol
functions, smoothing results in a new set of y values, not a function that can be evaluate
between the data points you specify. Thus, if you are interested in y values between the 
y values you specify, you should use a regression or interpolation function.

Linear  regression

Polynom ia l regression

These functions are useful when you have a set of measured y values corresponding to 
x values (or possibly multiple x values) and you want to fit a polynomial through thos
y values.   

Use regress when you want to use a single polynomial to fit all your data values. The
regress function lets you fit a polynomial of any order. However as a practical mat
you rarely should go beyond .

intercept(vx, vy) Returns a scalar: the y-intercept of the least-squares regression lin
for the data points in vx and vy. 

slope(vx, vy) Returns a scalar: the slope of the least-squares regression line fo
data points in vx and vy.

stderr(vx, vy) Returns the standard error associated with linear regression of t
elements of vy on the elements of vx. 

line(vx, vy) Returns the y-intercept and slope of the line that best approximat
the data in vx and vy.

medfit(vx, vy) Returns the y-intercept and slope of the line that best approximat
the data in vx and vy using median-median regression.

regress(vx, vy, n) Returns a vector of coefficients for the nth degree least-squares 
polynomial fit for the data points specified in vectors vx and vy. 
This vector becomes the first argument of the interp function.

Pro loess(vx, vy, span) Returns a vector specifying a set of second order polynomials 
best fit particular neighborhoods of data points specified in vect
vx and vy. This vector becomes the first argument of the interp 
function. The argument span, , specifies how large a 
neighborhood loess considers in performing this local regression

span 0>

n 4=
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The loess function, available in Mathcad Professional, performs a more localized 
regression. Instead of generating a single polynomial the way regress does, loess 
generates a different second order polynomial depending on where you are on the 
It does this by examining the data in a small neighborhood of a point you’re intereste

As in the case of Mathcad’s spline interpolation functions, the coefficients returne
regress and loess are designed to be passed to Mathcad’s interp function. interp returns 
a single interpolated y value for a given x value, but as a practical matter you’ll probabl
be evaluating interp for many different points.

Not e Mathcad also allows multivariate polynomial regression with regress or loess to fit y values 
corresponding to two or more independent variables. In this case, the regression function’
two arguments are Mx  and vy: the first is an  matrix specifying the m values of n predictor 
variables, and the second is a vector of response data corresponding to the factors in Mx . For an 
example see the “Data Analysis” QuickSheets in the Resource Center (choose Resource Center 
from the Help menu). You can add independent variables by simply adding columns to theMx  
array and a corresponding number of rows to the vector you pass to the interp function.    

Specia lized regression

Use these functions when you have a set of measured y values corresponding to x values 
and you want to fit a special type of curve through those y values. Although you can 
use the genfit function described on page 171 to perform a curve fit on any functio
the functions outlined above are simpler. Use them if they address the particular
function curve to which you are fitting your data. 

expfit(vx, vy, vg) Returns the parameter values for the exponential curve

that best approximates the data in vx and vy. Vector vg 
specifies guess values for the three unknown parameters a, b, and c. 
See Figure 10-8 for an example. 

lgsfit(vx, vy, vg) Returns the parameter values for the logistic curve

that best approximates the data in vx and vy. 
Vector vg specifies guess values for the three unknown paramet
a, b, and c.

logfit(vx, vy, vg) Returns the parameter values for the logarithmic curve

that best approximates the data in vx and vy. Vector 
vg specifies guess values for the three unknown parameters a, b, and 
c.

pwrfit(vx, vy, vg)Returns the parameter values for the power curve

that best approximates the data in vx and vy. Vector vg 
specifies guess values for the three unknown parameters a, b, and c.

sinfit(vx, vy, vg) Returns the parameter values for the sine curve
that best approximates the data in vx and vy. 

Vector vg specifies guess values for the four unknown parametera, 
b, and c.

n m×

a e
b x⋅( )

c+⋅

a 1 b e
c– x⋅( )⋅+( )⁄

a x( )bln⋅ c+

a x
b⋅ c+

a x b+( )sin⋅ c+
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Genera lized re g ression

linfit  is designed to model your data by a linear combination of arbitrary function

genfit is designed to model your data by some arbitrary (possibly nonlinear) func
whose parameters must be chosen. For example, if your data is to be modeled by t

and you wish to solve for the unknown parameters  and , you would use genfit. 
An example of using genfit is given in Figure 10-9.

Anything you can do with linfit  you can also do, albeit less conveniently, with genfit. 
The difference between these two functions is the difference between solving a sy
of linear equations and solving a system of nonlinear equations. The latter gene

Figure 10-8: Using the specialized regression function expfit.

linfit( vx, vy, F) Returns a vector containing the coefficients used to create a lin
combination of the functions in F that best approximates the data
points in vectors vx and vy. F is a function which returns a vector
consisting of the functions to be linearly combined. Elements 
vx should be in ascending order.

genfit(vx, vy, vg, F) Returns the parameters for the best fit by the (possibly nonline
function defined by f to the data points in the vectors vx and vy. 
F is a function that returns an  element vector containingf 
and its partial derivatives with respect to each of its n parameters. 
vg is an n-element vector of guess values for the n parameters.

n 1+

y a0 f0 x( )⋅ a1 f1 x( )⋅ … an fn x( )⋅+ + +=

f x( ) 2 a1x( )sin⋅ 3 a2x( )tanh⋅+=

a1 a2
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must be solved by iteration, which explains why genfit needs a vector of guess value
as an argument and linfit  does not. 

Sm oot hin g  funct ions

medsmooth is the most robust of the three smoothing functions since it is least lik
to be affected by spurious data points. This function uses a running median smoo
computes the residuals, smooths the residuals the same way, and adds these tw
smoothed vectors together. Note that medsmooth leaves the first and last  
points unchanged. In practice, the length of the smoothing window, n, should be small 
compared to the length of the data set.

Pro ksmooth, available in Mathcad Professional, uses a Gaussian kernel to compute 
weighted averages of the input vector vy. This smoother is most useful when your dat
lies along a band of relatively constant width. If your data lies scattered along a b

Figure 10-9: Using genfit for finding the parameters of a function so that it 
best fits the data.

medsmooth(vy, n) Returns an m-element vector created by smoothing vy with running 
medians. vy is an m-element vector of real numbers. n is the width 
of the window over which smoothing occurs. n must be an odd 
number less than the number of elements in vy.

Pro ksmooth(vx,vy, b)Returns an n-element vector created by using a Gaussian kerne
return weighted averages of vy. vy and vx are n-element vectors of 
real numbers. The bandwidth b controls the smoothing window and
should be set to a few times the spacing between your x data points. 
Elements in vx must be in ascending order.

Pro supsmooth(vx,vy) Returns an n-element vector created by the piecewise use of a 
symmetric k-nearest neighbor linear least-squares fitting proced
in which k is adaptively chosen. vy and vx are n-element vectors of 
real numbers. The elements of vx must be in increasing order.

n 1–( ) 2⁄
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whose width fluctuates considerably, you should use an adaptive smoother like 
supsmooth, also available in Mathcad Professional. supsmooth uses a symmetric k 
nearest neighbor linear least-squares fitting procedure to make a series of line seg
through your data. Unlike ksmooth which uses a fixed bandwidth for all your data, 
supsmooth adaptively chooses different bandwidths for different portions of your da

Finance Funct ions

These personal finance functions perform a variety of calculations for making cre
and investment decisions. All finance functions take only real values. Payments 
make, such as deposits in a savings account or payments toward a loan, must be e
as negative numbers. Cash you receive, such as dividend checks, must be ente
positive numbers. If you want to specify the timing of a payment, use the optional tim
variable, type, which can be equal to 0 for the end of the period and 1 for the beginn
If omitted, type is 0.

Rate  and p er iod

Ti p If rate does not converge to within  after 20 iterations, rate returns an error. In such a 
case, try different values for guess. In most cases, rate converges if guess is between 0 and 1.

cnper(rate, pv, fv) Returns the number of compounding periods require
for an investment to yield a future value, fv, given a 
present value, pv, and an interest rate period, rate. rate 
> -1. pv > 0. fv > 0.

crate(nper, pv, fv) Returns the fixed interest rate required for an 
investment at present value, pv, to yield a future value, 
fv, over a given number of compounding periods, nper. 
nper is a positive integer. pv > 0. fv > 0.

nper(rate, pmt, pv, [[fv],
[type]])

Returns the number of compounding periods for an
investment or loan based on periodic, constant 
payments, pmt, using a fixed interest rate, rate, and a 
present value, pv. If omitted, fv = 0 and type = 0. If pmt 
> 0, rate and pv must be opposite signs.

rate(nper, pmt, pv, [[ fv],
[type], [guess]])

Returns the interest rate per period of an investment
loan over a number of compounding periods, nper, 
given a periodic, constant payment, pmt, and a present 
value, pv. nper is a positive integer. If omitted, fv = 0, 
type = 0, and guess = 0.1 (10%).

1
7–×10
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Cum ula t ive  in te rest  and p r inci p a l

I n te rest  ra te

Future  va lue

cumint(rate, nper, pv, start, 
end, [type])

Returns the cumulative interest paid on a loan betwe
a starting period, start, and an ending period, end, 
given a fixed interest rate, rate, the total number of 
compounding periods, nper, and the present value of 
the loan, pv. rate ≥ 0. nper, start, and end are positive 
integers. If omitted, type = 0.

cumprn(rate, nper, pv, start, 
end, [type])

Returns the cumulative principal paid on a loan 
between a starting period, start, and an ending period, 
end, given a fixed interest rate, rate, the total number 
of compounding periods, nper, and the present value 
of the loan, pv. rate ≥ 0. nper, start, and end are 
positive integers. If omitted, type = 0.

Figure 10-10: Using the cumint function.

eff(rate, nper) Returns the effective annual interest rate (APR) give
the nominal interest rate, rate, and the number of 
compounding periods per year, nper. nper is positive.

nom(rate, nper) Returns the nominal interest rate given the effective
annual interest rate (APR), rate, and the number of 
compounding periods per year, nper. rate > -1. nper is 
positive.

fv(rate, nper, pmt, [[pv],
 [type]]) 

Returns the future value of an investment or loan ov
a number of compounding periods, nper, given a 
periodic, constant payment, pmt, and a fixed interest 
rate, rate. nper is a positive integer. If omitted, presen
value pv = 0 and type = 0. 

fvadj(prin, v) Returns the future value of an initial principal, prin, 
after applying a series of compound interest rates 
stored in v. v is a vector.
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Not e When using functions that require information about rates and periods, use the same unit o
for each. For example, if you make monthly payments on a four-year loan at an annual in
rate of 12%, use 1% as the interest rate per period (one month) and 48 months as the num
periods.

Paym ent

fvc(rate, v) Returns the future value of a list of cash flows 
occurring at regular intervals, v, earning an interest 
rate, rate. v is a vector.

pmt(rate, nper, pv, [[ fv], 
[type]])  

Returns the payment for an investment or loan base
on periodic constant payments over a given number
compounding periods, nper, using a fixed interest rate,
rate, and a present value, pv. nper is a positive integer. 
If omitted, future value fv = 0 and type = 0.

ipmt(rate, per, nper, pv, [[ fv], 
[type]]) 

Returns the interest payment of an investment or lo
for a given period, per, based on periodic constant 
payments over a given number of compounding 
periods, nper, using a fixed interest rate, rate, and a 
present value, pv. per and nper are positive integers, 
per ≤ nper. If omitted, future value fv = 0 and type = 0.

ppmt(rate, per, nper, pv, [[ fv], 
[type]]) 

Returns the payment on the principal, of a investme
or loan, for a given period, per, based on periodic 
constant payments over a given number of 
compounding periods, nper, using a fixed interest rate,
rate, and a present value, pv. per and nper are positive 
integers, per ≤ nper. If omitted, future value fv = 0 and 
type = 0.

Figure 10-11: Using the pmt, ipmt, and ppmt functions.
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Not e If irr  does not converge to within  of a percentage after 20 iterations, irr  returns an error.  
In such a case, try different values for guess. In most cases, irr  converges if guess is between 0 
and 1.

Present  va lue

Not e irr  and npv are related functions. The internal rate of return (irr ) is the rate for which the net 
present value (npv) is zero.

Different ia l E q ua t ion Funct ions

Pro This section describes how you can use Mathcad Professional to solve different
equations.

In a differential equation, you solve for an unknown function rather than just a varia
For ordinary differential equations, the unknown function is a function of one varia
Partial differential equations are differential equations in which the unknown is a 
function of two or more variables.

The easiest way to solve a single differential equation of any order in Mathcad 
Professional is to use a solve block and the function Odesolve. To solve systems of 
equations or to have more control over the solving process, you can use the gen
purpose differential equation solver rkfixed. Alternatively you can choose from 
additional, more specialized functions for solving differential equations.  

irr(v, [guess]) Returns the internal rate of return for a series of cas
flows, v, occurring at regular intervals. v is a vector 
that must contain at least one positive value and on
negative value. If omitted, guess = 0.1 (10%).

mirr(v, fin_rate, rein_rate) Returns the modified internal rate of return for a seri
of cash flows occuring at regular intervals, v, given a 
finance rate payable on the cash flows you borrow, 
fin_rate, and a reinvestment rate earned on the cas
flows as you reinvest them, rein_rate. v is a vector that 
must contain at least one positive value and one 
negative value.

pv(rate, nper, pmt, [[ fv]
 [type]])

Returns the present value of an investment or loan 
based on periodic constant payments over a given 
number of compounding periods, nper, using a fixed 
interest rate, rate, and a payment, pmt. nper is a 
positive integer. If omitted, fv = 0 and type = 0.

npv(rate, v) Returns the net present value of an investment give
discount rate, rate, and a series of cash flows occurring
at regular intervals, v. v is a vector.

1
5–×10
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Solv in g  a  Dif ferent ia l E q ua t ion Usin g  a  Solve Block

To solve a single differential equation of any order, use a solve block and the function 
Odesolve. A solve block for solving a differential equation is similar to a solve blo
for solving a system of equations as described on page 159. There are three ste
creating a differential equation solve block:

1. Type the word Given. You can type Given or given in any style, but be sure not to
type it in a text region.

2. Type the differential equation and constraints in any order below the word Given. 

Use the bold equal sign (click  on the Boolean toolbar or press [Ctrl ]=) for 
an equality. The independent variable x must be explicitly indicated throughout. A
typical initial value constraint might be y(a)=c or y‘(a)=d; Mathcad does not allow 
more complicated constraints like y(a)+y‘(a)=e. The differential equation can be

written using the derivative operators d/dx, d2/dx2, d3/dx3 , ... (press ? or [Ctrl ]? 
to insert the derivative or nth derivative operators) , or using prime notation y‘(x), 
y‘‘(x) , y‘‘‘(x) , .... (Press [Ctrl ] [F7] for the prime symbol.)

3. Finally, type the Odesolve function. The terminal point b must be larger than the 
initial point a.

Tip Prime notation is only allowed inside a solve block. If you use it outside of a solve block, y
see an error.

The output of Odesolve is a function of x, interpolated from a table of values compute
using the fixed step method employed by the function rkfixed, described below.  If you 
prefer to use an adaptive step method employed by the function Rkadapt:

1. Click on Odesolve with the right mouse button.

2. Choose Adaptive from the pop-up menu.

Pro Odesolve(x, b, [step]) Returns a function of x which is the solution to a single ordinary
differential equation. b is the terminal point of the integration 
interval. step (optional) is the number of steps. 

Figure 10-12: Solving a single differential equation.
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Not e Mathcad is very specific about the types of expressions that can appear between Given and 
Odesolve. The lower derivative terms can appear nonlinearly in the differential equation (e
they can be multiplied together or raised to powers), but the highest derivative term must a
linearly. Inequality constraints are not allowed. There must be n independent equality constraints
for an nth order differential equation. For an initial value problem, the values for y(x) and its first 
n−1 derivatives at a single initial point a are required. For a boundary value problem, the n 
equality constraints should prescribe values for y(x) and certain derivatives at exactly two points
a and b.

Genera l Pur p ose Dif ferent ia l E q ua t ion Solve r: r k f ixed
To solve systems of equations or to specify a starting point for the interval and th
number of points at which to approximate a solution, you can use the differential
equation solver rkfixed. Alternatively you can choose from additional, more specializ
functions for solving differential equations, described in the following section 
“Specialized Differential Equation Solvers.”

First  order  d if fe ren t ia l equat ions

A first order differential equation is one in which the highest order derivative of th
unknown function is the first derivative. To solve a first order differential equation
Mathcad, you can use Odesolve as described in “Solving a Differential Equation Usin
a Solve Block” or you can use rkfixed. rkfixed uses the fourth order Runge-Kutta metho
to solve a first order differential equation and return a two-column matrix in whic

• The left-hand column contains the points at which the solution to the differen
equation is evaluated.

• The right-hand column contains the corresponding values of the solution. 

rkfixed(y, x1, x2, npoints, D)

Figure 10-13 shows how to solve the differential equation subject

the initial condition .

y = A vector of n initial values where n is the order of the differential 
equation or the size of the system of equations you’re solving. For a 
order differential equation, the vector degenerates to one point, 

. 

x1, x2 = The endpoints of the interval on which the solution to the differentia
equations will be evaluated. The initial values in y are the values at x1.

npoints = The number of points beyond the initial point at which the solution is
be approximated. This controls the number of rows ( ) in t
matrix returned by rkfixed.

D(x, y) = An n-element vector-valued function containing the first n derivatives of 
the unknown functions.

y 0( ) y x1( )=

1 npoints+

xd
dy 3 y⋅+ 0=

y 0( ) 4=
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Not e The most difficult part of solving a differential equation using rkfixed, particularly with 
nonlinear differential equations, is solving for the first derivative so you can define the func
D(x, y). In such cases, you can sometimes solve for  symbolically and paste it into th
definition for D(x, y). To do so, use the symbolic solving techniques discussed in the secti
“Examples of Symbolic Calculation” in Chapter 14.

Second and h igher  order  diffe rent ia l equat ions

You can use Odesolve and a solve block, as described on page 177, or you can use
rkfixed to solve higher order differential equations. Using rkfixed to solve a second 
order differential equation is similar to solving a first order differential equation. T
key differences are:

• The vector of initial values y now has two elements: the value of the function an
its first derivative at the starting value, x1.

• The function D(t, y) is now a vector with two elements:

• The solution matrix contains three columns: the left-hand one for the t values; the 
middle one for ; and the right-hand one for .

Figure 10-13: Solving a first order differential equation.

y′ x( )

D t y,( ) y′ t( )
y″ t( )

=

y t( ) y′ t( )
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See Figure 10-14 for an example using rkfixed. See Figure 10-12 for an example usin
Odesolve.

Tip The procedure for solving higher order differential equations is an extension of that used 
second order differential equations. The main differences are that the vector of initial valuy 
now has n elements for specifying initial conditions of y, , the function D is 
now a vector with n elements corresponding to the first n derivatives of the unknown functions,
and the solution matrix contains n columns: the left-hand one for the t values and the remaining 
columns for values of y(t), .

System s of dif fe rent ia l equat ions

Solving a system of differential equations is similar to solving a higher order differen
equation using rkfixed. To solve a system of first order differential equations:

1. Define a vector containing the initial values of each unknown function.

2. Define a vector-valued function containing the first derivatives of each of the
unknown functions.

3. Decide at which points you want to evaluate the solutions.

4. Pass all this information into rkfixed.

rkfixed returns a matrix whose first column contains the points at which the soluti
are evaluated and whose remaining columns contain the solution functions evalu
at the corresponding point. Figure 10-15 shows an example solving the equation

Figure 10-14: Solving a second order differential equation.

y′ y″ … y n 1–( ), , ,

y′ t( ) y″ t( ) … y n 1–( ) t( ), , ,
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Solving a system of nth order differential equations is similar to solving a system o
first order differential equations. The main differences are:

• The vector of initial conditions must contain initial values for the  derivativ
of each unknown function in addition to initial values for the functions themselv

• The vector-valued function must contain expressions for the  derivatives
each unknown function in addition to the nth derivative.

 rkfixed returns a matrix in which the first column contains the values at which the
solutions and their derivatives are to be evaluated, and the remaining columns co
the solutions and their derivatives evaluated at the corresponding point in the firs
column. The order in which the solution and its derivatives appear matches the o
in which you put them into the vector of initial conditions.

Sp ecia lized D iffe ren t ia l E q ua t ion  Solve rs
Mathcad Professional includes several, more specialized functions for solving 
differential equations, and there are cases in which you may want to use these r
than the general-purpose rkfixed. These cases fall into the three categories given belo
Each of these functions solves differential equations numerically: you always get 
a matrix containing the values of the function evaluated over a set of points.

Figure 10-15: A system of first order linear equations.

x′0 t( ) µ x0 t( )⋅ x1 t( )– x0 t( )2 x1 t( )2+( ) x0 t( )⋅–=

x′1 t( ) µ x1 t( )⋅ x0 t( ) x0 t( )2 x1 t( )2+( ) x1 t( )⋅–+=

x0 0( ) 0= x1 0( ) 1=

n 1–

n 1–
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Tip When solving a differential equation it is a good idea to try more than one differential equa
solver because one method might suit your differential equation better than another meth

Sm oot h system s

When you know the solution is smooth, use Bulstoer, which uses the Bulirsch-Stoer 
method rather than the Runge-Kutta method used by rkfixed. 

Pro Bustoer(y, x1, x2, npoints, D)  

The argument list and the matrix returned by Bulstoer are identical to that for rkfixed.

Slow ly  varying  solu t ions

Given a fixed number of points, you can approximate a function more accurately if
evaluate it frequently wherever it’s changing fast and infrequently wherever it’s 
changing more slowly.  

Pro Rkadapt(y, x1, x2, npoints, D)  

The argument list and the matrix returned by Rkadapt are identical in form to that for 
rkfixed.

If you know that the solution has this property, you may be better off using Rkadapt. 
Unlike rkfixed, Rkadapt examines how fast the solution is changing and adapts its s
size accordingly.

Not e Although Rkadapt uses nonuniform step sizes internally when it solves the differential equat
it nevertheless returns the solution at equally spaced points.

St if f  syst em s

A system of differential equations expressed in the form  is a stiff system if 
the matrix A  is nearly singular. Under these conditions, the solution returned by rkfixed 
may oscillate or be unstable. When solving a stiff system, you should use one of
two differential equation solvers specifically designed for stiff systems, Stiffb and Stiffr, 
which use the Bulirsch-Stoer method and the Rosenbrock method, respectively. 
take the same arguments as rkfixed as well as one additional argument.

Pro Stiffb(y, x1, x2, npoints, D, J) 
Stiffr( y, x1, x2, npoints, D, J) 

J(x, y) = A function you define that returns the  matrix whose first 

column contains the derivatives  and whose remaining rows 

and columns form the Jacobian matrix ( ) for the system of 

differential equations. For example, if:

See rkfixed for a description of other parameters.

y A x⋅=

n n 1+( )×
D∂ x∂⁄

D∂ yk∂⁄

D x y,( )
x y1⋅

2– y1 y0⋅ ⋅
    then   = J x y,( )

y1 0 x

0 2– y1⋅ 2– y0⋅
=
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If you care about only the value of the solution at the endpoint, y(x2), rather than over 
a number of uniformly spaced x values in the integration interval bounded by x1 and 
x2, use the functions listed below. Each function corresponds to the capitalized ver
already discussed. The properties of each of these functions are identical to tho
the corresponding function in the previous sections, except for the arguments gi
below:

Pro bulstoer(y, x1, x2, acc, D, kmax, save)
rkadapt(y, x1, x2, acc, D, kmax, save) 
stiffb(y, x1, x2, acc, D, J, kmax, save) 
stiffr(y, x1, x2, acc, D, J, kmax, save) 

Boundar y  Va lue  Problem s
The specialized differential equation solvers discussed above are useful for solv
initial value problems. In some cases, however, you may know the value taken by
solution at the endpoints of the interval of integration, which is a boundary value 
problem. 

To solve boundary value problems in Mathcad, you can use Odesolve, described in 
“Solving a Differential Equation Using a Solve Block”, or sbval or bvalfit as described 
here.

Tw o- poin t  boundary va lue  problem s

Two-point boundary value problems are one-dimensional systems of differential
equations in which the solution is a function of a single variable and the value of
solution is known at two points. You can use sbval in the following case:

• You have an nth order differential equation.

• You know some, but not all, of the values of the solution and its first  
derivatives at the beginning of the interval of integration, x1, and at the end of the 
interval of integration, x2.

• Between what you know about the solution at x1 and at x2, you have n known values.

acc = Controls the accuracy of the solution. A small value of acc forces 
the algorithm to take smaller steps along the trajectory, thereby 
increasing the accuracy of the solution. Values of acc around 0.001 
generally yield accurate solutions.

kmax = The maximum number of intermediate points at which the solution 
will be approximated. The value of kmax places an upper bound on 
the number of rows of the matrix returned by these functions. 

save = The smallest allowable spacing between the values at which the 
solutions are to be approximated. This places a lower bound on the 
difference between any two numbers in the first column of the 
matrix returned by the function.

n 1–
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sbval returns a vector containing those initial values left unspecified at the first endp
of the interval. Once you know the missing initial values at x1, you have an initial value 
problem that can be solved using any of the functions discussed earlier in this se

Pro sbval(v, x1, x2, D, load, score) 

Not e As shown in Figure 10-16, sbval does not actually return a solution to a differential equation.
merely computes the initial values the solution must have in order for the solution to matc
final values you specify. You must then take the initial values returned by sbval and solve the 
resulting initial value problem using a function such as rkfixed.

It’s also possible that you don’t have all the information you need to use sbval but you 

do know something about the solution and its first  derivatives at some 
intermediate value, xf. bvalfit solves a two-point boundary value problem of this typ
by shooting from the endpoints and matching the trajectories of the solution and
derivatives at the intermediate point. This method becomes especially useful whe
derivative has a discontinuity somewhere in the integration interval.

v= Vector of guesses for initial values left unspecified at x1.

x1, x2 = The endpoints of the interval on which the solution to the 
differential equations will be evaluated.

D(x, y) = An n-element vector-valued function containing the first derivativ
of the unknown functions.

load(x1, v) = A vector-valued function whose n elements correspond to the value
of the n unknown functions at x1. Some of these values will be 
constants specified by your initial conditions. Others will be 
unknown at the outset but will be found by sbval. If a value is 
unknown, you should use the corresponding guess value from v.

score(x2, y) = A vector-valued function having the same number of elements av. 
Each element is the difference between an initial condition at x2, as 
originally specified, and the corresponding estimate from the 
solution. The score vector measures how closely the proposed 
solution matches the initial conditions at x2. A value of 0 for any 
element indicates a perfect match between the corresponding in
condition and that returned by sbval.

n 1–
184  Chapter 10  Built-in Functions



s 

 

 

nt 

 at 
Pro bvalfit(v1, v2, x1, x2, xf, D, load1, load2, score)

Figure 10-16: Using sbval to obtain initial values corresponding to given final 
values of a solution to a differential equation.

v1, v2 = Vector v1 contains guesses for initial values left unspecified at x1. 
Vector v2 contains guesses for initial values left unspecified at x2.

x1, x2 = The endpoints of the interval on which the solution to the 
differential equations will be evaluated.

xf = A point between x1 and x2 at which the trajectories of the solution
beginning at x1 and those beginning at x2 are constrained to be 
equal.

D(x, y) = An n-element vector-valued function containing the first 
derivatives of the unknown functions.

load1(x1, v1) = A vector-valued function whose n elements correspond to the 
values of the n unknown functions at x1. Some of these values will
be constants specified by your initial conditions. If a value is 
unknown, you should use the corresponding guess value fromv1.

load2(x2, v2) = Analogous to load1 but for values taken by the n unknown 
functions at x2.

score(xf, y) = An n element vector valued function used to specify how you wa
the solutions to match at xf. You’ll usually want to define score(xf, 
y) := y to make the solutions to all unknown functions match up
xf.
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Par t ia l d if fe ren t ia l e q uat ions

A second type of boundary value problem arises when you are solving a partial 
differential equation. Rather than being fixed at two points, the solution is fixed a
whole continuum of points representing some boundary.

Two partial differential equations that arise often in the analysis of physical syste
are Poisson’s equation:

and its homogeneous form, Laplace’s equation.

Ti p To type a partial differential equation symbol such as , insert the derivative operator 

typing ?, click on the derivative operator with the right mouse button, and choose View 
Derivative As ⇒ Partial Derivative from the pop-up menu.

Mathcad has two functions for solving these equations over a square boundary. 

should use relax if you know the value taken by the unknown function  on a
four sides of a square region.

If u(x, y) is zero on all four sides of the square, you can use multigrid, which often 
solves the problem faster than relax. Note that if the boundary condition is the same o
all four sides, you can simply transform the equation to an equivalent one in which
value is zero on all four sides.

relax returns a square matrix in which:

• An element’s location in the matrix corresponds to its location within the squa
region, and 

• Its value approximates the value of the solution at that point. 

This function uses the relaxation method to converge to the solution. Poisson’s equ
on a square domain is represented by:

Pro relax(a, b, c, d, e, f, u, rjac)

a . . . e = Square matrices all of the same size containing coefficients of the ab
equation.

f = Square matrix containing the source term at each point in the regio
which the solution is sought.

u = Square matrix containing boundary values along the edges of the re
and initial guesses for the solution inside the region.

x2

2

∂
∂ u

y2

2

∂
∂ u+ ρ x y,( )=

x∂
∂

xd
d

u x y,( )

aj k, uj 1+ k, bj k, uj 1– k, cj k, uj k 1+, dj k, uj k 1–, ej k, uj k,+ + + + fj k,=
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Pro multigrid(M , ncycle)

Miscellaneous Funct ions

Ex p ression T yp e

St r in g  Funct ions

rjac = Spectral radius of the Jacobi iteration. This number between 0 and 
controls the convergence of the relaxation algorithm. Its optimal val
depends on the details of your problem.

M  =  row square matrix whose elements correspond to the 
source term at the corresponding point in the square domain.

ncycle = The number of cycles at each level of the multigrid iteration. A 
value of 2 generally gives a good approximation of the solution.

Pro IsArray(x) Returns 1 if x is a matrix or vector, 0 otherwise.

Pro IsScalar(x) Returns 1 if x is a real or complex number, 0 otherwise.

Pro IsString(x) Returns 1 if x is a string, 0 otherwise.

Pro UnitsOf(x) Returns the units of x, 1 otherwise.

Pro concat(S1, S2, S3, ...) Returns a string formed by appending string S2 to the end of 
string S1, S3 to the end of S2, and so on.

Pro error(S) Returns the string S as an error tip. When Mathcad evaluate
the error function, the expression is highlighted in red and 
further numerical evaluation is suspended. When you click 
the expression, the string appears in an error tip.

Pro num2str(z) Returns a string formed by converting the real or complex 
number z into a decimal-valued string.

Pro search(S, S1, m) Returns the starting position of the substring S1 in string S 
beginning from position m, or  if no substring is found. m 
must be a nonnegative integer.

Pro str2num(S) Returns a constant formed by converting the characters in
string S to a number. S must contain only characters which 
constitute an integer, a floating-point or complex number, o
an e-format number such as 4.51e-3 (for ). Spac
are ignored.

Pro str2vec(S) Returns a vector of ASCII codes corresponding to the 
characters in string S. 

Pro strlen(S) Returns the number of characters in string S.

1 2n+( )

1–

4.51 10 3–⋅
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The strings used and returned by most of these functions are typed in a math place
by pressing the double-quote key (" ) and entering any combination of letters, number
or other ASCII characters. Mathcad automatically places double quotes around t
string expression and displays quotes around a string returned as a result. 

Not e When evaluating the functions search and substr, Mathcad assumes that the first character in
string is at position 0.

File  Access Funct ions
The file argument you supply to a Mathcad file access function is a string—or a variable 
to which a string is assigned—that corresponds either to:

• The name of a data or image file in the folder of the Mathcad worksheet you’
currently working on.

• The name of a colormap file (see page 190) in the CMAP subfolder of your Mathcad 
installation folder.

• A full or relative path to a data, image, or colormap file located elsewhere on a l
or network file system.

Reading and w r it ing ASCI I  da ta  f iles 

Files in plain ASCII format consist only of numbers separated by commas, spaces
carriage returns. The numbers in the data files can be integers like 3 or –1, floating-

point numbers like 2.54 , or E-format numbers like 4.51E - 4 (for ).

Tip These ASCII data file access functions are provided mainly for compatibility with workshe
created in earlier versions of Mathcad. The Input Table and File Read/Write component pr
more general methods of importing and exporting data in a variety of formats. See Chapt
“Vectors, Matrices, and Data Arrays.”

Pro substr(S, m, n) Returns a substring of S beginning with the character in the 
mth position and having at most n characters. m and n must be 
nonnegative integers.

Pro vec2str(v) Returns a string formed by converting a vector v of ASCII 
codes to characters. The elements of v must be integers 
between 0 and 255. 

READPRN(file) Reads a structured data file. Returns a matrix. Each line in the d
file becomes a row in the matrix. The number of elements in ea
row must be the same. Usually used as follows: 
A := READPRN(file)

WRITEPRN( file) Writes a matrix into a data file. Each row becomes a line in the fi
Must be used in a definition of the form WRITEPRN(file) :=  A 

APPENDPRN( file) Appends a matrix to an existing file. Each row in the matrix 
becomes a new line in the data file. Must be used in a definition
the form APPENDPRN(file) :=  A. Existing data must have as many
columns as A.

4.51 10 4–⋅
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Readin g  and w r it in g  im a g e f iles

READBMP(file) Creates a matrix containing a grayscale representation of
image in BMP format file. Each element in the matrix 
corresponds to a pixel. The value of a matrix element 
determines the shade of gray associated with the 
corresponding pixel. Each element is an integer between
(black) and 255 (white).

READRGB(file) Creates a matrix in which the color information in BMP 
format file is represented by the appropriate values of red
green, and blue. This matrix consists of three submatrice
each with the same number of columns and rows. Three
matrix elements, rather than one, correspond to each pix
Each element is an integer between 0 and 255. The thre
corresponding elements, when taken together, establish 
color of the pixel.

WRITEBMP(file) Creates a grayscale BMP file from the matrix. Must be used 
in a definition of the form WRITEBMP(file) :=  A.

 WRITERGB(file) Creates a color BMP file from a matrix in which the image is 
stored in RGB format. Must be used in a definition of the 
form WRITERGB(file) :=  A.

Pro READ_IMAGE( file) Creates a matrix containing a grayscale representation of
image in BMP, GIF, JPG, PCX, or TGA format file. 

Pro READ_HLS( file)
READ_HSV(file)

Creates a matrix in which the color information in BMP, GIF, 
JPG, PCX, or TGA format file is represented by the 
appropriate values of hue, lightness, and saturation (HLS) or 
hue, saturation, and value (HSV).

Pro READ_RED(file)   
READ_GREEN(file) 
READ_BLUE(file)

Extracts only the red, green, or blue component from a co
image in BMP, GIF, JPG, PCX, or TGA format file. The result 
has one-third the number of columns that the matrix return
by READRGB would have had.

Pro READ_HLS_HUE(file)
READ_HLS_LIGHT(file)
READ_HLS_SAT(file)

Extracts only the hue, lightness, or saturation componen
from a color image in BMP, GIF, JPG, PCX, or TGA format 
file. The result has one-third the number of columns that t
matrix returned by READ_HLS would have had.

Pro READ_HSV_HUE( file)
READ_HSV_SAT(file)
READ_HSV_VALUE(file)

Extracts only the hue, saturation, or value component fro
a color image in BMP, GIF, JPG, PCX, or TGA format file. 
The result has one-third the number of columns that the 
matrix returned by READ_HSV would have had.

Pro WRITE_HLS(file) Creates a color BMP file out of a matrix in which the image 
is stored in HLS format. Must be used in a definition of the
form WRITE_HLS(file) :=  A.
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Funct ions Related to 3 D Gra p hs

Load ing and saving colorm aps

A colormap is a .CMP file containing three columns of values that represent levels
red, green, and blue. You can apply a colormap to a 3D plot as described in “Fill C
on page 236. Each value in a colormap should be an integer between 0 and 255
inclusive. By default Mathcad saves and loads colormaps from the CMAPS subfolder 
of the location where you installed Mathcad.

Graph ing 3 D polyhedra

The uniform polyhedra are regular polyhedra whose 
vertices are congruent. Each has a name, a number, a 
dual (the name of another polyhedron), and a Wythoff 
symbol associated with it. To look up the name, 
Wythoff symbol, and dual name of a polyhedron, use 
PolyLookup.  

To graph a uniform polyhedron:

1. Click in a blank spot of your worksheet. Choose 
Graph⇒Surface Plot from the Insert menu.

2. In the placeholder, enter the Polyhedron function 
with an appropriate string argument.

3. Click outside the plot or press [Enter ].

Pro WRITE_HSV(file) Creates a color BMP file out of a matrix in which the image 
is stored in HSV format. Must be used in a definition of the
form WRITE_HSV(file) :=  A.

Pro LoadColormap(file) Returns an array containing the values in the colormap file.

Pro SaveColormap(file, M ) Creates a colormap file containing the values in the three-
column array M . Returns the number of rows written to file.

Pro PolyLookup(n) Returns a vector containing the name, the dual name, and the 
Wythoff symbol for the uniform polyhedron whose number code
n. n is a positive integer less than 81, a name typed as a string, 
Wythoff symbol typed as a string.

Pro Polyhedron(S) Generates the uniform polyhedron whose name, number code
Wythoff symbol is string S.
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Chapter  1 1
Vectors, Mat r ices, and Data  Arra y s

τ Creat ing Arrays

τ Accessing Array Elem ents

τ Display ing Arrays

τ Working with Arrays

τ Nested Arrays

Creat in g  Arra y s    

As introduced in “Inserting Math” on page 33, one technique of creating an array 
use the Matrix  command on the Insert menu to create an array of empty placeholde
and then to enter expressions directly into the placeholders. This technique can o
used for small arrays, but it can be used to create arrays of any kind of Mathcad
expression, not just numbers. This section describes this technique and other 
approaches for creating arrays of arbitrary size:

• Using range variables to fill in the elements. This technique is useful when yo
have some explicit formula for the array elements in terms of their indices. 

• Using the File Read/Write component to import data from external files in a var
of formats.

• Entering numbers manually in a spreadsheet-like input table.

Unlike the Insert Matrix command, however, these procedures can be used only for 
creating arrays of numbers, as opposed to arbitrary math expressions.

Not e The effective array size limit depends on the memory available on your system—usually at
1 million elements. In no system is it higher than 8 million elements. 

I nser t  M a t r ix  Com m and 
To insert a vector or matrix in Mathcad, follow these steps:

1. Click in either a blank space or on a math 
placeholder.

2. Choose Matrix  from the Insert menu, or click  
on the Matrix toolbar. A dialog box appears, as 
shown at right. 
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3. Enter the appropriate number of elements in the text boxes for 
“Rows” and “Columns.” For example, to create a three-element 
vector, enter 3 and 1.

4. An array with blank placeholders appears in your worksheet.

Next, fill in the array elements. You can enter any Mathcad expression 
into the placeholders of an array created in this way. Simply click in a placeholder
type a number or Mathcad expression. Use the [Tab ] key to move from placeholder to 
placeholder.

Not e Arrays created using the Matrix  command on the Insert menu are limited to 100 elements. 

Changing the size  of  a  vector or m at r ix  

You can change the size of a matrix by inserting and deleting rows and columns

1. Click on one of the matrix elements to place it between the 
editing lines. Mathcad begins inserting or deleting with this 
element.

2. Choose Matrix  from the Insert menu. Type the number of 
rows and/or columns you want to insert or delete. Then press 
either “Insert” or “Delete.” For example, to delete the 
column that holds the selected element, type 1 in the box 
next to “Columns,” 0 in the box next to “Rows,” and press “Delete.”

Not e If you insert rows or columns, Mathcad inserts rows below the selected element and inserts 
columns to the right of the selected element. If you delete rows or columns, Mathcad begins 
the row or column occupied by the selected element and deletes rows from that element 
downward and columns from that element rightward. To insert a row above the top row o
column to the left of the first column, first place the entire matrix between the editing lines

Crea t in g  Arra y s w ith  Ran g e  Var iables 
As introduced in “Range Variables” on page 101, you can use one or more rang
variables to fill up the elements of an array. If you use two range variables in an equ
for example, Mathcad runs through each value of each range variable. This is us

for defining matrices. For example, to define a  matrix whose i,jth element is 

, enter the equations shown in Figure 11-1. 

Recall that you enter the range variable operator by pressing the semicolon key (; ) or 

clicking  on the Calculator toolbar. You enter the subscript operator by clickin

 on the Matrix toolbar.

The  equation is evaluated for each value of each range variable, for a total o

evaluations. The result is the matrix shown at the bottom of Figure 11-1, with 5 r
and 5 columns. The element in the ith row and jth column of this matrix is .

Not e To be used to define an array element, a range variable can take on only whole-number v

5 5×
i j+

xi j,

i j+
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Tip You can also define individual array elements using the subscript operator, as described 
“Accessing Array Elements” on page 196.

Readin g  a  Da ta File
Mathcad provides the File Read/Write component to read a data file and store the dat
in a Mathcad array variable.

Not e A component is a specialized OLE object that you insert into a Mathcad worksheet to cre
link between the worksheet and either a data source or another application containing dat
more information on components, including specialized components for linking other 
computational applications dynamically to arrays in a Mathcad worksheet, see Chapter 1
“Advanced Computational Features.”

You can read data from files in a variety of formats, including:

• Excel (*.XLS)

• MATLAB  (*.MAT)

• Lotus 1-2-3 (*.WK*) 

• ASCII editors (*.DAT, *.CSV, *.PRN, *.TXT)

Tip Mathcad also provides a number of built-in functions for importing ASCII data files and im
files. See “File Access Functions” on page 188.

To read in data using the File Read/Write component:

1. Click in a blank spot of your worksheet.

2. Choose Component from the Insert  menu.

3. Choose File Read or Write from the list and click “Next.” This launches the F
Read or Write Wizard. 

4. Choose “Read from a file” and press “Next” to continue through the Wizard.

5. Specify the type of data file you want to read. Enter the path to the data file o
the “Browse” button to locate it.

Figure 11-1: Defining a matrix using range variables.
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6. Press “Finish.” You’ll see the File Read/Write 
component icon and the path to the data file. For 
example, if you specify a data file called data.txt in the 
C:\WINDOWS folder, you’ll see the component at 
right.

In the placeholder that appears, enter the name of the Mathcad variable to which
data from the file will be assigned. When you click outside the component, the dat
is read in and the data is assigned to the Mathcad array variable you entered int
placeholder.

Each time you calculate the worksheet, Mathcad re-reads the data from the file y
have specified. Figure 11-2 shows an example of reading in data using the File R
Write component. If you want to import data from a file just once into Mathcad, re
to“Importing Once from a Data File” on page 196. 

To read in a different data file or a different type of data file:

1. Click with the right mouse button on the component and select Choose File from 
the component pop-up menu.

2. In the “Files of type” text box, choose the type of file you’d like to import. Use t
dialog box to browse to the data file, select the data file, and click “Open.”

Tip By default, Mathcad reads in the entire data file and creates an array with the variable nam
provide. To read in only certain rows or columns of a data file, click once on the compone
select it, then click with the right mouse button on the component and choose Properties from 
the pop-up menu. Use the Properties dialog box to specify the row and columns at which to
and stop reading.

Figure 11-2: Reading in data from a data file. Whenever you calculate the 
worksheet, the data file is read in.
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Enter in g  Da ta  in to a Table
To get the convenience of a spreadsheet-like interface for entering data, you can 
an array using the Input Table component:

1. Click in a blank spot in your worksheet and choose Component from the Insert 
menu.

2. Select Input Table from the list and click “Next.” The Input Table component i
inserted into your worksheet. 

3. Enter the name of the Mathcad variable to which the data will be assigned in
placeholder that appears.

4. Click in the component and enter data into the cells. Each row must have the 
number of data values. If you do not enter a number into a cell, Mathcad inse
into the cell.

Figure 11-3 shows two input tables. Notice that when you create an input table, yo
actually assigning elements to an array that has the name of the variable you en
into the placeholder. 

When you click the table, you can edit the values in it. The scroll bars let you scr
through the table. To resize the table, move the cursor to one of these handles alo
sides of the region so that it changes to a double-headed arrow. Then press and
down the mouse button and drag the cursor to change the table’s dimensions.

Tip You can copy data from an input table as follows: first select some data, then click with the
mouse button on the component and choose Copy from the pop-up menu. You can paste a sing
number from the Clipboard into the table by selecting a cell and choosing Paste from the pop-
up menu. Choosing Paste Table from the pop-up menu overwrites the entire table with value
in the Clipboard.

Figure 11-3: Using input tables to create arrays of data.
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I m p or t in g  Once from  a  Da ta  Fi le
You can use an input table to import data a single time from a data file. To do so

1. Insert an input table by following the instructions given above.

2. In the placeholder that appears to the left, enter the name of the Mathcad va
to which this data will be assigned.

3. Click on the table to select it. Then click on it with the right mouse button on 
input table so that you see the pop-up menu.

4. Choose Import .

5. The Read from File dialog box appears. In the “Files of type” text box, choose
type of file you’d like to import. Use the dialog box to browse to the data file a
click “Open.”

The data from the data file appears in your worksheet in the input table.

Not e Unlike the File Read/Write component, the Import feature of an input table reads the data
when you choose Import , not each time you calculate the worksheet. If you want the data to
imported each time you calculate, use the File Read/Write component as described in “Re
a Data File” on page 193.

Accessin g  Arra y  Elem ents

You can access all the elements of an array simply by using its variable name, o
can access the elements individually or in groups. 

Subscr i p t s 
You access individual elements of a vector or matrix by using the subscript oper
described in “Vector and Matrix Operators” on page 127. Insert the subscript ope

by clicking  on the Matrix toolbar or by typing [ . To access an element of a vecto
enter one number in the subscript. To access a matrix element, enter two numbe
separated by a comma. To refer to the ith element of a vector, type v[i . In general, to 
refer to the element in the ith row, jth column of matrix M , type M[i,j . 

Figure 11-4 shows examples of how to define individual matrix elements and ho
view them.

Not e When you define vector or matrix elements, you may leave gaps in the vector or matrix. F

example, if v is undefined and you define  as 10, then , , and  are all undefined

Mathcad fills these gaps with zeros until you enter specific values for them, as shown in F
11-4. Be careful of inadvertently creating very large vectors and matrices by doing this. A
note that vector and matrix elements by default are numbered starting with row zero and co
zero unless the built-in variable ORIGIN has a value other than zero (see page 197).

You can use this kind of subscript notation in Mathcad to perform parallel calculat
on the elements of an array. See “Doing Calculations in Parallel” on page 201.

v3 v0 v1 v2
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Tip If you want to define or access a group of array elements at once, you can use a range v
in a subscript.

Accessin g  Row s and Colum ns
Although you can use a range variable to access all the elements in a row or colu
an array, Mathcad provides a column operator for quickly accessing all the elem

in a column. Click  on the Matrix toolbar for the column operator. Figure 11-5
shows how to extract the third column of the matrix M . 

To extract a single row from a matrix, transpose the matrix using the transpose ope

(click  on the Matrix toolbar) and then extract a column using the column opera
This is shown on the right-hand side of Figure 11-5.

Chan g in g  the  Ar ra y  Or i g in
When you use subscripts to refer to array elements, Mathcad assumes the array 
at the current value of the built-in variable ORIGIN. By default, ORIGIN is 0, but you 
can change its value. See “Built-in Variables” on page 98 for details.

Figure 11-4: Defining and viewing matrix elements.

Figure 11-5: Extracting a column from a matrix.
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Figure 11-6 shows a worksheet with the ORIGIN set to 1. If you try to refer to the zeroth
element of an array in this case, Mathcad displays an error message.

Dis p la y in g  Arra y s

As described in “Formatting Results” on page 110, Mathcad automatically displa
matrices and vectors having more than nine rows or columns as output tables ra
than as matrices or vectors. Smaller arrays are displayed by default in traditional m
notation. Figure 11-7 shows an example.

Not e An output table displays a portion of an array. To the left of each row and at the top of ea
column, there is a number indicating the index of the row or column. Click with the right mo
button on the output table and select Properties from the pop-up menu to control whether row
and column numbers appear and the font used for values in the table. If your results exte
beyond the table, a scroll bar appears along the appropriate edge of the table. You can s
through the table using these scroll bars just as you would scroll through any window. 

Figure 11-6: Arrays beginning at element one instead of at element zero.

Figure 11-7: Display results as a matrix or in an output table.
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To resize an output table:

1. Click the output table. You’ll see handles along the sides of the table.

2. Move the cursor to one of these handles so that it changes to a double-headed

3. Press and hold down the mouse button and drag the cursor in the direction you
the table’s dimensions to change.

Tip You can change the alignment of the table with respect to the expression on the left-hand s
the equal sign. Click with the right mouse button on the table, then choose one of the Alignment 
options from the pop-up menu.

Chan g in g  the  Dis p la y  of Arra y s — Table  ve rsus M at r ix
Although matrices and vectors having more than nine rows or columns are autom
cally displayed as scrolling output tables, you can have Mathcad display them as
matrices. You can also change matrices to output tables. To do so:

1. Click on the scrolling output table.

2. Choose Result from the Format menu.

3. Click on the Display Options tab.

4. Choose Matrix or Table in the “Matrix display style” drop-down box.

5. Click “OK.”

To display all the results in your worksheet as matrices or as tables regardless o
size, click “Set as Default” in the Result Format dialog box rather than “OK.”

Not e Mathcad cannot display extremely large arrays in matrix form. You should display a large a
as a scrolling output table. 

Chan g in g  the  Form at  of  Dis p la y ed Elem ents
You format the numbers in the array the same way you format other numerical res
as described in “Formatting Results” on page 110. Just click on the displayed arra
choose Result from the Format menu, and modify the settings there. When you clic
“OK,”  Mathcad applies the selected format to all the numbers in the table, vecto
matrix. It is not possible to format the numbers individually.   

Co py in g  and Past in g  Ar ra y s
You can copy an array of numbers directly from a spreadsheet or database into Ma
where you can take advantage of its free-form interface and its advanced mathem
tools. Once you’ve performed the necessary computations, you can paste the res
array of numbers back to its source or even into another application.

To copy just one number from a result array, simply click the number and choose Copy 

from the Edit  menu, or click  on the Standard toolbar. Copying multiple numbe
from a vector or matrix result differs depending on whether the array is displayed
matrix or as an output table. See “Formatting Results” on page 110 for more inform
on how vector and matrix results are displayed.
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To copy a result array displayed as a matrix:

1. Drag-select the array to the right of the equal sign to place the entire array bet
the editing lines.

2. Choose Copy from the Edit  menu. This places the entire array on the Clipboar

3. Click wherever you want to paste the result. If you’re pasting into another 
application, choose Paste from that application’s Edit  menu. If you’re pasting into 

a Mathcad worksheet, choose Paste from Mathcad’s Edit  menu, or click  on 
the Standard toolbar.

Not e You may only paste an array into a math placeholder or into a blank space in a Mathcad 
worksheet. 

When you display array results as a table, you can copy some or all of the numb
from the table and use them elsewhere:

1. Click on the first number you want to copy.

2. Drag the mouse in the direction of the other values you want to copy while hol
the mouse button down.

3. Click on the selected values with the right mouse button and choose Copy Selection 
from the pop-up menu.

To copy all the values in a row or column, click on the column or row number sho
to the left of the row or at the top of the column. All the values in the row or colum
are selected. Then choose Copy from the Edit  menu.

After you have copied one or more numbers from an output table, you can paste
into another part of your worksheet or into another application. Figure 11-8 show
example of a new matrix created by copying and pasting numbers from an output 

Figure 11-8: Copying and pasting results from an output table.
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W ork in g  w ith  Arra y s

Once you create an array, you can use it in calculations. There are many operato
functions designed for use with vectors and matrices. See “Vector and Matrix 
Operators” on page 127 and “Vector and Matrix Functions” on page 152 for an 
overview. This section highlights the vectorize operator, which permits efficient 
parallel calculations on the elements of arrays. You can also display the values o
array graphically or export them to a data file or another application.

Doin g  Ca lcu la t ions in  Para lle l 
Any calculation Mathcad can perform with single values, it can also perform with
vectors or matrices of values. There are two ways to do this:

• Iterate over each element using range variables. See for example “Creating A
with Range Variables” on page 192.

• Use the vectorize operator, which allows Mathcad to perform the same operatio
efficiently on each element of a vector or matrix.

Mathematical notation often shows repeated operations with subscripts. For exam
to define a matrix P by multiplying corresponding elements of the matrices M  and N, 
you would write:

Note that this is not matrix multiplication, but multiplication element by element. Iis 
possible to perform this operation in Mathcad using subscripts, but it is much fast
perform exactly the same operation with a vectorized equation.

Here’s how to apply the vectorize operator to an expression like :

1. Select the whole expression by clicking inside it and pressing 
[Space ] until the right-hand side is surrounded by the editing 
lines. 

2. Click  on the Matrix toolbar to apply the vectorize operator. 
Mathcad puts an arrow over the top of the selected expression.

Propert ies of  the  vector ize opera tor  

• The vectorize operator changes the meaning of the other operators and functions 
to which it applies. The vectorize operator tells Mathcad to apply the operators
functions with their scalar meanings, element by element. It does not change
meaning of the actual names and numbers. If you apply the vectorize operato
single name, it simply draws an arrow over the name. You can use this arrow
cosmetic purposes only if you like.

• Since operations between two arrays are performed element by element, all a
under a vectorize operator must be the same size. Operations between an arr
a scalar are performed by applying the scalar to each element of the array. 

• You can use any of the following matrix operations under a vectorize operator
product, matrix multiplication, matrix powers, matrix inverse, determinant, or 

Pi j, M i j, N i j,⋅=

M N⋅
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magnitude of a vector. The vectorize operator transforms these operations in
element-by-element scalar multiplication, exponentiation, or absolute value, a
appropriate.

Tip A number of Mathcad’s built-in functions and operators ordinarily take scalar arguments b
implicitly vectorize arguments that are vectors (one-column arrays): they automatically com
a result element by element, whether you apply the vectorize operator or not. Functions t
implicitly vectorize vector arguments include the trigonometric, logarithmic, Bessel, and 
probability distribution functions. Operators that implicitly vectorize vector arguments inclu
the factorial, square and nth root, and relational operators. You must continue to use the 
vectorize operator on arrays of other sizes with these functions and operators.

For example, suppose you want to apply the quadratic formula to three vectors 
containing coefficients a, b, and c. Figure 11-9 shows how to do this with the vectoriz
operator. 

The vectorize operator, appearing as an arrow above the quadratic formula in Fi

11-9, is essential in this calculation. Without it, Mathcad would interpret  as a 
vector dot product and also flag the square root of a vector as illegal. But with th
vectorize operator, both  and the square root are performed element by eleme

Gra p h ical Dis p la y  of  Arra y s
In addition to looking at the actual numbers making up an array, you can also se
graphical representation of those same numbers. There are several ways to do t

• For an arbitrary array, you can use the various three-dimensional plot types 
discussed in Chapter 13, “3D Plots.”

• For an array of integers between 0 and 255, you can look at a grayscale ima
choosing Picture from the Insert menu and entering the array’s name in the 
placeholder. 

Figure 11-9: Quadratic formula with vectors and the vectorize operator.

a c⋅

a c⋅
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• For three arrays of integers between 0 and 255 representing the red, green, an
components of an image, choose Picture from the Insert menu and enter the arrays
names, separated by commas, in the placeholder.

See Chapter 6, “Working with Graphics and Other Objects,” for more on viewing
matrix (or three matrices, in the case of a color image) in the picture operator.

W rit in g  to a  Da ta  Fi le
The File Read/Write component allows you to write the values stored in a Mathca
variable to a data file in a variety of formats, including the following:

• Excel (*.XLS)

• MATLAB  (*.MAT)

• Lotus 1-2-3 (*.WK*) 

• ASCII editors (*.DAT, *.CSV, *.PRN, *.TXT)

Tip Mathcad also provides a number of built-in functions to export arrays as ASCII data files 
image files. See “File Access Functions” on page 188.

To export data using the File Read/Write component:

1. Click in a blank spot in your worksheet.

2. Choose Component from the Insert  menu.

3. Select File Read or Write from the list and click “Next.” This launches the File
Read or Write Wizard. 

4. Choose “Write to a file” and press “Next” to continue through the Wizard.

5. Specify the type of data file you want to create. Also enter the path to the data
you want to write or click the “Browse” button to locate it. 

6. Press “Finish.” You’ll see the File Read/Write component icon 
and the path to the data file. For example, if you specify a data 
file called data.txt, you’ll see the component at right.

In the placeholder, enter the name of the Mathcad variable containing the data t
written to the data file. When you click outside the component, all the values in t
array are written to the file you specified. Each time you calculate the worksheet
data file is rewritten. See Figure 11-10 for an example.

To change the name of the data file being created to or to change the type of file 
created:

1. Click once on the component to select it.

2. Click with the right mouse button on the component and select Choose File from 
the pop-up menu to open the Write to File dialog box.

3. Choose the type of file you’d like to create in the “Files of type” text box. Use 
dialog box to browse to the folder in which the data file will be created and cl
“Open.”
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Tip When you display an array as an output table, as described in “Displaying Arrays” on page
you can export data directly from the table. Click with the right mouse button on the output t
choose Export  from the pop-up menu, and enter the name of the file that will receive the d
Unlike the File Read/Write component, the output table writes the data only when you cho
Export , not each time you calculate the worksheet.

Nested Arra y s

An array element need not be a scalar. It’s possible to make an array element its
another array. This allows you to create arrays within arrays.

These arrays behave very much like arrays whose elements are all scalars. How
there are some distinctions, as described below.

Not e Most of Mathcad’s operators and functions do not work with nested arrays, since there is
universally accepted definition of what constitutes correct behavior in this context. Certain
operators and functions are nevertheless useful and appropriate for nested arrays. Functio
enumerate rows or columns, or that partition, augment, and stack matrices, can be applie
nested arrays. The transpose, subscript, and column array operators and the Boolean eq
likewise support nested arrays.

Def inin g  a  Nested Arra y
You define a nested array in much the same way you would define any array. The
difference is that you cannot use the Matrix  command from the Insert menu when 
you’ve selected a placeholder within an existing array. You can, however, click o
placeholder in an array and type the name of another array. Figure 11-11 shows sever
ways to define a nested array. Additional methods include using a file access fun
such as READPRN in the array of placeholders created using the Insert Matrix 
command, and using the programming operators in Mathcad Professional to bui
an array whose elements are themselves arrays.

Figure 11-10: Exporting data with the File Read/Write component
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Not e The display of a nested array is controlled by Display Styles settings in the Result Format d
box (see page 110). You can expand a nested array when the array is displayed in matrix
otherwise, whenever an array element is itself an array, you see bracket notation showing
number of rows and columns rather than the array itself. If the nested array is displayed a
output table, you can see the underlying array temporarily. Click on the array element, then
with the right mouse button and choose Down One Level from the pop-up menu. Choose Up 
One Level from the pop-up menu to restore the array element to non-expanded form.

Figure 11-11: Defining nested arrays.
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2 D Plots

τ Overview of 2D Plot t ing

τ Graphing Funct ions and Expressions

τ Plot t ing Vectors of Data

τ Form at t ing a 2D Plot

τ Modify ing Your 2D Plot ’s Perspect ive 

Overview  of 2 D Plot t in g

To visually represent a function or expression of a single variable or X-Y data in 
Mathcad, you can create a 2D plot. You can create either a Cartesian X-Y plot o
polar plot. A typical X-Y plot shows horizontal x-values versus vertical y-values, while 
a typical polar plot shows angular values, θ, versus radial values, r. Figure 12-1 shows 
several examples of 2D plots.

Figure 12-1: Examples of 2D plots.
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Crea t in g  an  X- Y Plot
In general, to create an X-Y plot:

1. Click in your worksheet where you want the graph to appear. 

2. Choose Graph⇒X-Y Plot  from the Insert menu 

or click  on the Graph toolbar. Alternatively, 
type [ Shift ]  2 or @. Mathcad inserts a blank X-
Y plot.

3. Fill in both the x-axis placeholder (bottom center) 
and the y-axis placeholder (left center) with a 
function, expression, or variable.

4. Click outside the plot or press [ Enter ] .

Mathcad automatically chooses axis limits for you. If you want to specify the axis lim
yourself, click in the plot and type over the numbers in the placeholders at the en
the axes.

Mathcad creates the plot over a default range using default limits. See “Formatti
2D Plot” on page 216 for information on modifying these defaults.

Not e If a point is complex, Mathcad does not graph it. To graph the real or imaginary part of a p
or expression, use the Re and Im functions to extract the real and imaginary parts, respective

To resize a plot, click in the plot to select it. Then move the cursor to a handle al
the right or bottom edge of the plot until the cursor changes to a double-headed a
Hold the mouse button down and drag the mouse in the direction that you want 
plot’s dimension to change.

Not e If some points in a function or expression are valid and others are not, Mathcad plots only
valid ones. If the points are not contiguous, Mathcad does not connect them with a line. You
therefore see a blank plot if none of the points are contiguous. To see the points, format th
to have symbols. See “Formatting a 2D Plot” on page 216 for information on formatting tr

Crea t in g  a  p ola r  p lot
In general, to create a polar plot:

1. Click in your worksheet where you want the graph to 
appear.

2. Choose Graph⇒Polar Plot from the Insert menu or 

click  on the Graph toolbar.

3. Fill in both the angular-axis placeholder (bottom 
center) and the radial-axis placeholder (left center) 
with a function, expression, or variable.

4. Click outside the plot or press [ Enter ] .

Mathcad creates the plot over a default range using default limits. See “Formatti
2D Plot” on page 216 for information on modifying these defaults.
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The remaining sections in this chapter focus on plotting functions, expressions, a
data. Although the instructions and figures typically show X-Y plots, the instructio
apply to polar plots as well.

Gra phin g  Funct ions and Ex p ression s

2 D QuickPlots
A 2D QuickPlot is a plot created from an expression or function which represents
y-coordinates of the plot. With a QuickPlot, there is no need to define the independe
or x-axis variable.

To create an X-Y plot of a single expression or function:

1. Click in your worksheet where you want the graph to appear.

2. Enter the expression or function of a single variable you want 
to plot. Make sure the editing lines remain in the expression. 

3. Choose Graph⇒X-Y Plot  from the Insert  

menu or click  on the Graph toolbar.

4. Click outside the graph or press [Enter ].

Mathcad automatically produces a plot over a 
default domain for the independent variable, 
from –10 to 10.

To change the default domain for the
independent variable in a 2D QuickPlot, change the axis limits on the plot:

1. Click on the plot, and then click on one of the four axis limit placeholders loca
at the ends of the axes.

2. Type the value of the axis limit you want. There is no restriction on the values
can enter in these placeholders.

3. Click outside the graph or press [Enter ] to see the updated graph.

Def inin g  an inde p endent  va r iable
If you don’t want Mathcad to use a default range for the independent variable, you
define the independent variable as a range variable before creating the plot. For
example:

1. Define a range variable, such as x, that takes on the values you 
want to graph. The range variable need not be called x; you can 
use any valid name. See “Range Variables” on page 101.

2. Enter an expression or function you want to plot using that 
variable. Make sure the editing lines remain in the expression. 

3. Choose Graph⇒X-Y Plot  from the Insert menu or click  
on the Graph toolbar.

4. Type the name of the variable into the x-axis placeholder.
Graphing Functions and Expressions 209



the 
more 

veral 
e 
g 

ry 
le in 

.

5. Click outside the graph or press [Enter ]. 

Mathcad graphs one point for every value of the 
range variable, and, unless you specify 
otherwise, connects each pair of points with a 
straight line.

Tip To override Mathcad’s choices for the axis limits on a plot, click in the plot and type over 
limits in the placeholders at the ends of the axes. See “Setting Axis Limits” on page 217 for 
information.

 Plot t in g  Mult i p le 2 D  Curves 
You can graph several traces on the same X-Y or polar plot. A graph can show se
y-axis (or radial) expressions against the same x-axis (or angular) expression. See Figur
12-3. Or it can match up several y-axis (or radial) expressions with the correspondin
number of x-axis (or angular) expressions. See Figure 12-2.

To create a QuickPlot containing more than one trace:

1. Enter the expressions or functions of a single variable 
you want to plot, separated by commas. Make sure the 
editing lines remain in the expression.

2. Choose Graph⇒X-Y Plot from the Insert 

menu or click  on the Graph toolbar.

3. Click outside the graph or press [Enter ].

Mathcad produces a single graph containing 
plots of all the expressions or functions, over a 
default range for the independent variable(s), 
from –10 to 10. You can change the axis range 
by editing the upper and lower limits on the x-
axis as described in “Setting Axis Limits” on 
page 217.

Not e In a QuickPlot with multiple traces, you need not use the same independent variable in evey-
axis (or radial-axis) expression. Mathcad will provide the appropriate corresponding variab
the x-axis (or angular-axis) placeholder.

In general, to create a graph containing several independent curves:

1. Choose Graph⇒X-Y Plot from the Insert menu or click  on the Graph toolbar

2. Enter two or more expressions separated by commas in the y-axis placeholder.

3. Enter the same number of expressions separated by commas in the x-axis 
placeholder.
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Mathcad matches up the expressions in pairs—the first x-axis expression with first y-
axis expression, the second with the second, and so on. It then draws a trace fo
pair. Figure 12-2 shows an example.

Not e All traces on a graph share the same axis limits. For each axis, all expressions and limits o
axis must have compatible units.

Crea t in g  a  p a ram et r ic p lot
A parametric plot is one in which a function or expression is plotted against anot
function or expression that uses the same independent variable. You can create
an X-Y or polar parametric plot.

To create an X-Y parametric plot:

1. Click in your worksheet where you want the graph to appear. 

Figure 12-2: Graph with multiple expressions on both axes.

Figure 12-3: Graph with multiple y-axis expressions.
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2. Choose Graph⇒X-Y Plot  from the Insert menu or click  on the Graph toolbar
Mathcad inserts a blank X-Y plot with empty placeholders.

3. In both the x-axis and y-axis placeholders, enter a function or expression.

4. Click outside the plot or press [ Enter ] .

Mathcad produces a QuickPlot over a default range for the independent variable.  Figu
12-1 shows an example of a parametric plot.

If you don’t want Mathcad to use a default range for the plot, define the independ
variable as a range variable before creating the plot. Mathcad graphs one point for
value of the independent variable and connects each pair of points with a straight
Figure 12-4 shows two functions of θ plotted against each other. The range variableθ 
was previously defined. For more information, see “Range Variables” on page 10

Plot t in g  Vectors of Da ta

To graph a vector of data, you can create either an X-Y plot or a polar plot. Whe
creating either type of plot, you need to use the vector subscript (see “Vector and M
Operators” on page 127) to specify which elements to plot. Additionally, you can 
Axum LE (see “Using Axum to Plot Data” on page 214) to create a 2D plot of you
vectors or data. Some graphs of data vectors are shown in Figure 12-5.

Plot t in g  a  sin g le  vector  of data
To create an X-Y plot of a single vector of data:

1. Define a range variable, such as i, that references the subscript of each element
the vector you want to plot. For example, for a vector with 10 elements, your 
subscript range variable would be i := 0 .. 9.

2. Click in your worksheet where you want the graph to appear.

Figure 12-4: Graphing one function against another.
212  Chapter 12  2D Plots



. 

or 

t.

 only. 

 in the 
nto a 

 enter 

 

3. Choose Graph⇒X-Y Plot  from the Insert menu or click  on the Graph toolbar
Mathcad inserts a blank X-Y plot.

4. Enter i in the bottom placeholder and the vector name with the subscript (  f

example) in the placeholder on the left. Type [  as a shortcut to create the subscrip

5. Click outside the graph or press [Enter ].

Not e Subscripts must be integers greater than or equal to ORIGIN. Τhis means that the x-axis or 
angular variable used in the graphs in Figure 12-5 can run through whole-number values
If you want to graph fractional or negative values on the x-axis, graph a function or graph one 
vector against another, as described in the next section.

Tip If you have a handful of data points, you can use an input table to create a vector as shown
second graph in Figure 12-5 or in Figure 12-7. For more information, see “Entering Data i
Table” on page 195.

Plot t in g  one data  vector  a g a inst  another  
To graph all the elements of one data vector against all the elements in another,
the names of the vectors in the axis placeholders of an X-Y plot or polar plot.

For example, to create an X-Y plot of two data vectors x and y:

1. Define the vectors x and y.

2. Click in your worksheet where you want the graph to appear.

3. Choose Graph⇒X-Y Plot  from the Insert  menu, or click  on the Graph 
toolbar.

4. Enter in the y-axis placeholder and in the x-axis placeholder.

Figure 12-5: Graphing a vector.
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5. Click outside the graph or press [Enter ].

Mathcad plots the elements in the vector x against the elements in the vector y. 

Not e If the vectors being plotted are not the same length, Mathcad plots the number of elements
shorter vector.

If you want to plot only certain vector elements, define a range variable and use it
subscript on the vector names. In the example above, to plot the fifth through ten
elements of x and y against each other:

1. Define a range variable, such as k, going from 4 to 9 in increments of 1. (Note tha

the first elements of the vectors x and y are  and  by default.) 

2. Enter  and  in the axis placeholders.

Not e If you have a set of data values to graph, create a vector by reading in data from a data fi
pasting in the data from the Clipboard, or by typing data directly into an input table. See Ch
11, “Vectors, Matrices, and Data Arrays.” See Figure 12-7 for an example showing the us
an input table.

Usin g  Axum  to Plot  Data
Included on your Mathcad CD is the application Axum LE. Axum LE is a version
Axum that features numerous 2D plot types, complete control over graph format
and a full set of annotation tools. Axum LE gives you fine control over every aspe
your 2D plots, and you can integrate these plots into your Mathcad worksheets.

There are two basic methods for integrating plots from Axum into your Mathcad 
worksheet. You can create a graph in Axum and insert it into your Mathcad works
as an object. Or, you can define data in your Mathcad worksheet, send it to Axum
create a dynamic Axum graph directly in your Mathcad worksheet. Here are brie
instructions for each method.

Figure 12-6: Graphing two vectors.
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I nser t in g  an  Axum  g ra p h ob j ect

To insert an Axum graph object:

1. Create and save a graph in Axum. For more information about using Axum, s
Axum’s on line Help.

2. In Mathcad, choose Object from the Insert  menu. In the Insert Object dialog box
click Create from File, and browse for your saved Axum graph sheet. Once y
have selected your graph sheet, click OK.

3. The Axum graph appears into your Mathcad worksheet. If you check Link in 
Insert Object dialog, you may activate the plot from within your Mathcad 
worksheet, by double-clicking, and make changes to the original Axum graph

For more information about inserting objects, refer to “Chapter 6: Working with 
Graphics and Other Objects.”

I nser t in g  a  Dy nam ic Axum  g ra p h

To insert an Axum graph linked to data in your Mathcad worksheet:

1. In Mathcad, define the vector(s) of data you wish to plot.

2. Click in a blank spot in your worksheet. Be sure to click below or to the right 
your vector(s) of data.

3. Choose Component from the Insert  menu. Select Axum Graph from the list and
click Next. Choose a plot type and specify as many input variables as you have
vectors. Click Finish.

4. A blank Axum graph appears in your Mathcad worksheet. Enter the name(s)
your data vector(s)  in the placeholders in the bottom left corner of the graph. C
outside the graph or press [Enter ].

If you change the vectors of data upon which your Axum graph component is 
dependent, your graph updates automatically. For more information about using
components, refer to “Chapter 16: Advanced Computational Features.” Figure 12

Figure 12-7: Plotting vectors from input table data.
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shows an Axum graph that has been customized with axes labels, a title, and tex
graphic annotations.

Not e If you want to create an Axum graph component with multiple independent traces, define x- and 
y-vectors for each plot. Then, choose the plot type “Scatter Plots of XY Pairs” from the Ax
Graph dialog, and specify as many input variables as you have vectors of data. Enter the 
names in the placeholders in xy-pairs, i.e., (x1  y1  x2  y2  etc.)

Form att in g  a 2 D Plot  

When you create an X-Y plot or a polar plot, Mathcad uses the default settings to fo
the axes and traces. You can, however, reformat the axes and traces. You can a
titles and labels and control the default settings of the graph. 

Figure 12-8: An Axum graph in a Mathcad worksheet.
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To format a 2D graph:

1. Double-click the graph. Alternatively, 
click once on the graph and choose 
Graph⇒X-Y Plot or Graph⇒Polar 
Plot from the Format menu. You’ll 
see the dialog box for formatting a 
selected graph.

2. Click the tab for the page you want to 
work with. Use the Axes tab to 
determine the appearance of the axes 
and grid lines. Use the Traces tab to set 
the color, type, and width of the traces. 
Use the Labels tab to insert labels on 
the axes. Use the Defaults tab to 
specify the default appearance of your 
graphs.

3. Make the appropriate changes in the dialog box. 

4. Click Apply to see the effect of your changes without closing the dialog box. 

5. Close the dialog by clicking OK. 

Not e In the Axes page, make sure you turn options on and off in the appropriate axis column. I
Traces page, click on a trace’s name in the Legend Label column and change characteris
clicking on the arrow beside each of the drop-down options.

Tip If you double-click an axis on a graph, you’ll see a formatting dialog box for that axis alon

On- line Help Click Help in the dialog box for details on particular formatting options.

Set t in g  Axis Lim it s
When you create a 2D graph, the Autoscale option is turned on. Use the Axes pa
the plot formatting dialog box to turn Autoscale on or off:

• With Autoscale on, Mathcad automatically sets each axis limit to the first maj
tick mark beyond the end of the data. This is a reasonably round number larg
enough to display every point being graphed. 

• With Autoscale off, Mathcad automatically sets the axis limits exactly at the 
data limits. 

Specifying Other  Lim its

You can override Mathcad’s automatic limits by entering limits directly on the gra
To do so:

1. Click the graph to select it. Mathcad displays four additional numbers, one by 
axis limit. These numbers are enclosed within corner symbols, as illustrated in
selected plot in Figure 12-9. 
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2. Click on one of these numbers and type a number to replace it. Do the same f
other numbers if you want to change more than one limit.

3. Click outside the graph. Mathcad redraws it using the new axis limits you speci
The corner symbols below the limits you changed disappear. Figure 12-9 sho
the effect of manually setting limits on a graph.

Set t in g  Default  Form ats
Mathcad uses default settings to format the axes and traces of new graphs you c

Copying Defau lt s f rom  an Ex ist ing Graph

One way to create a new set of defaults is to use the format settings of an existing g
The advantage of this method is that you can actually see how the format settings
as you define them.

To use the format of a particular graph as 
the default graph format:   

1. Double-click the graph, or click in 
the graph and choose Graph⇒X-Y 
Plot (or Graph⇒Polar Plot) from 
the Format menu. Mathcad displays 
the dialog box for formatting a 
selected graph. 

2. Click the Defaults tab to see the 
Defaults page. 

3. Check Use for Defaults. When you 
click OK, to close the dialog box, 
Mathcad saves these settings as your 
default settings.

Figure 12-9: Data limits set automatically and manually. 
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Set t in g  Default s W ithout  Usin g  a  Gra p h

You can use the Setting Default Formats dialog box to change default plot setting
set defaults this way:

1. Make sure that you don’t have any graphs selected.

2. Choose Graph⇒X-Y Plot  (or Graph⇒Polar Plot) from the Format menu. You’ll 
see the Setting Default Formats dialog box. 

3. Change the appropriate settings on the Axes and Traces pages.

4. Click OK to accept your changes and close the dialog box.

Addin g  Custom  Tit les, Labe ls,  and Other  Annota t ions
One way to add titles and labels to your 2D graph is to use the options on the La
tab of the 2D Plot Format dialog box. A second way to add titles and labels, as we
annotations, is to create text or some other object in your worksheet and then m
on top of the graph.

To create an annotation for your 2D graph:

1. Create a text region, or insert a graphic object in your worksheet by pasting it 
by choosing Object from the Insert menu.

2. Drag the text or object onto your 2D graph and position it appropriately.

Figure 12-10 shows a graph containing both a text region (“inflection pt”) and a gra
object (an arrow).

Not e If you choose Separate Regions from the Format menu, all overlapping regions in your 
worksheet will separate. In the case of annotated graph, such as the one shown above, a
annotations move below the graph when you separate regions.

Figure 12-10: Mathcad graph with annotations.
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Modif y in g  Your  2 D Plot ’s Pers p ect ive

Mathcad provides the following options for manipulating your 2D graph:

• You can zoom in on a portion of the graph.

• You can get the x- and y-coordinates for any point that was plotted to construct 
individual plot.

• You can get the x- and y-coordinates for any location within the graph.

Zoom in g  in  on  a  Plot  
Mathcad allows you to select a region of a graph and magnify it. To zoom in on a po
of a graph, follow these steps:

1. Click in the graph and choose Graph⇒Zoom from 

the Format menu, or click  on the Graph toolbar. 
The Zoom dialog box appears. The X-Y Zoom dialog 
box is shown to the right. 

2. If necessary, reposition the Zoom dialog box so that 
you can see the entire region of the graph you want 
to zoom.

3. Click the mouse at one corner of the region in the graph you want to magnify

4. Press and hold down the mouse button and drag the mouse. A dashed selec
outline emerges from the anchor point. The coordinates of the selected regio
listed in the Min and Max text boxes (or the Radius text box of the Polar Zoom
dialog box).

5. When the selection outline just encloses the region you want to magnify, let g
the mouse button. If necessary, click on the selection outline, hold the mouse b
down, and move the outline to another part of the graph.

6. Click Zoom to redraw the graph. The axis limits are temporarily set to the 
coordinates specified in the Zoom dialog box. To make these axis limits perma
click OK.

Tip If you’re working with a graph that has already been zoomed, you can restore the default
appearance of the graph. To do so, click Full View in the Zoom dialog box. 
220  Chapter 12  2D Plots



 these 

. A 
ng 

e to 
traces.

f that 
e 

mains 

plot.
 

Get t in g  a  Readout  of Plot  Coordina tes 
To see a readout of coordinates of the specific points that make up a trace, follow
steps:

1. Click in the graph and choose Graph⇒Trace from 

the Format menu, or click  on the Graph 
toolbar. The X-Y Trace dialog box appears as in the 
example at right. Check Track Data Points if it isn’t 
already checked. If necessary, reposition the Trace 
dialog box so that you can see the entire graph.

2. Click and drag the mouse along the trace whose coordinates you want to see
dotted crosshair jumps from one point to the next as you move the pointer alo
the trace.

3. If you release the mouse button, you can use the left and right arrows to mov
the previous and next data points. Use the up and down arrows to select other 

4. As the pointer reaches each point on the trace, Mathcad displays the values o
point in the X-Value and Y-Value boxes (or the Radius and Angle boxes in th
Polar Trace dialog box).

5. The values of the last point selected are shown in the boxes. The crosshair re
until you click outside the plot.

Tip When Track Data Points is unchecked in the Trace dialog box, you can see a readout of 
coordinates for any location in a graph, not just the data points that created an individual 

Figure 12-11: A zoomed-in region of an X-Y plot.
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heet, 
Figure 12-12 shows an example of a plot whose coordinates are being read.

To copy and paste a coordinate using the Clipboard:

1. Click Copy X or Copy Y (or Copy Radius or Copy Angle in the case of a polar p

2. You can then paste that value into a math or text region in your Mathcad works
into a spreadsheet, or into any other application that allows pasting from the 
Clipboard.

Figure 12-12: Reading coordinates from a graph.
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Chapter  1 3
3 D Plots 

τ Overview of 3D Plot t ing

τ Creat ing 3D Plot s of Funct ions

τ Creat ing 3D Plot s of Data

τ Form at t ing a 3D Plot

τ Rotat ing and Zoom ing on 3D Plots

Overview  of 3 D Plot t in g

To visually represent in three dimensions a function of one or two variables or to
data in the form of x-, y-, and z-coordinates, you can create a surface plot, a contou
plot, a 3D bar plot, a 3D scatter plot, or a vector field plot. Create these different 
types using commands from the Insert menu or the 3D Plot Wizard. You can also plac
more than one 3D plot on the same graph. Mathcad renders 3D plots with sophistic
high performance OpenGL graphics.

I nser t in g  a  3 D  Plot
In general, to create a three-dimensional plot:

1. Define a function of two variables or a matrix of data.

2. Click in the worksheet where you want the plot to appear. Then choose Graph from 
the Insert menu and select a 3D plot. Alternatively, click one of the 3D graph 
buttons on the Graph toolbar. Mathcad inserts a blank 3D plot with axes and
empty placeholder.

3. Enter the name of the function or matrix in the placeholder.

4. Click outside the plot or press [Enter ]. Mathcad creates the plot according to th
function or matrix of data.

For example, the surface plot shown below was created 
in Mathcad from the function:
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When you create a 3D plot from a function, it’s 
called a QuickPlot. A QuickPlot uses default ranges 
and grids for the independent variables. To change 
these settings, double-click on the graph and use the 
QuickPlot Data page of the 3D Plot Format dialog. 
For more information on modifying these and other 
plot characteristics, see “Formatting a 3D Plot” on 
page 234.

To learn how to create a plot from a matrix of values, 
see the shown in Figure 13-2 on page 229.

3 D Plot  W iza rd
The 3D Plot Wizard gives you more control over the format settings of the plot as y
insert it. To use the Wizard:

1. Click in your worksheet wherever you want the graph to appear.

2. Choose Graph⇒3D Plot Wizard from the Insert menu. The first page of the 3D
Plot Wizard appears.

3. Select the type of three-dimensional graph you want to see and click “Next.”

4. Make your selections for the appearance and coloring of the plot on subsequ
pages of the Wizard. Click “Finish” and a graph region with a blank placehold
appears.

5. Enter appropriate arguments (a function name, data vectors, etc.) for the 3D
into the placeholder.

6. Click outside the plot or press [Enter ].

The plot is created using the settings you specified in the Wizard. For informatio
modifying the appearance of your plot, see “Formatting a 3D Plot” on page 234.

Creat in g  3 D Plots of Funct ions

This section describes how to create various 3D plots from functions in Mathcad,
known as QuickPlots. Although the instructions focus on using commands on the Insert 
menu and changing settings through the 3D Plot Format dialog box, you can als
the 3D Plot Wizard, as described on page 224.

Tip To see a variety of two- and three-dimensional functions and data sets visualized in plots,
the “Practical Curves and Surfaces” section of QuickSheets in the Mathcad Resource Ce
(choose Resource Center from the Help menu and click on “QuickSheets”). 
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Crea t in g  a  Surface , Bar, Contour , or  Sca t ter  Plot
You can visualize any function of two variables as a surface, bar, contour, or sca
plot in three dimensions.

Step 1 : Def ine  a  funct ion  or  se t  of funct ions

First, define the function in your worksheet in any one of the following forms:

F(x,y) is a function of two variables. In this type of function, the x- and y-coordinates 
of the plot vary, by default, from –5 to 5 with a step size of 0.5. Each z-coordinate is 
determined by the function using these x- and y-values.

G(u,v) is a vector-valued function of two variables. In this type of function, the 
independent variables u and v vary, by default, from –5 to 5 with a step size of 0.5. Th
x-, y-, and z-coordinates are plotted parametrically according to the definitions in t
three elements of the vector using these u- and v-values.

X(u,v), Y(u,v), and Z(u,v) are functions of two variables. In this type of function triple
the independent variables u and v vary, by default, from –5 to 5 with a step size of 0.5
The x-, y-, and z-coordinates are plotted parametrically according to the three funct
definitions using these u- and v-values.

Not e The function descriptions above assume that you are working in Cartesian coordinates. If
function represents spherical or cylindrical, rather than Cartesian, coordinates, you can 
automatically convert the function to Cartesian coordinates. Double-click on the plot, go to
QuickPlot Data page of the 3D Plot Format dialog box, and click “Spherical” or “Cylindrica
under Coordinate System.

Step 2 : I nser t  a  3 D plot

After you define a function or set of functions to plot, choose Graph from the Insert 
menu and select a 3D plot type.

For example, to create a surface plot from the functions X, Y, and Z, defined abo

1. Choose Graph⇒Surface Plot from the Insert menu or click  on the Graph 
toolbar. Mathcad inserts a blank 3D plot.

2. Enter the name of the functions in the placeholder. When you have 
more than one function definition for a single surface, separate the 
function names by commas and enclose the function names in paren-
theses. For this example, type:
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3. Press [Enter ] or click outside the plot.

To change your plot to a different plot type:

1. Double-click on the graph to bring up the 3D Plot Format dialog box.

2. In the Display As section on the General tab, select Bar Plot, Contour Plot, or 
Points from the array of plot types.

3. Click “OK.”

Figure 13-1 shows a 3D scatter plot created from the function G, and a contour p
created from the function F, both defined above:

Not e All 3D QuickPlots are parametric curves or surfaces. In other words, all QuickPlots are created 
from three vectors or matrices of data representing the x-, y-, and z-coordinates of the plot. In the 
case of a single function of two variables, Mathcad internally creates two matrices of x- and y-
data over the default range -5 to 5 with a step size of 0.5, and then generates z-data using these 
x- and y-coordinates.

Figure 13-1: A scatter plot and a contour plot created from functions of two 
variables.
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To change the default ranges and grids for the independent variables, double-cli
the graph and use the QuickPlot Data page of the 3D Plot Format dialog. For mo
information on modifying these and other plot characteristics, see “Formatting a 
Plot” on page 234.

Crea t in g  a  Sp ace  Curve
You can visualize any parametrically-defined function of one variable as a scatter
in three dimensions.

Step 1 : Def ine  a  funct ion  or  se t  of funct ions

First, define the function in your worksheet in one of the following forms:

H(u) is a vector-valued function of one variable. In this type of function, the independ
variable u varies, by default, from –5 to 5 with a step size of 0.5. The x-, y-, and z-
coordinates of the plot are determined by the functions in each element of the ve
using these u-values.

R(u), S(u), and T(u) are functions of one variable. In this type of function triple, the
independent variable u varies, by default, from –5 to 5 with a step size of 0.5. The x-, 
y-, and z-coordinates are plotted according to the function definitions using theseu-
values.

Not e A space curve often represents the path of a particle in motion through space where u is a time 
parameter.

Step 2 : I nser t  a  3 D sca t te r  p lot

To create a space curve from a single function or set of functions:

1. Choose Graph⇒3D Scatter Plot from the Insert menu or click   on the Graph
toolbar. Mathcad inserts a blank 3D plot.

2. Enter the name of function or functions in the placeholder. When you 
have more than one function definition, separate the function names 
by commas and enclose the function names in parentheses. To create 
a space curve from the functions R, S, and T, defined above, type:
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3. Press [Enter ] or click outside the plot.

For general information on formatting 3D plots, refer to “Formatting a 3D Plot” on
page 234. For specific information on formatting a scatter plot, refer to the topic “Sc
Plots” in the on-line Help.

Creat in g  3 D Plots of Da ta

This section describes how to create various 3D plots from data in Mathcad. Altho
the instructions focus on using commands on the Insert menu and changing settings 
through the 3D Plot Format dialog, you can also use the 3D Plot Wizard, as desc
on page 224.

Crea t in g  a  Surface , Bar, or  Sca t te r Plot
Surface, bar, and scatter plots are useful for visualizing two-dimensional data cont
in an array as either a connected surface, bars above and below the zero plane, o
in space.

For example, to create a surface plot from data:

1. Create or import a matrix of values to plot. The row and column numbers repre
the x- and y-coordinate values. The matrix elements themselves are the z-coordinate 
values plotted as heights above and below the xy-plane (at z = 0).

2. Choose Graph⇒Surface Plot from the Insert menu or click  on the Graph 
toolbar. Mathcad inserts a blank 3D plot.

3. Enter the name of the matrix in the placeholder.

4. Press [Enter ] or click outside the plot. Figure 13-2 shows a 3D bar plot creat
from a matrix, M:

In the default perspective, the first row of the matrix extends from the back left co
of the grid to the right, while the first column extends from the back left corner ou
toward the viewer.  See “Formatting a 3D Plot” on page 234 to learn how to chan
this default view.
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Crea t in g  a  Param et r ic Sur face  Plot
A parametric surface plot is created by passing three matrices representing the x-, y-, 
and z- coordinates of your points in space to the surface plot.

To create a parametric surface plot:

1. Create or import three matrices having the same number of rows and column

2. Choose Graph⇒Surface Plot from the Insert menu or click  on the Graph 
toolbar. Mathcad inserts a blank 3D plot.

3. Type the names of the three matrices separated by commas and enclosed in
parentheses in the placeholder. For example:

(X, Y, Z)

4. Press [Enter ] or click outside the plot.

Figure 13-3 shows a parametric surface plot created from the matrices, X, Y, an
defined above the plot.

For general information on formatting 3D plots, refer to “Formatting a 3D Plot” on
page 234. For specific information on formatting a parametric surface plot, refer to
topic “Surface Plots” in the on-line Help.

Not e The underlying parameter space is a rectangular sheet covered by a uniform mesh. In effe
three matrices map this sheet into three-dimensional space. For example, the matrices X, Y, and 
Z defined in Figure 13-3 carry out a mapping that rolls the sheet into a tube and then join
ends of the tube to form a torus.

Figure 13-2: Defining a matrix of data and plotting it as a 3D bar plot.
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Crea t in g  a  Three- d im ensiona l Param et r ic Curve
A three-dimensional parametric curve is created by passing three vectors represe
the x-, y-, and z-coordinates of your points in space to the surface plot. 

To create a three-dimensional parametric curve:

1. Create or import three vectors having the same number of rows.

2. Choose Graph⇒Scatter Plot from the Insert menu or click  on the Graph 
toolbar. Mathcad inserts a blank 3D plot.

3. Type the names of the three vectors separated by commas and enclosed in 
theses in the placeholder. For example:

(X, Y, Z)

4. Press [Enter ] or click outside the plot.

Figure 13-4 shows a three-dimensional parametric curve created from the vecto
Q, and R, defined above the plot:

For general information on formatting 3D plots, refer to “Formatting a 3D Plot” on
page 234. For specific information on formatting a scatter plot, refer to the topic “Sc
Plots” in the on-line Help.

Figure 13-3: Defining data for a parametric surface plot.
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Crea t in g  a  Contour  Plot
To view three-dimensional data as a two-dimensional contour map, you can crea
contour plot:

1. Define or import a matrix of values to plot. 

2. Choose Graph⇒Contour Plot from the Insert menu or click  on the Graph 
toolbar. Mathcad shows a blank plot with a single placeholder.

3. Type the name of the matrix in the placeholder. 

4. Press [Enter ] or click outside the plot.

Figure 13-5 shows a contour plot created from the matrix, C, defined above the 

The contour plot is a visual representation of the matrix’s level curves. Mathcad 
assumes that the rows and columns represent equally spaced intervals on the ax
then linearly interpolates the values of this matrix to form level curves or contour
Each level curve is formed such that no two cross. By default, the z-contours are shown 
on the x-y plane. Mathcad plots the matrix such that the element in row 0 and colu
0 is in the lower left corner. Thus the rows of the matrix correspond to values on tx-
axis, increasing to the right, and the columns correspond to values along the y-axis, 
increasing toward the top. 

For general information on formatting 3D plots, refer to “Formatting a 3D Plot” on
page 234. For specific information on formatting a contour plot, refer to the topic
“Contour Plots” in the on-line Help.

Not e If you create a contour plot of a function as described above, the positive x-axis of the plot 
extends to the right and the positive y-axis extends toward the top of the plot.

Figure 13-4: Defining data for a space curve.
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Crea t in g  a  Vector  Fie ld Plot    
In a vector field plot, each point in the x-y plane is assigned a two-dimensional vecto
There are two ways to set up the data needed for a vector field plot:

1. Create a matrix of complex numbers in which the following conditions exist:

• The row and column numbers represent the x- and y-coordinates

• The real part of each matrix element is the x-component of the vector associated
with that row and column

• The imaginary part of each element is the y-component of the vector associated 
with that row and column.

2. Create two matrices having the same number of rows and columns. The first m
should have the x-components of the vectors, the second the y-components.

Once you have defined your data, as described above, to create a vector field p

1. Choose Graph⇒Vector Field Plot from the Insert menu or click  on the 
Graph toolbar. 

2. Type the name(s) of the matrix or matrices in the placeholder. If you have mo
than one matrix for a vector field plot, separate the matrix names by commas
enclose the matrix name set in parentheses. For example:

(X, Y)

3. Press [Enter ] or click outside the plot.

Figure 13-5: Defining data for a contour plot.
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Figure 13-6 shows a vector field plot created from the matrix, Q, defined above 
the plot:

For general information on formatting 3D plots, refer to “Formatting a 3D Plot.” F
specific information on formatting a vector field plot, refer to the topic “Vector fiel
plots” in the on-line Help.

Gra p h in g  M ult i p le  3 D Plots
Pro Just as you can plot more than one trace on a two-dimensional graph, you can p

more than one surface, curve, contour, bar, or scatter plot on a three-dimensional

For example, to create a 3D graph with a contour plot and a surface plot:

1. Define two functions of two variables or any combination of two acceptable 
argument sets for a 3D plot (two matrices, two sets of three vectors, etc.).

2. Choose Graph⇒Contour Plot from the Insert menu or click  on the Graph 
toolbar. Mathcad inserts a blank 3D plot.

3. Enter the name of the function or matrix for the contour plot into the placehol
Then type ,  (a comma).

4. Enter the name of the function or matrix for the surface plot.

5. Press [Enter ] or click outside the plot. You see two contour plots. 

6. Double-click the graph to bring up the 3D Plot Format dialog box. In the Disp
As section of the General tab, click the tab labeled Plot 2 and select Surface 
the array of plot types. Click “OK.”

Figure 13-6: Defining data for a vector field plot.
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Both the contour plot and the surface plot, with default format settings, appear in
single graph.

Tip As a general rule, you will not want to create a 3D graph with more than two or three plot
together since they may obscure each other and make the graph difficult to interpret.

Form att in g  a 3 D Plot

A three-dimensional plot’s default appearance depends on how you insert it. When
choose Graph⇒3D Plot Wizard from the Insert menu, you make selections in the 
pages of the Wizard that determine a plot’s appearance. When you insert a plot 
choosing a plot type from the Insert menu, however, the plot automatically acquire
default characteristics. 

You can change the appearance of any 3D plot after it is inserted. To do so, you
the many options available in the 3D Plot Format dialog box. For example, you can
the options to change a plot’s color, format the axes, add backplanes, and forma
lines or points.

To bring up the 3D Plot Format dialog box:

Figure 13-7:  Two plots, one contour and one surface, shown on the
same graph.
234  Chapter 13  3D Plots



 for 
n 
tions 

et the 

. 
arks. 
mat 

ith 
f the 

 lines. 
nes 
ne 

ts 
ce, 
trol 

s 
on 
1. Click once on the plot to select 
it and choose Graph⇒3D Plot 
from the Format menu. Alter-
natively, double-click the plot 
itself. Mathcad brings up the 3D 
Plot Format dialog box. The 
General page is shown at right. 
The remaining tabs take you to 
additional pages.

2. Click the tab for the page you 
want to work with.

3. Make the appropriate changes 
in the dialog box.

4. Click Apply to see the effect of your changes without closing the dialog box. 

5. Close the dialog by clicking OK. 

The 3 D Plot  Form at  D ia lo g  Box
The tabs in the 3D Plot Format dialog box bring you to pages containing options
formatting various aspects of a three-dimensional plot. Some options available o
certain pages in the dialog box depend on the kind of plot you are formatting. Op
on other pages are available for any three-dimensional graph. 

• The General page gives you access to basic options that control the overall 
appearance of the graph. Use these options to control the position of a plot, s
axis style, draw a border or a box, or convert a plot to another type.

• The options on the Axes page allow you to control exactly how each axis looks
You can specify the weight of each axis and whether it has numbers or tick m
You can also specify the axis limits. Use the tabs at the top of the page to for
the x-, y-, or z-axis. 

• The Backplanes page has options for specifying whether a backplane is filled w
a color, has a border, or has grid lines or tick marks. Use the tabs at the top o
page to format the xy-, yz-, or xz-backplane.

Not e Both the Backplanes page and the Axes page have options for setting and formatting grid
When you set the grid lines for an axis on the Axes tab, you set them for the two backpla
shared by the axis. When you set the grid lines on the Backplanes tab, you set them for o
backplane only.

• Use the options on the Appearance page to format the surfaces, lines, and poin
that make up a plot. For example, you can apply color directly to a plot’s surfa
its contours, or its lines and points. The following sections discuss how to con
the surfaces, lines, and points of a plot.

• The Lighting page options control both the overall lighting of the plot as well a
individual lights directed onto it. See “Lighting” on page 240 for more informati
on lighting.
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• The Title  page provides a text box for entering a title for the graph and options
specifying the location of the title on the graph.

• The Special page allows you to control options related to specific kinds of plot
For example, the Bar Plot Layout options let you specify the way the bars are
arranged in a 3D bar plot.

• The Advanced page has options used only when you need very fine control o
the appearance of a plot, such as the vertical scale.

• The QuickPlot Data page contains the range and grid settings for the independ
variables that control a 3D QuickPlot. Additionally, you can specify whether yo
function(s) are in Cartesian, spherical, or cylindrical coordinates.

On- line Help For details on the options available on a particular page in the 3D Plot Format dialog box,
the Help button at the bottom of the dialog box.

Some options in the 3D Plot Format dialog box work together to control the appear
of a plot. For example, the choices on the Appearance page, the Lighting page, a
Special and Advanced pages together control the color of a plot.

Not e When you format a graph containing more than one plot (using Mathcad Professional), as
described in “Graphing Multiple 3D Plots” on page 233, some options in the 3D Plot Form
dialog box apply to an entire graph while others apply to individual plots. For example, all
options on the Axes, Backplanes, and Lighting pages are for the graph as a whole: each p
the graph uses common axes, backplanes, and lighting. However, options on the Appeara
are specific to each plot on the graph. That is, each plot can be filled with its own color, ha
own lines drawn, etc. Use the tabs labeled Plot 1, Plot 2, etc. to control the settings for indiv
plots.

Fill  Color
The color of a plot is primarily determined by its fill color. This section describes 
ways to apply color to a plot by filling its surfaces or contours. A plot’s color and 
shading are also affected by lighting, as described in more detail in page 240.

Mathcad allows you to apply either a solid color or a colormap to the surface or con
of a plot. A solid color is useful when you don’t want to overcomplicate a plot wit
many colors or when you want to use lighting to shade a plot. A colormap applie
array of color to a plot according to its coordinates. 

Not e Mathcad comes with a variety of colormaps for applying rainbow colors and shades of gray
green, and blue. You can also create and load custom colormaps in Mathcad Professiona
using the SaveColormap and LoadColormap functions, described on page 190. By default, a 
colormap is applied in the direction of the z-values, or according to the height of the plot. You
can apply the colormap in the direction of the x-values or y-values by clicking the Advanced tab
and choosing a direction in the Colormap section. For more information on colormaps, se
line Help.
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Fillin g  the  Surface

The options on the Appearance page of the 3D Plot Format dialog box allow you t
the plot’s surface with a solid color or a colormap. For example, to color the bars
3D bar plot according to a colormap:

1. Double-click the graph to bring 
up the 3D Plot Format dialog 
box.

2. Click the Appearance tab. 

3. Click both Fill Surface in Fill 
Options and Colormap in Color 
Options.

4. Click Apply to preview the 
plot. Click OK to close the dia-
log box.

Figure 13-8 shows an example.

The plot is shaded using the default colormap “Rainbow.” To choose a different 
colormap, click the Advanced tab of the 3D Plot Format dialog box and select a 
colormap from the Choose Colormap drop-down menu.

If you wanted to fill the bars of the plot with a solid color, choose Solid Color inste
of Colormap and click the color box next to Solid Color to select a color.

Fillin g  Cont ours

When you format a surface plot, you can choose Fill Contours instead of Fill Sur
in the Fill Options section of the Appearance page. If you fill the contours of a sur
plot, the plot is filled according to its contours rather than directly by its data. You 

Figure 13-8: Filling the surface or contours of a plot.
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fill according to the x-, y-, or z-contours or two at the same time. For a contour plot
you must choose Fill Contours instead of Fill Surface to fill the contours of the pl

For example, to fill a contour plot with color:

1. Double-click the graph to bring up the tabbed dialog box.

2. Click the Appearance tab. 

3. In the Fill Options section, click Fill Contours.

4. Click Apply to preview the plot. Click OK to close the dialog box.

The plot is shaded using the default colormap Rainbow. To choose a different color
click the Advanced tab of the 3D Plot Format dialog box and select a colormap f
the Choose Colormap drop-down menu.

Not e If you have a contour plot projected on a plane other than the x-y plane, you can fill the contour 
using options on the Special page of the 3D Plot Format dialog box. To do so, click the Sp
tab, then choose a contour direction from the drop-down menu. Click Fill for each contour
want to color. For example, if you have Fill checked for the z-contours and x-contours, you will 
see contour color on both the x-y backplane and the y-z backplane. 

Lines
Mathcad provides many ways to control the appearance of the lines on a three-
dimensional plot. You can draw the lines so they form a wireframe, or you can d
only the contour lines. You can also control the weight and color of the lines on a

Draw ing a  W ire fram e

To control whether lines form a wireframe on a plot, use the options on the Appear
page of the 3D Plot Format dialog box. For example, to remove the wireframe o
surface plot as shown in Figure 13-9:

1. Double-click the graph to bring up the tabbed dialog box.

2. Click the Appearance tab. 

3. In the Line Options section, click No Lines.

4. Click Apply to preview the plot. Click OK to close the dialog box.

To turn lines on again later, choose Wireframe on the Appearance page.

Draw ing Contour Lines

When you format a surface plot, you can choose Contour instead of Wireframe in
Line Options section of the Appearance page. Contour lines are those drawn acco
to the contours of a surface. You can draw either the x-, y-, or z- contour lines, two of 
these contours lines, or all three.

Not e For contour plots, Mathcad always chooses Contour instead of Wireframe to draw contour 

For example, to draw lines showing the x-contours of a surface plot:

1. Double-click the graph to bring up the tabbed dialog box.

2. Click the Appearance tab. 

3. Click Contour in the Line Options section. 
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4. Click the Special tab.

5. Verify that Z-Contours is selected in the drop-down menu at the bottom of th
Contour Options section. Click Draw Lines to remove the check mark. This tu
lines off for the z-contours. 

6. Choose Z-Contours from the drop-down menu on the Special page.

7. Check Draw Lines.

8. Click Apply to preview the plot. Click OK to close the dialog box.

The surface plot is drawn with contour lines perpendicular to the z-axis, as shown in 
Figure 13-9.

Not e When you format a contour plot on a multi-plot graph (see page 224), the options in the d
down menu on the Special tab determine on which backplane the contour lines are drawn
example, if you have Draw Lines checked for the z-contours and x-contours, you will see contour 
lines on both the x-y backplane and the y-z backplane. 

Line  Color

You can control the color of the lines in a plot using the color options in the Line Opt
section of the Appearance page. Just as you can fill a plot’s surface with a colorm
a solid color, described on page 237, you can also apply a colormap or solid colo
the lines in a plot.

For example, to make the lines of a contour plot orange:

1. Double-click the graph to bring up the tabbed dialog box.

2. Click the Appearance tab. 

Figure 13-9: A wireframe vs. contour lines on a surface plot.
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3. In the Line Options section, click Contour to draw contour lines and Solid Co

4. Click the color box next to Solid Color, click the orange box, and click OK.

5. Click Apply to preview the plot. Click OK to close the dialog box.

Poin ts
You can draw and format points on most three-dimensional plots, since all 3D pl
are constructed from discrete data points. (The exceptions are vector field plots, co
plots, bar plots, and patch plots.) Points are most useful, however, on a 3D scatte
in which points are the main focus of the plot. Mathcad allows you to control the sym
used for the points in a plot as well as the color and size of the symbol.

To draw or remove points on a surface plot:

1. Double-click the graph to bring up the 3D Plot Format dialog box.

2. Click the Appearance tab.

3. In the Points Options section, check (or uncheck) Draw Points.

4. Click Apply to preview the plot. Click OK to close the dialog box.

To format the symbol, color, and size of the points on your 3D scatter plot using 
Points Options section of the Appearance tab:

• Choose a Symbol from the drop-down list to change the symbol displayed.

• Use the arrows next to Size to increase or decrease the size of the symbol.

• Click the color box next to Solid Color and choose a hue from the color palette
click Colormap to change the coloring of the symbols.

Li g ht in g
The color of a three-dimensional plot is a result of color you use to fill its surface, li
and points as well as the color of any ambient light or directed lights shining on it. 
behavior is identical to the effect of light on object color in the real world. Objects
reflect and absorb light depending on their color. For example, a yellow ball refle
mostly yellow light and absorbs others, and it can look grayish under dim lighting
green under blue lighting, and bright yellow in bright lighting.

You can fill a plot’s surfaces, contours, lines, and points with either a solid color 
colormap using the options on the Appearance and Advanced pages of the 3D P
Format dialog box. 

Light is controlled using the options on the Lighting page of the 3D Plot Format dia
box. If you are content to fill a plot with a colormap, you may not need to use ligh
at all. However, if you want to shade the plot differently, or if you fill the plot with
solid color and want to shade it, you can enable lighting.

Not e If your 3D graph contains multiple plots, lighting affects all the plots in a graph, but you can
individual plots with color independently.

Not e If you want lighting to be the sole determinant of the color of a plot, use the Appearance p
options in the 3D Plot Format dialog box to fill the plot with solid white.
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To enable lighting:

1. Double-click the plot to open the tabbed dialog box.

2. Click the Lighting tab.

3. Check Enable Lighting in the Lighting section.

4. Click the options on tabs labeled Light 1, Light 2, etc. to enable a directed light
set its color and location. Mathcad lets you set up to eight directed lights.

5. Click the Ambient Light Color box to set the ambient light color. Note that bla
corresponds to no ambient light.

6. Click Apply to preview the plot. Click OK to close the dialog box.

On- line Help For details on the options available on the Lighting page, click the Help button at the botto
the dialog box. For additional information on lighting, see “Advanced Topics” under Overv
and Tutorial in the Mathcad Resource Center.

Chan g in g  One  3 D Plot  t o Another
You can change almost any three-dimensional plot into another kind of three-
dimensional plot by using the Display As options on the General tab in the 3D Pl
Format dialog box. Simply select another available 3D plot type and click Apply 
OK to change the plot instantaneously to another type. Figure 13-11 shows the s
matrix displayed as three different plot types.

Not e Some three-dimensional plots cannot be converted to other forms. For example, you can
convert a vector field plot into any other kind of plot. If a plot cannot be converted to anoth
kind of plot, that plot type is grayed in the 3D Plot Format dialog box.

Annota t ions
In addition to adding a title to your three-dimensional plot by using options on the T
page of the 3D Plot Format dialog box, you can annotate a three-dimensional pl

Figure 13-10: A white surface plot with lighting enabled.
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placing text or bitmaps anywhere on it. This allows you to label or highlight any p
of the plot that you wish.

To add a text annotation to a three-dimensional plot:

1. Create a text region in your worksheet using the methods described in Chap
“Working with Text.” 

2. Drag the text region from its location in your worksheet and drop it directly on
the plot. See “Moving and Copying Regions” on page 10 for more on dragging
dropping regions.

You can select the text annotation on your plot to reposition it. To edit a text annota
on a plot, select the text and drag it off the plot to your worksheet. You can now 
the text region. Then drag the text region back onto the plot.

Tip You can drag a bitmap image from your Mathcad worksheet onto a three-dimensional plo
as you drag and drop text annotations. To place a bitmap you created in another applicatio
a three-dimensional plot, copy the bitmap from the other application to the Clipboard, clic
the plot with the right mouse button, and choose Paste Special from the pop-up menu.

Figure 13-11:  The same data displayed in several different 3D plots.
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Modif y in g  3 D Qu ickPlot  Da ta
When you create a 3D QuickPlot, as described on page 224, you can change the
and step size of each independent variable by using the settings on the QuickPlo
page of the 3D Plot Format dialog box.

To change the range of either independent variable:

1. Set the start and end values of either range using the text boxes for each ran

2. Click Apply to keep the dialog box open. Click OK to close the dialog box.

To change the step size, the number of grids generated along each variable’s ax
between the start and end values:

1. Use the arrows next to # of Grids for each range to increase or decrease the
value. Alternatively, you can type in a value in the text box.

2. Click Apply to keep the dialog box open. Click OK to close the dialog box.

Not e The ranges you set for the independent variables in the QuickPlot Data page do not nece
control the axis limits of the plot, unless you are plotting a single function of two variables
Cartesian coordinates. In all other cases, the axis limits are determined by the x-, y-, and z-data 
generated for the QuickPlot by your function(s).

To perform automatic coordinate system conversions on your QuickPlot data:

1. Click the radio button under Coordinate System corresponding the coordinat
system of the function you are plotting.

2. Click Apply to keep the dialog box open. Click OK to close the dialog box.

Rotat in g  and Zoom in g  on 3 D Plots

You can resize a three-dimensional plot using the same methods you use to resiz
graph region in Mathcad. Click on it and use the handles that appear along the e
to drag out the edges. Mathcad provides several additional options for manipula
the presentation of your 3D plot:

• You can rotate the plot to see it from a different perspective.

• You can set the plot in motion about an axis of rotation so that it spins continuo

• You can zoom in or out on a portion of the plot.

Not e When you rotate, spin, or zoom a three-dimensional plot, any visible axes move or resize
themselves with the plot. Text or graphic annotations you add to the plot (see page 241) r
anchored at their original sizes and positions.

Rota t in g  a  Plot
You can rotate a plot interactively with the mouse or by specifying parameters in
3D Plot Format dialog box.

To rotate a three-dimensional plot interactively by using the mouse:

1. Click in the plot, and hold the mouse button down.
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2. Drag the mouse in the direction you want the plot to turn.

3. Release the mouse button when the plot is in the desired position.

To rotate a three-dimensional plot by using the 3D Plot Format dialog box:

1. Click once on the plot to select it and choose Graph⇒3D Plot from the Format 
menu. Alternatively, double-click the plot.

2. Click the General tab.

3. Edit the settings for Rotation, Tilt, and Twist in the View options.

4. Click Apply to preview the plot. Click OK to close the dialog box.

Sp inn in g  a  Plot
You can set a plot in motion so that it spins continuously about an axis of rotatio

1. Click in the plot, and hold the [Shift ] key and the mouse button down.

2. Drag the mouse in the direction you want the plot to spin.

3. Release the mouse button to set the plot in motion.

 The plot spins continuously until you click again inside the plot.

Not e If you make changes to equations that affect a plot, the plot recomputes even when it is spi

Tip To create an AVI file of a spinning plot, see the techniques in “Animation” on page 119.

Zoom in g  a  Plot
You can zoom in or out of a plot interactively or by specifying a zoom factor in the
Plot Format dialog box.

To zoom in on a three-dimensional plot by using the mouse:

1. Click in the plot, and hold the [Ctrl ] key and the mouse button down.

2. Drag the mouse toward the top of the plot to zoom out, or drag the mouse to
the bottom to zoom in.

3. Release the mouse button when the plot is at the desired zoom factor.

Tip If you use an IntelliMouse-compatible mouse with a center wheel, you can rotate the whe
zoom in or out of a three-dimensional plot.

To zoom in or out of a three-dimensional plot by using the 3D Plot Format dialog 

1. Click once on the plot to select it and choose Graph⇒3D Plot from the Format 
menu. Alternatively, double-click the plot.

2. Click the General tab.

3. Edit the Zoom setting in the View options.

4. Click Apply to preview the plot. Click OK to close the dialog box.
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Chapter  1 4
Sy m bolic Ca lcula t ion

τ Overview of Sym bolic Math

τ Live Sym bolic Evaluat ion

τ Using t he Sym bolics Menu

τ Exam ples of Sym bolic Calculat ion

τ Sym bolic Opt im izat ion

Overview  of S y m bolic Math

Elsewhere in this User’s Guide, you’ve seen Mathcad engaging in numeric calculations. 
This means that whenever you evaluate an expression, Mathcad returns one or 
numbers, as shown at the top of Figure 14-1. When Mathcad engages in symbolic 
mathematics, however, the result of evaluating an expression is generally anoth
expression, as shown in the bottom of Figure 14-1. 

There are three ways to perform a symbolic transformation on an expression.

• You can use the symbolic equal sign as described in “Live Symbolic Evaluati
on page 246. This method feels very much as if you’re engaging in numeric m
If you need more control over the symbolic transformation, you can use keywords 
with the symbolic equal sign.

• You can use commands from the Symbolics menu. See “Using the Symbolics 
Menu” on page 254.

Figure 14-1: A numeric and symbolic evaluation of the same expression.
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• You can make the numeric and symbolic processors work together, the latter
simplifying an expression behind the scenes so that the former can work with
more efficiently. This is discussed in “Symbolic Optimization” on page 265.

Not e For a computer, symbolic operations are, in general, much more difficult than the correspo
numeric operations. In fact, many complicated functions and deceptively simple-looking 
functions have no closed-forms as integrals or roots.

Live S y m bolic Evaluat ion 

The symbolic equal sign provides a way to extend Mathcad’s live document inter
beyond the numeric evaluation of expressions. You can think of it as being analo
to the equal sign “=.” Unlike the equal sign, which always gives a numeric result 
the right-hand side, the symbolic equal sign is capable of returning expressions. You 
can use it to symbolically evaluate expressions, variables, functions, or program

To use the symbolic equal sign:

1. Make sure that Automatic Calculation on the Math  menu has a check beside it.
If it doesn’t, choose it from the menu.

2. Enter the expression you want to evaluate.

3. Click  on the Symbolic toolbar or press [Ctrl ].  
(the Control key followed by a period). Mathcad 
displays a symbolic equal sign, “→.”

4. Click outside the expression. Mathcad displays a 
simplified version of the original expression. If an 
expression cannot be simplified further, Mathcad 
simply repeats it to the right of the symbolic equal sign.

The symbolic equal sign is a live operator just like any Mathcad operator. When 
make a change anywhere above or to the left of it, Mathcad updates the result. T
symbolic equal sign “knows” about previously defined functions and variables and 
them wherever appropriate. You can force the symbolic equal sign to ignore prio
definitions of functions and variables by defining them recursively just before you
evaluate them, as shown in Figure 14-6 on page 253.

Figure 14-2 shows some examples of how to use the symbolic equal sign, “→.” 

Not e The symbolic equal sign, “→,” applies to an entire expression. You cannot use the symbolic
equal sign to transform only part of an expression. 

Tip Figure 14-2 also illustrates the fact that the symbolic processor treats numbers containing
decimal point differently from numbers without a decimal point. When you send numbers 
decimal points to the symbolic processor, any numeric results you get back are decimal 
approximations to the exact answer. Otherwise, any numeric results you get back are exp
without decimal points whenever possible. 
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The “→” takes the left-hand side and places a simplified version of it on the right-h
side. Of course, exactly what “simplify” means is a matter of opinion. You can, to
limited extent, control how the “→” transforms the expression by using one of the 
symbolic keywords. To do so:

1. Enter the expression you want to evaluate.

2. Click  on the Symbolic toolbar or press [Ctrl ] 
[Shift].  (Press the Control and Shift keys and type a 
period.) Mathcad displays a placeholder to the left of the symbolic equal sign, “→.”

3. Click on the placeholder to the left of the symbolic equal sign 
and type any of the keywords from the following table. If the 
keyword requires any additional arguments, separate the 
arguments from the keyword with commas.

4. Press [Enter ] to see the result.

Tip Another way to use a keyword is to enter the expression you want to evaluate and click o
keyword button from the Symbolic toolbar. This inserts the keyword, placeholders for any
additional arguments, and the symbolic equal sign, “→.” Just press [Enter ] to see the result.

Figure 14-2: Using the symbolic equal sign.
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complex Carries out symbolic evaluation in the complex domain. Resu
is usually in the form .

float, m Displays a floating point value with m places of precision 
whenever possible. If the argument m, an integer, is omitted, the
precision is 20. 

simplify Simplifies an expression by performing arithmetic, canceling
common factors, and using basic trigonometric and inverse 
function identities.

expand, expr Expands all powers and products of sums in an expression ex
for the subexpression expr. The argument expr is optional. The 
entire expression is expanded if the argument expr is omitted. 

If the expression is a fraction, expands the numerator and wr
the expression as a sum of fractions. Expands sines, cosines
tangents of sums of variables or integer multiples of variables
far as possible into expressions involving only sines and cosi
of single variables.

factor, expr Factors an expression into a product, if the entire expression 
be written as a product. Factors with respect to expr, a single 
radical or a list of radicals separated by commas. The argum
expr is optional. 

Usually factors a single variable into powers of primes. 
Otherwise, attempts to convert the expression into a product
simpler functions. Combines a sum of fractions into a single 
fraction and often simplifies a complex fraction with more tha
one fraction bar.

solve, var Solves an equation for the variable var or solves a system of 
equations for the variables in a vector var. 

collect,
var1,...,varn

Collects like terms with respect to the variables or 
subexpressions var1 through varn. 

coeffs, var Finds coefficients of an expression when it is rewritten as a 
polynomial in the variable or subexpression var. 

substitute,
var1 =var2

Replaces all occurrences of a variable var1 with an expression or 
variable var2. Press [Ctrl]=  for the bold equal sign.

series,
var =z,m

Expands an expression in one or more variables, var, around the 
point z. The order of expansion is m. Arguments z and m are 
optional. By default, the expansion is taken around zero and 
polynomial of order six. By default, finds Taylor series (series
nonnegative powers of the variable) for functions that are 
analytic at 0 and Laurent series for functions that have a pole
finite order at 0. 

a i b⋅+

1 m 250≤ ≤
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parfrac ,var

Converts an expression to a partial fraction expansion in var, the 
variable in the denominator of the expression on which to 
convert. Usually factors the denominator of the expression in
linear or quadratic factors having integer coefficients and 
expands the expression into a sum of fractions with these fac
as denominators. 

fourier, var Evaluates the Fourier transform of an expression with respec
the variable var. Result is a function of ω given by:

where f(t) is the expression to be transformed.

invfourier, var Evaluates the inverse Fourier transform of an expression wit
respect to the variable var. Result is a function of t given by:

where F(ω) is the expression to be transformed. 

laplace, var Evaluates the Laplace transform of an expression with respec
the variable var. Result is a function of s given by:

where f(t) is the expression to be transformed.

invlaplace, var Evaluates the inverse Laplace transform of an expression wi
respect to the variable var. Result is a function of t given by:

where F(s) is the expression to be transformed and all 
singularities of F(s) are to the left of the line .

ztrans, var Evaluates the z-transform of an expression with respect to the
variable var. Result is a function of z given by:

where f(n) is the expression to be transformed.

invztrans, var Evaluates the inverse z-transform of an expression with respec
to the variable var. Result is a function of n given by a contour 
integral around the origin:

where F(z) is the expression to be transformed and C is a contour 
enclosing all singularities of the integrand. 

assume
constraint

Imposes constraints on one or more variables according to th
expression constraint.
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Many of the keywords take at least one additional argument, typically the name 
variable with respect to which you are performing the symbolic operation. Some o
arguments are optional. See Figure 14-3 and Figure 14-4 for examples.

Not e Keywords are case sensitive and must therefore be typed exactly as shown. Unlike varia
however, they are not font sensitive. 

Keyw ord m odif ie rs

Some keywords take additional modifiers that specify the kind of symbolic evalua
even further.

To use a modifier, separate it from its keyword with a comma. For example, to us
“assume=real” modifier with the simplify  keyword on an expression:

1. Enter the expression to simplify.

Figure 14-3: Using keywords with a symbolic evaluation sign.

Figure 14-4: Evaluating expressions symbolically.
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2. Click  on the Symbolic toolbar or press [Ctrl ] [Shift].  (hold down the 
Control and Shift keys and type a period). Mathcad displays a placeholder to
left of the symbolic equal sign, “→.”

3. Enter simplify,assume=real  into the placeholder (press [Ctrl ]= for the 
equal sign).

4. Press [Enter ] to see the result.

Modif iers for “assum e”

Modif iers for “sim p lif y ” 

Figure 14-5 shows some examples using the simplify  keyword with and without 
additional modifiers.

Ti p Keyword modifiers can be typed or inserted from the buttons on the Modifier toolbar.

Usin g  More  Than One  Ke y w ord
In some cases, you may want to perform two or more types of symbolic evaluati
consecutively on an expression. Mathcad allows you to apply several symbolic k
words to a single expression. There are two ways of applying multiple keywords. 
method you choose depends on whether you want to see the results from each ke
or only the final result.

To apply several keywords and see the results from each:

1. Enter the expression you want to evaluate.

var =real Evaluates the expression on the assumption that the variablevar 
is real.

var =
RealRange( a, b)

Evaluates on the assumption that all the indeterminates are 
and are between a and b, where a and b are real numbers or 
infinity ([ Ctrl ][ Shift ]Z).

assume=real Simplifies on the assumption that all the indeterminates in th
expression are real.

assume=
RealRange( a, b)

Simplifies on the assumption that all the indeterminates are r
and are between a and b, where a and b are real numbers or 
infinity ([ Ctrl ][Shift ]Z).

trig Simplifies a trigonometric expression by applying only the 
following identities:

It does not simplify the expression by simplifying logs, power
or radicals.

x( )sin
2

x( )cos
2

+ 1=

x( )cosh
2

x( )sinh
2

– 1=
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2. Press  on the Symbolic toolbar or type 
[Ctrl ] [Shift].  (Hold down the Control 
and Shift keys and type a period.) Mathcad displays a placeholder to the left o
symbolic equal sign, “→.”

3. Enter the first keyword into the placeholder to 
the left of the symbolic equal sign, including 
any comma-delimited arguments the keyword 
takes.

4. Press [Enter ] to see the result from the first 
keyword.

5. Click on the result and press [Ctrl ] 
[Shift].  again. The first result disappears 
temporarily. Enter a second keyword and any 
modifiers into the placeholder. 

6. Press [Enter ] to see 
the result from the 
second keyword.

Continue applying keywords to the intermediate results in this manner.

To apply several keywords and see only the final result:

1. Enter the expression you want to evaluate.

Figure 14-5: Modifiers such as “assume=real” allow you to control simpli-
fication.
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2. Click  on the Symbolic toolbar or press 
[Ctrl ] [Shift].  so that Mathcad displays a 
placeholder to the left of the symbolic equal sign, “→.”

3. Enter the first keyword into the placeholder, 
including any comma-delimited arguments it 
takes.

4. Press [Ctrl ] [Shift].  again and enter a 
second keyword into the placeholder. The 
second keyword is placed immediately below 
the first keyword.

5. Continue adding keywords by pressing [Ctrl ] 
[Shift].  after each one. Press [Enter ] to 
see the final result.

I g nor in g  Previous Def in it ions
When you use the symbolic equal sign to evaluate an expression, Mathcad chec
the variables and functions making up that expression to see if they’ve been def
earlier in the worksheet. If Mathcad does find a definition, it uses it. Any other varia
and functions are evaluated symbolically. 

There are two exceptions to this. In evaluating an expression made up of previo
defined variables and functions, Mathcad ignores prior definitions:

• When the variable has been defined recursively. 

• When the variable has been defined as a range variable. 

These exceptions are illustrated in Figure 14-6.

Figure 14-6: Defining a variable in terms of itself makes the symbolic 
processor ignore previous definitions of that variable.
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Not e Although Mathcad does not evaluate range variables symbolically, it does symbolically eva
any vectors or matrices that you define using range variables.

Usin g  the S y m bolics Menu

One advantage to using the symbolic equal sign, sometimes together with keyw
and modifiers as discussed in the last section, is that it is “live,” just like the num
processing in Mathcad. That is, Mathcad checks all the variables and functions ma
up the expression being evaluated to see if they’ve been defined earlier in the work
If Mathcad does find a definition, it uses it. Any other variables and functions are
evaluated symbolically. Later on, whenever you make a change to the workshee
results automatically update. This is useful when the symbolic and numeric equa
in the worksheet are tied together.

There may be times, however, when a symbolic calculation is quite separate from
rest of your worksheet and does not need to be tied to any previous definitions. In 
cases, you can use commands from the Symbolics menu. These commands are not live
you apply them on a case by case basis to selected expressions, they do not “kn
about previous definitions, and they do not automatically update. 

The commands on the Symbolics menu perform the same manipulations as many o
the keywords listed on page 247. For example, the Symbolics menu command 
Polynomial Coefficients evaluates an expression just as the keyword coeffs  does. 
The only differences are that the menu command does not recognize previous 
definitions and does not automatically update.

The basic steps for using the Symbolics menu are the same for all the menu comman

1. Place whatever math expression you want to evaluate between the two editing lines. 
You can drag-select a part of the expression to place it between the editing li

2. Choose the appropriate command from the Symbolics menu. Mathcad then places
the evaluated expression into your document.

For example, to evaluate an expression symbolically using the Symbolics menu, follow 
these steps:

1. Enter the expression you want to evaluate.

2. Surround the expression with the editing lines.

3. Choose Evaluate⇒Symbolically from the Symbolics menu. 
Mathcad places the evaluated expression into your worksheet. The 
location of the result in relation to the original expression depends 
on the Evaluation Style you’ve selected (see “Displaying Symbolic Results” o
page 255). 

Some commands on the Symbolics menu require that you click on or select the variab
of interest rather than select the entire expression. If a menu command is unavai
try selecting a single variable rather than an entire expression.
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Tip Since the commands on the Symbolics menu operate only on the part of the expression curren
selected by the editing lines, they are useful when you want to address parts of an expres
For example, if evaluating or simplifying the entire expression doesn’t give the answer yo
want, try selecting a subexpression and choose a command from the Symbolics menu. 

Lon g  Result s 
Symbolic calculations can easily produce results so long that they don’t fit convenie
in your window. If you obtain a symbolic result consisting of several terms by usi
commands on the Symbolics menu, you can reformat such a result by using Mathca
“Addition with line break” operator (see “Operators” on page 298 in the Appendic

Sometimes, a symbolic result is so long that you can’t conveniently display it in y
worksheet. When this happens, Mathcad asks if you want the result placed in th
Clipboard. If you click “OK,” Mathcad places a string representing the result on t
Clipboard. When you examine the contents of the clipboard, you’ll see a result wr
in a Fortran-like syntax. See the topic “Special functions and syntax used in Symb
results” in the on-line Help for more information on this syntax.

Dis p la y in g  Sy m bolic Resu lt s 
If you’re using the symbolic equal sign, “→,” the result of a symbolic transformation
always goes to the right of the “→.” However, when you use the Symbolics menu, you 
can tell Mathcad to place the symbolic results in one of the following ways:

• The symbolic result can go below the original expression. 

• The symbolic result can go to the right of the original expression. 

• The symbolic result can simply replace the original expression. 

In addition, you can choose whether you want Mathcad to generate text describing
had to be done to get from the original expression to the symbolic result. This text 
between the original expression and the symbolic result, creating a narrative for 
symbolic evaluation. These text regions are referred to as “evaluation comments

To control both the placement of the symbolic result and the presence of narrative
choose Evaluation Style from the Symbolics menu to bring up the “Evaluation Style”
dialog box. 

Exam p les of S y m bolic Calcula t ion

Just as you can carry out a variety of numeric calculations in Mathcad, you can c
out all kinds of symbolic calculations. As a general rule, any expression involving
variables, functions, and operators can be evaluated symbolically using either th
symbolic equal sign or the menu commands, as described earlier in this chapter

Tip When deciding whether to use the symbolic equal sign or menu commands from the Symbolics 
menu, remember that unlike the keyword-modified expressions, expressions modified by
commands from the Symbolics menu do not update automatically, as described in the secti
“Using the Symbolics Menu” on page 254.
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This section describes how to symbolically evaluate definite and indefinite integr
derivatives, and limits. It also covers how to symbolically transpose, invert, and f
the determinant of a matrix. Finally, this section describes how to perform symbo
transforms and solve equations symbolically. Keep in mind that these are just a fe
the calculations you can perform symbolically.

Not e Functions and variables you define yourself are recognized by the symbolic processor whe
use the symbolic equal sign. They are not, however, recognized when you use the Symbolics 
menu commands. Figure 14-7 shows the difference.

Der iva t ives 
To evaluate a derivative symbolically, you can use Mathcad’s derivative operator
the live symbolic equal sign as shown in Figure 14-8:

1. Click    on the Calculus toolbar or type ? to insert the derivative operator. 

Alternatively, click  on the Calculus toolbar or type [Ctrl ]? to insert the nth 
order derivative operator.

2. Enter the expression you want to differentiate and the variable with respect to w
you are differentiating in the placeholders. 

3. Click  on the Symbolic toolbar or press [Ctrl ].  (the Control key followed by 
a period). Mathcad displays a symbolic equal sign, “→.”

4. Press [Enter ] to see the result.

Figure 14-7: The symbolic processor recognizes certain built-in functions. 
Functions and variables you define yourself are only recognized when you 
use the symbolic equal sign.
256  Chapter 14  Symbolic Calculation



tive 

 

 

Figure 14-9 shows you how to differentiate an expression without using the deriva
operator. The Symbolics menu command Variable⇒Differentiate differentiates an 

expression with respect to a selected variable. For example, to differentiate 
with respect to x: 

1. Enter the expression.

2. Click on or select the x. 

3. Choose Variable⇒Differentiate from the Symbolics menu. Mathcad displays the

derivative, . Note that y is treated as a constant.

Figure 14-8: Evaluating integrals and derivatives symbolically.

Figure 14-9: Differentiating and integrating with menu commands.

2 x2⋅ y+

4 x⋅
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If the expression in which you’ve selected a variable is one element of an array, Ma
differentiates only that array element. To differentiate an entire array, differentiate 
element individually: select a variable in that element and choose 
Variable⇒Differentiate from the Symbolics menu.

Tip Be sure to select a variable in an expression before choosing from the Symbolics menu. 
Otherwise, the Variable⇒Differentiate menu command is not available. 

I n te g rals    
To symbolically evaluate a definite or indefinite integral:

1. Click  or  on the Calculus toolbar to insert the definite or indefinite integ
operator.

2. Fill in the placeholder for the integrand and, if applicable, the placeholders for
limits of integration.

3. Place the integration variable in the placeholder next to the “d.” This can be any 
variable name.

4. Click  on the Symbolic toolbar or press [Ctrl ].  (the Control key followed by 
a period). Mathcad displays a symbolic equal sign, “→.”

5. Press [Enter ] to see the result.

See Figure 14-8 for examples of integrals evaluated symbolically.

When evaluating a definite integral, the symbolic processor attempts to find an 
indefinite integral of your integrand before substituting the limits you specified. If 
symbolic integration succeeds and the limits of integration are integers, fractions
exact constants like π, you get an exact value for your integral. If the symbolic proces
can’t find a closed form for the integral, you’ll see an appropriate error message

Another way to integrate an expression indefinitely is to enter the expression and 
on the variable of integration. Then choose Variable⇒Integrate from the Symbolics 
menu. See Figure 14-9 for an example. Be sure to select a variable in an express
before choosing from the Symbolics menu. Otherwise, the Variable⇒Integrate menu 
command is unavailable. 

Tip When you apply the Variable⇒Integrate command on the Symbolics menu, the expression 
you select should not usually include the integral operator. You should select only an expre
to integrate. If you include the integral operator in the selected expression, you are taking
double integral.
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Lim it s
Mathcad provides three limit operators. These can only be evaluated symbolically
use the limit operators:

1. Click    on the Calculus toolbar or press [Ctrl ]L to insert the limit operator. 

To insert the operator for a limit from the left or right, click    or  on the 
Calculus toolbar or press [Ctrl ][Shift ]B or [Ctrl ][Shift ]A.

2. Enter the expression in the placeholder to the right of the “lim.”

3. Enter the limiting variable in the left-hand placeholder below the “lim.”

4. Enter the limiting value in the right-hand placeholder below the “lim.”

5. Click  on the Symbolic toolbar or press [Ctrl ].  (the Control key followed by 
a period). Mathcad displays a symbolic equal sign, “→.”

6. Press [Enter ] to see the result.

Mathcad returns a result for the limit. If the limit does not exist, Mathcad returns 
error message. Figure 14-10 shows some examples of evaluating limits.

Solv in g  an  Eq ua t ion  for  a  Var iable     
To solve an equation symbolically for a variable, use the keyword solve:

1. Type the equation. Make sure you click  on the Boolean toolbar or type 
[Ctrl ]= to create the bold equal sign.

Not e When solving for the root of an expression, there is no need to set the expression equal to
See Figure 14-11 for an example.

Figure 14-10: Evaluating limits.
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2. Click  on the Symbolic toolbar or type [Ctrl ] [Shift].  (hold down the 
Control and Shift keys and type a period). Mathcad displays a placeholder to
left of the symbolic equal sign, “→.”

3. Type solve  in the placeholder, followed by a comma and the variable for whi
to solve.

4. Press [Enter ] to see the result.

Mathcad solves for the variable and inserts the result to the right of the “→.” Note that 
if the variable was squared in the original equation, you may get two results back when 
you solve. Mathcad displays these in a vector. Figure 14-11 shows an example.

Tip Another way to solve for a variable is to enter the equation, click on the variable you wan
solve for in the equation, and choose Variable⇒Solve from the Symbolics menu.

Solv in g  a  Sy stem  of  E q uat ions S y m bolica ll y : “Solve”  Ke y w ord    
One way to symbolically solve a system of equations is to use the same solve keyword 
used to solve one equation in one unknown. To solve a system of n equations for n 
unknowns:

1. Press  on the Matrix toolbar or type [Ctrl ]M to insert a vector having n rows 
and 1 column.

2. Fill in each placeholder of the vector with one of the n equations making up the 

system. Make sure you click  on the Boolean toolbar or type [Ctrl ]= to enter 
the bold equal sign.

Figure 14-11: Solving equations, solving inequalities, and finding roots.
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3. Press  on the Symbolic toolbar or type [Ctrl ] [Shift].  (hold down the 
Control and Shift keys and type a period). Mathcad displays a placeholder to
left of the symbolic equal sign, “→.”

4. Type solve  followed by a comma in the placeholder.

5. Type [Ctrl ]M or press  on the Matrix toolbar to create a vector having n rows 
and 1 column. Then enter the variables you are solving for.

6. Press [Enter ] to see the result. 

Mathcad displays the n solutions to the system of equations to the right of the symbo
equal sign. Figure 14-12 shows an example.

Solv in g  a  Sy stem  of  E q uat ions S y m bolica ll y : Solve  Block
Another way to solve a system of equations symbolically is to use a solve block, sim
to the numeric solve blocks described in “Solving and Optimization Functions” on p
157: 

1. Type the word Given. This tells Mathcad that what follows is a system of equation
You can type Given in any combination of upper- and lowercase letters and in a
font. Just be sure you don’t type it while in a text region.

2. Now enter the equations in any order below the word Given. Make sure that for 

every equation you click  on the Boolean toolbar or type [Ctrl ]= to insert the 
bold equal sign for each equation.

3. Enter the Find function with arguments appropriate for your system of equatio
This function is described in “Linear/Nonlinear System Solving and Optimizatio
on page 159.

Figure 14-12: Two methods for solving a system of equations symbolically.
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4. Click  on the Symbolic toolbar or press [Ctrl ].  (the Control key followed by 
a period). Mathcad displays the symbolic equal sign.

5. Click outside the Find function or press [Enter ]. 

Mathcad displays the solutions to the system of equations to the right of the sym
equal sign. Figure 14-12 shows an example.

Most of the guidelines for solve blocks described in “Linear/Nonlinear System Solv
and Optimization” on page 159 apply to the symbolic solution of systems of equati
The main difference is that when you solve equations symbolically, you do not e
guess values for the solutions.

Sy m bolic M at r ix  Man i p u la t ion   
You can use Mathcad to find the symbolic transpose, inverse, or determinant of a m
using a built-in operator and the symbolic equal sign. To find the transpose of a m
for example:

1. Place the entire matrix between the two editing lines by clicking [Space ] one or 
more times.

2. Click  on the Matrix toolbar or press [Ctrl ] |  to insert the matrix transpose
operator.

3. Click  on the Symbolic toolbar or press [Ctrl ].  (the Control key followed by 
a period). Mathcad displays the symbolic equal sign, “→.”

4. Press [Enter ] to see the result.

Mathcad returns the result to the right of the “→.” Figure 14-13 shows some examples

Figure 14-13: Symbolic matrix operations.
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Another way to find the transpose, inverse, or determinant of a matrix is to use t
Matrix  commands on the Symbolics menu. For example, to find the transpose of a
matrix:

1. Place the entire matrix between the two editing lines by pressing [Space ] one or 
more times.

2. Choose Matrix ⇒Transpose from the Symbolics menu.

Unlike matrices evaluated with the symbolic equal sign, matrices modified by 
commands from the Symbolics menu do not update automatically, as described in t
section “Using the Symbolics Menu” on page 254.

Transform at ions      
You can use symbolic keywords to evaluate the Fourier, Laplace, or z- transform of a 
expression and to evaluate the inverse transform. For example, to evaluate the F
transform of an expression:

1. Enter the expression to be transformed.

2. Click  on the Symbolic toolbar or type [Ctrl ] [Shift].  (hold down the 
Control and Shift keys and type a period). Mathcad displays a placeholder to
left of the symbolic equal sign, “→.”

3. Type fourier  in the placeholder, followed by a comma and the name of the
transform variable.

4. Press [Enter ] to see the result. 

Not e Mathcad returns a function in a variable commonly used for the transform you perform. If
expression you are transforming already contains this variable, Mathcad avoids ambiguity
returning a function of a double variable. For example, Mathcad returns a function in the var
ω when you perform a Fourier transform. If the expression you are transforming already con
an ω, Mathcad returns a function of the variable ωω instead. 

The Fourier transform result is a function of ω given by: 

Use the keyword invfourier  to return the inverse Fourier transform as a functio
given by:

where f(t) and F(ω) are the expressions to be transformed. 

Use the keywords laplace , invlaplace , ztrans , and invztrans  to perform 
a Laplace or z-transform or their inverses.

The Laplace transform result is a function of s given by:

f t( )e i– ωt td
∞–

 ∞+

∫

1
2π
------ F ω( )ei ωt ωd

∞–

 ∞+

∫

f t( )e st– td
0

 ∞+

∫
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Its inverse is given by:

where f(t) and F(s) are the expressions to be transformed. All singularities of F(s) are 
to the left of the line .

The z-transform result is a function of z given by:

Its inverse is given by:

where f(n) and F(z) are the expressions to be transformed and C is a contour enclosing 
all singularities of the integrand.

Tip You can substitute a different variable for the one Mathcad returns from a transform or its
inverse by using the substitute keyword. 

Another way to evaluate the Fourier, Laplace, or z- transform or their inverses on an 
expression is to use commands on the Symbolics menu. For example, to find the 
Laplace transform of an expression:

• Enter the expression.

• Click on the transform variable.

• Choose Transform⇒Laplace from the Symbolics menu.

Keep in mind that, unlike keyword-modified expressions, expressions modified b
commands from the Symbolics menu do not update automatically, as described in t
section “Using the Symbolics Menu” on page 254.

Not e Results from symbolic transformations may contain functions that are recognized by Math
symbolic processor but not by its numeric processor. An example is the function Dirac shown 
in the middle of Figure 14-14. You’ll find numeric definitions for this and other such functio
in “Symbolic Transformation Functions” on page 301 in the Appendices as well as in the 
Resource Center QuickSheet titled “Special Functions.”

1
2π
------ F s( )est td

σ i ∞–

σ i∞+

∫

Re s( ) σ=

f n( )z n–

n 0=

 ∞+

∑

1
2πi
-------- F z( )zn 1– zd

C

 ∫
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Sy m bolic O p t im izat ion

In general, Mathcad’s symbolic and numeric processors don’t communicate with
another. You can, however, make the numeric processor ask the symbolic proce
for advice before starting what could be a needlessly complicated calculation. 

For example, if you were to evaluate an expression such as:

Mathcad would undertake the task of evaluating a numeric approximation of the t
integral even though one could arrive at an exact solution by first performing a fe
elementary calculus operations. 

This happens because by itself, Mathcad’s numeric processor does not simplify b
plunging ahead into the calculation. Although Mathcad’s symbolic processor kno
all about simplifying complicated expressions, these two processors do not consul
each other, although for certain definitions, it would be helpful. To make these tw
processors talk to each other for a particular definitionclick on a definition with th
right mouse button and choose Optimize from the pop-up menu.

Once you’ve done this, Mathcad’s live symbolic processor simplifies the expressio
the right of a “:=” before the numeric processor begins its calculations. This helps
Mathcad’s numeric processor evaluate the expression more quickly. It can also a
any computational issues inherent in the numeric calculation.

If Mathcad finds a simpler form for the expression, it responds by doing the follow

• It marks the region with a red asterisk. 

• It internally replaces what you’ve typed with a simplified form. 

Figure 14-14: Performing symbolic transforms.

x2 y2 z2 xd yd zd+ +
0

w

∫0

v

∫0

u

∫
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• The equivalent expression is evaluated instead of the expression you specifie
see this equivalent expression, double-click the red asterisk beside the regio

If Mathcad is unable to find a simpler form for the expression, it places a blue asterisk 
next to it.

In the previous example, the symbolic processor would examine the triple integra
return the equivalent, but much simpler expression:

Then it uses any defintions that exist in your worksheet and simplifies the expres
further. To see this expression in a pop-up window, click the red asterisk with the 
mouse button and choose Show Popup from the pop-up menu (see Figure 14-15). 

To enable optimization for an entire worksheet, choose Optimization  from the Math  
menu. To disable optimization for an expression, right-click it and uncheck Optimize 
on the pop-up menu. Mathcad evaluates the expression exactly as you typed it. 

To disable optimization for all expressions, remove the check from Optimization  on 
the Math  menu. 

Figure 14-15: A pop-up window showing the equivalent expression that 
Mathcad actually evaluates.

1
3
--- w3vu wv3u wvu3+ +( )
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Def inin g  a Pro g ram

A Mathcad program is a special kind of expression you can 
create in Mathcad Professional. It’s an expression made up of a 
sequence of statements created using programming operators, 

available on the Programming toolbar. Click  on the Math 
toolbar, or choose Toolbars⇒Programming from the View 
menu, to open the Programming toolbar.

You can think of a program as a compound expression that 
involves potentially many programming operators. Like any expression, a progra
returns a value—a scalar, vector, array, nested array, or string—when followed b
equal sign or the symbolic equal sign. Just as you can define a variable or functi
terms of an expression, you can also define them in terms of a program.

The following example shows how to make a simple program to define the funct

Although the example chosen is simple enough not to require programming, it 
illustrates how to separate the statements that make up a program and how to u
local assignment operator, “←.” 
1. Type the left side of the function definition, followed by a 

“ := ”. Make sure the placeholder is selected.

2. Click  on the Programming toolbar. Alternatively, press 
] . You’ll see a vertical bar with two placeholders, which will 
hold the statements that comprise your program.

f x w,( ) x
w
---- 

 log=
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3. Click in the top placeholder. Type z , then click  on the 
Programming toolbar. Alternatively, press {  to insert a “←,” 
which is also known as the local definition symbol.

4. Type x/w  in the placeholder to the right of the local definition 
symbol. Then press [Tab ] to move to the bottom placeholder, 
or click on the bottom placeholder.

5. Enter the value to be returned by the program in the remaining 
placeholder. Type log(z) .

You can now use this function just as you would any other function 
in your worksheet.

Not e You cannot use Mathcad’s usual assignment operator, “:=,” inside a program. You must u
local assignment operator, represented by “←,” instead. Variables defined inside a program wit
the local assignment operator, such as z in the example above, are local to the program and a
undefined elsewhere in the worksheet. However, within a program, you can refer to Math
variables and functions defined previously in the worksheet.

Figure 15-1 shows a more complex example involving the quadratic formula. Altho
you can define the quadratic formula with a single statement as shown in the top
of the figure, you may find it easier to define it with a series of simple statements
shown in the bottom half. 

Tip A program can have any number of statements. To add a statement, click  on the
Programming toolbar or press [ . Mathcad inserts a placeholder below whatever statement 
you’ve selected. To delete the placeholder, click on it and press [Bksp ].

As with any expression, a Mathcad program must have a value. This value is sim
the value of the last statement executed by the program. It can be a string expre
a single number, or an array of numbers. It can even be an array of arrays (see “N
Arrays” on page 204).

Figure 15-1: A more complex function defined in terms of both an expression 
and a program.
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You can also write a Mathcad program to return a symbolic expression. When you 
evaluate a program using the symbolic equal sign, “→,” described in Chapter 14, 
“Symbolic Calculation,” Mathcad passes the expression to its symbolic processor
when possible, returns a simplified symbolic expression. You can use Mathcad’s a
to evaluate programs symbolically to generate complicated symbolic expression
polynomials, and matrices. Figure 15-2 shows a function that, when evaluated 
symbolically, generates symbolic polynomials. 

Not e Programs that include the return  and on error  statements, described on page 273 and 
page 275, cannot be evaluated symbolically since the symbolic processor does not recog
these operators.

On- line Help For programming examples, see the “Programming” section in the Resource Center 
QuickSheets. The Resource Center also includes a special section, “The Treasury Guide
Programming,” which provides detailed examples and applications of Mathcad programs.

Condit ional Sta tem ents

In general, Mathcad evaluates each statement in your program from the top down. 
may be times, however, when you want Mathcad to evaluate a statement only wh
particular condition is met. You can do this by including an if  statement.

For example, suppose you want to define a function that forms a semicircle aroun
origin but is otherwise constant. To do this:

1. Type the left side of the function definition, followed by 
a “:= ”. Make sure the placeholder is selected.

2. Click  on the Programming toolbar. 
Alternatively, press ] . You’ll see a vertical bar with two 

Figure 15-2: Using a Mathcad program to generate a symbolic expression.
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placeholders. These placeholders will hold the statements making up your prog

3. Click  on the Programming toolbar in the top 
placeholder. Alternatively, press } . Do not type “if.”

4. Enter a Boolean expression in the right placeholder 
using one of the relational operators on the Boolean 
toolbar. In the left placeholder, type the value you want 
the program to return whenever the expression in the 
right placeholder is true. If necessary, add more placeholders by clicking 

5. Select the remaining placeholder and click  on 
the Programming toolbar or press [Ctrl ] 3.

6. Type the value you want the program to return if the 
condition in the first statement is false. 

Figure 15-3 shows a plot of this function.

Not e The if  statement in a Mathcad program is not the same as the if function (see “Piecewise 
Continuous Functions” on page 148). Although it is not hard to define a simple program u
the if function, as shown in Figure 15-3, the if function can become unwieldy as the number o
branches exceeds two. 

Looping

One of the greatest strengths of programmability is the ability to execute a sequen
statements repeatedly in a loop. Mathcad provides two loop structures. The choi
which loop to use depends on how you plan to tell the loop to stop executing.

• If you know exactly how many times you want a loop to execute, use a for  loop. 

Figure 15-3: Using the if  statement to define a piecewise continuous function.
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• If you want the loop to stop when a condition has been met, but you don’t kn
how many loops will be required, use a while  loop.

Tip See “Controlling Program Execution” on page 272 for methods to interrupt calculation wit
the body of a loop.

“For ” Loops
A for  loop terminates after a predetermined number of iterations. Iteration is contro
by an iteration variable defined at the top of the loop. The definition of the iteration
variable is local to the program.

To create a for  loop:

1. Click  on the Programming toolbar or press [Ctrl ] “ . Do 
not type the word “for.” 

2. Type the name of the iteration variable in the placeholder to the 
left of the “∈.” 

3. Enter the range of values the iteration variable should take in the 
placeholder to the right of the “∈.” You usually specify this range 
the same way you would for a range variable (see page 101). 

4. Type the expression you want to evaluate in the remaining 
placeholder. This expression generally involves the iteration 
variable. If necessary, add placeholders by clicking  on the 
Programming toolbar.

The upper half of Figure 15-4 shows this for  loop being used to add a sequence of integers.

Not e Although the expression to the right of the “∈” is usually a range, it can also be a vector or a li
of scalars, ranges, and vectors separated by commas. The lower half of Figure 15-4 show
example in which the iteration variable is defined as the elements of two vectors. 

Figure 15-4: Using a for  loop with two different kinds of iteration variables.
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“W hile ” Loo p s
A while  loop is driven by the truth of some condition. Because of this, you don’t n
to know in advance how many times the loop will execute. It is important, howeve
have a statement somewhere, either within the loop or elsewhere in the program
eventually makes the condition false. Otherwise, the loop executes indefinitely.

To create a while  loop:

1. Click  on the Programming toolbar or press [Ctrl ] ] . 
Do not type the word “while.”

2. Click in the top placeholder and type a condition. This is 
typically a Boolean expression like the one shown.

3. Type the expression you want evaluated in the remaining 
placeholder. If necessary, add placeholders by clicking 

 on the Programming toolbar.

Figure 15-5 shows a larger program incorporating the above loop. 
Upon encountering a while  loop, Mathcad checks the condition. If the condition is 
true, Mathcad executes the body of the loop and checks the condition again. If th
condition is false, Mathcad exits the loop.

Cont rolling Program  Execut ion

The Programming toolbar in Mathcad Professional includes three statements for
controlling program execution:

Figure 15-5: Using a while  loop to find the first occurrence of a particular 
number in a matrix. 
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• Use the break  statement within a for  or while  loop to interrupt the loop when a 
condition occurs and move execution to the next statement outside the loop.

• Use the continue  statement within a for  or while  loop to interrupt the current 
iteration and force program execution to continue with the next iteration of the l

• Use the return  statement to stop a program and return a particular value from wi
the program rather than from the last statement evaluated. 

The “Break” Sta tem ent
It is often useful to break out of a loop upon the occurrence of some condition. F
example, in Figure 15-6 a break  statement is used to stop a loop when a negative
number is encountered in an input vector.

To insert a break  statement, click on a placeholder inside a loop and click  
the Programming toolbar or press [Ctrl ] { . Do not type the word “break.” You 
typically insert break  into the left-hand placeholder of an if  statement. The break  is 
evaluated only when the right-hand side of the if  is true.

Tip To create the program on the left in Figure 15-6, for example, you would click  first, 

then click .

The “Cont inue” Sta tem ent
To ignore an iteration of a loop, use continue . For example, in Figure 15-6 a continue  
statement is used to ignore nonpositive numbers in an input vector.

To insert the continue  statement, click on a placeholder inside a loop and click 
on the Programming toolbar or press [Ctrl ] [ . Do not type the word “continue.” As 
with break , you typically insert continue  into the left-hand placeholder of an if  

Figure 15-6: The break  statement halts the loop. Program execution resumes 
on the next iteration when continue  is used.
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statement. The continue  statement is evaluated only when the right-hand side of 
if  is true.

The “Return”  Statem ent
A Mathcad program returns the value of the last expression evaluated in the prog
In simple programs, the last expression evaluated is in the last line of the program
you create more complicated programs, you may need more flexibility. The return  
statement allows you to interrupt the program and return particular values other 
the default value. 

A return  statement can be used anywhere in a program, even within a deeply n
loop, to force program termination and the return of a scalar, vector, array, or str
As with break  and continue , you typically use return  on the left-hand side of an if  
statement, and the return  statement is evaluated only when the right-hand side of 
if  statement is true.

The following program fragment shows how a return  statement is used to return a 
string upon the occurrence of a particular condition:

1. Click  on the Programming toolbar.

2. Now click  on the Programming toolbar or 
press [Ctrl ]| . Do not type “return.”

3. Create a string by typing the double-quote key (" ) 
on the placeholder to the right of return . Then type 
the string to be returned by the program. Mathcad 
displays the string between a pair of quotes.

4. Type a condition in the placeholder to the right of if . 
This is typically a Boolean expression like the one 
shown. (Type [Ctrl ]= for the bold equal sign.)

In this example, the program returns the string “int” when the expression 
is true.

Tip You can add more lines to the expression to the right of return  by clicking  on the 
Programming toolbar.

Error  Handling

Errors may occur during program execution that cause Mathcad to stop calculatin
program. For example, because of a particular input, a program may attempt to d
by 0 in an expression and therefore encounter a singularity error. In these cases M
treats the program as it does any math expression: it marks the offending expres
with an error message and highlights the offending name or operator in a different c
as described in Chapter 8, “Calculating in Mathcad.” 

Mathcad Professional gives you two features to improve error handling in progra

floor x( ) x=
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• The on error  statement on the Programming toolbar allows you to trap a numer
error that would otherwise force Mathcad to stop calculating the program.

• The error string function gives you access to Mathcad’s error tip mechanism 
lets you customize error messages issued by your program.

“On Er ror ” Sta tem ent

In some cases you may be able to anticipate program inputs that lead to a nume
error (such as a singularity, an overflow, or a failure to converge) that would forc
Mathcad to stop calculating the program. In more complicated cases, especially 
your programs rely heavily on Mathcad’s numerical operators or built-in function 
you may not be able to anticipate or enumerate all of the possible numerical error
can occur in a program. The on error statement is designed as a general-purpose er
trap to compute an alternative expression when a numerical error occurs that wo
otherwise force Mathcad to stop calculating the program. 

To use the on error  statement, click  on the Programming toolbar or type 
[Ctrl ] ‘ . Do not type “on error.” In the placeholder to the right of on error , create 
the program statement(s) you ordinarily expect to evaluate but in which you wish
trap any numerical errors. In the placeholder to the left of on error , create the program 
statement(s) you want to evaluate should the default expression on the right-han
fail.

Figure 15-7 shows on error  operating in a program to find a root of an expression

I ssu ing  Er ror  M essages
Just as Mathcad automatically stops further evaluation and produces an approp
“error tip” on an expression that generates an error (see the bottom of Figure 15
an example), you can cause evaluation to stop and make custom error tips appea
your programs or other expressions are used improperly or cannot return answe

Figure 15-7: The on error  statement traps numerical errors in a program.
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Mathcad Professional’s error string function gives you this capability. This function
described in “String Functions” on page 187, suspends further numerical evaluati
an expression and produces an error tip whose text is simply the string it takes a
argument. Typically you use the error string function in the placeholder on the left-
hand side of an if  or on error  programming statement so that an error and appropri
error tip are generated when a particular condition is encountered.

Figure 15-8 shows how custom errors can be used even in a small program.

Not e Some error strings are automatically translated to a Mathcad error message that is similar
error string. For example “must be real” is translated to “This value must be real. Its imagi
part must be zero.”

Program s W ithin Program s

The examples in previous sections have been chosen more for illustrative purpo
rather than their power. This section shows examples of more sophisticated prog

Much of the flexibility inherent in programming arises from the ability to embed 
programming structures inside one another. In Mathcad, you can do this in the follo
ways:

• You can make one of the statements in a program be another program, or yo
define a program elsewhere and call it from within another program as if it we
subroutine.

• You can define a function recursively.

Subrout ines
Figure 15-9 shows two examples of programs containing a statement which is its
program. In principle, there is no limit to how deeply nested a program can be. 

Figure 15-8: Generating custom errors via the error string function.
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One way many programmers avoid overly complicated programs is to bury the 
complexity in subroutines. Figure 15-10 shows an example of this technique.

Tip Breaking up long programs with subroutines is good programming practice. Long program
those containing deeply nested statements can become difficult for other users to unders
a glance. They are also more cumbersome to edit and debug. 

In Figure 15-10, the function adapt carries out an adaptive quadrature or integratio
routine by using intsimp to approximate the area in each subinterval. By defining 

Figure 15-9: Programs in which statements are themselves programs.

Figure 15-10: Using a subroutine to manage complexity.
Pro Programs Within Programs 277



in 

, 

tive 
intsimp elsewhere and using it within adapt, the program used to define adapt becomes 
considerably simpler.

Recursion
Recursion is a powerful programming technique that involves defining a function 
terms of itself, as shown in Figure 15-11. See also the definition of adapt in Figure 15-
10. Recursive function definitions should always have at least two parts:

• A definition of the function in terms of a previous value of the function.

• An initial condition to prevent the recursion from continuing forever.

The idea is similar to mathematical induction: if you can determine  from 

and you know , then you know all there is to know about f.

Tip Recursive function definitions, despite their elegance and conciseness, are not always 
computationally efficient. You may find that an equivalent definition using one of the itera
loops described earlier will evaluate more quickly.

Figure 15-11: Defining functions recursively.

f n 1+( ) f n( )
f 0( )
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Chapter  1 6
Advanced Com putat iona l Features

τ Worksheet  References

τ Exchanging Data wit h Other  Applicat ions

τ Scr ipt ing Custom  OLE Autom at ion Objects

τ Accessing Mathcad from  With in Another  Applicat ion

W orksheet  Re ferences    

There may be times when you want to use formulas and calculations from one Ma
worksheet inside another. You may also have calculations and definitions that yo
use frequently in your work. You can, of course, simply use Copy and Paste from the 
Edit  menu to move whatever you need to move, or drag regions from one works
and drop them in another. However, when entire worksheets are involved, this me
can be cumbersome or may obscure the main computations of your worksheet. 

Mathcad therefore allows you to reference one worksheet from another—that is, to 
access the computations in the other worksheet without opening it or typing its 
equations or definitions directly in the current worksheet. When you insert a refere
to a worksheet, you won’t see the formulas of the referenced worksheet, but the cu
worksheet behaves as if you could. 

Tip An alternative described in “Safeguarding an Area of the Worksheet” on page 85 is to cre
collapsible area to hide calculations in your worksheet. This method, while it does not let y
re-use calculations in the same way as a worksheet reference, does give you the option o
password protecting or locking an area of calculations.

To insert a reference to a worksheet:

1. Click the mouse wherever you want to insert the reference. Make sure you cli
empty space and not in an existing region. The cursor should look like a cross

2. Choose Reference 
from the Insert  
menu. 

3. Click “Browse” to 
locate and select a 
worksheet. Alterna-
tively, enter the path 
to a worksheet. You 
can also enter an In-
ternet address (URL) to insert a reference to a Mathcad file that is located on th
World Wide Web. 
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4. Click “OK” to insert the reference into your worksheet.

To indicate that a reference has been in-
serted, Mathcad pastes a small icon wher-
ever you had the crosshair. The path to the referenced worksheet is to the right 
icon. All definitions in the referenced worksheet are available below or to the righ
this icon. If you double-click this icon, Mathcad opens the referenced worksheet i
own window for editing. You can move or delete this icon just as you would any o
Mathcad region.

Not e By default, the location of the referenced file is stored in the worksheet as an absolute sy
path (or URL). This means that if you move the main worksheet and the referenced work
to a different file system with a different directory structure, Mathcad cannot locate the 
referenced file. If you want the location of the referenced file on a drive to be stored relativ
the Mathcad worksheet containing the reference, click “Use relative path for reference” in
Insert Reference dialog box. The reference is then valid even if you move the referenced fi
the main worksheet to a different drive but keep the relative directory structure intact. To use a
relative path, you must first save the file containing the reference.

If you edit the contents of a referenced file so that any calculations change, you 
re-open any worksheets that contain references to that file for calculations to up
The calculations in those worksheets do not update automatically.

Exchan g in g  Data w ith Other A pp licat ions

Components are specialized OLE objects that allow you to access the functions of oth
computational applications (such as MathSoft’s Axum and S-PLUS, Microsoft Excel, 
and MATLAB ) within your Mathcad worksheet. Unlike other kinds of OLE objects you 
insert into a worksheet, as described in the section “Inserting Objects” in Chapte
component can receive data from Mathcad, return data to Mathcad, or do both, 
dynamically linking the object to your Mathcad computations.

Tip As described in Chapter 11, “Vectors, Matrices, and Data Arrays,” Mathcad also provides
File Read/Write component for you to import and export static data files in a variety of formats 
compatible with other computational programs. For linking dynamically to an object for wh
Mathcad does not have a dedicated component, see “Scripting Custom OLE Automation 
Objects” on page 292.

The available components in Mathcad include:

• Axum, for creating highly customizable Axum graphs

• Excel, for accessing cells and formulas in a Microsoft Excel spreadsheet

• SmartSketch, for creating 2D drawings and designs

• S-PLUS Graph component, for creating S-PLUS graphs

Pro • S-PLUS Script component, for accessing the programming environment of S-PLUS

Pro • MATLAB, for accessing the programming environment of MATLAB
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Not e To use an application component, you must have the application for that component insta
but not necessarily running, on your system.

Tip See the SAMPLES folder of the location where you installed Mathcad for a variety of exam
files that use components.

How  to Use Com p onents
Components receive input from one or more Mathcad variables, perform operations 
the data you specify, and in most cases return output to other Mathcad variables. An 
“input variable” is a scalar, vector, or matrix you have already defined in your Math
worksheet. It contains the data that is passed into a component. Output from a 
component (again, either a scalar, vector, or matrix) is then assigned to a Mathc
variable. This variable is referred to as an “output variable.” 

The basic steps for using a component are as follows:

• Insert the component.

• Specify the input variable(s) and output variable(s).

• Configure the component to handle inputs from and return outputs to Mathca

Since some components only take input or only send output, these steps differ sl
for each component. The ideas presented in these steps provide an overview.

Tip Many components support strings as well as scalars, vectors, and matrices for the input a
output.

Step 1 : I nser t ing a  com ponent

To insert a component into a Mathcad worksheet:

1. Click in a blank spot of your Mathcad worksheet where you want the compon
to appear. Click below or to the right of definitions for any variables that will 
become inputs to the component.

2. Choose Component from the Insert menu. This launches the Component Wizar

3. Choose one of the components from the list and click “Next.” Depending on t
component you choose, you may see an additional dialog box that lets you sp
properties of the component before it is inserted. When you click “Finish,” the
component is inserted into your worksheet. 

If you don’t see a Wizard when you choose one of the components from the Inse
Component dialog box, you’ll immediately see the component, with some defaul
properties, inserted into your worksheet. 

Each component has its own particular appearance, but all components have on
more placeholders to the left of the := and/or at the bottom of the component. Fo
example, the Excel component (with one input and two outputs) looks like this w
inserted into your worksheet:
Exchanging Data with Other Applications 281



sly 
utput 

the 

d 
 

 so 
 what 

, the 
in 
t.

 

e other 
thcad 

ange 
onent 
t. This 
The placeholder(s) at the bottom of the component are for the names of previou
defined input variables. The placeholder(s) you see to the left of the := are for the o
variables. 

After you fill in the placeholders for the input and output variables, you can hide 
variables by clicking with the right mouse button on the component and choosing Hide 
Arguments from the pop-up menu.

Not e To add an input or output variable, click with the right mouse button on the component an
choose Add Input Variable  or Add Output Variable  from the pop-up menu. To eliminate an
input or output, choose Remove Input Variable or Remove Output Variable from the menu.

Step 2 : Conf igur ing a  com ponent

Once you’ve inserted a component into a worksheet, you configure its properties
that the component knows how to handle any inputs it receives from Mathcad and
to send as output. To configure the properties for a component:

1. Click on the component once to select it.

2. Click on the component with the right mouse button to see a pop-up menu.

3. Choose Properties from the pop-up menu.

The settings in the Properties dialog box differ for each component. For example
Properties dialog box for the Excel component lets you specify the starting cells 
which the input values are stored and the cell range from which the output is sen

Tip When you insert an application component, you see a small window on that application’s
environment embedded in your Mathcad worksheet. When you double-click the component, the 
component is activated in place and Mathcad’s menus and toolbars change to those of th
application. This gives you access to the features of that application without leaving the Ma
environment.

Step 3 : Exchanging  da ta

Once you’ve configured the component, click outside it. At that point, the data exch
takes place: data passes from the input variable(s) into the component, the comp
processes the data, and the output variable(s) receive output from the componen
exchange happens whenever you click on the component and press [F9],  when the 
input variables change, or when you choose Calculate Worksheet from the Math  
menu.
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Tip Some components allow you to save the file with which the component exchanges data a
separate file. Click on a component with the right mouse button and choose Save As... from the 
pop-up menu.

Axum  Com p onent
Axum is a technical graphing and data analysis application available from MathS
that gives you access to over 90 two- and three-dimensional graph types with so
ticated formatting options. If you have Axum LE for Mathcad (included in your 
Mathcad Professional package) or Axum 5.03 or higher installed on your system
Axum component brings some of this graphing power to your Mathcad workshee

I nser t ing an  Axum  graph

To insert an Axum component into a Mathcad worksheet:

1. Create the array(s) that will provide input to the Axum component and that Ax
will display in a graph. For information on the number and type of arrays requ
for each type of graph, see Axum’s on-line help or refer to the Axum User’s Guide 
which is available in PDF format on the Mathcad CD.

2. Click in a blank spot in your worksheet. Be sure to click below or to the right 
the array(s).

3. Choose Component from the Insert  menu.

4. Select Axum Graph from the list and click “Next.” Choose a plot type and spe
the appropriate number of input variables. Click “Finish.”

5. A blank Axum graph appears in your Mathcad worksheet. Enter the names of 
array variables in the placeholders in the bottom left corner of the graph. Clic
outside the graph or press [Enter ].

When you click outside the component, the array data are displayed in the Axum
type you selected. See Figure 16-1 for an example.

Figure 16-1: Creating an Axum graph via the Axum component.
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Edit in g  an  Axum  g ra p h

After inserting an Axum component into a Mathcad worksheet, you can format th
graph using Axum’s formatting options. To do so:

1. Double-click the Axum graph in the Mathcad worksheet. The menus and tool
change to Axum’s menus and toolbars. 

2. Edit the Axum graph using available options in the Axum environment.

3. Click back in the Mathcad worksheet to recalculate the component and to res
working in Mathcad.

For more information about using Axum, refer to the on-line help in Axum. Samp
Mathcad files containing Axum components are located in the SAMPLES\AXUM folder 
of the location where you installed Mathcad.

Excel Com p onent
The Excel component allows you to exchange data with and access the features
Microsoft Excel (version 7 or higher), if it is installed on your system. 

Ti p If you only need to import or export a static data file in Excel format, use the File Read/W
component as described in Chapter 11, “Vectors, Matrices, and Data Arrays.”

I nser t in g  an  Exce l com p onent

To insert an Excel component into a Mathcad worksheet:

1. Click in a blank spot in your worksheet. If you want to send values to the compo
from a Mathcad variable defined in your worksheet, click below or to the right
the variable definition.

2. Choose Component from the Insert  menu.

3. Select Excel from the list and click “Next.” To create an object based on a file
you’ve already created, choose “Create from file,” and type the path name in
text box or use the Browse button to locate the file; then click “Open.” Otherwi
choose “Create an empty Excel Worksheet.”

4. Click Display as Icon if you want to see an icon in your Mathcad worksheet ra
than a portion of the Excel file.

Successive pages of the Wizard allow you to specify:

• The number of input and output variables. Supply multiple input and output 
variables. The number of input and output variables you can pass between Ma
and Excel is only limited by the memory and speed of your computer. There i
set limit.

• Input ranges. The cells in which the values of each input variable from Mathc
will be stored. Enter the starting cell, which is the cell that will hold the elemen
the upper left corner of an input array. For example, for an input variable contai

a  matrix of values, you can specify A1 as the starting cell, and the values
be placed in cells A1 through C3.

3 3×
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• Output ranges. The cells whose values will define the output variables in Mathc
For example, enter C2:L11 to extract the values in cells C2 through L11 and c
a  matrix.

Tip You can specify a particular Excel worksheet and cell range using notation such as 
Sheet2!B2:C2. You can also specify named cells and cell ranges.

When you finish using the Wizard, the Excel component appears in your worksh
with placeholders for the input and output variables. Enter the names of input varia
in the bottom placeholders. Enter the names of the output variables into the placeh
to the left of the :=. When you click outside the component, input variables are se
Excel from Mathcad and a range of cells are returned to Mathcad. 

Figure 16-2 shows an example of an Excel component in a Mathcad worksheet.

Not e By default, the Excel component displays only some of the rows and columns of the under
spreadsheet. To see more or fewer rows and columns, double-click the component so tha
see handles along the sides of the component. Then resize the component by dragging a

Changing the inputs and outputs

If you add input or output variables, you need to specify which cells in the compo
will store the new input and which will provide the new output. To do so:

1. Click on the component with the right mouse button and choose Properties from 
the pop-up menu.

Figure 16-2: An Excel spreadsheet in a Mathcad worksheet.

10 10×
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2. Choose the Inputs tab or the Outputs tab and specify a range of cells for each
and each output.

You should also follow these steps if you want to change the cell ranges for inputs
outputs you initially specified in the Setup Wizard.

Accessin g  Exce l

After inserting an Excel component into a Mathcad worksheet, you can use the 
component to perform calculations in Excel. To do so:

1. Double-click the Excel component in the Mathcad worksheet. The Excel com
nent opens and the menus and toolbars change to Excel’s menus and toolba

2. Edit the Excel component.

3. Click back in the Mathcad worksheet to have the component recalculate and
resume working in Mathcad.

Sm ar tSke tch Com p onent
SmartSketch is a 2D drawing and design tool developed by Intergraph. The Sma
Sketch component allows you to create in a Mathcad worksheet SmartSketch dra
whose dimensions are computationally linked to your Mathcad calculations. For 
example, your Mathcad equations can drive the size of drawing objects. 

The SmartSketch component makes Mathcad the ideal platform for creating tech
illustrations and specification-driven designs. You can use the SmartSketch comp
if you have installed SmartSketch LE for Mathcad (included with your Mathcad 
package), SmartSketch 3 or higher, Imagination Engineer, or Imagineer Technic

I nser t in g  a  Sm ar tSk etch draw in g

To insert a drawing that is computationally linked to your Mathcad worksheet:

1. Click in a blank spot in your worksheet. If you want to send values to the draw
from a Mathcad variable defined in your worksheet, click below or to the right
the variable definition.

2. Choose Component from the Insert menu. Select SmartSketch and click “Next.
The first page of the SmartSketch component Wizard appears.

3. To insert a SmartSketch drawing you've already created, choose “From Exis
File,” and type the path name in the text box or use the Browse button to locat
file; then click “Open.” Otherwise, choose “New SmartSketch Document.” Th
next page of the Wizard appears.

4. Specify the number of inputs and outputs. If you are using an existing file, als
specify the names of the variables, dimensions, or symbols in the drawing to 
input to and retrieve output from. Use the drop-down menus in the text boxes 
to each input and output.

When you click “Finish,” the SmartSketch component appears in your worksheet 
placeholders for the input and output variables. Enter the names of Mathcad inp
variables in the bottom placeholders. Enter the output variables in the placeholde
the left of the :=. 
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Figure 16-3 shows a SmartSketch drawing inserted into a Mathcad worksheet. T

values from the variables RadiusA, RadiusB, and Distance are sent to SmartSketch as
input and used to create the drawing. The variables WrapB, BLength, and Beta1 are 
output variables.

Not e  Input values that do not have units attached are passed in SI units. For example, if you se
as input for a length, it is assumed to be 2.0 meters. SmartSketch, by default, converts this
display units (inches by default) and creates the drawing. 

Creat ing a  new  draw ing

If you choose “New SmartSketch Document” when inserting the SmartSketch com
nent, you need to create a new SmartSketch drawing after the component appea
do so:

1. Double-click on the component and use SmartSketch's menus and toolbars to 
a drawing. Use the Dimensions toolbar to add dimensions to your drawing. 

2. Choose Variables from the Tools menu to define variables or edit dimensions. 
Close the Variable Table before clicking back in the Mathcad worksheet.

Next you need to bind variables, dimensions, or symbols to the inputs or outputs
do so, click on the component with the right mouse button and choose Properties from 
the pop-up menu. Use the Properties dialog to specify:

• Input names. The dimension, symbol, or variable names used in the SmartSke
drawing that are controlled by the inputs to the SmartSketch component. Cho
dimension or variable name from the drop-down list.

Figure 16-3: Integrating a SmartSketch drawing into a Mathcad worksheet.
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• Output names. The dimension, symbol, or variable names used in the SmartSk
drawing that define the output variables in Mathcad. Choose a dimension or var
name from the drop-down list.

When you click outside the component, input values are sent to the SmartSketch
drawing from Mathcad and values are returned to Mathcad as output.

Tip If the drawing is so large that it extends beyond the component window, click on the compo
with the right mouse button, choose Properties from the pop-up menu, and click the box next
to Automatic Resizing.

Not e In order for the dimensions in a drawing to resize relative to any changes to the dimensions
should be a check next to the Maintain Relationships option under the Tools menu in 
SmartSketch. To verify this, double-click on the component and choose Tools from the menu 
bar.

For more information on SmartSketch, refer to the tutorials and documentation a
able from the Help menu in SmartSketch. Sample Mathcad files containing Sma
Sketch components are located in the SAMPLES\CAD folder of the location where you 
installed Mathcad.

S- PLUS Gra p h Com p onent
S-PLUS is a sophisticated exploratory data analysis and statistics application avai
from MathSoft. The S-PLUS Graph component allows you to integrate calculations 
your Mathcad worksheet with a wide range of two- and three-dimensional S-PLU
graphs, including Trellis plots. You must have S-PLUS 4.5 or higher installed on your 
computer to use this component.

I nser t ing an  S- PLUS graph

To insert an S-PLUS Graph component into a Mathcad worksheet:

1. Create the array(s) which will provide input to the S-PLUS component. See t
documentation that accompanied your copy of S-PLUS for details about the number
and type of arrays required for each type of graph.

2. Click in a blank spot in your worksheet. Be sure to click below or to the right 
the array(s).

3. Choose Component from the Insert  menu.

4. Select S-PLUS Graph from the list and click “Next.” Choose a plot type and be 
to specify the appropriate number of input variables. Click “Finish.”

5. A blank S-PLUS graph appears in your Mathcad worksheet. Enter the name
your array variables in the placeholders in the bottom left corner of the graph. C
outside the graph or press [Enter ].

Tip The only way to send meaningful values to output variables is to set the graph type to “Ca
Graph Script” (see below) and specify the outputs within the script.
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Not e By default, the data in the Mathcad input variables are sent into S-PLUS variables named in0 , 
in1 , in2 , and so on. The S-PLUS variables out0 , out1 , out2 , and so on define the data
to be passed to the Mathcad output variables, if any. To change these names, choose Properties 
from the component’s pop-up menu, and enter new names in the Input Variables and Ou
Variables tabs.

Types of  graphs

To access the different graph types after you have inserted the component, click
the right mouse button on the component and choose Properties from the pop-up menu. 
The Graph Type tab in the Properties dialog box allows you to select one of the 
following:

• Gui Graph . This graph type supports any of the S-PLUS graphs available through 
the S-PLUS graphical user interface. For this component, the inputs are interpre
as arrays whose data columns are passed to the graph-creation routines. The
type rendered is specified in the “Axis Type” and “Plot Type” fields. Click “Choo
Axis/Plot Type” to open the S-PLUS dialog box for choosing plot types and viewing
thumbnail images of the different types.

Not e On Gui graphs, particular inputs can be treated as conditioning variables in order to produ
Trellis plots (conditioned, multipanel plots). To do this, click the boxes in the Input Variabl
tab of the Properties dialog box.

• Call Graph Script . This graph type supports any commands that generate “tr
tional” (version 3.3-style) S-PLUS graphics. To enter commands, open the Scrip
Editor by choosing Edit Script  from the component’s pop-up menu. The script yo
enter can contain any S-PLUS code with calls to plot(),  points() , etc. to 
generate one or more graphs. The inputs, outputs, and static variables are spe
on the Input Variables and Output Variables tabs of the Properties dialog box,
as they are in the S-PLUS Script component (see below). If the script is totally empt
by default the script is defined as plot(in0) . The variable graphsheet.name  
can be accessed within the script to get the name of the graph sheet. When y
finished editing the script, choose Close & Return from the Script Editor’s File 
menu.

Not e Normally, the plot is cleared before each call to the script to update the graph. If you remov
check from “Clear plot before each call” on the Graph Type page of the Properties dialog
this is not done. In this way you can collect multiple plots in different pages.

S- PLUS Scr i p t  Com p onent
The S-PLUS Script component allows you to write and execute S-PLUS 4.5 or higher 
programs and link them to other computations in Mathcad Professional.

I nser t ing an  S- PLUS scr ipt

To insert an S-PLUS Script component into a Mathcad worksheet:

1. Click in a blank spot in your worksheet. If you want to send values to the compo
from a Mathcad variable, click below or to the right of the variable definition.

2. Choose Component from the Insert  menu.
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3. Select S-PLUS Script from the list and click “Next.”

4. Type in the script you wish to execute and specify the number of inputs and out
Click “Finish.” The S-PLUS script component appears showing the script.

5. In the placeholder that appears at the bottom, enter the name of the Mathcad
variable to pass into the component. In the placeholder that appears to the le
the component, enter the name of the Mathcad output variable to be defined.

Not e By default, inputs are referred to in your script as variables named in0 , in1 , in2 , and so on, 
and outputs as out0 , out1 , out2 , and so on. To change these names, choose Properties 
from the component’s pop-up menu and type in new names in the Input Variables and Ou
Variables tabs.

Edit ing the scr ipt

To edit your S-PLUS code or import a script from a saved S-PLUS script file, open t
Script Editor by clicking the right mouse button on the component and choosing Edit 
Script from the component’s pop-up menu.

Your S-PLUS code, which can include multiple statements, is inserted within an 
automatically created function to run the component. This code can use tempora
variables, but any temporary variables are not visible outside of the component (u
assign  is called to change the S-PLUS databases). For example, a script could conta
out0<-sin(in0)  to set the output to the sine of the input.

Not e For details on the script syntax, see the documentation and on-line Help accompanying S-

Tip To declare static variables, which keep their values between calls to the script, add the va
names (separated by commas) to the Static Variable Names field on the Input Variables 
the component’s Properties dialog box. Remember that all static variables are reset whene
script itself is changed.

The following variables can be accessed within a script:

• input.var.names  and output.var.names  are vectors of strings that give
the input and output variable names for the component. You can use these var
to write scripts that handle different numbers of inputs and outputs.

• first.call  has a value of T if this is the first time this script has been execut
This variable can be used to initialize static variables.

When you are finished editing the script, choose Close & Return from the Script 
Editor’s File menu. When you click outside the component, the script is executed
the text of an S-PLUS program cannot be parsed (for example, if it contains an 
unmatched parenthesis), or if an error occurs when it is executed, a popup wind
appears.

Not e If “Show Captured Results” on the S-PLUS Script component’s pop-up menu is checked,
component displays the text produced by the last execution of the S-PLUS program, inclu
any printing done by the script, as if it had been executed at the S-PLUS command line. 
Capturing this text can slow down the execution. Error messages are always captured, ho
so after an error occurs the display can be switched to see the error message.
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MATLAB Com p onent
Pro The MATLAB  component allows you to exchange data with and access the progr

ming environment of The MathWorks’ MATLAB  Professional 4.2c or higher, if it is 
installed on your system.

Tip If you only need to import or export a static data file in MATLAB format, use the File Read
Write component as described in Chapter 11, “Vectors, Matrices, and Data Arrays.”

I nser t ing a  MATLAB com ponent

To insert a MATLAB  component into a Mathcad worksheet:

1. Click in a blank spot in your worksheet. If you want to send values to the MATLAB  
component from a Mathcad variable, click below or to the right of the variable
definition.

2. Choose Component from the Insert  menu.

3. Select MATLAB  from the list and click “Next.” The MATLAB  component is inserted 
into your worksheet.

4. In the placeholder that appears at the bottom, enter the name of the Mathcad
variable to pass into the MATLAB  component. In the placeholder that appears t
the left of the component, enter the name of the Mathcad output variable to b
defined.

Not e By default, the data in the Mathcad input variables are sent into MATLAB variables name
in0 , in1 , in2 , and so on. The MATLAB variables out0 , out1 , out2 , and so on define 
the data to be passed to the Mathcad output variables. To change these names, choose Properties 
from the component’s pop-up menu and type in new names in the Inputs and Outputs tab

To use the MATLAB  component to perform calculations in MATLAB :

1. Double-click the MATLAB  component in the Mathcad worksheet. The MATLAB  
component opens a text window for entering MATLAB  commands.

2. Edit the MATLAB  script however you’d like. Be sure to use the appropriate 
MATLAB  variable names to take the input from Mathcad and provide the outp

When you click outside the component, input variables from Mathcad are sent to
MATLAB,  and arrays from MATLAB are assigned to output variables in Mathcad.

Not e Some versions of MATLAB support multidimensional arrays and other complex data struct
While you may use these structures within the MATLAB component, you may pass only sca
vectors, and two-dimensional arrays from Mathcad to the MATLAB component and vice ve

MathConnex
Pro The components available in Mathcad are used to connect a Mathcad worksheet to

data sources and applications. If you have Mathcad Professional, you can use th
MathConnex application to connect these data sources and applications to each other 
as well as to Mathcad.

In addition to the components available in Mathcad Professional, MathConnex con
a number of other components for manipulating data, such as a Mathcad compo
Exchanging Data with Other Applications 291
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for connecting to a Mathcad worksheet. The MathConnex environment lets you con
any of one of the available components to any other component. MathConnex is
therefore a tool for controlling data as it flows from one data source or applicatio
another. You can visually design systems of data flow to analyze projects which inv
a variety of applications and data sources.

To run MathConnex, click  on the Standard toolbar, or exit Mathcad and run
MathConnex as you would any application. For more information about using Ma
Connex, refer to the MathConnex User’s Guide, available as a PDF file on the Mathcad 
CD.

Scri p t in g  Custom  OLE Autom at ion Ob j ects

Pro As described in the previous section, Mathcad has several specialized componen
using the functionality of other technical computing environments within your Math
worksheet. However, you can dynamically exchange data between a Mathcad w
sheet and any other application that supports OLE Automation, even if Mathcad does
not have a specific component to do so. To do so, use the Scriptable Object component. 
You can create a custom scriptable object from any object you can insert into a Ma
worksheet as well as any ActiveX controls installed on your computer. 

To create a Scriptable Object component, you must:

1. Be proficient in a supported scripting language, such as Microsoft VBScript o
JScript, that is installed on your system.

2. Have some knowledge of the way the other application has implemented OLE.

3. Have the other application or control installed on your system.

Scr i p t in g  Lan g ua g es
To use a Scriptable Object component, you must have a supported scripting lang
installed on your system. The following two scripting languages are supported: M
crosoft VBScript (Visual Basic Scripting Edition) and Microsoft JScript (an implem
tation of JavaScript). Both of these scripting languages are included with Micros
Internet Explorer, which can be installed from the Mathcad installation media. Th
scripting languages can also be downloaded at no charge from Microsoft, Inc. at

http://msdn.microsoft.com/scripting

Not e VBScript is a strict subset of the Visual Basic for Applications language used in Microsoft 
Excel, Project, Access, and the Visual Basic development system. VBScript is designed to
lightweight interpreted language, so it does not use strict types (only Variants). Also, beca
VBScript is intended to be a safe subset of the language, it does not include file input/outp
direct access to the underlying operating system. JScript is a fast, portable, lightweight 
interpreter for use in applications that use ActiveX controls, OLE automation servers, and
applets. JScript is directly comparable to VBScript (not Java). Like VBScript, JScript is a p
interpreter that processes source code rather than producing stand-alone applets. The syn
techniques used in the scripting language you choose are beyond the scope of this User’s Guide. 
292  Chapter 16  Advanced Computational Features
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I nser t in g  a  Scr i p tab le Ob j ect
To insert a Scriptable Object component into a Mathcad worksheet:

1. Click in a blank spot in your worksheet. If you want to send values to the obje
from a Mathcad variable, click below or to the right of the variable definition.

2. Choose Component from the Insert  menu.

3. Select Scriptable Object from the list in the Wizard and click “Next.” 

This launches the Scripting Wizard. The Object to Script scrolling list shows the 
available server applications on your system. Choose an application that suppor
OLE 2 automation interface (consult the documentation for the application for deta

You must specify:

• Whether the component is a new file or whether you will insert an existing file

• Whether you will see the actual file or an icon in your Mathcad worksheet.

In the remaining pages of the Wizard you specify: the scripting language you are u
the type of object you want to script, the name of the object, and the number of in
and outputs the object will accept and provide.

A Scriptable Object component appears in your worksheet with placeholders for
input and output variables. Enter the input variables in the bottom placeholders. E
the output variables into the placeholders to the left of the :=.

Ob j ect  M odel
The Scriptable Object component has the following predefined objects, properties
methods that enable you to configure it to work as a component in Mathcad.

Collect ions

• Inputs  and Outputs  are predefined collections of DataValue objects (see 
below) containing the Scriptable Object’s inputs and the outputs, respectively

• The Count  property can be used to query the total number of elements in the
collection. For example, Outputs.Count  returns the number of output variables

• The Item  method is used to specify an individual element in the collection. T
refer to a particular input or output, use the notation Inputs.Item( n)  or 
Outputs.Item( n) , where n is the index of the input or output. The index n 
always starts from 0. Since Item  is the default method, languages such as VBScr
and JScript let you drop the method name to imply the default method. For exam
Inputs(0)  is equivalent to Inputs.Item(0)  and references the first input.

DataValue ob jects

• The Value  property accesses a DataValue’s real part. For example, in VBSc
or JScript Inputs(0).Value  returns the real part of the first input.

• The IValue  property accesses a DataValue’s imaginary part. For example, i
VBScript or JScript Outputs(1).IValue  returns the imaginary part of the 
second output. If there is no imaginary part, the IValue  portion returns “NIL.”

• The IsComplex  property returns “TRUE” if a DataValue has a valid imaginary 
part; this property returns “FALSE” otherwise. For example, the expression 
Scripting Custom OLE Automation Objects 293
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(inputs(0).IsComplex)  returns “FALSE” if the first input has only a real 
part.

• The Rows and Cols  properties yield the number of rows and columns.

Globa l m ethods

• The alert  function takes a single string parameter that is presented to the us
a standard modal Windows message box with an “OK” button.

• The errmsg  function takes a string parameter that appears as an error mess
from within the script and causes the script to stop execution. A second, optio
parameter is a string used to display the source of the error.

Not e In JScript, the names of functions, methods, objects, and properties are case sensitive, w
VBScript they are not. 

Scr i p t in g  the Ob j ect
To script an object, click once on the component to select it. Then click on the 
component with the right mouse button and choose Edit Script  from the pop-up menu. 
You’ll see a Script Editor window containing three subroutine stubs in which you in
your own scripting code.

The script you write will usually contain at a minimum the following three subroutin

• A starting routine, called once when execution of the component begins. This
good place to initialize variables, open files for reading and writing, etc.

• An execution routine that by default takes as arguments the collections Inputs  
and Outputs . 

• A stopping routine, called once when execution of the component stops.

The commands in each section are executed in sequence whenever the Mathca
worksheet is calculated. What you include in these subroutines is determined lar
by the properties of the OLE object you are scripting; consult the documentation for t
server or control. 

Choose Close & Return from the Script Editor’s File menu when you have completed
your script and want to resume working in the Mathcad worksheet.

Ti p See the SAMPLES folder of the location where you installed Mathcad for sample files usin
scriptable object component.

Accessin g  Mathcad from  W ithin Another  A pp lica t ion

The previous section describes how to script a custom OLE object in Mathcad. 
Mathcad’s OLE automation interface provides a mechanism for the complementa
process of using Mathcad as an automation server from within another Windows 
application. Using Mathcad’s OLE automation interface, you can send data dynamica
to Mathcad from another application, use Mathcad to perform calculations or other
manipulations, and send results back to the original application. 
294  Chapter 16  Advanced Computational Features



e DDE 

.

 or 
 
ther 
les 
ed 

-

i-

 the 

tions 

. 

men-

 store 

on.

 

Not e The OLE automation interface is supported in Mathcad 7.02 and higher and supersedes th
interface supported in Mathcad 5 and 6. For current information on and examples of the 
interface, visit the MathSoft Web site at http://www.mathsoft.com/support/ . Also 
refer to TRAJECTORY.XLS in the \SAMPLES\EXCEL folder where you installed Mathcad

Mathcad Docum ent  Ob j ect  Mode l
To use the OLE automation interface, you must write a program in Visual Basic 5.0
higher or in an application that can serve as an OLE automation client, such as Microsoft
Excel 5.0 and higher. (Check with the application’s documentation to find out whe
it is an OLE automation client.) You use the program to define and retrieve variab
in Mathcad Document objects. The variables being defined in Mathcad must be nam
in0 , in1 , in2 , etc. The variables being retrieved from Mathcad must be named out0 , 
out1 , out2 , etc.

Aut om at ion m ethods

• GetComplex (Name, RealPart, ImagPart) retrieves complex data (real and imag
inary parts) from Mathcad variable Name, where Name is one of out0 , out1 , 
out2 , etc.

• SetComplex (Name, RealPart, ImagPart) assigns complex data (real and imag
nary parts) to Mathcad variable Name, where Name is one of in0 , in1 , in2 , etc.

• Recalculate  triggers recalculation of the Mathcad document.

• SaveAs (Name) saves the Mathcad document as a file whose path is given by
string Name.

Scr i p t in g  the Ob j ect
The specific procedures required to script a Mathcad OLE automation object differ 
slightly depending on the application that serves as an OLE automation client, but the 
main steps are as follows:

1. Provide or create a Mathcad OLE object with which to communicate. 

2. Set up the client application with the data to send to Mathcad and/or with loca
to put the data retrieved from Mathcad. 

3. Write code to specify the data to send to Mathcad and/or the data to retrieve

The following example shows how to use Microsoft Excel’s VBA environment to 
assign a complex number to the variable in0  in a Mathcad OLE object, trigger a 
calculation in Mathcad, and return the answer to Excel:

1. Insert a Mathcad object into an Excel worksheet. For details, see Excel’s docu
tation and on-line Help. 

2. Set up Excel so that there is data to pass to Mathcad and/or available cells to
data returned from Mathcad.

3. Write a Visual Basic macro module. Refer to Excel’s on-line Help for informati

4. Double-click the Mathcad object in the Excel worksheet to activate the linked
object. Click outside the object. Then run the Excel macro. 
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Figure 16-4 shows how data stored in cells G7 through H8 are passed into the Ma
variable in0 . Mathcad performs a calculation (in this simple example, it trivially ad
1 to the values), and the results stored in the Mathcad variable out0  are returned to 
cells G12 through H13. The VBA macro looks like this:

Sub UpdateWorksheet()
Dim MathcadObject As Object
Dim outRe, outIm As Variant
Dim inRe, inIm As Variant
' Get a reference to the Mathcad object
Set MathcadObject = ActiveSheet.OLEObjects(1).Object
' Read in values to be passed from Excel to Mathcad
inRe = ActiveSheet.Range("G7:G8").Value
inIm = ActiveSheet.Range("H7:H8").Value
' Send the values over to Mathcad, assign them to variable in0, and recalcul
Call MathcadObject.SetComplex("in0", inRe, inIm)
Call MathcadObject.Recalculate
' Place the result values into the chosen Excel cells
Call MathcadObject.GetComplex("out0", outRe, outIm)
ActiveSheet.Range("G11:G12").Value = outRe
ActiveSheet.Range("H11:H12").Value = outIm

End Sub

Not e To pass real data into Mathcad, you should have cell(s) containing zeros for the imaginar

Figure 16-4: Mathcad as an OLE automation server within Microsoft Excel. 
296  Chapter 16  Advanced Computational Features
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In this table:

• A  and B represent arrays, either vector or matrix.

• u and v represent vectors with real or complex elements.

• M  represents a square matrix.

• z and w represent real or complex numbers.

• x and y represent real numbers.

• m and n represent integers.

• i represents a range variable.

• S and any names beginning with S represent string expressions.

• t represents any variable name.

• f represents a function.

• X and Y represent variables or expressions of any type.

For information about programming operators in Mathcad Professional, see Cha
15, “Programming.” For information about symbolic operators and keywords, see
Chapter 14, “Symbolic Calculation.”

Operat ion Appearance Ke yst roke Descr ipt ion

Parenthe ses ' Grouping operator.

Vector 
Subscr ip t

[ Returns indicated element of a vector.

Matr ix  
Subscr ip t

[ Returns indicated element of a matrix.

Superscr ipt [Ctrl]6 Extracts column n from array A. Returns a vector.

Vector ize [Ctrl]– Forces operations in expression X to take place element by 
element. All vectors or matrices in X must be the same size.

Factor ia l ! Returns  The integer n cannot be negative.

Com ple x 
con jugate  

" Inverts the sign of the imaginary part of X. This keystroke creates 
a string expression in a blank placeholder and a text region in 
blank area of the worksheet.

Transpose [Ctrl]1 Returns a matrix whose rows are the columns of A and whose 
columns are the rows of A. A can be a vector or a matrix.

Pow er ^ Raises z to the power w. 

Pow ers 
ofm at r ix , 
m at r ix  inverse 

^ nth power of square matrix M  (using matrix multiplication). n 
must be a whole number.  is the inverse of M . Other negative 
powers are powers of the inverse. Returns a square matrix.

N egat ion – Multiplies X by –1.

Vector sum [Ctrl]4 Sums elements of vector v; returns a scalar.

 X ( )

vn

Am n,

A n〈 〉

X

n! n n 1–( ) n 2–( )…⋅ ⋅

X

AT

zw

M n

M 1–

X–

Σv
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Square root \ Returns positive square root for positive z; returns principal value 
for negative or complex z.

nth  root [Ctrl]\ Returns nth root of z; returns a real valued root whenever possibl
n must be a positive integer.

Magnitude, 
Absolute  
va lue 

|
Returns . 

Magnitude of 
vector 

| Returns the magnitude of the vector v:  if all elements in v 

are real. Returns  if any element in v is complex.

Dete rm ina nt  | Returns the determinant of the square matrix M . Result is a scalar.

Div ision / Divides the expression X by the non-zero scalar z. If X is an array, 
divides each element by z.

I n- l ine 
D iv ision

[Ctrl]/ Divides the expression X by the non-zero scalar z. If X is an array, 
divides each element by z.

Mult iplica t ion * Returns the product of X and Y if both X and Y are scalars. 
Multiplies each element of Y by X if Y is an array and X is a scalar, 
or vice versa. Returns the dot product (inner product) if X and Y are 
vectors of the same size. Performs matrix multiplication if X and Y 
are conformable matrices.

Cross product [Ctrl]8 Returns cross-product (vector product) for the three-element 
vectors u and v.

Sum m a t ion [Ctrl]
[Shift]4

Performs summation of X over . X can be any 
expression. It need not involve i but it usually does. m and n must 
be integers.

Product [Ctrl]
[Shift]3

Performs iterated product of X for . X can be 
any expression. It need not involve i but it usually does. m and n 
must be integers.

Ra nge sum $ Returns a summation of X over the range variable i. X can be any 
expression. It need not involve i but it usually does.

Ra nge product # Returns the iterated product of X over the range variable i. X can 
be any expression. It need not involve i but it usually does. 

I nt egra l & Returns the definite integral of f(t) over the interval . a and 
b must be real scalars. All variables in the expression f(t), except 
the variable of integration t, must be defined. The integrand, f(t), 
cannot return an array.

Der ivat ive ? Returns the derivative of f(t) evaluated at t. All variables in the 
expression f(t) must be defined. The variable t must be a scalar 
value. The function f(t) must return a scalar.

z

zn

z
Re z( )2 Im z( )2+

v v v⋅
v v⋅

M

X
z
---

X z÷

X Y⋅

u v×

X

i m=

n

∑
i m m 1 … n, ,+,=

X
i m=

n

∏
i m m 1 … n, ,+,=

X

i
∑

X
i

∏

f t( ) td
a

b

∫ a b,[ ]

td
d f t( )
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nth Der ivat ive [Ctrl]? Returns the nth derivative of f(t) evaluated at t. All variables in f(t) 
must be defined. The variable t must be a scalar value. The 
function f(t) must return a scalar. n must be an integer between 0
and 5 for numerical evaluation or a positive integer for symbol
evaluation.

Addit ion + Scalar addition if X, Y, or both are scalars. Element by element 
addition if X and Y are vectors or matrices of the same size. If X is 
an array and Y is a scalar, adds Y to each element of X.

Subt ract ion – Performs scalar subtraction if X, Y, or both are scalars. Performs 
element by element subtraction if X and Y are vectors or matrices 
of the same size. If X is an array and Y is a scalar, subtracts Y from 
each element of X.

Addit ion w ith  
l ine  brea k

[Ctrl][ ↵] Same as addition. Line break is purely cosmetic.

And [Ctrl]
[Shift]7

Returns the value 1 if both x and y are nonzero. Returns 0 if at leas
one of x or y is zero.

Or [Ctrl]
[Shift]6

Returns the value 1 if at least one of x or y is nonzero. Returns 0 if 
both x and y are zero.

N ot [Ctrl]
[Shift]1

Returns 0 if x is nonzero and 0 if x is zero.

Xor 
( Exclusive or )

[Ctrl]
[Shift]5

Returns 1 if precisely one of x or y is nonzero. Returns 0 if both x 
and y are zero or both are nonzero.

Great er than , > For real scalars x and y, returns 1 if , 0 otherwise. For string 
expressions S1 and S2, returns 1 if S1 strictly follows S2 in ASCII 
order, 0 otherwise.

Less than , < For real scalars x and y, returns 1 if , 0 otherwise. For string 
expressions S1 and S2, returns 1 if S1 strictly precedes S2 in ASCII 
order, 0 otherwise.

Great er than 
or  equa l

, [Ctrl]0 For real scalars x and y, returns 1 if , 0 otherwise. For string 
expressions S1 and S2, returns 1 if S1 follows S2 in ASCII order, 
0 otherwise.

Less than or 
equa l

, [Ctrl]9 For real scalars x and y, returns 1 if , 0 otherwise. For string 
expressions S1 and S2, returns 1 if S1 precedes S2 in ASCII order, 
0 otherwise.

N ot  equa l t o , [Ctrl]3 For scalars z and w, returns 1 if , 0 otherwise. For string 
expressions S1 and S2, returns 1 if S1 is not character by characte
identical to S2. 

Equal to [Ctrl]= Returns 1 if , 0 otherwise. Appears as a bold = on the 
screen. 

tn

n

d

d f t( )

X Y+

X Y–

X…
Y+

x y∧

x y∨

x¬

x y⊕

x y>
S1 S2>

x y>

x y<
S1 S2<

x y<

x y≥
S1 S2≥

x y≥

x y≤
S1 S2≤

x y≤

z w≠
S1 S2≠

z w≠

X Y= X Y=
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Sy m bolic Transform at ion Funct ions

Some symbolic transformations (see Chapter 14) are given in terms of functions
aren’t among Mathcad’s built-in functions. The list below gives definitions for tho
special functions. Except for Ei, erf, and Zeta, which involve infinite sums, and W, you 
can use these definitions to calculate numerical values.

You can define many of these functions in Mathcad. See the “Other Special Funct
area in the QuickSheets of the Resource Center for examples of each of these.

γ is Euler’s constant, approximately 0.5772156649.

 if x is not zero.  

 (x > 0)

   (for complex z)

Chi x( ) γ x( )ln t( )cosh 1–
t

--------------------------- td
0

x

∫+ +=

Ci x( ) γ x( )ln
t( )cos 1–
t

------------------------ td
0

x

∫+ +=

di x( )log t( )ln
1 t–
------------ td

1

x

∫=

Dirac x( ) 0= Dirac x( ) xd
∞–

∞

∫ 1=

Ei x( ) γ x( )ln xn

n n!⋅
------------

n 1=

∞

∑+ +=

erf x( ) 2

π
------- 1–( )nz2n 1+

n! 2n 1+( )
-----------------------------

n 0=

∞

∑=

FresnelCx( ) π
2
---t2 

 cos td
0

x

∫=

FresnelSx( ) π
2
---t2 

 sin td
0

x

∫=

LegendreEx k,( ) 1 k2 t2⋅–

1 t2–
----------------------- 

  1 2/
td

0

x

∫=

LegendreEck( ) LegendreE 1k,( )=

LegendreEc1k( ) LegendreEc 1 k2–( )=

LegendreFx k,( ) 1

1 t2–( ) 1 k2 t2⋅–( )
-------------------------------------------------- td

0

x

∫=

LegendreKck( ) LegendreF 1k,( )=

LegendreKc1k( ) LegendreKc 1 k2–( )=
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.
 is the principal branch of a function satisfying 

 is the nth branch of W(x).

 (s > 1)

The functions arcsec, arccsc, arccot, arcsech, arcscsh, arccoth can be calculated by 
taking reciprocals and using the Mathcad built-in functions acos, asin, etc. For example:

The Psi function and Γ appear frequently in the results of indefinite sums and products. 

LegendrePix n k, ,( ) 1

1 n
2

t
2⋅–( ) 1 t2–( ) 1 k2 t2⋅–( )

----------------------------------------------------------------------------------- td
0

x

∫=

LegendrePicn k,( ) LegendrePi 1n k, ,( )=

LegendrePic1k( ) LegendrePicn 1 k2–,( )=

Psi n x,( )
xn

n

d

d Psi x( )=

Psi x( )
xd

d Γ x( )( )ln=

Shi x( ) t( )sinh
t

----------------- td
0

x

∫=

Si x( ) t( )sin
t

-------------- td
0

x

∫=

W x( ) W x( ) W x( )( )exp⋅ x=

W n x,( )

Zeta s( ) 1

ns
-----

n 1=

∞

∑( )

arc x( )sec
1
x
--- 

 acos:=
302  Appendices



 

SI  Unit s 

Base  Unit s

An g ula r M easure

Len g th

Mass

Tim e

Area , Volum e

Velocit y , Acce le ra t ion

Force, Ener gy , Pow er

m (meter), length kg (kilogram), mass s (second), time
A (ampere), current K (kelvin), temperature cd (candela), luminosity
mole or mol, substance

rad 1=
deg

π
180
--------- rad⋅=

sr 1 sr⋅=

cm 0.01
·

m⋅= km 1000 m⋅= mm 0.001 m⋅=

ft 0.3048 m⋅= in 2.54 cm⋅= yd 3 ft⋅=

mi 5280 ft⋅=

gm 10
3–

kg⋅= tonne 1000 kg⋅= lb 453.59237 gm⋅=

mg 10 3– gm⋅= ton 2000 lb⋅= slug 32.174 lb⋅=

oz lb
16
------=

min 60 s⋅= hr 3600 s⋅= day 24 hr ⋅=

yr 365.2422 day ⋅=

hectare 104 m2⋅= acre 4840 yd2⋅= L 0.001 m
3⋅=

mL 10 3– L⋅= fl_oz 29.57353 cm3⋅= gal 128 fl_oz⋅=

mph mi
hr
------= kph km

hr
--------= g 9.80665

m

s2
----⋅=

N kg
m
s2
----⋅= dyne 10 5– N⋅= lbf g lb⋅=

kgf g kg⋅= J N m⋅= erg 10 7– J⋅=

cal 4.1868 J⋅= kcal 1000 cal⋅= BTU 1.05506 103 J⋅ ⋅=

W J
s
--=

kW 1000 W⋅=
hp 550

ft lbf⋅
s

---------------⋅=
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Pressure , V iscosit y

Elect r ica l

Fre q uenc y , Act iv it y

Tem p era ture

Dose

Lum inous Flux , I llum inance

Pa N

m2
-------= psi lbf

in2
-------= atm 1.01325 105 Pa⋅ ⋅=

in_Hg 3.37686 103 Pa⋅ ⋅= torr 1.33322 102 Pa⋅ ⋅=
stokes 10 4– m2

s
-------⋅=

poise 0.1 Pa s⋅ ⋅=

C A s⋅=
V J

C
----= mV 10 3– V⋅=

kV 103 V⋅= Ω V
A
----= kΩ 103 Ω⋅=

M Ω 106 Ω⋅= S 1
Ω
----= mho 1

Ω
----=

H
V
A
---- s⋅= µH 10 6– H⋅= mH 10 3– H⋅=

µA 10 6– A⋅= mA 10 3– A⋅= kA 103 A⋅=

F C
V
----= pF 10 12– F⋅= nF 10 9– F⋅=

µF 10 6– F⋅= Wb V s⋅=

Oe
1000
4 π⋅
------------ A

m
----⋅= T Wb

m2
---------= gauss 10 4– T⋅=

Hz 1
s
---= kHz 103 Hz⋅= MHz 106 Hz⋅=

GHz 109 Hz⋅= Bq 1
s
---=

Hza 2 π Hz⋅ ⋅=

R 0.556 K⋅=

Gy J
kg
------= Sv J

kg
------=

lm cd sr⋅=
lx cd st⋅

m2
--------------=
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CGS unit s 

Base  Unit s

An g ula r M easure

Len g th

Mass

Tim e

Area , Volum e

Velocit y , Acce le ra t ion

Force, Ener gy , Pow er

cm (centimeter), length gm (gram), mass sec (second), time

coul (coulomb), charge K (kelvin), temperature

rad 1=
deg

π
180
--------- rad⋅=

m 100 cm⋅= km 1000 m⋅= mm 0.1 cm⋅=

ft 30.48 cm⋅= in 2.54 cm⋅= yd 3 ft⋅=

mi 5280 ft⋅=

kg 1000 gm⋅= tonne 1000 kg⋅= lb 453.59237 gm⋅=

mg 10 3– gm⋅= ton 2000 lb⋅= slug 32.174 lb⋅=

oz lb
16
------=

min 60  sec⋅= hr 3600  sec⋅= day 24 hr ⋅=

yr 365.2422 day ⋅=

hectare 108 cm2⋅= acre 4840 yd2⋅= liter 1000 cm3⋅=

mL cm3= fl_oz 29.57353 cm3⋅= gal 128 fl_oz⋅=

mph mi
hr
------= kph km

hr
--------= g 980.665

cm
 2sec

------------⋅=

c 2.997925 1010 cm 
sec
---------⋅ ⋅= c_ c

sec
m
-------⋅=

dyne gm
cm

sec2
----------⋅= newton 105 dyne⋅= lbf g lb⋅=

kgf g kg⋅= erg dyne cm⋅= joule 107 erg⋅=

cal 4.1868 107 erg⋅ ⋅= BTU 1.05506 1010 erg⋅ ⋅= kcal 1000 cal⋅=

watt joule
sec

-------------=
kW 1000 watt⋅=

hp 550
ft lbf⋅

sec
---------------⋅=
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ined in 
Pressure , V iscosit y

Elect r ica l
These are CGS-esu units, based only on mass, length, and time. The “stat” units are def
terms of dyne, cm, and sec.

Fre q uenc y

Tem p era ture

Conversions to SI  Un it s

Pa 10
dyne
cm2
------------⋅= psi lbf

in2
-------= atm 1.01325 105 Pa⋅ ⋅=

in_Hg 3.38638 103 Pa⋅ ⋅= torr 1.33322 102 Pa⋅ ⋅=
stokes cm2

sec
----------=

poise 0.1 Pa sec⋅ ⋅=

statamp dyne0.5 cm sec1–⋅ ⋅= statcoul dyne0.5 cm⋅= statvolt dyne0.5=

statohm sec cm1–⋅= statsiemens cm sec1–⋅= statfarad cm=

statweber dyne0.5 cm⋅= stathenry sec2 cm 1–⋅= stattesla dyne0.5 cm sec 2–⋅ ⋅=

Hz 1
sec
-------= kHz 103 Hz⋅= MHz 106 Hz⋅=

GHz 109 Hz⋅= Hza 2 π Hz⋅ ⋅=

R 0.556 K⋅=

amp
c_
10
------ statamp⋅= volt watt

amp
-----------= ohm volt

amp
-----------=

coul amp sec⋅=
farad coul

volt
-----------= henry volt

sec
amp
-----------⋅=
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U.S. Custom ar y  Unit s 

Base  Unit s

An g ula r M easure

Len g th

Mass

Tim e

Area , Volum e

Velocit y , Acce le ra t ion

Force, Ener gy , Pow er

ft (foot), length lb (pound), mass sec (second), time

coul (coulomb), charge K (kelvin), temperature

rad 1=
deg

π
180
--------- rad⋅=

in ft
12
------= m ft

0.3048
----------------=

yd 3 ft⋅=

cm 0.01 m⋅= mi 5280 ft⋅= km 1000 m⋅=

mm 0.001 m⋅=

slug 32.174 lb⋅=
oz lb

16
------=

ton 2000 lb⋅=

kg lb
0.45359237
----------------------------=

tonne 1000 kg⋅= gm 10 3– kg⋅=

mg 10 3– gm⋅=

min 60  sec⋅= hr 3600  sec⋅= day 24 hr ⋅=

yr 365.2422 day ⋅=

acre 4840 yd2⋅= hectare 104 m2⋅= fl_oz 29.57353 cm3⋅=

liter 0.035 ft
3⋅= mL 10 3– liter⋅= gal 128 fl_oz⋅=

mph mi
hr
------= kph km

hr
--------= g 32.174

ft
 2sec

------------⋅=

lbf g lb⋅=
newton kg

m

sec2
----------⋅= dyne 10 5– newton⋅=

kgf g kg⋅= joule newton m⋅= erg 10 7– joule⋅=

cal 4.1868 joule⋅= kcal 1000 cal⋅= BTU 1.05506 103 joule⋅ ⋅=

watt joule
sec

-------------= hp 550
ft lbf⋅

sec
---------------⋅=

kW 1000 watt⋅=
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Pressure , V iscosit y

Elect r ica l

Fre q uenc y

Tem p era ture

psi lbf
in2
-------= Pa newton

m2
-------------------= atm 1.01325 105 Pa⋅ ⋅=

in_Hg 3.386 103 Pa⋅ ⋅= torr 1.333 102 Pa⋅ ⋅=
stokes cm2

sec
----------=

poise 0.1 Pa sec⋅ ⋅=

volt watt
amp
-----------= mV 10 3– volt⋅= KV 103 volt⋅=

ohm volt
amp
-----------= mho 1

ohm
-----------= siemens 1

ohm
-----------=

Ω ohm= KΩ 103 ohm⋅= MΩ 106 ohm⋅=

henry weber
amp

----------------= µH 10 6– henry⋅= mH 10 3– henry⋅=

amp coul
sec

-----------= µA 10 6– amp⋅= mA 10 3– amp⋅=

KA 103 amp⋅= farad coul
volt
-----------= pF 10 12– farad⋅=

nF 10 9– farad⋅= µF 10 6– farad⋅= weber volt sec⋅=

oersted
1000
4 π⋅
------------ amp

m
-----------⋅= tesla weber

m2
----------------= gauss 10 4– tesla⋅=

Hz 1
sec
-------= kHz 103 Hz⋅= MHz 106 Hz⋅=

GHz 109 Hz⋅= Hza 2 π Hz⋅ ⋅=

R 0.556 K⋅=
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MKS Unit s 

Base  Unit s

An g ula r M easure

Len g th

Mass

Tim e

Area , Volum e

Velocit y , Acce le ra t ion

Force, Ener gy , Pow er

m (meter), length kg (kilogram), mass sec (second), time

coul (coulomb), charge K (kelvin), temperature

rad 1=
deg

π
180
--------- rad⋅=

cm 0.01 m⋅= km 1000 m⋅= mm 0.001 m⋅=

ft 0.3048 m⋅= in 2.54 cm⋅= yd 3 ft⋅=

mi 5280 ft⋅=

gm 10
3–

kg⋅= tonne 1000 kg⋅= lb 453.59237 gm⋅=

mg 10 3– gm⋅= ton 2000 lb⋅= slug 32.174 lb⋅=

oz lb
16
------=

min 60  sec⋅= hr 3600  sec⋅= day 24 hr ⋅=

yr 365.2422 day ⋅=

hectare 104 m2⋅= acre 4840 yd2⋅= liter 0.1 m⋅( )3=

mL 10 3– liter⋅= fl_oz 29.57353 cm3⋅= gal 128 fl_oz⋅=

mph mi
hr
------= kph km

hr
--------= g 9.80665

m

 2sec
------------⋅=

newton kg
m

sec2
----------⋅= dyne 10 5– newton⋅= lbf g lb⋅=

kgf g kg⋅= joule newton m⋅= erg 10 7– joule⋅=

cal 4.1868 joule⋅= kcal 1000 cal⋅= BTU 1.05506 103 joule⋅ ⋅=

watt joule
sec

-------------=
kW 1000 watt⋅=

hp 550
ft lbf⋅

sec
---------------⋅=
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Pressure , V iscosit y

Elect r ica l

Fre q uenc y

Tem p era ture

Pa newton

m2
-------------------= psi lbf

in2
-------= atm 1.01325 105 Pa⋅ ⋅=

in_Hg 3.38638 103 Pa⋅ ⋅= torr 1.33322 102 Pa⋅ ⋅=
stokes 10 4– m2

sec
-------⋅=

poise 0.1 Pa sec⋅ ⋅=

volt watt
amp
-----------= mV 10 3– volt⋅= kV 103 volt⋅=

ohm volt
amp
-----------= mho 1

ohm
-----------= siemens 1

ohm
-----------=

Ω ohm= kΩ 103 ohm⋅= MΩ 106 ohm⋅=

henry weber
amp

----------------= µH 10 6– henry⋅= mH 10 3– henry⋅=

amp coul
sec

-----------= µA 10 6– amp⋅= mA 10 3– amp⋅=

kA 103 amp⋅= farad coul
volt
-----------= pF 10 12– farad⋅=

nF 10 9– farad⋅= µF 10 6– farad⋅= weber volt sec⋅=

oersted
1000
4 π⋅
------------ amp

m
-----------⋅= tesla weber

m2
----------------= gauss 10 4– tesla⋅=

Hz 1
sec
-------= kHz 103 Hz⋅= MHz 106 Hz⋅=

GHz 109 Hz⋅= Hza 2 π Hz⋅ ⋅=

R 0.556 K⋅=
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Predefined Var iables

Mathcad’s predefined variables are listed here with their default starting values.

Consta nt = Value Meaning

π = 3.14159... Pi. Mathcad uses the value of π to 15 digits. To type π, press 
[Ctrl ][Shift ]p.

e = 2.71828... The base of natural logarithms. Mathcad uses the value of e to 15 
digits.

∞ = Infinity. This symbol represents values larger than the largest re
number representable in Mathcad (about ). To type ∞, press 
[Ctrl ][Shift ]Z.

% = 0.01 Percent. Use in expressions like 10*% (appears as ) or as a 
scaling unit at the end of an equation with an equal sign.

CTOL = Constraint tolerance used in solving and optimization functions:
how closely a constraint must be met for a solution to be conside
acceptable. For more information, see “Solving and Optimizatio
Functions” on page 157.

Pro CWD = “[system path]” String corresponding to the working folder of the worksheet.

FRAME = 0 Counter for creating animation clips.

Pro in n = 0, out n = 0  Input and output variables (in0 , in1 , out0 , out1 , etc.) in a 
Mathcad component in a MathConnex system. See the MathConnex 
User’s Guide for details.

ORIGIN = 0 Array origin. Specifies the index of the first element in arrays.

PRNCOLWIDTH = 8 Column width used in writing files with WRITEPRN function.

PRNPRECISION = 4 Number of significant digits used when writing files with the 
WRITEPRN function.

TOL = Tolerance used in numerical approximation algorithms (integral
equation solving, etc.): how close successive approximations m
be for a solution to be returned. For more information, see the 
sections on the specific operation in question.

10307

10307

10 %⋅

10 3–

10 3–
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Suffixes for  Num bers

The table below shows how Mathcad interprets numbers (sequences of letters beg
with a digit) that end with a letter.

Radix

Unit s and other

Not e Because Mathcad by default treats most expressions involving a number followed immed
by a letter to mean implied multiplication of a number by a variable name, you will need to
backspace over the implied multiplication operator to create expressions like 4.5M . 

Suff ix Exam p le Mea nin g

b, B 100001b Binary

h, H 8BCh Hexadecimal

o, O 1007o Octal

Suff ix Exam p le Mea nin g

i or j 4i, 1j, Imaginary

K –273K Standard absolute temperature unit

L –2.54L Standard length unit

M 2.2M Standard mass unit

Q –100Q Standard charge unit

S 6.97S Standard substance unit in SI unit system

T 3600T Standard time unit

C 125C Standard luminosity unit in SI unit system

3 1.5j+
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Greek  Let ters

To type a Greek letter into an equation or into text, press the Roman equivalent 
the table below, followed by [Ctrl ]G. Alternatively, use the Greek toolbar.

Not e The Greek letter π is so commonly used that it has its own keyboard shortcut: [Ctrl ][Shift ]P.

Nam e Upperca se Low ercase Rom a n equiva lent

alpha Α α A

beta Β β B

chi Χ χ C

delta ∆ δ D

epsilon Ε ε E

eta Η η H

gamma Γ γ G

iota Ι ι I

kappa Κ κ K

lambda Λ λ L

mu Μ µ M

nu Ν ν N

omega Ω w W

omicron Ο ο O

phi Φ φ F

phi (alternate) ϕ J

pi Π π P

psi Ψ ψ Y

rho Ρ ρ R

sigma Σ σ S

tau Τ τ T

theta Θ θ Q

theta (alternate) ϑ J

upsilon Υ υ U

xi Ξ ξ X

zeta Ζ ζ Z
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Arrow  and Movem ent  Ke y s

Ke ys Act ions

[↑] Move crosshair up. In math: move editing lines up. In text: move 
insertion point up to previous line.

[↓] Move crosshair down. In math: move editing lines down. In text: 
move insertion point down to next line.

[←] Move crosshair left. In math: select left operand. In text: move 
insertion point one character to the left.

[→] Move crosshair right. In math: select right operand. In text: move 
insertion point one character to the right.

[PgUp] Scroll up about one-fourth the height of the window.

[PgDn] Scroll down about one-fourth the height of the window.

[Shift ][↑] In math: move crosshair outside and above expression. In text: 
highlight from insertion point up to previous line.

[Shift ][↓] In math: move crosshair outside and below expression. In text: 
highlight from insertion point down to next line.

[Shift ][←] In math: highlight parts of an expression to the left of the insertion
point. In text: highlight to left of insertion point, character by 
character.

[Shift ][→] In math: highlight parts of an expression to the right. In text: highligh
to right of insertion point, character by character.

[Ctrl ][↑] In text: move insertion point to the beginning of a line.

[Ctrl ][↓] In text: move insertion point to the end of a line.

[Ctrl ][←] In text: move insertion point left to the beginning of a word.

[Ctrl ][→] In text: move insertion point to the beginning of next word.

[Ctrl ][↵] Insert a hard page break. In math: insert addition with line break 
operator. In text: set the width of the text region.

[Ctrl ][Shift ][↑] In text: highlight from insertion point up to the beginning of a line.

[Ctrl ][Shift ][↓] In text: highlight from insertion point to end of the current line.

[Ctrl ][Shift ][←] In text: highlight left from insertion point to the beginning of a word

[Ctrl ][Shift ][→] In text: highlight from insertion point to beginning of the next word.

[Space ] In math: cycles through different states of the editing lines.

[Tab ] In text: moves the insertion point to the next tab stop. In math or plo
move to next placeholder.

[Shift ][Tab ] In math or plot: move to previous placeholder.

[PgUp] Move 80% up the window.

[PgDn] Move 80% down the window.

[Shift ][PgUp] Move up to previous pagebreak.

[Shift ][PgDn] Move down to next pagebreak.
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xt 
 Funct ion Ke y s

Not e These function keys are provided mainly for compatibility with earlier Mathcad versions. 
Mathcad also supports standard Windows keystrokes for operations such as file opening
[Ctrl ]O], and saving, [Ctrl ]S], copying, [Ctrl ]C], and pasting, [Ctrl ]V]. Choose 
Preferences from the View menu and check “Use standard Windows shortcut keys” on the
General tab to enable all Windows shortcuts.

[Home] Move to beginning of previous region. In text, move to beginning o
current line.

[End] Move to next region. In text, move to end of current line.

[Ctrl ][Home] Scroll to beginning of worksheet. In text, move insertion point to 
beginning of text region or paragraph.

[Ctrl ][End] Scroll to end of worksheet. In text, move insertion point to end of te
region or paragraph.

[↵] In text: start new line. In equation or plot: move crosshair below 
region, even with left edge of region.

Ke ys Act ions

[F1] Help.

[Shift ][F1] Context sensitive help.

[F2] Copy selected region to clipboard.

[F3] Cut selected region to clipboard.

[F4] Paste contents of clipboard.

[Ctrl ][F4] Close worksheet or template.

[Alt ][ F4] Close Mathcad.

[F5] Open a worksheet or template.

[Ctrl ][F5] Search for text or math characters.

[Shift ][F5] Replace text or math characters.

[F6] Save current worksheet.

[Ctrl ][F6] Make next window active.

[Ctrl ][F7] Inserts the prime symbol (‘).

[F7] Open a new worksheet.

[F9] Recalculate a selected region.

[Ctrl ][F9] Inserts blank lines.

[Ctrl ][F10 ] Deletes blank lines.
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ASCI I  codes

Decimal ASCII codes from 32 to 255. Nonprinting characters are indicated by “npc.”

Code Character Code Character Code Character Code Character Code Character
32 [space] 80 P 130 ‚ 182 ¶ 230 æ
33 ! 81 Q 131 ƒ 183 · 231 ç
34 " 82 R 132 „ 184 ¸ 232 è
35 # 83 S 133 ... 185 ¹ 233 é
36 $ 84 T 134 † 186 º 234 ê
37 % 85 U 135 ‡ 187 » 235 ë
38 & 86 V 136 ˆ 188 ¼ 236 ì
39 ' 87 W 137 ‰ 189 ½ 237 í
40 ( 88 X 138 Š 190 ¾ 238 î
41 ) 89 Y 139 ‹ 191 ¿ 239 ï
42 * 90 Z 140 Œ 192 À 240 ð
43 + 91 [ 141–4npc 193 Á 241 ñ
44 , 92 \ 145 ‘ 194 Â 242 ò
45 - 93 ] 146 ’ 195 Ã 243 ó
46 . 94 ^ 147 “ 196 Ä 244 ô
47 / 95 _ 148 ” 197 Å 245 õ
48 0 96 ` 149 • 198 Æ 246 ö
49 1 97 a 150 – 199 Ç 247 ÷
50 2 98 b 151 — 200 È 248 ø
51 3 99 c 152 ˜ 201 É 249 ù
52 4 100 d 153 ™ 202 Ê 250 ú
53 5 101 e 154 š 203 Ë 251 û
54 6 102 f 155 › 204 Ì 252 ü
55 7 103 g 156 œ 205 Í 253 ý
56 8 104 h 157–8npc 206 Î 254 þ
57 9 105 i 159 Ÿ 207 Ï 255 ÿ
58 : 106 j 160 npc 208 Ð
59 ; 107 k 161 ¡ 209 Ñ
60 < 108 l 162 ¢ 210 Ò
61 = 109 m 163 £ 211 Ó
62 > 110 n 164 ¤ 212 Ô
63 ? 111 o 165 ¥ 213 Õ
64 @ 112 p 166 ¦ 214 Ö
65 A 113 q 167 § 215 ×
66 B 114 r 168 ¨ 216 Ø
67 C 115 s 169 © 217 Ù
68 D 116 t 170 ª 218 Ú
69 E 117 u 171 « 219 Û
70 F 118 v 172 ¬ 220 Ü
71 G 119 w 173 - 221 Ý
72 H 120 x 174 ® 222 Þ
73 I 121 y 175 ¯ 223 ß
74 J 122 z 176 ° 224 à
75 K 123 { 177 ± 225 á
76 L 124 | 178 ² 226 â
77 M 125 } 179 ³ 227 ã
78 N 126 ~ 180 ´ 228 ä
79 O 127–9npc 181 µ 229 å
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I ndex
↵ (Enter key) 2
∫ (integral) 136, 299
→ (symbolic equal sign) 246
× (vector cross product) 130, 299
∑ (vector sum) 130, 299
→ (vectorize operator) 130, 201, 298
∑ and ∏ (summation and product) 130, 299
! (factorial) 123, 298
% 98, 298, 311
( ) (parentheses) 48
+ (with line break) 300
+, –, ·, and / 125, 300
:= (definition) 13, 97
<, >, ≤, ≥ (inequalities) 125, 300
= (Boolean equal) 126, 300
= (evaluating expression) 14, 99
| · | (determinant) 130, 299
| · | (magnitude/absolute value) 130, 299
∞ (infinity) 98, 311
≠ (not equal to) 126, 300
√ (square root) 125, 299
3D Plot Format dialog box 234
aborting calculations in progress 118
absolute value 127, 299
accessing Mathcad from other applications 294
acos function 146
acosh function 146
ActiveX 292, 294
adaptive smoothing of data 173
addition 125, 300
Ai and Bi Bessel functions 147
Airy functions 147
algorithms

See numerical methods
aligning

output tables 199
regions 79
text 60

and 125
angle function 145
Animate command 119
animation

compressing AVI files 120
creating 119
playback 120
saving 119
saving with worksheet 121
speed 119–120

antisymmetric tensor function 148
APPEND function 188
APPENDPRN function 188
approximations

Minerr function 160
root of expression 157

area
collapsing 85
deleting 87
inserting 85
locking and unlocking 85
naming 85
password protecting 85

arg function 148
arguments

of functions 104
arrays

calculations by element 201
copying and pasting 199
creating 35, 191
defining with range variables 192
displaying in results 198
exporting data from 203
extracting a row or column 197
extracting a subarray 154
functions for 152
graphical display of 202
importing data into 193, 196
nested 111, 204
operators for 127
ORIGIN used with 197
See also matrices and vectors

arrow keys, for editing 9, 314
ASCII codes

entering in strings 36
table 316

asin function 146
asinh function 146
assume keyword 249
assume keyword modifier 251
atan function 146
atan2 function 146
atanh function 146
augment function 153, 155
Auto (on status bar) 117
automatic calculation mode 117
autoscaling of axis limits 217
AutoSelect

in numerical integration 136
in solving 162
overriding 137, 163
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AVI files
compression 120
creating 119
hyperlinking from worksheet 121
playback 120

Axum component 283
Axum graphs in Mathcad 214
Axum LE 214
background color 82
bar plots (3D)

formatting 234
base 10 logarithm 147
base b logarithm 147
base of results (decimal/hex/octal/binary) 111
base units 113
bei and ber Bessel functions 147
Bessel functions 147
Bessel Kelvin functions 147
binary numbers 34, 111
bitmaps

color palettes 70
copying from the Clipboard 69
creating pictures from 68
functions for reading 189

blank lines, inserting or deleting 80
blank pages in printouts 94
blank space between regions 10
BMP files 68, 84, 189
bookmarks 26
Boolean operators 125, 127, 148, 161
border around a region 10
boundary value problems 183
break statement 273
breaking equations 255, 300
bspline function 167
B-splines 167–168
built-in functions

listed by type 143
symbolic only 301

built-in variables 98
bulleted paragraphs 60
business functions 173
bvalfit function 185
CAD drawings 286
Calc on message line 118
calculation 14

controlling 117
disabling for individual equation 118
equations 14, 99, 110
interrupting 118
locking area 85

order in worksheets 99
restarting after interrupting 118
units in 113

calculator, using Mathcad as 12
calling Mathcad from other applications 294
ceil function 149
Celsius 109, 116
CFFT function 150
cfft function 150
CGS units 114, 305
characters, deleting or inserting in math 43
Chi function 301
cholesky function 156
Ci function 301
Clipboard 49, 255
closing a worksheet 20
closing Mathcad

See exiting Mathcad
CMP (colormap) files 190
cnorm function 166
cnper function 173
coeffs keyword 247–248
Collaboratory 22, 28
collapsing an area 86
collect keyword 248
colon (:) as definition symbol 13, 97
color

Electronic Book annotation 24
equation highlight 82
in equations 52
in text 59
of worksheet background 82

color images
displaying 67
reading 189

color palettes for bitmaps 70
colormap files 190, 236
cols function 152
column vectors

See vectors
combin function 149
combinatorics functions 149
common logarithm 147
complementary error function 149
complex conjugate 127, 298
complex keyword 247–248
complex numbers

conjugate 127
determining angle 127
display of 111
entering 34
318  I ndex



imaginary unit symbol 111
magnitude of 127
operators and functions for 127, 149
real and imaginary parts 127
vector field plots 232

complex threshold 111
Component Wizard 281
components

inserting 281
overview of 280

compounding periods 173
computing results 14, 99, 104
concat function 187
cond1 and cond2 functions 153
conde and condi functions 153
condition number of matrix 153
conditional

functions 148, 188
statement 269

conjugate (complex) 127, 298
constants

changing the font style of 51
See also numbers and predefined variables

constraint
in solve blocks 161
tolerance 162

context menu
See pop-up menu

continue statement 273
contour integrals 138
contour plots

creating 231
formatting 234
See also plots, 3D

convert keyword 249, 254
Convert to Partial Fraction command 254
converting to partial fractions 249
copy and paste 10, 71, 116
copying

expressions 49
from Electronic Book 25
regions 10
results 116

corr function 163
cos function 145
cosh function 146
cosine (cos) function 187
cosine integral 301
cot function 145
coth function 146
covariance 163

crate function 173
CreateMesh function 154
CreateSpace function 154
creating

2D plots 207
3D plots 223
contour plots 231
Electronic Books 89
hyperlinks 87
pop-up window 87
surface plots 225, 227–228
text regions 55
vector field plots 232
worksheet templates 75

cross product 130, 299
crosshair for insertion 10
csc function 145
csch function 146
csign function 148
csort function 157
cspline function 167
CTOL variable 162, 311
cube root 112, 299
cubic spline interpolation 167
cumint function 174
cumprn function 174
cumulative distribution functions 164
cumulative interest paid 174
cumulative principal paid 174
curve fitting

functions for 169
polynomial 169–170
using cubic splines 167

curves, finding area under 136
custom operators 140
cvar function 163
δ function 148
d/dx

See derivatives
dashed selection rectangle 10
data

entering into a table 195
graphing 214

data files
exporting from an array 204
functions for reading and writing 188
importing data from 196
reading data from 193
reading into a matrix 193
writing from an array 203

data input 196
Index 319



date in header or footer 84
dbeta function 165
dbinom function 165
dcauchy function 165
dchisq function 165
debugging a worksheet 121
decimal places

in displayed results 111
internal precision 110

decimal points
numerical calculation 111
symbolic calculation 247

decomposition
matrix 156
partial fraction 247
singular value 157

default formats
2D plots 218
3D plots 234
numerical results 110
template 75
worksheet layout 75

defining
complex numbers 34
functions 104
global variables 100
local variables in program 268
multiple definitions of variable 100
numbers 33
operators 140
programs 267
range variables 102
See also creating
strings 35
units 109, 113
variables 13, 97

definite integral 258
definition symbol (:=) 13, 97
degrees, converting to radians 116, 145
deleting

blank lines 80
characters in math 43
equations 11
hard page breaks 83
hyperlinks 88
operators 46
parentheses 49
parts of an expression 50
regions 11
text 55

delta function 148, 301

derivatives 133, 299
higher order 135
symbolic 256

determinant 130, 262, 299
device-independent bitmap 69
dexp function 165
dF function 165
dgamma function 165
dgeom function 166
dhypergeom function 166
diagonal matrix (diag) function 152
dialects (spell-checker) 66
DIB

See device-independent bitmap
dictionaries (spell-checker) 66
differential equations 176

higher order 177, 179
partial 186
second order 177, 179
slowly varying solutions 182
smooth systems 182
stiff systems 182
systems 180

differentiation
See derivatives

differentiation variable 133, 135
digamma function 302
dilog function 301
dilogarithmic integral 301
dimensions 108
Dirac delta function 301
disabling equations 64, 118
display of arrays 198
display of operators 124
displayed precision

See decimal places
distribution functions 164
division 125, 299
dlnorm function 166
dlogis function 166
dnbinom function 166
dnorm function 166
dot product 129
double integrals 139
Down One Level command 205
dpois function 166
drag and drop 10, 25, 50, 71, 73, 116, 242
dragging regions 10
drawings

See pictures
dt function 166
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dunif function 166
dweibull function 166
ε function 148
e, base of natural logarithms 98, 311
Edit Go to Page command 9
Edit Links command 73
editing equations

annotated example 42
applying an operator 43
changing a number 43
changing a variable or function name 43
compared to word processors 42
deleting an operator 46
deleting parentheses 49
deleting parts of expression 50
inserting an operator 44
making expression an argument to a function 49
moving parts of an expression 49
moving/rearranging equations 79

editing lines 16, 42
eff function 174
effective annual interest rate 174
Ei function 301
eigenvalues 155–156
eigenvectors 155–156
Electronic Book

browsing history 24
copying information from 25
creating 89
moving around in 23, 26
searching for information in 24
toolbar 23, 26

Electronic Books 21, 87, 89
Email 28, 95
endpoints for ranges 103
engineering notation 111
Enter key 2
epsilon function 148
equal sign (=)

as Boolean operator 300
in numerical calculations 99
in solve blocks 159
symbolic calculations 246, 259–260

equality constraints 161
equations

as constraints in solve blocks 161
breaking 255, 300
calculating results 14, 99
color 52
disabling calculation for 64, 118
dragging and dropping 50

effect of range variables in 103
errors in 121
font 51
global definitions 100
in text 63
locking in area 85
order of evaluation 99, 117
processing and calculating 13, 117
properties 64, 118
solving for root 157
solving symbolically 259–261
solving with solve blocks 159
styles 51
units in 106
variable definition 97
wrapping 300

erf function 149, 301
erfc function 149
ERR variable and Minerr 162
error (erf) function 149–150, 301
error messages

correcting 122
custom 187
in equations 121
in programs 276
tracing the source of 121
with units 108

error string function 187, 276
Euler’s constant 301
Evaluate Complex command 254
Evaluate Floating Point command 247, 254
Evaluate in Place option 255
Evaluate Symbolically command 254
Excel

calling Mathcad from 295
Excel component 284
reading an Excel data file 193
writing data to an Excel file 203

exclusive or 125
exiting Mathcad 20
exp function 147
Expand command 254
expand in series 248
expand keyword 247–248, 254
expand nested arrays 111
Expand to Series command 247
Expert Solver 159, 163
expfit function 170
exponent 125, 298
exponential

function 147
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integral 301
notation, entering 34
notation, in displayed results 111
threshold 111

exporting
worksheets as HTML 77
worksheets as RTF 76

exporting data 203
expressions

applying a function to 49
converting to partial fractions 254
correcting errors in 122
deleting parts of 50
error messages in 121
evaluating 99
expanding 247, 254
factoring 247
finding the coefficients of 247
moving parts of 49
on multiple lines 300
selecting several 79
simplifying 254
symbolic evaluation of 246–247

Extending Mathcad in the Resource Center 22
Extension Packs 143
F (function) keys, table of 315
Φ function 148
Factor command 254
factor keyword 247–248
factorial (!) 125, 298
Fahrenheit 109, 116
fast Fourier transform 150
FFT function 151
fft function 150
fhyper function 149
file access functions 188
File Read/Write component 193, 203
File Send command 95
files

opening 76
reading data from 188, 193
saving 19
See also data files
See also worksheets
writing data to 188

filters
for exporting data 203
for importing data 193

finance functions 173
Find function 159–160, 261
first order differential equation 178

float keyword 247–248
floor function 149
font

changing in header or footer 84
changing in math 51
changing in text 58

footers 84
for loop 271
Format Header/Footer command 84
Format Properties command 64
Format Style command 61
formatting

2D plots 216
3D plots 234
numbers in matrices 199
operators 124
results 110
symbolic 255
worksheets 83

Formatting toolbar 8
math styles 52
text styles 61

fourier keyword 247, 249, 263
Fourier transforms

numeric functions 150
symbolic 247, 249, 263

FRAME for animation 119
Fresnel cosine integral 301
Fresnel sine integral 301
FTP 28
functions

applying to an expression 49
built-in 143
business 173
colormap 190, 236
combinatorics 149
complex arithmetic 127
defining 16, 104
error message 187
file access 188
finance 173
Fourier transform 150
hyperbolic 146
inserting 143
interpolation 167
inverse trigonometric 146
log and exponential 147
matrix decomposition 156
number theory 149
optimization 157
piecewise continuous 148, 188
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population statistics 163
prediction 167
probability distribution 164
recursive 106
regression 169
See also built-in functions
smoothing 172
solving 157
special 149
statistical 163
string manipulation 187
symbolic calculation 301
tensor 148, 187
that take vector arguments 152
to combine arrays 153–154
to compute angle to a point 148
to create arrays 154
to find roots of expressions 157
to manipulate strings 187
trigonometric 145
uniform polyhedra 190
user-defined 36, 104
vector and matrix 152

future value calculations 174
fv function 174
fvadj function 174
fvc function 175
gamma (Euler’s constant) 301
gamma function 149
Gaussian distribution 166
gcd function 149
generalized

eigenvalues 155
eigenvectors 155
inverse of a matrix 152
regression 171

genfit function 171
geninv function 152
genvals function 155
Given, in solve blocks 159, 261
global definitions 100
gmean function 163
Gopher 28
graphics, inserting 67
graphing

data 212
expressions 211
functions 211, 224
in 2D 207
in 3D 223
uniform polyhedra 190

vector 212
graphs

Axum 283
creating 17, 190, 223
formatting 18
resizing 18
See also  plots, 2D or plots, 3D
S-PLUS 288

greater than 125
greater than or equal to 125
greatest common divisor 149
greatest integer function 149
Greek letters

in equations 37
in text 57
table of 313

Greek toolbar 38, 57, 313
guess

for root finding 157
for solve blocks 159

guidelines for aligning regions 80
hard page breaks 83
HBK file for an Electronic Book 90
HBK files 22
headers and footers 84
heaviside step function 148
Help

context-sensitive 26
on-line 26
See also Resource Center and technical support

Her function 149
hexadecimal numbers 34, 111
highlighting equations 82
hist function 164
histograms 164
history of browsing in Electronic Book 24
hmean function 164
HTML 25, 77
HTTP 28
hyperbolic cosine integral 301
hyperbolic functions 146
hyperbolic sine integral 302
hyperlinks

and relative paths 88
deleting 88
editing 88
to other file types 89
to worksheets 87

Hypertext Mark-up Language
See HTML

i (imaginary unit) 34
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I0, I1, and In Bessel functions 147
ibeta function 149
ICFFT function 150
icfft function 150
identity function 152
identity matrix 152
if function 148, 188
if statement 269
ifft and icfft functions 150
IFFT function 151
Im function 148
image file

BMP format 68, 189
in headers and footers 84

imaginary numbers
entering 34
symbol for 34, 111

imaginary value 111
implied multiplication 42, 108, 312
importing data 193, 196
impulse function 148
incompatible units (error message) 108
increments for ranges 103
indefinite integral 258
indented paragraphs 60
index for an Electronic Book 91
index variables

See range variables
inequalities 125, 300

as constraints in solve blocks 161
infinity (∞) 37, 98, 311
in-line division 129
inner product 129
in-place activation 71, 282
Input Table component 195–196
input to a component 281
Insert Area command 85
Insert Function command 143
Insert Hyperlink command 87
Insert key 44, 56
Insert Link command 87
Insert Math Region command 63
Insert Matrix command

to create array 35, 191
to resize array 192

Insert Object command 10, 71, 116
Insert Reference command 87, 279
Insert Unit command 108, 113
inserting

blank lines 80
characters 43

equations in text 63
functions 49
graphic objects 71
graphics computationally linked 74
hyperlinks 87
math region 63
minus sign in front of expression 47
parentheses around expression 48
pictures 67
text 55
units 108
worksheet 279

insertion point 12
installation instructions 5
integral transforms

Fourier 247, 263
Laplace 247, 263
z 247, 263

integrals 136, 299
algorithms 136
AutoSelect 136
contour 138
double 139
indefinite 258
symbolic evaluation of 258
tolerance 138
variable limits 137

integration
adaptive 137
improper endpoints 137
infinite limits 137
Romberg 137

IntelliMouse support 9, 244
intercept function 169
interest rate 174
interest rate calculations 173
internal rate of return 176
International System of units (SI) 114
Internet

access 27
Collaboratory 28
Web browsing 25

Internet Explorer
See Microsoft Internet Explorer

Internet setup 28
interp function 167
interpolation

cubic spline 167
functions 167
linear 167

interrupting calculations in progress 118
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inverse
cumulative distributions 164
Fourier transform 247, 249, 263
hyperbolic functions 146
Laplace transform 247, 249, 263
matrix 130, 298
trigonometric functions 146
wavelet transform 152
z-transform 247, 249, 263

invfourier keyword 247, 249, 263
invlaplace keyword 247, 249, 263
invztrans keyword 247, 249, 263
ipmt function 175
irr  function 176
IsArray function 187
IsScalar function 187
IsString function 187
iterated product 130, 299
iterated sum 130
iteration

in programs 270
with range variables 15

iwave function 152
j (imaginary unit) 34
J0, J1, and Jn Bessel functions 147
Jac function 150
Jacobian matrix 182
JavaScript 292
js and ys spherical Bessel functions 147
JScript 292
K0, K1, and Kn Bessel functions 147
keywords, symbolic 247–250
Kronecker’s delta function 148
ksmooth function 173
kurt function 164
Lag function 150
Lambert’s W function 302
laplace keyword 247, 249, 263
Laplace transforms 247, 249, 263
Laplace’s equation 186
last function 152
Laurent series 247
lcm function 149
least common multiple 149
least integer function 149
left inverse of a matrix 152
Leg function 150
length function 152
less than 125
less than or equal to 125
lgsfit function 170

limits, evaluating 124, 259
line break

in equation 300
in text 56

line function 169
linear

interpolation 167
prediction 167
programming 159
regression 169
system solver and optimizer 159
systems of differential equations 180
systems of equations 156, 159

linfit  function 171
link

See also hyperlinks
to objects 71
to other worksheets 87, 279

linterp function 167
literal subscripts 39
ln (natural log) function 147
LoadColormap function 190, 236
local result format 17
lockable area

See area
locked calculations 85–86
locking and unlocking an area 85
loess function 169
log function 147
logarithms and exponential functions 147
logfit function 170
logical operators

See Boolean operators
long equations 255, 300
looping

for loop 271
while loop 272

lsolve function 156
lspline function 167
lu function 156
magnitude

complex numbers 127, 299
vector 130

mailing worksheets 95
manual mode 117
margins 83
Math Optimization command 266
Math Options command 98
math styles

applying 52
Constants 51
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editing 51
saving 53
Variables 51

Math toolbar 8, 38
Mathcad

accessing from other applications 294
Mathcad 6, 7, or 8 77
Mathcad Document object model 295
Mathcad OLE automation objects 294
Mathcad Overview 22
Mathcad Web Libary 22
MathConnex 291
MathSoft

contacting 6
MathSoft home page 25
MATLAB component 291
matrices

adding/deleting rows or columns 192
as array elements 204
calculations by element 201
combining 153–154
condition number 153
creating 35
creating from bitmaps 189
creating with components 281
decomposition functions 156
defining by formula 192
defining with two range variables 192
definition of 35, 191
determinant 130, 262, 299
displayed as pictures 67
displayed as scrolling output tables 198
extracting a column 196
extracting a submatrix 154
extracting elements 196
functions for 152
inverting 130, 298
limits on size 191, 199
matrix arithmetic 129
norm 153
norm of 153
numbering elements 197
operators for 127
ORIGIN used with 197
plotting in contour plot 231
plotting in surface plot 228
raising to a power 298
rank 153
See also arrays
singular values 157
sorting by row or column 157

special characteristics 153
start with row and column zero 197
subscripts 196
trace 153
transpose 130, 298

Matrix Determinant command 262–263
Matrix display style 111
matrix function 154
Matrix Invert command 263
matrix subscript 298
Matrix Transpose command 262–263
max function 152
Maximize function 160
MCD file 75
MCT file 75
mean

arithmetic 164
geometric 163
harmonic 164

mean function 164
measurement for the ruler 80
medfit function 169
median function 164
metafile 69
mhyper function 150
Microsoft Internet Explorer 22, 25, 292
Microsoft Office 73, 284
min function 152
Minerr function 160, 162
Minimize function 160
minus sign

for negation 125, 298
inserting in front of expression 47

MIP
See mixed integer programming

mirr function 176
mixed integer programming 163
MKS units 114, 309
mod function 149
mode

See automatic mode, manual mode
mode function 164
moving

crosshair 10, 314
editing lines 43, 314
insertion point 43, 314
regions 10

multigrid function 187
multiple integrals 139
multiple roots

finding with polyroots 158
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finding with solve blocks 162
multiple summations 131
multiplication 42, 299

implied 42, 108, 312
multivalued functions 112
names of variables and functions 36
natural logarithm 147
negating an expression 47, 298
nested arrays

defining 204
displaying 204
expanding 111, 205

new features in Mathcad 4
nom function 174
nominal interest rate 174
nonlinear systems of equations 159
nonscalar value (error message) 102
norm

of matrix 153
of vector 130, 299

norm1 and norm2 functions 153
normal distribution 166
norme and normi functions 153
not 125
not converging (error) 138
not equal to 125
notation in this User’s Guide 1
nper function 173
npv function 176
nth order derivative 135
nth root 125, 299
num2str function 187
number format

See result format
number theory functions 149
numbered paragraphs 60
numbers 33

binary 34, 111
complex 34
decimal 111
displayed as zero 111
exponential notation for 34, 111
format for computed results 110
formatting 16, 110
hexadecimal 34, 111
imaginary 34
octal 34, 111
radix (base) for results 111
rounding 149

numerical methods
differentiation 133, 135

integration 136
root finding 158
solving and optimization 162

object linking and embedding
See OLE

object model, Mathcad Document 295
objects

embedding 71
linking 71

octal numbers 34, 111
odesolve function 177
OLE

automation 292, 294
drag and drop 73
editing links 73
in-place activation 71, 73, 282
scripting objects 293
via components 280

on error statement 275
on-line resources 21
OpenGL 223
opening worksheets 76
operator placeholder 47
operators

Boolean 125
changing the display of 124
customizing 140
defined 39
deleting 46
derivative 133, 256
for complex numbers 127
for vectors and matrices 127
indefinite integral 258
inserting 44
integral 136
iterated product 130
iterated sum 130
logical 125, 148
nth order derivative 135
replacing 47
symbolic 124
table of 298
toolbars 8, 123
vector sum 132

Optimize Palette command 70
optimizers 159
or 125
or, exclusive 125
order

of derivative 135
of polynomial regression 169
Index 327



of worksheet evaluation 100
ORIGIN variable 98, 197
output from a component 281
output table 198

alignment 199
resizing 199
versus matrix display style 111

overlapping regions 81
overtyping text 56
overview of Mathcad features 4, 22
page

breaks, inserting and deleting 83
headers and footers 84
length 83
numbering 84

Page Setup dialog box 83, 93
palettes, color, for bitmaps 70
paragraphs 55

bullets 60
hanging indent 60
indenting 60
numbers 60
properties 59
tab stops 60
text alignment in 60

parametric surface plots
creating 229–230
See also plots, 3D

parentheses
deleting from expression 49
inserting into an expression 48

partial differential equations 186
partial fractions 247
password protecting an area 85
Paste command 11, 72
Paste Special command 11, 69, 72
pasting

bitmaps 69
device-independent bitmaps 69
from Clipboard 49, 69
metafiles 69
OLE objects 11, 72

payment calculations 175
pbeta function 165
pbinom function 165
pcauchy function 165
pchisq function 165
Pearson’s correlation coefficient 163
pending computations 117–118
percent 98, 311
permut function 149

permutations 148
personal

dictionary (spell-checker) 66
QuickSheets 141

pF function 165
pgamma function 165
pgeom function 166
phypergeom function 166
pi (∏, product symbol) 130
pi (3.14159...) 43, 98, 311, 313
picture operator 67, 203
pictures

border on 70
creating from bitmap file 68
creating from matrix 68
creating using SmartSketch 286
formatting 70
importing into an array 189
pasted from Clipboard 69
resizing 70

Piecewise 148
piecewise continuous functions 148
placeholder 12, 33
placeholder for an operator 47
Playback command 120
plnorm function 166
plogis function 166
plots 3D

graphing functions 224
plots, 2D

autoscaling of axis limits 217
changing perspective 220
copying format from existing plot 218
creating 208
default formats 218–219
formatting 216
graphing expressions 209
graphing functions 209
graphing vectors 213
multiple traces on 210
of data 214
QuickPlot 18
read-out of coordinates 221
reference lines in 218
resizing 18
setting axis or data limits 217
setting default formats 219
Show Markers 218
titles and labels 216
traces on 210
tracing coordinates on 221
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zooming 220
plots, 3D 223

3D Plot Format dialog box 235
3D Plot Wizard 224
annotations 241
backplanes 235
color 236, 240
colormaps 236–237
contour lines 238
contour plots 231
converting 241
creating 223
examples 224, 228
fill color 236
filling contours 237
fog 234
formatting 234
graphic annotations on 241
lighting 240
line color 239
lines 238
multiple plots on 233
OpenGL graphics 223
parametric surface plots 229–230
point color 240
point symbols 240
QuickPlot 224
resizing 18
rotating 243
space curves 227
spinning 244
surface plots 225, 227–228
text on 241
titles 236
uniform polyhedra 190
vector field plots 232
wireframe 238
zooming 243–244

pmt function 175
pnorm function 166
Poisson’s equation 186
polar plots

creating 208
formatting 216
See also plots, 2D

polygamma function 302
polyhedra 190
Polyhedron function 190
PolyLookup function 190
polynomial

finding the roots of 158

regression 169–170
Polynomial Coefficients command 247
polyroots function 157–158
population standard deviation 164
population statistics 163
population variance 164
popup hyperlink 87
pop-up menu

3D plots 242
animation playback 120
component 282
Excel component 285
Input Table component 195
integration 137
MATLAB component 291
Scriptable Object component 294
SmartSketch component 286
solving 163
S-PLUS Graph component 289
S-PLUS Script component 290
Web browsing 26

pop-up window, creating 87
power 125, 298
ppmt function 175
ppois function 166
precision, internal 110
predefined variables 98
predict function 167
prediction, linear 167
present value calculations 176
principal branch of function 112
Print Preview command 94
printing 20, 93

and calculation of worksheet 118
and pagination 84
blank pages in 83, 94
color 82
print preview 94
wide worksheets 93

PRNCOLWIDTH variable 98, 311
PRNPRECISION variable 98, 311
probability distributions 164
processing equations 13, 117–118

results of 117
product 130, 299

cross product 130
dot product 129
iterated 130

programs 267
adding lines 267
break statement 273
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continue statement 273
controlling or interrupting 272
defining 267
error handling 274
error messages in 276
for loop 271
generating symbolic results 269
if statement 269
local assignment 267
looping 270
nested 276
on error statement 275
output of 267
recursion 278
return statement 274
statements 267
subroutines 276
symbolic evaluation of 269
while loop 272

properties
of components 282
region 81

proxy server 28
Psi functions 302
pspline function 167
pt function 166
punif function 166
pv function 176
pweibull function 166
pwrfit function 170
qbeta function 165
qbinom function 165
qcauchy function 165
qchisq function 165
qF function 165
qgamma function 165
qgeom function 166
qhypergeom function 166
qlnorm function 166
qlogis function 166
qnorm function 166
qpois function 166
qr function 156
qt function 166
quadratic equation solving 163
QuickPlot 18, 209, 224
QuickSheets 21

See also Resource Center
storing custom operators 141

qunif function 166
qweibull function 166

radians
converting to degrees 116, 145
trig functions 145

radix of displayed results 111
range variables

array calculations with 201
creating arrays with 192
defining 15, 102–103
fundamental principle for 103
how Mathcad evaluates equations with 103
setting endpoints and increments 103

rank function 153
rater function 173
rbeta function 165
rbinom function 165
rcauchy function 165
rchisq function 165
Re function 148
READ_BLUE function 189
READ_GREEN function 189
READ_HLS function 189
READ_HLS_HUE function 189
READ_HLS_LIGHT function 189
READ_HLS_SAT function 189
READ_HSV function 189
READ_HSV_HUE function 189
READ_HSV_SAT function 189
READ_HSV_VALUE function 189
READ_IMAGE function 189
READ_RED function 189
READBMP function 189
reading a data file 193
READPRN function 188
READRGB function 189
recursion 106
reduced-row echelon form 152
reference tables in the Resource Center 22
references

and relative paths 280
to other worksheets 279

regions 10
aligning 79
blank space between 10
copying 10
deleting 11
dragging 10
dragging across documents 11
equation 10
locking 85
moving 10
overlapping 81
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putting borders around 10
separating 81
text 55
unlocking 86
viewing 10, 81

regress function 169
regression

functions 169
generalized 171
linear 169
localized 170
multivariate 170
polynomial 169–170
using linear combinations of functions 171

relational operators 148
relative paths

for hyperlinks 88
for references 280

relax function 186
Repaginate Now command 84
replacing characters in math or text 65
replacing operators 47
reports

for a solve block 163
resizing

graphs 18
pictures 70

Resource Center 21
accessing worksheets on Web 25
bookmarks 26
Mathcad Web Library 22
Web browsing in 25

resources, on-line 21
result format 110
results

calculating 14
calculating with equations 99, 110
complex 112
copying 116
formatting 110
units and dimensions in 113
wrapping 255

return statement 274
reverse function 157
rF function 165
rgamma function 165
rgeom function 166
rhypergeom function 166
rich text format (RTF) 76
right page margin 83
rkfixed function 178

rlnorm function 166
rlogis function 166
rnd function 166
rnorm function 166
root function 157
roots

finding 157
finding multiple with solve blocks 162
finding symbolically 259
numerical approximations used 158
of polynomials 158

round function 149
rounding numbers 149
row vectors

See vectors
rows function 152
rpois function 166
rref function 152
rsort function 157
rt function 166
RTF file 75

See also rich text format
ruler

for formatting a worksheet 79
for formatting text 60

runif function 166
rweibull function 166
sample standard deviation 164
sample variance 164
Save As dialog box 19
SaveColormap function 190, 236
saving

new file 19
templates 78
worksheets 19, 75

sbval function 184
scalar

addition 129
definition of 35, 191
division 129
multiplication 129

scatter plots (3D)
formatting 234
See also plots, 3D

scientific notation 111
Scriptable Object component 292

object model 293
search

Electronic Book 24
in equations 64
in text 64
Index 331



Search Book command 24
search function 187
sec function 145
sech function 146
second derivatives, calculating 135
second order differential equations 179
selecting

graphs 18
math expression 45
page break 83
regions 10
text 56

selection rectangle 10
semicolon, in range variable definitions 102
Separate Regions command 81, 84
separating overlapping regions 81, 84
series 247
series keyword 248
Shi function 302
Show Border option 70
Si function 302
sigma (summation symbol) 130

for vector 130
sign function 148
signum function 148
Simplify command 254
simplify keyword 248, 254
simultaneous equations, solving numerically 156, 159
sin function 145
sine integral 302
sinfit function 170
singular value decomposition 157
sinh function 146
skew function 164
slope function (linear regression) 169
SmartSketch component 74, 286
smooth systems (differential equations) 182
smoothing of data 172
soft page breaks 83
solve blocks 159, 177

constraints in 161
definition of 159
expressions allowed in 161
finding multiple solutions 162
Given in 159
reports for 163
tolerance 162
using to solve differential equations 177
using to solve numerically 159
using to solve symbolically 261
values returned by 160

solve keyword 248, 259–260
Solving and Optimization Extension Pack 159
solving equations 159

AutoSelect of algorithm 162
linear systems 162
nonlinear systems 162
See also solve blocks
with lsolve 156
with root function 157
with solve blocks 159, 261
with Solve for Variable 259
with solve keyword 259

sort function 157
sorting vectors and matrices 157
space curves

creating 227
See also plots, 3D

spaces, inserting or deleting 80
special functions 149
spell-checking 65
spline functions 167–168
S-PLUS Graph component 288
S-PLUS Script component 289
spreadsheets, exchanging data with 280
square root 299
stack function 154–155
stack overflow error 106
standard deviation of a data set 164
standard normal distribution 166
statistics

cubic spline interpolation 167
cumulative distribution functions 164
functions 163
generalized linear regression 171
interpolation 167
inverse cumulative distributions 164
linear interpolation 167
linear prediction 167
linear regression 169
multivariate polynomial regression 170
polynomial regression 169
probability density functions 164

stderr function 169
Stdev and stdev functions 164
step function 148
step size

for differential equation solving 182
for iteration 103

str2num function 187
str2vec function 187
strings
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arguments to file access functions 188
as elements of vectors 35
comparing 127
converting to numbers and vectors 187
defining 35
editing 46
evaluating 35
manipulating 187
variables 35

strlen function 187
styles

math 51
text 61

submatrix function 154
subroutines 276
subscripts

in text 59
last element function 152
literal 39
non-numeric 39
ORIGIN used with 197
start with zero 197
vector and matrix 298

Substitute for Variable command 247
substitute keyword 247–248
substr function 188
subtraction 125, 300
summation 299

iterated 130
of vector elements 130
variable upper limit 132

superscript
array 130, 298
to get column from matrix 197

supsmooth function 173
surface plots

creating 225, 227–228
formatting 234
parametric 229–230
See also plots, 3D

svd function 157
svds function 157
symbolic

equal sign 246
evaluation 246
evaluation of programs 269
keywords 247

Symbolics menu commands 254
system requirements for Mathcad 5
tab stops in a worksheet 79
table of contents for an Electronic Book 90

tables of data 195
tabs in a paragraph 60
tan function 145
tanh function 146
Taylor series 247
Tcheb function 150
technical support 6
temperature conversions 109, 116
templates 75

creating new 77
modifying 78
See also QuickSheets
used to save calculation mode 117
using to create a worksheet 75

text 55
alignment 60
bullets in 60
changing font 58
color 59
editing 58
entering 14
Greek letters in 57
inserting equations in 63
moving 57
moving insertion point in 56
Occupy Page Width option 58
Push Regions Down As You Type option 59
regions 55
selecting 56
spell-checking 65
styles 61

text box 14, 55
text regions 55

changing width 57
creating 14, 55
editing 58
how to exit 15, 55

text ruler 60
text styles 61

applying 61
creating 62
modifying 61

tilde (~), used in global definitions 100
time in header or footer 84
Tip of the Day 27
TOL variable 98, 311

and integrals 138
and solve blocks 162

tolerance
See TOL variable and CTOL variable

toolbars 8, 123
Index 333



customizing 9
Electronic Book 23, 26
operator 123
programming 267
Web 25

top-to-bottom evaluation 99
tr function 153
traces, on 2D plots 210
tracing the source of an error 121
trailing zeros 111
training 23
transcendental functions 145
transforms

discrete Fourier 150
Fourier (symbolic) 247, 263
Laplace 247, 263
symbolic 247
wavelet 152
z 247, 263

transpose of matrix 130, 262, 298
trig keyword modifier 251
trigonometric functions 145

inserting without parentheses 142
with degrees and radians 116

trunc function 149
truncation functions 149
two-point boundary value problems 183
typing over text 56
U.S. Customary units 114
Ucheb function 150
undefined variables 99, 101
uniform polyhedra 190
Uniform Resource Locator

See URL
unit impulse function 148
unit step function 148
units

alternative definitions 113
base units 113
CGS system 114
common sources of error 108
converting calculated results 115
default 107
defining 109, 113
dimensional consistency 108
errors in dimensions 108
in calculated values 113
in equations 106
metric 114
MKS system 114
of variable or expression 187

placeholder 113
prefixes 114
SI 114
simplifying 111
U.S. customary 114

UnitsOf function 109, 187
Up One Level command 205
update

window manually 118
worksheet 118
worksheet window 118

URL
Collaboratory 28
MathSoft home page 25

Use Default Palette command 70
user-defined functions 104

evaluating variables in 105
valid names 36

Var and var functions 164
Variable Differentiate command 256
Variable Integrate command 258
Variable Solve command 260
Variable Substitute command 254
variables

changing the font style of 51
defining 13, 97
global definitions of 100
in red 101, 121
matrices 35, 191
names 36
predefined 98
range variables 15, 101
string 35
substituting for 247
undefined 121
vectors 35, 191

variance of a data set 164
VBScript 292
vec2str function 188
vector field plots

creating 232
from complex matrices 232
See also plots, 3D

vector product 299
vector subscript 298
vector sum operator 132
vectorize operator 201, 298

effect of 201
how to type 201
properties of 201

vectors
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as array elements 204
calculations by element 201
column vectors 130
combining 154
creating 35, 191
cross product 130
displayed as scrolling output tables 198
dot product 129
functions for 152
graphing 213
limit on size 191
magnitude 130, 299
numbering elements 197
operators for 127
ORIGIN used with 197
row 130
See also arrays
sorting elements 157
start with element zero 197
subscripts 196
sum elements of 130, 298
undefined elements filled with zeros 197
vector arithmetic 129
vectorize operator 201

View Animate command 119
View Zoom command 9
Visual Basic in Microsoft Excel 295
Visual Basic Scripting Edition 292
W function 302
wait message 117
wave function 152
wavelet transforms 152
Web

See World Wide Web
Web Store 23
Web toolbar 25
while loops 272
windows

update results manually 118
working with 9
zooming in and out of 9

Windows keystrokes 9, 315
wireframe, in 3D plots 238
Wizards

for inserting 3D plots 224
for inserting a component 281

worksheet ruler 79
worksheets

closing 20
exporting as HTML 77

exporting as RTF 76
formatting 83
gathering in an Electronic Book 89
hyperlinking 87
in pop-up window 87
including by reference 87
opening 76
opening from Internet 26
order of evaluation 99
printing 20, 93
referencing in another worksheet 279
saving 19, 75
saving as templates 78
saving in an earlier format 77
sending by Email 95

World Wide Web
accessing 25
bookmarks for browsing 26
browsing 25, 77
Collaboratory 28
HTML browsing 25, 77
MathSoft home page 25
toolbar 25

wrapping equations 300
WRITE function 188
WRITEBMP function 189
WRITEPRN function 188
WRITERGB function 189–190
writing data to a data file 203
WWW

See World Wide Web
Wythoff symbol for a polyhedron 190
xor 125
X-Y plots

creating 208
formatting 216
QuickPlot 18
See also plots, 2D

Y0, Y1, and Yn Bessel functions 148
y-intercept 169
zero threshold 111
zeros of expressions or functions

See roots
Zeta function 302
zooming

2D plots 220
3D plots 244
windows 9

ztrans keyword 247, 249, 263
z-transforms 247, 249, 263
Index 335
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